




• SAFETY PRECAUTIONS •
(Always read these instructions before using this equipment.)

Before using this product, please read this manual and the relevant manuals introduced in this manual
carefully and pay full attention to safety to handle the product correctly.
The instructions given in this manual are concerned with this product. For the safety instructions of the
programmable controller system, please read the CPU module user's manual.
In this manual, the safety instructions are ranked as "DANGER" and "CAUTION".

! DANGER

CAUTION!

Indicates that incorrect handling may cause hazardous conditions,
resulting in death or severe injury.

Indicates that incorrect handling may cause hazardous conditions, 
resulting in medium or slight personal injury or physical damage.

Note that the ! CAUTION level may lead to a serious consequence according to the circumstances.
Always follow the instructions of both levels because they are important to personal safety.

Please save this manual to make it accessible when required and always forward it to the end user.

[Design Instructions]
!  DANGER

• For data change, program change, and status control made to the PLC which is running from a
Personal computer, configure the interlock circuit externally so that the system safety is
ensured. The action to be taken for the system at the occurrence of communication errors
caused by such as loose cable connection must be determined for online operation of PLC from
Personal computers.

!  CAUTION
• Be sure to read the manual careful and exercise an appropriate amount of caution connecting to

PLC CPU and performing online operations (PLC CPU program change during RUN, forced
input/output operation, RUN-STOP or other operation condition changes, remote control
operation) while the personal computer is operating.
Regarding the PLC CPU program change during RUN (Online change), the program may be
corrupted or have other problems depending on operation conditions. Exercise the appropriate
amount of caution with regard to the Caution points in section 8.4.3.

• Please refer to the manual of each module for online module change and swap module during
run, since there is restriction on the exchangeable module.



The texts, illustrations, diagrams and examples in this manual are only
intended as aids to help explain the functioning, operation, use and

programming of the GX IEC Developer IEC programming and
documentation system.

For using and usage of this software only the user his own is
responsible.

If you have any questions regarding the installation and operation of the
software described in this manual, please do not hesitate to contact your

sales office or one of your Mitsubishi distribution partners.
You can also obtain information and answers to frequently asked questions

from our Mitsubishi website under
www.mitsubishi-automation.com.

The GX IEC Developer software is supplied under a legal license
agreement and may only be used and copied subject to the terms of this

License Agreement.

No part of this manual may be reproduced, copied, stored in any kind of
information retrieval system or distributed without the prior express written

consent of MITSUBISHI ELECTRIC.

MITSUBISHI ELECTRIC reserves the right to change the specifications of
its products and/or the contents of this manual at any time and without

prior notice.

The IEC 61131.1 standard cited in this manual is available from the
publishers Beuth Verlag in Berlin (Germany).

© October 2008
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Art. No.: 43597

Version Changes / Additions / Corrections

A 03/1995 ME First issue

B 05/1996 ME Software update

C 07/1997 ME Software update

D 01/1998 ME Software update

E 08/2000 pdp-rs Update to software version 2.40

F 06/2001 pdp-rs Update to software version 4.00

G 05/2002 pdp-rs Update to software version 5.00

H 09/2003 pdp-ow Update to software version 6.00

I 10/2004 pdp-ow Update to software version 6.10

J 09/2005 pdp-ow Update to software version 7.00

K 12/2006 pdp-ow Update to software version 7.01

L 09/2007 pdp-ow Update to software version 7.02

M 10/2008 pdp-ow Update to software version 7.03





Typographic Conventions

Use of notes

Notes containing important information are clearly identified as follows:

NOTE Note text

Use of examples

Examples containing important information are clearly identified as follows:

Example Example text

�

Numbering in figures and illustrations

Reference numbers in figures and illustrations are shown with white numbers in a black
circle and the corresponding explanations shown beneath the illustrations are identified with
the same numbers, like this:
� � � �

Procedures

In some cases the setup, operation, maintenance and other instructions are explained with
numbered procedures. The individual steps of these procedures are numbered in ascending
order with black numbers in a white circle, and they must be performed in the exact order
shown:

� Text

� Text

� Text

Footnotes in tables

Footnote characters in tables are printed in superscript and the corresponding footnotes
shown beneath the table are identified by the same characters, also in superscript.

If a table contains more than one footnote, they are all listed below the table and numbered in
ascending order with black numbers in a white circle, like this:
� Text
� Text
� Text

Character formatting and orientation aids

Menu names, menu commands, submenu commands, and dialogue box options are printed in
boldface type. Examples: The menu item New in the menu Project or the options PLC inter-
face and Computer Link in the dialogue box Transfer-Setup.

Please keep this manual in a place where it is always available for the users.





GX IEC Developer Reference Manual IX

Contents

Contents

1 Introduction

1.1 This manual …. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-1

1.2 The Beginner's Manual… . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-1

1.3 If you are not yet familiar with Windows…. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-1

1.4 If you are not yet completely familiar with the IEC 61131-3 standard … . . . . . . . . . . . . . . . . . . . . . . 1-1

1.5 If you are already acquainted with IEC 61131-3 and want to get to work right away …. . . . . . . . . . . 1-1

1.6 If you need more information on programmable  controllers … . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2

1.7 If you need help on programming instructions when you are developing your programs … . . . . . . . 1-2

1.8 If you get stuck … . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-2

2 Installation

2.1 Hardware requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-1

2.1.1 Recommended hardware configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-1

2.1.2 Software Requirements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-1

2.1.3 Compatibility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-2

2.1.4 Copyright . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-3

2.1.5 Filling out the registration card . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-3

2.2 Installing GX IEC Developer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-4

2.2.1 Installing GX IEC Developer on your hard disk. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-4

2.3 Starting GX IEC Developer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-4

2.4 Quitting GX IEC Developer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-4

2.5 Bringing GX IEC Developer into the Foreground . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-4

2.6 The MMP703.INI Program Initialisation File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-5

2.6.1 Format of the MMP703.INI File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-5

2.6.2 Editing MMP703.INI Entries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-10

2.7 Windows Vista Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-11

2.7.1 File System Virtualization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-11

2.7.2 File Write Error Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-12

2.7.3 INI File Location in Windows Vista . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-19



X MITSUBISHI ELECTRIC

Contents

2.8 General Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-20

2.8.1 Cross Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-20

2.8.2 CSV-Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-21

2.8.3 Editing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-23

2.8.4 General . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-25

2.8.5 Graphic . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-27

2.8.6 Import/Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-28

2.8.7 LD-Guided Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-29

2.8.8 LD-Variable Name. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-30

2.8.9 Monitor Indication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-31

2.8.10 Monitor Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-32

2.8.11 ST Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-33

2.8.12 Tooltips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-34

2.8.13 Transition Condition. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-35

2.8.14 Variable Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-36

2.8.15 Zoom Header/Body . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-37

2.9 Project specific options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-38

2.9.1 Code Generation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-39

2.9.2 Compiler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-43

2.9.3 Online Change . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-46

2.9.4 Redundancy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-48

2.9.5 Reset Devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-50

2.9.6 System Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-51

2.10 Connecting the programmable controller (PLC) to the computer . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-53

2.10.1 Connecting FX/FX2/FXU/FX2U/FX2C series controllers . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-55

2.10.2 Connecting FX0/FX0N/FX0S/FX1S/FX1N/FX2N/FX2NC series controllers . . . . . . . . . . . . . . . 2-56

2.10.3 Connecting FX3U series controllers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-57

2.10.4 Connecting A/QnA series controllers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-61

2.10.5 Connecting Q series controllers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-65

2.11 Supported utility packages for the Q series . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-69

2.12 Connecting a printer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-69

2.13 Connection between PC and PLC via Modem . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-70

2.14 Installing the USB Driver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-71

2.14.1 When Windows� 2000 Professional is used . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-71

2.14.2 When Windows� XP Professional and Windows� XP Home Edition is used . . . . . . . . . . . . 2-73

2.14.3 When Windows Vista� is used . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-75



GX IEC Developer Reference Manual XI

Contents

3 The User Interface

3.1 The Title Bar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-2

3.2 The Menu Bar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-2

3.2.1 Menu Conventions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-2

3.2.2 Selecting menu commands. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-3

3.3 The Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-4

3.4 The Project Navigator Window and the Objects it contains . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-4

3.4.1 Navigator views . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-4

3.4.2 Objects in the Project Navigator window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-5

3.4.3 How objects are displayed in the Project Navigator window . . . . . . . . . . . . . . . . . . . . . . . . . 3-5

3.4.4 Editing objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-10

3.5 The Status Bar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-11

3.6 Working with Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-13

3.6.1 Object windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-13

3.6.2 Changing window display size . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-14

3.6.3 Dialogue boxes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-16

3.7 Special Functions and Dialogs of Redundant PLC Systems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-17

3.7.1 Rules for Redundant PLC Systems in Backup Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-17

3.7.2 Confirmation Dialogue in Backup Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-17

3.7.3 PLC Redundancy Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-20

3.8 Customising the Screen Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-22

3.9 Mouse and keyboard operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-26

3.10 General editing functions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-26

3.10.1 Using menu or keyboard operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-26

3.11 Drag&Drop by mouse operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-29

3.11.1 Functional description and user interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-29

3.11.2 Valid dropping targets inside one project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-31

3.12 Working in tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-33

3.12.1 Editing in tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-34

3.12.2 Automatic copying of the contents of the preceding line
into the new line (Autoincrement) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-36

3.12.3 Export and Import of Excel files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-37

3.12.4 Selecting data types in the declaration table . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-38

3.12.5 Automatic default data types in the declaration table . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-39



XII MITSUBISHI ELECTRIC

Contents

3.13 Working in the editors (Body) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-40

3.13.1 Networks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-41

3.14 The ST editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-45

3.14.1 Syntax colouring . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-46

3.14.2 Options in structured text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-48

3.14.3 Monitor functionality in ST editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-50

3.14.4 Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-52

3.14.5 Edit functions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-53

3.15 The graphical editors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-54

3.15.1 Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-55

3.15.2 Context menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-56

3.15.3 Right mouse button or F2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-56

3.15.4 Program Elements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-57

3.15.5 AutoConnect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-59

3.15.6 Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-63

3.15.7 Jump and Return Instructions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-67

3.15.8 Graphic macros. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-68

3.16 Selecting Programming Instructions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-69

3.17 Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-71

3.17.1 Selecting existing variables and declaring new variables . . . . . . . . . . . . . . . . . . . . . . . . . . 3-71

3.17.2 Find unused variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-74

3.18 Search and Replace . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-76

3.19 Tooltips. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-79

4 Projects and Objects

4.1 Projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-1

4.1.1 The automatically-generated project files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-1

4.1.2 Files with standard extensions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-2

4.2 What are the components of a project? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-2

4.3 The Project Navigator and Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-3

4.3.1 Library Pool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-3

4.3.2 Parameter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-4

4.3.3 Task Pool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-4

4.3.4 DUT Pool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-4

4.3.5 Global Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-4

4.3.6 POU Pool. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-5



GX IEC Developer Reference Manual XIII

Contents

4.4 The Program Organisation Unit (POU) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-6

4.5 Preparation Before You Start Programming . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-7

4.6 Library Concept . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-8

4.7 Working with Projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-12

4.8 Working with Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-19

4.9 Protecting Your Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-25

4.9.1 Project security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-25

4.9.2 Protected Symbolic Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-29

4.10 Printing Out Project Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-33

4.10.1 Print options for project data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-34

4.11 Cross Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-38

4.12 Double Coil Check. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-41

4.12.1 Filtering the Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-44

4.12.2 Sorting the Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-46

4.12.3 Showing the Location of the Coil in the Source . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-47

4.13 Verifying Projects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-49

5 Parameters

5.1 PLC Parameter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-1

5.1.1 Setting the PLC Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-2

5.1.2 Common Notes on Parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-2

5.1.3 PLC Parameter Item Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-6

5.1.4 Reading of PLC Parameter from the PLC. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-17

5.2 Parameters for Redundant PLCs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-18

5.3 Network Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-19

5.3.1 Setting the Network Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-19

5.3.2 Common Notes on Parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-20

5.3.3 Network Parameter Item Lists. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-23

5.3.4 Explanations for Network Parameter Setting Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-28

5.4 Memory Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-29

5.4.1 Memory Parameters (MELSEC A) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-29

5.4.2 Memory Parameters (MELSEC FX) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-30

5.4.3 Memory Parameters (MELSEC Q/QnA) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-31



XIV MITSUBISHI ELECTRIC

Contents

5.5 Latch Ranges . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-32

5.5.1 Latch Ranges (MELSEC A) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-32

5.6 Device Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-33

5.6.1 Device Settings (MELSEC Q/QnA) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-33

5.6.2 Devices in a Redundant System. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-36

5.7 Boot Settings (MELSEC Q/QnA (except Q25SS (SX Controller)) . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-37

5.8 PLC System (FX2N) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-38

5.9 I/O Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-40

5.9.1 I/O Configuration (MELSEC A) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-40

5.9.2 I/O Configuration (MELSEC A2C). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-41

5.9.3 I/O Configuration (MELSEC QnA) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-42

5.9.4 I/O Configuration (MELSEC Q) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-43

5.10 MELSECNET / Ethernet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-46

5.10.1 A series . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-46

5.10.2 QnA series . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-47

5.10.3 Q series. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-50

5.10.4 Qn(H) series and QnU(D)(E)(H) series . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-54

5.11 PLC Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-58

5.11.1 PLC Setup (MELSEC A) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-58

5.11.2 PLC Setup (MELSEC Q/QnA). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-59

5.12 CC-Link (MELSEC Q/QnA) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-62

5.12.1 CC-Link station information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-64

5.12.2 Remote device station initial setting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-65

5.12.3 Interrupt settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-67

5.13 MELSECNET/MINI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-68

5.13.1 MELSECNET/MINI (MELSEC A/QnA) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-68

5.14 Multiple PLC settings (Q series only, except Q00(J)) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-70

5.15 Serial (Q00 and Q01 only). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-71

5.16 CPU Type Selection. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-72



GX IEC Developer Reference Manual XV

Contents

6 Programming

6.1 The Structure of GX IEC Developer Programs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-1

6.2 Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-1

6.2.1 Event-triggered Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-2

6.2.2 Event-triggered tasks with Timer/Output Control (MC-MCR execution) . . . . . . . . . . . . . . . . . 6-2

6.2.3 Interval-triggered Tasks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-3

6.2.4 Priority-controlled Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-4

6.2.5 Special task MELSEC_FIRST. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-4

6.3 Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-5

6.3.1 Global and Local Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-5

6.3.2 Variable declarations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-5

6.3.3 Class . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-6

6.3.4 Identifiers and Absolute Addresses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-6

6.3.5 Initial Value . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-9

6.3.6 Comment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-9

6.3.7 Remark . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-9

6.3.8 Data Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-10

6.3.9 Address Batch Replace. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-12

6.3.10 Auto Update . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-12

6.4 Programming Languages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-13

6.4.1 Networks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-13

6.4.2 Text Editors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-14

6.4.3 Graphical Editors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-15

6.4.4 Sequential Function Chart (SFC) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-16

6.5 Programming in Sequential Function Chart Language . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-19

6.5.1 Sequential Function Chart Language Program Structure . . . . . . . . . . . . . . . . . . . . . . . . . . 6-20

6.5.2 Sequence rules and examples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-21

6.5.3 Editing elements in the SFC language . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-24

6.5.4 Content indication in SFC editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-24

6.5.5 Zoom functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-24

6.5.6 Assigning Actions to Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-25

6.5.7 Assigning Transition Conditions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-26

6.5.8 Enhanced Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-27

6.5.9 Comments in Sequential Function Chart Language. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-28

6.5.10 Manual SFC Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-29

6.5.11 Sequence errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-30



XVI MITSUBISHI ELECTRIC

Contents

6.5.12 Start, stop, and initialise SFC for QnA and System Q CPUs . . . . . . . . . . . . . . . . . . . . . . . . 6-31

6.5.13 ST for Boolean transitions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-35

6.5.14 SV instruction for QnA. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-45

6.6 Programming Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-51

6.6.1 Using timers in functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-51

6.6.2 Declarations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-52

6.6.3 Calling functions in the text editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-53

6.6.4 Calling functions in the graphical editors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-54

6.7 Programming Function Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-55

6.7.1 Using timers in function blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-55

6.7.2 Declaration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-56

6.7.3 Instantiation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-57

6.7.4 Calling function blocks in the text editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-58

6.7.5 Calling function blocks in the graphical editors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-60

6.7.6 Multiple use of a single instance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-60

6.7.7 Combine several steps and transitions to create a macro . . . . . . . . . . . . . . . . . . . . . . . . . . 6-60

6.7.8 Execution of Function Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-61

6.7.9 Global Function Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-65

6.8 Programming Data Unit Types. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-66

6.8.1 Declaration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-66

6.8.2 Use of the DUT as global variable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-67

6.8.3 Use of the DUT as local variable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-70

6.9 Programming Arrays . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-71

6.9.1 Declaration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-71

6.9.2 Calling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-72

6.9.3 Accessing an Array of BOOL as 16 or 32 bit Data Type. . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-73

6.10 Programming Timers and Counters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-74

6.10.1 TIMER and COUNTER Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-74

6.10.2 TIMER and COUNTER Function Blocks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-75

6.11 The EN input and ENO output. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-79

6.11.1 Execution with and without EN and ENO . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-80



GX IEC Developer Reference Manual XVII

Contents

7 Guided Ladder Editor

7.1 Main Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-1

7.1.1 Guided Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-2

7.1.2 Guided Editing Modes & Cursors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-3

7.1.3 Guided editing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-10

7.1.4 Character mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-23

7.1.5 Auto comment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-26

7.1.6 Characteristics of guided mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-29

7.1.7 Editing a pre-created circuit in Guided Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-31

7.1.8 Ladder option settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-32

7.2 Enhanced functionalities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-34

7.2.1 Additional functionalities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-34

7.2.2 Modified functionalities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-35

7.3 User-friendly hotkeys. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-36

7.3.1 Enhanced program component variable name display. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-39

7.3.2 Ladder circuit printout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-41

8 Compiling and Downloading Programs

8.1 Error Check . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-1

8.1.1 Execution order . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-2

8.2 Compiling. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-3

8.3 Downloading Projects to the CPU . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-5

8.3.1 Transfer Setup - Ports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-5

8.4 Modem settings for analog Modems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-13

8.5 Modem settings for GSM Modems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-16

8.5.1 FX-Series – Communication via Programming port . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-16

8.5.2 FX-Series – Communication with RS 232 BD . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-22

8.5.3 FX-Series – Communication via MAC (Transparent Mode) . . . . . . . . . . . . . . . . . . . . . . . . . 8-28

8.5.4 A-Series – Communication with C24 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-39

8.5.5 A-Series – Communication via MAC (Transparent Mode) . . . . . . . . . . . . . . . . . . . . . . . . . . 8-46

8.5.6 QnA-Series – Communication with C24 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-53

8.5.7 QnA-Series – Communication via MAC (Transparent Mode) . . . . . . . . . . . . . . . . . . . . . . . . 8-60

8.5.8 Q-Series – Communication with C24 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-67

8.5.9 Q-Series – Communication via MAC (Transparent Mode) . . . . . . . . . . . . . . . . . . . . . . . . . . 8-75

8.5.10 Special Remarks on using GSM modems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-82



XVIII MITSUBISHI ELECTRIC

Contents

8.6 Transfer Setup - Project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-83

8.6.1 Downloading the Intelligent Parameter file for Q projects . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-86

8.6.2 Download symbolic information by menu command. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-89

8.6.3 Ignore checks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-90

8.6.4 The Q/QnA’s File Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-91

8.6.5 Copy program memory to flash ROM (MELSEC Q only) . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-96

8.6.6 Copy Program Cache to Program Memory. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-96

8.6.7 Latch Data Backup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-97

8.6.8 Downloading the Project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-99

8.7 Comparison and Online Change of Project Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-100

8.7.1 Consistency. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-100

8.7.2 Comparing the programs in the PLC CPU and GX IEC Developer . . . . . . . . . . . . . . . . . . 8-104

8.7.3 Online Changes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-106

8.7.4 Transfer from Program Cache to Program Memory after Online Program (Ex)Change. . . 8-115

8.8 Exporting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-116

8.8.1 Exporting an GX IEC Developer project into an ASCII file . . . . . . . . . . . . . . . . . . . . . . . . . 8-116

8.8.2 Export to EPROM . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-116

8.8.3 CSV variable export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-117

8.9 Importing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-118

8.9.1 Importing GX IEC Developer ASCII files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-118

8.9.2 Importing GX Developer ASCII files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-120

8.9.3 Importing MELSEC MEDOC print files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-122

8.9.4 Upload PLC to MEDOC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-123

9 Diagnostics Functions and Online Operation

9.1 Debugging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-1

9.2 PLC diagnostics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-2

9.2.1 A CPU diagnostics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-2

9.2.2 QnA CPU diagnostics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-3

9.2.3 Q CPU/Q Remote I/O Module diagnostics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-5

9.2.4 FX diagnostics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-6

9.3 MELSECNET Diagnostics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-7

9.4 Ethernet Diagnostics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-15

9.5 CC-Link(-LT) Diagnostics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-17

9.6 System Monitor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-21



GX IEC Developer Reference Manual XIX

Contents

9.7 CC-Link IE Controller Network Diagnostics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-24

9.7.1 Network information display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-26

9.7.2 Select station network device status display. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-30

9.7.3 Logging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-32

9.7.4 System monitor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-34

9.7.5 Remote Operation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-38

9.8 Online Module Change . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-39

9.9 PLC System Error Check . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-43

9.9.1 System errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-43

9.9.2 User-defined errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-44

9.9.3 Hardware Diagnostics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-45

9.9.4 Scan . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-45

9.9.5 Show Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-46

9.10 The Device Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-48

9.10.1 The worksheet. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-49

9.10.2 Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-50

9.10.3 The pop-up menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-50

9.10.4 Editing tables in Microsoft Excel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-54

9.11 Forced Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-55

9.11.1 Forced Input/Output . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-55

9.11.2 Starting/Stopping a PLC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-57

9.11.3 Setting the PLC Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-59

9.12 The Monitor Function. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-60

9.12.1 Inheritance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-60

9.12.2 Monitor Mode Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-61

9.12.3 System Switching during Monitoring a Redundant System . . . . . . . . . . . . . . . . . . . . . . . . . 9-61

9.12.4 The Program Monitor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-62

9.12.5 The Entry Data Monitor (EDM) and the Header Monitor . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-66

9.12.6 Changing variable values . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-73

9.12.7 Display direct address of a variable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-78

9.12.8 Tracking variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-79

9.12.9 Tracking Variables in a Redundant System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-82

9.12.10Monitoring Boolean I/Os of function blocks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-84

9.13 In Cycle Monitor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-85

9.13.1 Running the In Cycle Monitor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-85



XX MITSUBISHI ELECTRIC

Contents

9.14 Buffer Memory Monitoring . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-89

9.14.1 Monitor Formats . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-91

9.14.2 Monitor Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-92

9.14.3 Monitor Value . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-93

9.15 GX Simulator . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-94

9.16 Intelligent Function Module Utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-96

9.16.1 Starting the utility. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-97

9.16.2 Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9-98

10 Working with Projects of Version 6.11 and before

10.1 External Variables are no longer used . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10-1

10.1.1 Using Global Variables in Bodies . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10-1

10.1.2 Compiler Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10-3

10.1.3 Variable Declaration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10-5

10.1.4 Update Variables. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10-7

10.1.5 Import from Excel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10-8

10.1.6 ASCII Import and Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10-9

10.1.7 User Libraries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10-11

10.1.8 Browser . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10-13

10.1.9 Entry Data Monitor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10-14

10.2 Opening Projects saved by former Versions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10-15

10.2.1 Opening older projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10-15

10.2.2 Copying and Moving Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10-16

10.2.3 Clipboard Operations and Drag & Drop in the Project Navigator . . . . . . . . . . . . . . . . . . . . 10-17

10.3 Special characters for identifier . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10-19

10.4 Compatibility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10-21

10.4.1 File based compatibility with former versions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10-21

10.4.2 PLC project based compatibility with former versions . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-21

10.4.3 Compatibility with other programming software for MELSEC PLCs: . . . . . . . . . . . . . . . . . 10-22

11 Support of other Applications

11.1 GX Configurator-DP Support. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .11-1

11.2 FX Configurator-EN Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .11-3



GX IEC Developer Reference Manual XXI

Contents

A Glossary

B Keyboard Commands

B.1 GX IEC Developer Menu Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-1

B.2 Common Keys. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-2

B.3 Project Navigator Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-3

B.4 Object Window Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-5

B.5 Dialogue Box Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-6

B.6 Declaration Table Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-7

B.7 Entry Data Monitor Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-9

B.8 Show Generated Code Keys. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-9

B.9 Show Verify Differences Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-9

B.10 Device Editor Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-10

B.11 Text Editor Keys (IL, MIL, ST) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-12

B.12 Graphical Editor Keys (FBD, LD). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-14

B.13 Sequential Function Chart Editor Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-17

B.14 Keys for Checking and Downloading Programs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-19

B.15 Online Help System Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-20

C Tools

C.1 General Tool Icons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-1

C.2 Instruction List Editor Tool Icons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-2

C.3 Ladder Diagram and Function Block Diagram Editor Tool Icons . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-3

C.4 Sequential Function Chart Editor Tool Icons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-4

C.5 Project Navigator Window Tool Icons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-5

D Temporary Files

D.1 Temporary Files Created when Projects are Compiled . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .D-1

D.2 Temporary files Created During Downloads . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .D-2



XXII MITSUBISHI ELECTRIC

Contents

E Programming Instructions

E.1 IEC Programming Instructions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-5

E.2 IEC – MELSEC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-10

E.2.1 Addition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-10

E.2.2 Subtraction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-11

E.2.3 Multiplication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-12

E.2.4 Division . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-13

E.2.5 Move . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-14

E.2.6 BCD –  BIN conversion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-15

E.2.7 Logic Operations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-16

E.2.8 Start of an Operation and Output of a Result . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-17

E.2.9 Comparisons. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-18

E.2.10 Shift . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-20

E.2.11 Rotation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-21

E.2.12 Set and Reset Operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-22

E.2.13 Rising/Falling Edge . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-23

E.2.14 Negation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-24

E.2.15 Jumps/Program Branching . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-25

E.2.16 Calling Subprograms and Function Blocks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-26

E.2.17 Exclusive Q Series Instructions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E-27

F Menu structure

G Compliance List



1 Introduction

1.1 This manual …

… is not designed to be read from cover to cover. It is organised so that it can be used as a
reference work in which you can find detailed explanations of all the menus and menu
commands in GX IEC Developer when you need them. However, the Reference Manual is not
based directly on the menu structure of GX IEC Developer, but rather on the central elements
of IEC Standard 61131-3 such as Projects, Objects, Variables, Program Organisation Units
and Programming Languages. The menus and all menu commands and options are listed in
the Appendix F of this manual.

1.2 The Beginner's Manual…

… is the ideal aid for getting acquainted with the basic terms and concepts of the new IEC
61131-3 standard. This manual teaches you how to use GX IEC Developer in easy steps, with
a sample program that provides a practical illustration of the most important operations.

1.3 If you are not yet familiar with Windows…

… please at least read the Windows Fundamentals section in the Windows User's Guide or work
through the exercises of the online Windows tutorial (accessible in the Program Manager).
This will give you the information and skills you need for using the elements of Windows that are
the same in all application programs.

1.4 If you are not yet completely familiar with the IEC
61131-3 standard …

… please read the chapter on the IEC 61131-3 standard in the Beginner's Manual. This
chapter explains the basic principles of this industry standard, together with the most
important new terms you need to know. A glossary of all the terms used is provided at the end
of this Reference Manual.

1.5 If you are already acquainted with IEC 61131-3 and
want to get to work right away …

… you will find the basic instructions you need to be able to produce immediate results in the
‘Getting Started' chapter in the Beginner's Manual.This chapter tells you how to perform all the
basic GX IEC Developer operations, from creating new projects to downloading your finished
programs to the PLC (programmable controller).
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1.6 If you need more information on programmable
controllers …

… please refer to the documentation provided with the hardware components of your system.

1.7 If you need help on programming instructions when
you are developing your programs …

… use the GX IEC Developer online help system. This provides direct access to brief explana-
tions of all programming instructions, together with their syntax, parameters and operands. A
list of all IEC and MELSEC programming instructions is also provided in the Appendix E of this
manual. More detailed descriptions and sample programs can be found in the programming
manuals of the individual PLCs.

1.8 If you get stuck …

… in what looks like an insoluble problem or if you have questions about GX IEC Developer or
the connected PLC configuration, please first refer to the manuals. Use the detailed index
provided in this Reference Manual. Answers to many of your questions can also be found in
GX IEC Developer‘s context-sensitive online help system, which can always be accessed by

pressing�. Please also make use of the Search command in the Help menu.

If you fail to find an answer to your particular question in any of these places you can also
obtain help from your local MITSUBISHI ELECTRIC representative. Alternatively, you can call
us directly at the MITSUBISHI ELECTRIC European headquarters in Ratingen, Germany.The
addresses and phone numbers are listed on the rear of all PLC manuals.
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2 Installation

2.1 Hardware requirements

2.1.1 Recommended hardware configuration

� Pentium II 350 processor or above

� 64 MB RAM (Microsoft Windows� 2000)
128 MB RAM (Microsoft Windows� XP)
1024 MB RAM (Microsoft Windows Vista�)

� Serial interface (RS-232)

� USB port

� Hard disk with at least 200 MB free space

� CD/DVD-ROM drive

� 17" (43 cm) VGA monitor (1024 x 768 pixels)

2.1.2 Software Requirements

GX IEC Developer is a 32-bit product. The following operating systems are supported:

� Microsoft Windows� 2000 Professional (with ServicePack 2 or higher)

� Microsoft Windows� XP Professional (up to ServicePack 3)

� Microsoft Windows� XP Home Edition (up to ServicePack 3)

� Microsoft Windows Vista� (32-Bit) (up to ServicePack 1)

Versions of Microsoft Windows which are based on double-byte character sets
(e. g. Japanese) are not supported.
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2.1.3 Compatibility

File based compatibility with former versions

� GX IEC Developer 7.03 can open project databases (*.pro file) of MM+ 2.1, 2.30a, 2.31,
2.31a, 2.32, 2.40, 2.40a, 2.50, 3.00, GX IEC Developer 4.00, 5.00, 5.01, 5.02, 6.00, 6.01,
6.10, 6.11, 7.00, 7.01 and 7.02, but these versions can not open GX IEC Developer 7.03
project databases.
Exception:GX IEC Developer 7.03 can not open project databases (*.pro file) of MM+ 2.1,
2.30a, 2.31, 2.31a, 2.32, 2.40, 2.40a, 2.50 and 3.00 with Microsoft Windows� XP and
Microsoft Windows Vista�.

� GX IEC Developer 7.03 can not open project databases (*.pro file) of MM+ 2.41 and vice
versa.

� GX IEC Developer 7.03 can import projects, which have been exported (*.asc file) by
MM+ 2.1, 2.30a, 2.31, 2.31a, 2.32, 2.40, 2.40a, 2.41, 2.50, 3.00, GX IEC Developer 4.00,
5.00, 5.01, 5.02, 6.00, 6.01, 6.10, 6.11, 7.00, 7.01 and 7.02, but these versions cannot
import *.asc exports of GX IEC Developer 7.03.

� GX IEC Developer 7.03 can open library files (*.lib file) of GX IEC Developer 4.00, 5.00,
6.00, 6.10, 6.11, 7.00, 7.01 and 7.02, but these vers ions cannot open
GX IEC Developer 7.03 library files.

PLC project based compatibility with former versions

It is possible, that the generated code of GX IEC Developer 7.03 is different to the generated
code of a former version of GX IEC Developer. This could result in the following facts:

� An online change can fail, if the project was not downloaded with GX IEC Developer 7.03.

� The functionality to verify the generated code with the program on the PLC can show
differences.

The reason for the differences are internal changes in the code generator which result from the
implementation of new features in GX IEC Developer 7.03.

NOTE Please also see section 2.9.1, Code Generation.
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Compatibility with other programming software for MELSEC PLCs:

� GX IEC Developer 7.03 can import MELSEC MEDOC/DOS print files (*.tmp) of the
versions 1.64b/c, 2.20 and 2.30.

� GX IEC Developer 7.03 generally can not upload parameters and programs from Q and
QnA/S CPUs, which are generated by GX Developer or GPPQ.

� GX IEC Developer 7.03 can upload only programs from Q and QnA/S CPUs which are
generated according to the limitations of GX IEC Developer 7.03 compared to the Q and
QnA/S features (only one program file MAIN.QPG).

� GX IEC Developer 7.03 can upload programs from A CPUs which are generated with
GX Developer or GPPA.

� GX IEC Developer 7.03 can not open project databases from GX Developer, GPPQ or
GPPA.

There is currently no direct possibility to exchange projects between GX IEC Developer 7.03
and GX Developer, GPPQ or GPPA.

2.1.4 Copyright

E
WARNING:
This software is protected by copyright. By opening the distribution CD-ROM package
you automatically accept the terms and conditions of the License Agreement. You are
only permitted to make one single copy of the original distribution disk for your own
backup and archiving purposes.

2.1.5 Filling out the registration card

You are only entitled to full technical support from MITSUBISHI ELECTRIC if you fill out and
return the enclosed registration card – don't forget to include your serial number! You will then
also receive information on updates and new versions of GX IEC Developer.
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2.2 Installing GX IEC Developer

During this procedure the installation program will create a directory on your hard disk, into
which all the GX IEC Developer files will be copied.

2.2.1 Installing GX IEC Developer on your hard disk

� Make sure that the correct Microsoft Windows version is properly installed on your
computer. For information on using Microsoft Windows please refer to the Windows
User's Guide.

� Start Microsoft Windows.

� Insert the installation CD-ROM in the CD-ROM drive.
The GX IEC Developer installation program starts automatically
(if not, execute the file SETUP.EXE on the installation CD-ROM).

	 Follow the instructions that appear on the screen.


 Enter the user name, company name, and serial number of the software.

� Follow the instructions that appear on the screen.

� When the installation procedure is finished the program will create a new program group
in the Start menu containing the GX IEC Developer program icon.

For further details on the necessary Microsoft Windows procedures please refer to your
Microsoft Windows documentation.

2.3 Starting GX IEC Developer
� In the Start menu click on the GX IEC Developer program icon. The icon is located in:

Start > Programs > MELSOFT Application > GX IEC Developer. This starts GX IEC
Developer and displays the start-up screen.

� Confirm with the� key.

2.4 Quitting GX IEC Developer

You can quit GX IEC Developer directly at any point in the program by pressing the key combi-

nation��.

Or:

Double-click on the Quit command in the Project menu.

2.5 Bringing GX IEC Developer into the Foreground

When GX IEC Developer is active on the screen at the same time as one or more other applica-
tions you can bring GX IEC Developer into the foreground by double-clicking on its icon in the
Program Manager.
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2.6 The MMP703.INI Program Initialisation File

The MMP703.INI initialisation file contains important parameters required by the Windows
application GX IEC Developer.

In previous versions of the GX IEC Developer, the MMPxxx.INI and MMPxxxProf.INI files were
located in the Windows folder. Now these files are relocated to the folder indicated by the
COMMONFILESFOLDER environment variable (usually C:\Program Files\Common Files).
The installer will create a folder named “MELSEC\GX IEC Developer” and place the INI files
there (� page 2-10).

2.6.1 Format of the MMP703.INI File

MMP703.INI is arranged in several sections that all have the same basic format. The following
list shows the standard and some sample settings. So your own INI file may look different!
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Contents of the MMP703.INI File
(Standard and sample entries) Explanation

[PROJECTS]
Project0=C:\MMP_PROJ\SILO1
Project1=C:\MMP_PROJ\TEST3
Project2=C:\MMP_PROJ\EXAMPLE
Project3=C:\MMP_PROJ\SILO2

PROJECT
List of the last four projects opened in GX IEC Developer
These projects are also displayed at the bottom of the Project
menu.
DO NOT EDIT!

[CompatibleCpu]
A1=A1N
A2=A2N
FX0/FX0S=FX0 / FX0S
FX2=FX / FX2
FX2C/Vup=FXU / FX2U / FX2C
FX2N=FX2N / FX2NC
Q2A=Q2A(H)
Q2A / Q2AS=Q2A(H)
Q2A-S1=Q2A(H)-S1
Q2A-S1 / Q2AS-S1=Q2A(H)-S1

COMPATIBLE CPU
List of compatible CPU types
DO NOT EDIT!

Tab. 2-1: Format of the MMP703.INI file (1)
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Contents of the MMP703.INI File
(Standard and sample entries) Explanation

[OPTIONS]
StepZoom=1
FBZoom=1
MacroGraphics=5
AutomaticIOpin=TRUE
PinOverWrite=TRUE
IncremNewDecl=TRUE
CommentCopy=TRUE
ChkDeclareExternal=TRUE
ChkErrors=25
ChkWarnings=100
LRUProjects=4
ArrayElementsToShow=10
CanEditPou=FALSE
MinDiskSpace=20
DefaultStringLength=32
AutoExportSUL=FALSE
AutoImportSUL=FALSE
AutoIMEXSUL=TRUE
ErrorLogFile=C:\MELSEC\

GX IEC Developer 7.03\ERR.TXT
InitNetworkHeight=4
CreateTmpVarForPLS=TRUE
CreateTmpVarForPLF=TRUE
CreateTmpVarForALT=TRUE
AllowFBCallWithVarOut=FALSE
ErrorForOverlappingElementsExceptLines

=FALSE
AutomaticIOPinENO=FALSE
ErrorForOverlappingElementsExceptLines

=FALSE
LRUVarsel=3
AutoUpdate=TRUE

OPTIONS
in the EXTRAS menu

Detailed information see page 2-38

MonitorStringLen=16
OnlineChangeFreeSpace=500
ActiveSystemTimer=FALSE
AllTimerActive=FALSE
RD_Enabled=FALSE
RD_ExcludeLatched=FALSE
RD_Include_D_Devices=FALSE
RD_Include_M_Devices=FALSE
RD_Include_T_Devices=FALSE
RD_Include_C_Devices=FALSE
RD_Include_S_Devices=FALSE
RD_Include_ST_Devices=FALSE
MinimizeErrlistboxAfterShow=FALSE
MinimizeVarselAfterDeclare=FALSE
MinimizeFunselAfterDeclare=FALSE
DoNotShowFXOnlineChangeMessage

=FALSE
AdjustSFCActiveInfoTable=TRUE
OnlineToolbar=FALSE
ActionOnZoomIntoFbd=2
ActionOnZoomIntoPou=1
VarExportGlobalsOnly=FALSE
AutoUpdateAllUserLib=FALSE
AllowSpecialChar=FALSE

OPTIONS
in the EXTRAS menu

Detailed information see page 2-38

[Online]
OnlinePollrate=250
RunTimeSystem=Generic
Baudrate=19200
Bytesize=8
Parity=0
Stopbits=1
Port=COM1
Downloader=

ONLINE
Online settings

Tab. 2-1: Format of the MMP703.INI file (2)
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Contents of the MMP703.INI File
(Standard and sample entries) Explanation

[View]
AutoLoadSaveWS=FALSE
ColorBackground=16777215
ColorForeground=12632256
ColorText=0
ColorSelection=8421504
ColorError=255
ColorBPEnabled=65535
ColorBPActive=65280
ColorMonitoring=65535
ColorTextLocked=8421504
ColorTextReadOnly=8421504
ColorShadeLT=16777215
ColorShadeRB=8421504
ColorGrid=0
ColorTextSelected=16777215
ColorBrowsedItem=16776960
ColorShadeMM=12632256
ColorSFCRasterElement=16777215
ColorCursorOvr=255
ColorCursorIns=16711680
ColorCursorLine=65280
ColorFillCursor=16711680

COLORS
The color setting (View - Colors) is also stored in the ini-file
(MMP703.ini) of GX IEC Developer 7.03 and no longer in the
project. This means, that changes in the color setting have effect
to all new or opened projects.

The entries in the column on the left represent the default values.

The entries in the ini-file are reset to the default values after
activating the menu item View - System Defaults.

[LADDER]
HLineLength=4

LADDER DIAGRAM
Horizontal length in Ladder diagram
Length in grid elements
Default setting: 4

VLineLength=3 Vertical height in Ladder diagram
Height in grid elements
Default setting: 3

[RC_GROUP]
1=1,53,Clock, ,
2=2,73,Security Level, ,
3=3,150,Editor Info, ,
4=4,40,Online, ,
5=5,55,CpuType, ,
6=6,110,ConnStatus,
Not Connected,;Connection Status Box

7=7,110,ErrorStatus,
Not Connected,;Error Status Box

8=8,25,GuidedEditing, ,;Guided Editing Mode
9=9,200,Path,,
10=10,30,System Resources,,
11=11,50,Free Memory,,
12=12,110,Redundant Info,,
13=13,150,MXC status,,

STATUS BAR
Status bar configuration settings
DO NOT EDIT!

[WORK_GROUP]
LEFT=20,2,8,
RIGHT=1,3,

STATUS BAR
Field size of the status bar entries
DO NOT EDIT!

[DEFAULT_GROUP]
LEFT=2,3,
RIGHT=1,

STATUS BAR
Field size of the status bar entries
DO NOT EDIT!

[LIBRARIES]
ManufacturerHelpPath=
C:\MELSEC\GX IEC Developer 7.03

USER LIBRARIES
Directory for the library help files

ManufacturerLibPath=
C:\MELSEC\GX IEC Developer 7.03\
LIBSMMP

Directory for the library files

Tab. 2-1: Format of the MMP703.INI file (3)
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Contents of the MMP703.INI File
(Standard and sample entries) Explanation

Manufacturer0=Standard_Lib,
SLIB.lib,FUNCTION.HLP

Manufacturer1=Manufacturer_Lib,
MLIB.lib,FUNCTION.HLP

Specification of the libraries
Max. 50 libraries are allowed.
Input order:
ManufacturerX=library name, library file, help file
(help file not necessary)
DO NOT EDIT!

[PRINT]
PrintFrame=1

PRINTOUT
=1: Printout options are enabled
=0: Printout options are disabled

OemBitmap=C:\MELSEC\
GX IEC Developer 7.03\MEGLOGO.BMP

Directory and file of bitmap
Bitmap is shown in the upper left corner in the page header

PrBitmap=C:\GX IEC Developer 7.03\
MMPLOGO.BMP

Directory and file of bitmap
Bitmap is shown in the upper right corner in the page header

Text1=Company XXX
Text2=Department XXX
Text3=Application XXX

Text in footer
3 text lines are shown in the page footer

PrintRaster=10 Size of printout
Default setting:10
depends on printer

ScDoc=1 ScDoc
ScDoc=1: Activates the interface to the documentation software
SCDoc.

[CrossReference]
GenerateSCT=TRUE
GenerateSCX=TRUE
GenerateSCXAfterBuild=FALSE

CROSS REFERENCE
Automatic link of the SCT files to the SCX file when creating
the cross reference data base
=TRUE: Function enabled
=FALSE: Function not enabled

[ScDoc]
ScPath=
NewBack=FALSE
NewBack1=FALSE
Changed=FALSE
Linkrev=FALSE
CallSc=FALSE
ScdPath=
Link=FALSE
LastPtr=

SCDOC
Section containing additional printer settings

[PARAM]
COMPORT=0

PARAMETER
Selection of the COM port of Personal Computer
COMPORT=0  Selection of COM1
COMPORT=1  Selection of COM2
The selection of the COM port will not be saved together with the
project. The COM port can be selected in the MMP703.INI.

[PATH]
CNF=C:\MELSEC\GX IEC Developer 7.03\
TYP_CNF
TYP=C:\MELSEC\GX IEC Developer 7.03\
TYP_CNF
EXE=C:\MELSEC\GX IEC Developer 7.03
LIB=C:\MELSEC\GX IEC Developer 7.03\
LIBSMMP
PPR=C:\MELSEC\GX IEC Developer 7.03\
PPR
MODEM=C:\MELSEC\GX IEC Developer 7.03\
MODEMSUP
16BITEXE=C:\MELSEC\GX IEC Developer 7.03\
MMPCNV\SC.EXE
PARAM=C:\MELSEC\GX IEC Developer 7.03\
DEFPARAM
GCDP=C:\MELSEC\GX IEC Developer 7.03\..\

DIRECTORIES
CNF Configuration files for all PLC types (special format)
TYP Configuration files for all PLC types (standard format)
EXE GX IEC Developer program files
PPR Project templates for all PLC types
DO NOT EDIT!

Tab. 2-1: Format of the MMP703.INI file (4)
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Contents of the MMP703.INI File
(Standard and sample entries) Explanation

[IEC_Export]
ExportFile=VARLIST.CSV
Separator=;
OverwriteExportFile=TRUE
AutoGenerateExportFile=FALSE

IEC-EXPORT
Section containing settings for the IEC export functionality

[WIZARD]
MELSEC=TRUE

WIZARD
Automatic POU and Task creation
MELSEC=TRUE
When you create a new project the Wizard is displayed on the
screen with a prompt asking if you wish to create a POU and a
task automatically.
MELSEC=FALSE
This setting disables the Wizard.

[SFC]
GenerateSfcStartupCode=TRUE

SEQUENCES
Automatic generation of startup code
LD M9039
OUT M9101
The special relay M9101 starts the execution of the SFC
processing.
1) The section [SFC] or the entry GenerateSfcStartupCode does
not exist or any of them is spelled incorrectly:
� The startup code will be generated automatically.
2) The section [SFC] and the entry GenerateSfcStartupCode
exist and the value is set to either TRUE, YES or 1:
� The startup code will be generated automatically.
3) The section [SFC] and the entry GenerateSfcStartupCode
exist and the value is set to any other value:
� The startup code will not be generated.

Usually the entry should be set to TRUE, to generate a proper
SFC processing.

[REG]

NAME: xxxxx
COMPANY: xxxxx
DISTRIBUTOR: xxxxx
SERIAL: xxxxx

GX IEC Developer REGISTRATION

Name/Company: information entered when you install GX IEC
Developer
Distributor/Serial: Distributor name and encoded serial number
DO NOT EDIT!

[Ccodegen]
TabDump=TRUE

CODE-GENERATOR
When TabDump=TRUE the following files are generated in the
project directory when GX IEC Developer is started with the
/debug option:
- PRECGEN.TAB
- POSTCMPR.TAB
- POSTCGEN.TAB

[devel]
eds=TRUE

[DEVICE_SETTING]
USE_COLORS=1

DEVICE EDITOR
Colors
Context menu - Options - Use Colors
=1: Use of different colors in display mode enabled
=0: Use of different colors in display mode disabled

SAFETY_INQUIRY=1 Safety inquiry
Context menu - Options - Additional Safety Inquiry
=1: Additional safety inquiry prompt is displayed
=0: Additional safety inquiry prompt is not displayed

[EDM]
FIELD0=Name
FIELD1=Type
FIELD2=Address (IEC)
FIELD3=Value (dec)
FIELD4=Value (bin)
ObjListInclLibraries=1

ENTRY DATA MONITOR
Configuration of Entry Data Monitor table

Tab. 2-1: Format of the MMP703.INI file (5)



2.6.2 Editing MMP703.INI Entries

E
WARNING:
Most MMP703.INI parameters should not be edited by the user! Please observe the
DO NOT EDIT! warnings in the table above.

How to make changes in the user-editable sections

� Create a backup copy of the file MMP703.INI in another directory or on a different
drive.

Important: Allways create a backup copy, because if the changes you make do not
work or result in unexpected problems when you run GX IEC Developer you can then
restore the original file in the folder named “MELSEC\GX IEC Developer” in the
common files section from the backup copy.

� Load MMP703.INI into a standard text editor such as the Windows Notepad utility.

Do not use an editor or word processor that inserts formatting codes in the text file, as
the system would then no longer be able to read the file.

� Make the necessary editing changes.

	 Save the edited file.


 Close the GX IEC Developer program and restart it.

Changes made to the MMP703.INI file do not take effect until you restart the
GX IEC Developer program.
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2.7 Windows Vista Support

2.7.1 File System Virtualization

When a limited user or a non-elevated administrator launches an application that is not aware
of Windows Vista’s User Account Control system, a Vista feature called “virtualization” is acti-
vated. If such an application attempts to write in a folder where it has no write rights (e.g. the
Windows and Program Files folders), the created file is automatically redirected to a folder in
the user’s profile (i.e. usually to the folder C:\Users\[username]\AppData\Local\VirtualStore).

In the Windows Common Dialogs, these redirected files are visible as if they were in the
original folder. In Windows Explorer, they can be revealed with the button Compatibility Files.

Since this Vista feature interferes with the project creation process of GX IEC Developer, this
feature has been disabled in GX IEC Developer Version 7.03. Attempting to create or save a
project or file in a folder without having write access rights to that folder will fail, and an error
message will be displayed. The affected functionalities and the shown error messages are
described in the following section.
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Fig. 2-1: Windows Vista Explorer



2.7.2 File Write Error Messages

Creating a folder

The following error messages will be displayed in the various functionaliaties when you
attempt to create a folder without having write permission to its parent folder:

The error message in Fig. 2-2 is shown when:

� Creating a project (Project�New…)

� Saving a project to a new location (Project�Save As…)

� Copying a project (Project�Other�Copy…)

� Upload from PLC to a new project (Project�Transfer�Upload from PLC…)

� Restoring a backup project (Extras�Project Restore…)

The error message in Fig. 2-3 is shown when:

� Renaming (moving) a project (Project�Other�Rename…).
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Fig. 2-2:
Error message when
creation of a folder
fails

Fig. 2-3:
Error message when
renaming (moving) a
folder



Creating a file

When a GX IEC Developer functionality needs to write a file, the common Windows file selec-
tion dialog is shown.Under Windows Vista the following message is displayed by the operating
system in the file selection dialog when you attempt to save a file in a folder where you have no
write permission. If you choose Yes, the current folder is changed to the user’s profile folder. If
you choose No, the Common Dialog remains open.

However, this message will not be displayed if you select an existing file in a folder where you
do not have write permission. Therefore, the following error messages – displayed by GX IEC
Developer when a file writing operation fails – will be shown, which include the write permis-
sion information.

The error message in Fig. 2-5 is shown when:

� ASCII export of project (Project�Other�Export…)

� ASCII export of object (Object�Export…)
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Fig. 2-4:
Error message when
writing a file in a
folder without write
permission

Fig. 2-5:
Error message when
file writing operations
fail in ASCII export



The error message in Fig. 2-6 is shown when:

� Excel export in EDM

� Excel export in the EDM Setup dialog

� Excel export in Device Edit

� Excel export in Forced Input/Output Registration/Cancellation

� Excel Export in Declaration Editors

� Excel Export in the DUV Address dialog

The error message in Fig. 2-7 is shown when:

� Exporting to Eprom (for A PLCs) (Project�Other�Export to Eprom)
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Fig. 2-6:
Error message when
file writing operations
fail in Excel export

Fig. 2-7:
Error message when
file writing operations
fail in export to
Eprom



The error message in Fig. 2-8 is shown when:

� Save Build logfile (Project�Build, Project�Rebuild All)

The error message in Fig. 2-9 is shown when:

� Reading from PLC in File Info (Online�File Info)
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Fig. 2-8:
Error message when
file writing operations
fail in building a
logfile

Fig. 2-9:
Error message when
file writing operations
fail in reading from a
PLC



The error message in Fig. 2-10 is shown when:

� Backing up a project (Extras�Project Backup…)

The error message in Fig. 2-11 is shown when:

� Exporting variables to CSV file (Extras�Export Variables)
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Fig. 2-10:
Error message when
file writing operations
fail in backing up a
project

Fig. 2-11:
Error message when
file writing operations
fail in exporting
variables



The error message in Fig. 2-12 is shown when:

� Exporting SV Alarm Info (Extras�SV�Export Alarm Info)

The error message in Fig. 2-13 is shown when:

� Reorganizing a database (Tools�Reorganize Database)
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Fig. 2-12:
Error message when
file writing operations
fail in exporting alarm
info

Fig. 2-13:
Error message when
file writing operations
fail in reorganizing a
database



Project Open Error Message

GID projects cannot be opened if any of the project files are write protected, or if you have no
write access to the project. The following extended error message will be shown.

The error message in Fig. 2-14 is shown when:

� Opening a project (Project�Open…)

� Verifying a project (Project�Other�Verify…)
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fails



2.7.3 INI File Location in Windows Vista

In previous versions of the GX IEC Developer, the MMPxxx.INI and MMPxxxProf.INI files were
located in the Windows folder. In Windows Vista limited users and non-elevated administrators
have no write access rights to this folder; therefore you would not be able to save any options
stored in these files.

Because of this, now these files are relocated to the folder indicated by the
COMMONPROGRAMFILES environment variable (usually C:\Program Files\Common Files).
The installer will create a folder named “MELSEC\GX IEC Developer” and place the INI files
there.Since all users have write access to this folder, you will be able to save the global options
here.

GX IEC Developer Reference Manual 2 – 19

Installation Windows Vista Support

Fig. 2-15: Windows Vista Explorer



2.8 General Options

The options are configured in the Extras - Options menu.

2.8.1 Cross Reference

Cross Reference Options

Used to define the options for generation of the cross reference database.

Generate *.SCT files while checking a project: Activates generation of the SCT files during
project checks.

Automatically link the *.SCT files to the *.SCX file after ‘Rebuild All': Activates automatic
linking of the SCT files to the SCX file after compiling a project.

Automatically link the *.SCT files to the *.SCX file after ‘Build': Activates automatic linking
of the SCT files to the SCX file after building a project.
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General Options -
Cross Reference



2.8.2 CSV-Export

All variables defined in the GVL and the POU header of a project can be exported as ASCII file
in Comma Separated Value format (*.csv).

Export File: Enter the path and name of the file to be exported

Separator:Select either the “Comma”or the “Semicolon”as separator character between values.

Export file:Select whether to either “Overwrite existing export file” or to “Backup existing file in
.CSX file”.

Generate export file after every successful build process: Activate this option, if desired.

Export global variables only: If this option is checked, only global variables are exported by
the Extras� Export Variables functionality. Local variables and type info are omitted.

NOTE Please also note the following section.
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General Options -
CSV-Export



Project name substitution in CSV-Export file name

The Export filename specified in Extras Options CSV-Export will be checked if it contains
the following string: “$(PrjName)”. If this string is found, it will be replaced with the short name
of the current project. If a relative path, or a file name without a path is specified, it will be
extended to a full path using the current project path.
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Full project path
(as an example)

Export file setting Full path of generated export file
(as an example)

D:\Projects\MyProject VarList.csv D:\Projects\MyProject\VarList.csv

D:\Projects\MyProject Export\VarList.csv D:\Projects\MyProject\Export\VarList.csv

D:\Projects\MyProject D:\Exports\VarList.csv D:\Exports\VarList.csv

D:\Projects\MyProject $(PrjName).csv D:\Projects\MyProject\MyProject.csv

D:\Projects\MyProject Export\$(PrjName) D:\Projects\MyProject\Export\MyProject.csv

D:\Projects\MyProject D:\Exports\$(PrjName).csv D:\Exports\MyProject.csv

Tab. 2-5: Examples of the generated file names

Fig. 2-18:
General Options -
CSV-Export with
project name
substitution



2.8.3 Editing

Declaration Editor

Auto update: Updates global and local variables automatically after changing a variable
declaration. The following changes of a variable declaration are updated: Class, Identifier,
Address, Type, Initial. All changes made in the GVL will also be executed in the POUs.
When you change a POU header, its body will also be changed automatically. The
variables are updated after the declaration editor changes have been saved.

Auto update all user libraries: Global variables defined in the project GVL can also
be referenced from POUs in a user library, but those variables are not updated by the
Auto update. Similarly when a global variable defined in a user library GVL is
changed, its references are not updated in other open user libraries, only in the user
library having the global variable, and in the project POUs. Checking this option
automatic updates all open user libraries. If there are no references in the user libraries
to global variables of the project or another user library, you should turn this option off
(uncheck) to enhance the performance of auto update.

Incremental New Declarations: When this option is enabled the contents of the
previous lines are copied automatically when new lines are inserted in the declaration
tables. The designators and addresses are automatically incremented by 1. If you also
want the system to copy the contents of the type and comment fields you must also
enable the Copy Comment and Type Fields check box.

Copy Comment and Type Fields: See Incremental New Declarations.
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Fig. 2-19:
General Options -
Editing



FBD/LD

Declare New Identifiers: When you overwrite a dummy variable in a graphical editor
with a variable identifier name that has not yet been declared the Variable Selection
(Mode NewVar) dialogue box will be displayed automatically so that you can enter the
declaration for the new variable.

Pin Overwrite: When you create a connection to an empty variable connection in a
graphical editor the empty variable will be overwritten.

Automatic Input/Output Variables: The system will automatically create the input and
output variables when you insert a function block in a graphical editor.

Automatic ENO Variables: The system will automatically create the ENO output
variable when you insert a function block in a graphical editor. If the ENO output
variable is not needed this option has to be disabled.
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2.8.4 General

Error Log File

Path and filename for the error log file.

Stop Check By

Errors: Stop the check operation when the number of errors found exceeds the
maximum limit specified here.
Range: 1 - 9,999

Warnings: Stop the check operation when the number of warnings exceeds the
maximum limit specified here.
Range: 1 - 9,999

Default string length (characters): You can set the default length of the STRING data type to
any value up to a maximum of 50 characters.

Array elements to show: The Entry Data Monitor can display the individual elements of an
array, but this can be impossible if the array is too large. This option enables you to set the
number of array elements to display to a maximum of 50 (� page 9-72 ).

You can also change this value in the prompt dialogue that is displayed when you open an
array in the Entry Data Monitor.

Most recently used files (number):The last projects opened are always displayed at the bottom
of the Project menu. You can set the number of projects to be displayed to a maximum of 9.

Minimum disk space (Mbytes): GX IEC Developer displays a warning message when the
amount of free space available on the current drive falls below the value specified here.

Allow special characters for identifier names

If checked, special characters can be used for identifier names. The following special charac-
ters are supported as valid characters:

� ä, Ä, ö, Ö, ü, Ü, ß, _, å, Å
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The usage of these characters is valid for the following identifier and all functionalities where
these identifiers are used (e.g. Variable selection dialogue):

� Library names

� Task names

� DUT names and DUT component names

� Global and local variable names

� POU names (PRG, FUN, FB)

� Network label names

� SFC Transition names

� SFC Action names

� SFC Step names

� SFC Jump label names

The character ‘_’ (underscore) was already allowed in older versions of GX IEC Developer.
Due to the restrictions by the IEC naming convention it was not allowed to use a double under-
score character at the beginning of an identifier (e.g. “__TestVar”). Additionally there was a
restriction for the usage of the underscore character as the last character of an identifier (e.g.
“TestVar_”). These restrictions can now be disabled by the user.

These identifiers can be used in every program editor:

� LD

� FBD

� IL

� MELSEC-IL

� SFC

� ST
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2.8.5 Graphic

Predefined network height when inserting: The initial height of a network.
Range: 4 - 100 grid points
Default: 4

Horizontal grid length of line segment: Horizontal length of line segments in the ladder
diagram editor, in grid points.
Range: 1 - 100 grid points
Default: 4

Vertical grid height of line segment: Vertical length of line segments in the ladder diagram
editor, in grid points.
Range: 1 - 100 grid points
Default: 3

Number of graphic macros: Number of additional graphic macros available.
Graphic macros 1 through 5 are always available.
Range: 5 - 25
Default: 5
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2.8.6 Import/Export

Import/Export options

Specifies how the user libraries are handled when a project is imported or exported.

Automatic import/export of user libraries:
Enables the automatic import or export of the user libraries.

Import all user libraries of the import file without any user confirmation:
Imports all user libraries without requesting any confirmation.

Export all user libraries of the current project without any user confirmation:
Exports all user libraries without requesting any confirmation.
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2.8.7 LD-Guided Mode

Wrapping of Ladder circuit

Do not wrap: Do not wrap the ladder circuit. This setting is applicable for the circuit
that is going to be edited after making this setting and not for the pre-created circuits.

Wrap after: Wrap if the ladder circuit exceeds the nth component position. This setting
is applicable for the circuit that is going to be edited after making this setting and not
for the pre-created circuits.

Components: The number of components to wrap after.
Range: 2 - 100
Default: 8

Auto comment Block width / Components: Set the auto comment block with a width of n
components in the network.
Range: 1 - 100
Default: 8

Set Guided Mode as default editing mode: The LD editor should be opened in Guided Mode
by default.

Allow Hotkey Repeater: The hotkey repeater window will be displayed whenever the Hori-
zontal or Vertical Line hotkey is pressed or accessed through the menu.
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2.8.8 LD-Variable Name

Settings for input/output variable names

Limit variable name display for input/output variables: When this option is checked,
the display of variable names for input/output variables is limited to the specified
number of characters.
default: unchecked

Visible characters per variable: Maximum number of characters for displaying
input/output variable names
Range: 2–255 characters
default: 12

Settings for contact/coil variable names

No multiline variable naming: When this option is checked, variable names are
displayed in one line.

Display variable name in: When this option is checked, a variable name will be
wrapped or folded in n lines in the network display.
Range: 1–4 lines
Default: 1

Visible characters per line: Maximum number of characters for displaying multiple line
variable names.
Range: 2–255 characters
default: 8

Allow Multiline for instance names: If checked, variable names for function blocks will be
displayed in multiple lines. The number of characters per line depends on the function block
width.

Do not allow “?” as a variable name: Do not allow the user to give the “?” mark as variable
name in Guided Mode. When this option is checked, you must specify a proper variable name
whenever you place a new program component in the network.
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2.8.9 Monitor Indication

If the monitor mode is active, the corresponding icon in the toolbar changes its colour from
black to red.

Indicate Monitoring by Title bar of

GX IEC Developer main window: If the monitor mode is active and objects are
monitored in one window at least (e.g. body of a POU or Entry Data Monitor), the text
"Monitoring" in the title bar of GX IEC Developer is blinking according to the defined blink
rate.

Window to be monitored: If the monitoring is started for a window (e.g. body of a POU
or Entry Data Monitor), the text "Monitoring" in the title bar of this window is blinking
according to the defined blink rate.

Blink Rate: The blink rate can be adjusted depending on the poll rate.
Range: 1 - 10
Default: 1
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2.8.10 Monitor Mode

Displayed String Length: Displaying long strings significantly reduces performance in moni-
toring mode. It is thus advisable to limit the number of characters to be displayed.
Range: 2 - 50
Default: 16

Poll rate: Interval at which the monitor polls the CPU, expressed in ms.
Range: 1 - 5,000 ms
Default: 250 ms

Word type variables

Decimal: Displays monitor values of word type variables in decimal format.

Hexadecimal: Displays monitor values of word type variables in hexadecimal format
(default setting).

This feature is also available in editors of the type IL, LD, FBD, and MIL via a context menu
when the monitor mode is active.

SFC

If the SFC body is observed in the monitor mode, you have to scroll through the
window. This can be done manually or by means of the autoscroll function.

The autoscroll function tracks the active steps of the SFC and scrolls the window
automatically. The horizontal and vertical position of the active step in the window can
be defined.

If the SFC includes more than one active step, the upper left active step is used for
autoscrolling.
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Even an active macro step is opened and the active step inside the macro step is
scrolled into view. If all steps get inactive in the SFC macro step, it is closed and the
former shown level is shown again.

If you have zoomed into a macro step before you started the monitoring or during
monitoring, this level is not left for the next higher level even when no step is active.

Enable autoscroll: These settings define the position where the active step will be
scrolled to (0 % / 0 % is the upper left corner).
Range: 0 - 100 %
Default: 10 %

2.8.11 ST Editor

Auto indentation: Auto indentation

Identifier proposal: Identifier proposal

Line number status: Line number status

Tabulator length: Set Tabulator length
Range: 1 - 64
Default: 4
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2.8.12 Tooltips

Enable Tooltips: This checkbox when checked enables the Tooltips without resetting the
display options.

Show tooltip for

Monitored value: If checked, tooltips are shown for monitored values.

Class: If checked, tooltips are shown for classes.

Mitsubishi address: If checked, tooltips are shown for Mitsubishi addresses.

IEC address: If checked, tooltips are shown for IEC addresses.

Type: If checked, tooltips are shown for types.

Initial value: If checked, tooltips are shown for initial values.

Comment: If checked, tooltips are shown for comments.

Remark: If checked, tooltips are shown for remarks.

Display tooltip in

Single line: Tooltips are shown in one single line.

Multiline: Tooltips are shown in multiple lines, if necessary.
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2.8.13 Transition Condition

When opening the transition's rectangle (e.g. by double click or by Zoom Into)

Transition Condition: is selected.
The TC editor will appear.

Standard Body: is selected.
The standard body editor will appear for new transitions.

GX IEC Developer Reference Manual 2 – 35

Installation General Options

Fig. 2-30:
General Options -
Transition Condition



2.8.14 Variable Selection

Setting for Variable Selection: Determines which library is pre-initialised when the Variable
Selection dialogue is shown.
Range: Header, Global Variable, Last Selected Entry
Default: Last Selected Entry

Setting if variable exists in GVL: Determines which library is pre-initialised when the
Variable Selection dialogue is shown from the LD/FBD when you type a variable name that is
not defined in the header but exists in the GVL.
Range: Ask, Use Global, Define Local
Default: Use Global

Setting if variable doesn’t exists: Determines which library is pre-initialised when the
Variable Selection dialogue is shown from the LD/FBD when you type a variable name that is
not defined either in the header nor the GVL.
Range: Ask, Define Global, Define Local
Default: Ask
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2.8.15 Zoom Header/Body

Navigator Zoom

Expand: Double-clicking on entries in the POU Pool displays/hides lower levels in the
hierarchy (default).

Open Header: Double-clicking on entries in the POU Pool opens the corresponding
header.

Open Body: Double-clicking on entries in the POU Pool opens the corresponding
body.

FBD/LD Zoom

Open Header: Double-clicking on a function block in a graphical editor opens the
corresponding header (default).

Open Body: Double-clicking on a function block in a graphical editor opens the
corresponding body.

Step Zoom Into

Step Action Association: Double-clicking on a step opens the Action Association
dialogue box (association of an action to a step).

First Action If Any: If actions are already associated with the step double-clicking on
the step displays the PLC program of the first action in the list.

Comment: Double-clicking on a step displays the Comment dialogue box
(for entering comment texts).
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2.9 Project specific options

The options are configured in the Extras - Options menu.

The MM+ versions 2.40 and higher provide the possibility to define project specific settings.
The project specific settings will be saved together with the project in the database.

Availability

Due to the fact that the project specific options belong to a specific project and are no general
settings, these options in the Options dialogue are available only if a project has been loaded.

To indicate that these settings refer only to the project currently loaded, the title of the Options
dialogue is Project Specific Options.

Database

Opening old projects

When opening old projects, i.e. projects created by lower MM+ versions, missing settings will
be filled up with the settings included in the .INI file. If the entries in the .INI file are not available,
hard coded settings will be inserted instead.

Creating new projects

When creating new projects the individual default values included in the .INI file are inserted. If
the entries do not exist in the .INI file, the hard coded default settings are inserted instead.
This behaviour is exactly the same as to open the Options dialogue and pressing the button
Load Defaults of both sections.

Compatibility

Due to the necessary changes in the database a project created by means of MM+ 2.40 or
higher cannot be opened by lower MM+ versions.

Files with the extensions *.PRO and *.PCD generated by MELSEC MEDOC plus 2.50 or lower
can not be opened by the current version of GX IEC Developer. In this case we recommend the
import/export functions or an external conversion tool (available on request).
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2.9.1 Code Generation

The section Code Generation is available for all CPU types.

Generate code for Manual SFC Control

This item is available for Q and QnA CPUs only, except Q00, Q00J, Q01, Q25SS, and
QnU(D)(E)(H).
If this option is enabled, a special sequence code is generated which includes one SET and
one RST instruction for the steps S0–Sn, where n is the maximum step number of all SFC
POUs. The code also includes a BRSET instruction at the beginning which sets the current
block according to a system word register.

This code helps to influence the step flags of every SFC block by setting the values for the D
and M devices. By the SFC editor only on SFC block can be handled at one time. Using LDP
allows to set a step in a running SFC without risking to activate the same step again several
times.
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The following checks are performed during the manual SFC control operation:

� The consistency is checked between PLC and project.

� The PLC must operate in RUN mode.

Generated sample code:

LD> K-1 D2048

BRSET D2048

LDP M4098

AND M4100

SET S0

LDP M4099

AND M4101

RST S0

:

LDP M4098

AND M4120

SET S10

LDP M4099

AND M4121

RST S10

:

Time Scheduler

This item is available for Q and QnA CPUs only.Timers in the A series CPU are not executed in
the same way as those in the Q/QnA series CPU. If a jump is made over a program part
containing a timer, the timer behaviour differs as follows:

If an A series project has been converted to a Q/QnA series project, the described timer
behaviour may result in a different execution of the complete project, especially in the following
cases:

� use of MELSEC function blocks
(e.g. TIMER_10_FB, TIMER_CONT_FB, TIMER_HIGH_FB)

� use of IEC function blocks (e.g. TOF, TON_HIGH)

� internal use of timers (e.g. timers controlling tasks)

� direct use of timers and retentive timers (via index qualification as well)

In order to avoid the different timer behaviour the timer scheduler function can be used. The
timer scheduler generates a special code which ensures the same timer behaviour in the
Q/QnA series CPU as in the A series CPU.
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If the timer scheduler is activated, the new code generation causes the following disadvan-
tages:

� The project needs more system variables.

� The scan timer will be longer.

� The code size will be bigger.

The timer scheduler can be activated/deactivated in this dialogue.

Generate code as in GX IEC Developer 5.02

The code generation option is available for all CPU types. For A and FX series all entries are
disabled except the compatibility flag. The button Load Defaults and Save As Defaults will
work only on the compatibility and different code warning flag of the Code Generation options
for A and FX series.

If the compatibility flag is set the same sequence code is generated as in GX IEC Developer
5.02.For old 32bit projects the compatibility flag is automatically set.For old 16bit projects and
for new projects the value of the compatibility flag depends on the default values, which were
saved by the user. If no default value is found in the INI file for the compatibility flag, FALSE is
taken.

If the different code warning flag is set, a warning is shown for every location where a different
code is produced in GX IEC Developer 7.03 compared to GX IEC Developer 5.02. The
messages of the warnings are different depending on the flag Generate code as in GX IEC
Developer 5.02.

For old 32bit projects the different code warning flag is automatically set. For old 16bit projects
and for new projects the value of the different code warning flag depends on the default values,
which were saved by the user. If no default value is found in the INI file for the different code
warning flag, TRUE is taken.

In GX IEC Developer 5.02 a boolean destination of some standard functions and of user func-
tions with EN/ ENO is changed even when the EN is FALSE. When the compatibility flag is not
set the boolean destinations keep their values and are not changed.

According to the value of the compatibility flag a different code is produced in GX IEC Devel-
oper 7.03 for the standard functions with boolean destinations:

� INT_TO_BOOL_E, WORD_TO_BOOL_E

� DINT_TO_BOOL_E, DWORD_TO_BOOL_E, TIME_TO_BOOL_E

� LIMIT_E

� NOT_E

� EQ_E, NE_E, GT_E, GE_E, LT_E, LE_E

� CPY_BIT_OF_INT, CPY_BIT_OF_INT_E

� AND_E, OR_E, XOR_E

� MAX_E, MIN_E

To get the same code produced in GX IEC Developer 7.03 as in GX IEC Developer 5.02
without setting the compatibility flag, the above standard functions could be replaced with the
functions without EN/ENO where the boolean result is connected to an AND block with the
former EN as other input. The former destination must then be used as output of the AND.
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Show warnings for different coding compared with GX IEC Developer 5.02

When enabled a warning is shown for every location where different code is produced in
GX IEC Developer 7.03 compared to GX IEC Developer 5.02.

Use SET/RST for Boolean Outputs

If a SET/RST flag is not set, the generated code uses the OUT instruction to write to the bit
output for the according EN/ENO functions in LD/FBD.

Allow SFC reset variable as transition

An SFC POU of an FX project can have a “reset variable”, a Boolean variable which – when
activated – resets all steps and sets the initial step.Using this variable as transition has no use,
because when the transition’s state gets switched on, the control will get back to the initial step,
not to the step or steps following the path of the transition.
(Also see: EMERGENCY OFF for FX Series, page 6-18.)

You are able to choose if such a situation should lead to an error or a warning.

The following warning will be produced by the compiler if an SFC reset variable is used as tran-
sition and it is allowed in the Options:

C9175 SFC reset variable used as transition.

The following error will be produced by the compiler if an SFC reset variable is used as transi-
tion and it is not allowed in the Options:

C9175 SFC reset variable used as transition. This error can be converted to a warning
in the Options.

Activate all initial steps in the first scan

This option is available for the FX series only. It allows the control of the activation of the initial
step by the user.

The default status is enabled. The compiler will produce a sequence code to activate all initial
steps in the first scan. When this option is not checked the sequence code is not produced.

If you want to keep the status of the steps of the SFC POUs for the FX series, you must deacti-
vate the option, latch all step flags of the system variable address range and control the activa-
tion of the SFC POUs by their according SFC Reset variables.
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2.9.2 Compiler

Create temporary variables for instruction PLS_M / PLF_M / ALT_M

System variables are required for internal processing when the output variables of the instruc-
tions PLS_M, PLF_M and ALT_M are used to activate additional instructions. If you use many
instructions of this kind the maximum limit for number of system variables (system labels) that
you can use can be reached very quickly.

If this happens you should disable the option Create temporary variables for instruction
PLS_M / PLF_M / ALT_M. Your PLC program must then be modified accordingly.

Default: Enabled
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Function block calls - Allow VAR_OUTPUT in call of FB (IL and ST)

If checked it is allowed to use a VAR-OUTPUT assignment directly with the call of a FB
instance. E.g. CAL FBInst (FBVarOut:=Variable).

Function block calls - Allow unassigned inputs for Macro-FB calls

This option can be used to decide, if an unassigned input in a macro will result in a compiler
warning or a compiler error.

Example In the following examples the same Macro-FB instance is called with the same operands. In all
three cases the assignment for the input parameter "ValueIn" is missing.

�
Although this is not illegal, and can be used on purpose, it is a potential source of problems.
By this compiler option the user can select if missing input assignments in Macro-FB calls
should result in a compiler error or a compiler warning.

If this option is checked, unassigned inputs result in compiler warnings. And if unchecked,
unassigned inputs result in compiler errors.

NOTES If the option is changed from checked to unchecked, the error will not be found in already
compiled POUs when Build is called, only when Rebuild All is called.
The reason is that already compiled, errorless POUs are not checked again during
incremental build, only if some change in the project affects them or Rebuild All is called.
To inform the user about this behavior, a message is displayed when the option is changed
from checked to unchecked, which has to be confirmed by pressing the OK button.

For further details concerning macros please see sections 6.7.7 and 6.7.8.
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Variables - Allow local variable with the same name as a global variable

If checked, global variable hiding will not be considered to be an error. This option allows to
choose if global variable hiding should be considered to be a programming error or not. By
default, if a local variable of a POU has the same name as a global variable, an error will be
shown when the POU is checked. If you turn this option on, global variable hiding will be
allowed and the POU will be compiled.

Variables - Allow lower case Mitsubishi device/constant names as variable names

This option is used to give the user a hint, that a Mitsubishi Device or Constant could be hidden
by a variable declaration with lower case letters.

� If the option is checked, a warning is shown when a Mitsubishi device/constant name is
used in a lower case format as variable name.

� If the option is unchecked, an error is shown when a Mitsubishi device/constant name is
used in a lower case format as variable name.

Disable Compiler Warnings

The display of compiler warnings in the error box during a Check, Build, or Rebuild all execu-
tion can be disabled. Default setting: Warnings enabled.

To disable a compiler warning, take the following steps:

� Enter the compiler warning code in the edit field.

� Press the Add... button.

The compiler warning is disabled and listed in the list box.

To enable a compiler warning, take the following steps:

� Select a compiler warning code from the list box.

� Press the Delete... button.

The compiler warning is enabled and removed from the list box.

User defaults

The user defaults are handled by three functional buttons:

� Reset Defaults, resets the settings to the manufacturer default settings
(saved user defaults will remain untouched)

� Load Defaults, loads user defaults

� Save As Defaults, saves the current settings as your own user defaults

These ease the setting by giving you the opportunity to define and reload your own default
settings (the so called “user defaults”). Initially the user defaults are the same as the manufac-
turer defaults, until you save different, user defined settings as defaults by using the button
Save As Defaults.

On creating a new project, the options will then be set to the user defaults. Similarly, when
opening an existing project last saved with GX IEC Developer version 7.03 or earlier, the
options will be set to your own user defaults. Afterwards, when the project is saved in the new
version, the compiler options become part of the project and can be set individually.
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2.9.3 Online Change

The section Online Change is available for all CPU types except the A series.

Allow online change for inconsistent projects

See section 8.7.1 for further details.

Additional program size

This item is available for Q and QnA CPUs only.Due to the file structure of the MELSEC Q and
QnA CPUs it is necessary to define an additional program range (in units of steps) for online
changes (� 8.7.2).

After the Additional Program Size has been changed, the value will be checked when leaving
the dialogue. This check can be done via the OK button or changing the section by clicking on
another entry in the List Options. In case of an error an error message will appear.
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Automatic transfer from program cache to program memory

This item is available for QnU CPUs only. When checked, the contents of the program cache
will be automatically transferred to the program memory after online program change opera-
tion.Otherwise the user will be asked after each online program change operation whether the
transfer should be made.

For further information refer to section 8.6.6.
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2.9.4 Redundancy

The section Redundancy is available only for QnPRH CPUs.

Allow device writing on the Standby system: If checked, device writing on the standby
system is enabled, and the following confirmation message will be displayed when attempting
to write on the standby system.

Show redundancy information in title bar of online dialogs: If checked, information about
the status of the redundant system will be displayed in the window title for specific
functionalities on QnPRH PLCs in the following format:

Original window title - Actual operating mode – Status of connected system

The following functionalities are included:

� Device Edit

� Buffer Memory Batch Monitor

� File Info

� Format Drive

� Monitoring Indicator

� User Errors

� Hardware Diagnostics

� Scan Time

� Forced I/O Registration/Cancellation
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Synchronize file selection if both systems are enabled: This option is relevant if operations
on both systems are enabled in the menu Online - File Info (� page 8-92).
The synchronization of selected files concerns the selected files in the file lists of the two
systems.
When this option is checked, the selections in the two file lists will be kept synchronized. Any
changes in selections in one list will be automatically reflected in the other list (if the
selected/unselected file also exists on the other PLC).
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2.9.5 Reset Devices

If the option Enable reset system devices is not selected, all other options are disabled to
indicate that the reset devices are not active.

Reset Defaults

When pressing the button Reset Defaults the settings of this section are reset to their default
values, i.e. the hard coded settings are loaded. This is especially helpful to restore the original
settings.

Load Defaults

When pressing the button Load Defaults the default settings saved in the .INI file are loaded.
If the .INI file does not include any entries, the hard coded settings are loaded.

Save As Defaults

When pressing the button Save As Defaults the current settings are saved as default settings
to the .INI file. If the .INI file does not include any saved default settings yet, they will be created
by this operation.
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2.9.6 System Variables

System variable ranges for the actual project. Available if an Q/QnA project is open.

Word Range

D: D devices are used as word system variables.

R: R devices are used as word system variables.

W: W devices are used as word system variables.

Word range – From/to: PLC type dependant, as defined in the parameters.

Timers

Standard (T) – From/to: PLC type dependant, as defined in the parameters.

Retentive (ST) – From/to: PLC type dependant, as defined in the parameters.

Counters ©)

Counters – From/to: PLC type dependant, as defined in the parameters.

Bit range

M: M devices are used as bit system variables.

Bit range – From/to: PLC type dependant, as defined in the parameters.

Labels (P)

Labels – From/to: PLC type dependant, as defined in the adequate CNF file.

Step flags (S)

Step flags – From/to: PLC type dependant, as defined in the adequate TYP file.

Display Program Size: A summary of the used program size is displayed on a separate
dialogue box. If the program is not compiled the dialogue shows a ‘?’ character instead of the
program size. If SFC or SUB programs are not available for this CPU, the correspondent line
will be grayed.

Display Used Ranges: A summary of the used system variable ranges is displayed on a
separate dialogue box.
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System variable ranges for the actual project. Available if an A/FX project is open.

Word Range

D: D devices are used as word system variables.

R (A projects only): R devices are used as word system variables.

W (A projects only): W devices are used as word system variables.

Word range – From/to: PLC type dependant, as defined in the parameters.

Timers

100 ms (T) – From/to: PLC type dependant, as defined in the parameters.

10 ms (T) – From/to: PLC type dependant, as defined in the parameters.

Retentive (T) – From/to: PLC type dependant, as defined in the parameters.

Counters (C)

Counters – From/to: PLC type dependant, as defined in the parameters.

Bit Range

M: M devices are used as bit system variables.

Bit range – From/to: PLC type dependant

Labels (P)

Labels – From/to: PLC type dependant

Step flags (S) (FX projects only)

Step flags – From/to: PLC type dependant

Display Used Ranges: A summary of the used system variable ranges is displayed on a
separate dialogue box.
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2.10 Connecting the programmable controller (PLC) to
the computer

In the Project Navigator click on PLC_Parameter and in the dialogue box on the button CPU
Type. You get a list containing all CPU types which are supported by GX IEC Developer. A
detailed summary of all CPU types supported by GX IEC Developer is included in section 5.16.

This manual does not include instructions for installing your controller hardware. Each
controller system is supplied with documentation including comprehensive installation
instructions.

There are a number of different options for connecting the PLC to your personal computer:

� Via the CPU interface

� Via the computer link modules

� Via an Ethernet module

� Via the USB interface

The transparent mode enables data transmission by modem between the personal computer,
terminal and the PLC.

The options for selecting the connection type and setting the corresponding parameters can
be found in the Online menu under Transfer Setup - Ports
(� Chapter 8).

The following figure on the next page shows all supported options for connecting the PLC to
your personal computer.
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2.10.1 Connecting FX/FX2/FXU/FX2U/FX2C series controllers

The controllers of the FX series can only be connected to the computer via the CPU interface.

a) Connection via the CPU interface with the SC-09 interface converter

Connect the 9-pin D-shell connector to the computer. If your computer port has a 25-pin
connector you will also need a 9/25-pin adapter. Connect the 25-pin D-shell connector to the
FX controller.

b) Connection via the CPU interface with the FX-232AW serial interface

You will need two additional cables for connecting the FX-232AW module:

� FX-422CAB for connecting the FX controller to the FX-232AW

� F2-232CAB or FX-232CAB for connecting the FX-232AW to the personal computer

If your computer port has a 9-pin connector you will also need a 25/9-pin adapter as both of
these cables (F2-232CAB, FX-232CAB) are fitted with 25-pin D-shell connectors at the PC
end.
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2.10.2 Connecting FX0/FX0N/FX0S/FX1S/FX1N/FX2N/FX2NC series controllers

The controllers of the FX series can only be connected to the computer via the CPU interface.

a) Connection via the CPU interface with the SC-09 interface converter

Connect the 9-pin D-shell connector to the computer. If your computer port has a 25-pin
connector you will also need a 9/25-pin adapter. Connect the 8-pin min-DIN connector to the
FX controller. This connector is delivered together with the SC-09.

b) Connection via the CPU interface with the FX-232AW serial interface

You need three additional cables for connecting the systems with the FX-232AW module:

� The FX-422CAB and the FX-20PCADP cables for connecting the FX controller to the
FX-232AW

� The F2-232CAB or FX-232CAB cable for connecting the FX-232AW to the personal
computer

If your computer port has a 9-pin connector you will also need a 25/9-pin adapter, as both
these cables (F2-232CAB, FX-232CAB) have 25-pin D-shell connectors at the computer end.
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2.10.3 Connecting FX3U series controllers

a) Connection of the CPU interface via the FX-232AWC-H

You can use two additional cables for connecting the CPU and the PC:

� The FX-422CAB0 cable for connecting the FX3U controller to the FX-232AWC-H

The FX-422CAB0 cable can be connected to the FX3U via the programming port
(PP Port) or via the extension board FX3U-422-BD.

� The F2-232CAB-1 cable for connecting the FX-232AWC-H to the personal computer

b) Connection of the CPU interface via the FX-232CAB-1 cable

You can use the FX-232CAB-1 cable for connecting the CPU and the PC:

� The FX-232CAB-1 cable can be connected to the FX3U via the extension board
FX3U-232-BD.

� The FX-232CAB-1 cable can be connected to the FX3U via the special function module
FX3U-232-ADP.
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c) Connection of the CPU interface via an USB cable

You can use an USB cable for connecting the CPU and the PC:

� The USB cable can be connected to the FX3U via the extension board FX3U-USB-BD.

� The USB cable can be connected to the FX3U via the connection adapter FX-USB-AW.

d) Connection of the CPU interface via modem

You can use modems for connecting the CPU and the PC:

� The CPU side modem can be connected to the FX3U via the extension board
FX3U-232-BD.

� The CPU side modem can be connected to the FX3U via the special function module
FX3U-232-ADP.
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Fig. 2-53:
CPU connection
via USB cable
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e) Connection of the CPU interface via HMI module

You can use HMI modules for connecting the CPU and the PC:

� The FX3U can be connected to the PC via a GOT-F900.

The CPU is connected to the GOT-F900 by the FX-50DU-CAB0 cable via the
programming port (PP Port).

The PC is connected to the GOT-F900 by the FX-232CAB-1 cable.

� The FX3U can be connected to the PC via a GOT-1000.

The CPU is connected to the GOT-1000 by the GT01-C�R4-8P cable via the
programming port (PP Port).

The PC is connected to the GOT-1000 by the GT01-C30R2-9S cable or the
GT08-C20USB-5P cable.
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f) Connection of the CPU interface via the ETHERNET

You can connect the CPU to the PC via the ETHERNET:

� The FX3U can be connected to the ETHERNET via the special function module
FX3U-ENET.
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Fig. 2-56:
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2.10.4 Connecting A/QnA series controllers

The A series controllers can be connected to the computer via either the CPU interface,
computer link module, the A7BDE interface card or the Ethernet module.

a) Connection via the CPU interface with the SC-09 interface converter

Connect the 9-pin D-shell connector of the SC-09 to the computer. If your computer's port has
a 25-pin connector you will also need a 25/9-pin adapter.Connect the 25-pin D-shell connector
to the CPU port.

b) Connection via the computer link module

The following computer link modules are available: AJ71UC24, A1SJ71UC24-R2,
AJ71QC24(-R), AJ71QC24N(-R2), A1SJ71QC24(-R2), A1SJ71QC24N(-R2). The computer
link module is installed in the base unit (module rack). Connect the RS-232 interface of your
computer to the RS-232 port of the computer link module via the interface cable.Check the pin
assignments of the cable before using it (see below).The communications parameters you set
in Online - Transfer Setup - Ports (� Section 8.3.1) must match the DIP switch settings on
the computer link modules.

NOTE See the computer link module manuals for full details on their settings.
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Pin assignments of the RS-232 interface cable

The pin assignments of 25-pin connectors with applicable CD signal on pin 8 are as follows:

DC code control or DTR/DSR control is enabled by connecting the computer link module to an
external device as shown above.

The pin assignments of 25-pin connectors without applicable CD signal on pin 8 are as
follows:

DC code control or DTR/DSR control is enabled by connecting the computer link module to an
external device as shown above.
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Computer Link Module Cable Connection and Signal
Direction (Full-/Half-Duplex)
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Signal Pin Pin Signal

FG 1 ����� 1 FG

SD (TXD) 2 ����� 3 RD (RXD)

RD (RXD) 3 ����� 2 SD (TXD)

RS 4

CS (CTS) 5 ����� 8 CD

DSR (DR) 6 ����� 20 DTR (ER)

SG 7 ����� 7 SG

4 RS

CD 8 ����� 5 CS (CTS)

DTR (ER) 20 ����� 6 DSR (DR)

Tab. 2-7: Pin assignments of the RS-232 interface cable (25-pin, with CD signal)

Computer Link Module Cable Connection and Signal
Direction (Full-Duplex)

GX IEC Developer

Signal Pin Pin Signal

FG 1 ����� 1 FG

SD (TXD) 2 ����� 3 RD (RXD)

RD (RXD) 3 ����� 2 SD (TXD)

RS 4 4 RS

CS (CTS) 5 5 CS (CTS)

DSR (DR) 6 ����� 20 DTR (ER)

SG 7 ����� 7 SG

CD 8 8 CD

DTR (ER) 20 ����� 6 DSR (DR)

Tab. 2-8: Pin assignments of the RS-232 interface cable (25-pin, no CD signal)



The pin assignments of 9-pin connectors with applicable CD signal on pin 1 are as follows:

DC code control or DTR/DSR control is enabled by connecting the computer link module to an
external device as shown above.

The pin assignments of 9-pin connectors without applicable CD signal on pin 1 are as follows:

DC code control or DTR/DSR control is enabled by connecting the computer link module to an
external device as shown above.
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GX IEC Developer

Signal Pin Pin Signal

7 RS (RTS)

CD 1 ����� 8 CS (CTS)

RD (RXD) 2 ����� 3 SD (TXD)

SD (TXD) 3 ����� 2 RD (RXD)

DTR (ER) 4 ����� 6 DSR (DR)

SG 5 ����� 5 SG

DSR (DR) 6 ����� 4 DTR (ER)

RS (RTS) 7

CS (CTS) 8 ����� 1 CD

Tab. 2-9: Pin assignments of the RS-232 interface cable (9-pin, with CD signal)

Computer Link Module Cable Connection and Signal
Direction (Full-Duplex)

GX IEC Developer

Signal Pin Pin Signal

CD 1 1 CD

RD (RXD) 2 ����� 3 SD (TXD)

SD (TXD) 3 ����� 2 RD (RXD)

DTR (ER) 4 ����� 6 DSR (DR)

SG 5 ����� 5 SG

DSR (DR) 6 ����� 4 DTR (ER)

RS 7 7 RS

CS (CTS) 8 8 CS (CTS)

Tab. 2-10: Pin assignments of the RS-232 interface cable (9-pin, no CD signal)



DIP switch settings

The communications parameters you set in Online - Transfer Setup - Ports
(� Section 8.3.1) must match the DIP switch settings on the computer link modules.

NOTE Please see the manual of the computer link module for details on the DIP switch settings.

c) Connection via the Ethernet module

GX IEC Developer enables a MELSEC A series' PLC to be programmed via the Ethernet.
The Ethernet module is installed in the base unit. The connection between the Personal
Computer and the Ethernet module is realized via the coaxial cable 10BASE5 (Ethernet) or
10BASE2 (Cheapernet).

The following Ethernet modules can be used:

� AJ71E71-S3 � AJ71E71N-B2 � AJ71E71N-B5T

� AJ71QE71 � AJ71QE71N-B2 � AJ71QE71N-B5T

� A1SJ71E71-S3 � A1SJ71E71N-B2 � A1SJ71E71N-B5T

� A1SJ71QE71 � A1SJ71QE71N-B2 � A1SJ71QE71N-B5T

The communications parameters you set in Online - Transfer Setup - Ports
(� Section 8.3.1) must match the DIP switch settings on the Ethernet module.

NOTES See Ethernet manuals for full details on Ethernet module settings.

The Ethernet modules will only work together properly with GX IEC Developer, if its version
“E” (or higher) is used.

You will find the version number directly on the Ethernet modules.

When the AnU CPU type has been started on the personal computer, change the PLC type
to the AnA CPU.
Communications can only be performed within the same segment.
Communications can not be performed via the router or gateway.
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2.10.5 Connecting Q series controllers

The Q series controllers can be connected to the computer via either the CPU interface
(RS-232 or USB), computer link module or the Ethernet module.

a) Connection via the CPU interface with the QC30R2 interface cable

Connect the RS-232 interface of your computer to the RS-232 port of the CPU via the interface
cable QC30R2. If your computer's port has a 25-pin connector you will also need a 25/9-pin
adapter.

b) Connection via the computer link module

The computer link module QJ71C24(-R2) is installed in the base unit (module rack). Connect
the RS-232 interface of your computer to the RS-232 port of the computer link module via the
interface cable AC30N2A. Check the pin assignments of the cable before using it (see below).
The communications parameters you set in Online - Transfer Setup - Ports (� Section 8.3.1)
must match the DIP switch settings on the computer link modules.

NOTE Please see the manual of the computer link module for details on the DIP switch settings.
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Pin assignments of the RS-232 interface cable

The connector specifications are indicated below:

The pin assignments of 9-pin connectors with applicable CD signal on pin 1 are as follows:

DC code control or DTR/DSR control is enabled by connecting the computer link module to an
external device as shown above.
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Pin Signal Description
Signal Direction,

Q-compatible C24 <->
External Device

1 CD Receive carrier detection �����

2 RD (RXD) Receive data �����

3 SD (TXD) Send data �����

4 DTR (ER) Data terminal ready �����

5 SG Send ground �����

6 DSR (DR) Data set ready �����

7 RS Request to send �����

8 CS (CTS) Clear to send �����

9 RI (CI) Call indication �����

Tab. 2-11: Pin assignments of the RS-232 interface cable

Computer Link Module Cable Connection and Signal
Direction (Full-/Half-Duplex)

GX IEC Developer

Signal Pin Pin Signal

7 RS (RTS)

CD 1 ����� 8 CS (CTS)

RD (RXD) 2 ����� 3 SD (TXD)

SD (TXD) 3 ����� 2 RD (RXD)

DTR (ER) 4 ����� 6 DSR (DR)

SG 5 ����� 5 SG

DSR (DR) 6 ����� 4 DTR (ER)

RS (RTS) 7

CS (CTS) 8 ����� 1 CD

Tab. 2-12: Pin assignments of the RS-232 interface cable (9-pin, with CD signal)



The pin assignments of 9-pin connectors without applicable CD signal on pin 1 are as follows:

DC code control or DTR/DSR control is enabled by connecting the computer link module to an
external device as shown above.

DIP switch settings

The communications parameters you set in Online - Transfer Setup - Ports
(� Section 8.3.1) must match the DIP switch settings on the computer link modules.

NOTE Please see the computer link module manual for details on the DIP switch settings.

c) Connection via the Ethernet module

GX IEC Developer enables a MELSEC Q series' PLC to be programmed via the Ethernet.
The Ethernet module QJ71E71(-B2) is installed in the base unit. The connection between the
Personal Computer and the Ethernet module is realized via the coaxial cable 10BASE5
(Ethernet) or 10BASE2 (Cheapernet).

NOTE See Ethernet manuals for full details on Ethernet module settings.

The communications parameters you set in Online - Transfer Setup - Ports
(� Section 8.3.1) must match the DIP switch settings on the Ethernet module.
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Computer Link Module Cable Connection and Signal
Direction (Full-Duplex)
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Signal Pin Pin Signal

CD 1 1 CD

RD (RXD) 2 ����� 3 SD (TXD)

SD (TXD) 3 ����� 2 RD (RXD)

DTR (ER) 4 ����� 6 DSR (DR)

SG 5 ����� 5 SG

DSR (DR) 6 ����� 4 DTR (ER)

RS 7 7 RS

CS (CTS) 8 8 CS (CTS)

Tab. 2-13: Pin assignments of the RS-232 interface cable (9-pin, no CD signal)

Q CPU QJ71E71

GX IEC
Developer

ETHERNET
Cheapernet

Fig. 2-62:
Ethernet connection



d) Connection via the CPU interface with a QC30-USB cable

The USB port of the computer is connected to the USB port (not on Q00(J), Q01, Q02 CPUs) of
the CPU via a QC30-USB connection cable.

NOTES Connecting/disconnecting the USB cable, resetting the PLC, or switching power OFF/ON
frequently during communications with the PLC can cause a communications error, from
which recovery may not be made.
Hence, place GX IEC Developer in an offline status where possible before connecting/
disconnecting the USB cable, resetting the PLC, or switching power OFF/ON.
If recovery cannot be made from the communications error, completely disconnect the USB
cable once and reconnect it after more than five seconds. (Even after this operation, an error
may occur at the initial communication, but communications will be made properly at the
second time and later.)
Offline status: Indicates the status other than PLC write/read, monitor, test and PLC
diagnostic.

When the PLC CPU is reset while communicating with the PLC CPU via USB connection in
the Windows� 2000 environment the message “Unsafe Removal of Device” is displayed.
In this case restart the communication with the PLC CPU after resetting the PLC CPU.
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2.11 Supported utility packages for the Q series

The following utility packages for the Q series are available:

� SWnD5C-QADU-E for A/D Conversion Modules

� SWnD5C-QCTU-E for High Speed Counter Modules

� SWnD5C-QDAU-E for D/A Conversion Modules

� SWnD5C-QSCU-E for Q Corresponding Serial Communication Modules

� SWnD5C-QTCU-E for Temperature Control Modules

� SWnD5C-QDNU-E for DeviceNet Master/Slave Modules

� SWnD5C-QTIU-E for Thermocouple Input Modules

� SWnD5C-QPTU-E for Positioning Control Modules

� SWnD5C-QMBU-E for MODBUS®/TCP Interface Modules

� SWnD5C-QASU-E for AS-i Master Modules

� SWnD5C-QFLU-E for FL-net (OPCN-2) Interface Modules

2.12 Connecting a printer

Install your printer, following the manufacturer's instructions.

The Windows User's Guide contains detailed instructions on installing printers, printer drivers,
additional fonts, the print options and using the Windows Print Manager.

In GX IEC Developer, you can access the printer setup options by selecting Printer Setup in
the Project menu.
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2.13 Connection between PC and PLC via Modem

The connection between a PC and a PLC via telephone network using GSM and/or analogue
modems can be set up as following:
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2.14 Installing the USB Driver

When Windows� 2000 Professional, Windows� XP Professional or Windows� XP Home
Edition is used, the USB driver must be installed to make CPU USB communication. The
following is the USB driver installation procedure.

NOTE If the USB driver cannot be installed, check the following setting.

When Windows� 2000 Professional is used
If you have selected "Block-Prevent installation of unsigned files" after [ControlPanel] -
[System] - [Hardware] - [Driver Signing], the USB driver may not be installed. Choose
"Ignore-Install all files, regardless of file signature" or "Warn-Display a message before
installing an unsigned file" for [Driver Signing], and install the USB driver.

When Windows� XP Professional or Windows� XP Home Edition is used
If you have selected "Block-Never install unsigned driver software" after [ControlPanel] -
[System] - [Hardware] - [Driver Signing], the USB driver may not be installed. Choose
"Ignore-Install the software anyway and don't ask for my approval" or "Warn-Prompt me
each time to choose an action" for [Driver Signing], and install the USB driver.

2.14.1 When Windows 2000 Professional is used

The following indicates the procedure for installing the USB driver when using Windows� 2000
Professional.

� The screen shown below appears when you connect the personal computer and
Q CPU (Q mode) by the USB cable. Click the button Next.

� Choose "Search for a suitable driver for my device (recommended)" and click the
button Next.

GX IEC Developer Reference Manual 2 – 71

Installation Installing the USB Driver

Fig. 2-65:
Welcome to the Found New Hardware
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Fig. 2-66:
Install Hardware Device Drivers



� Check Specify a location and click the button Next.

	 As the screen below appears, set the product installation destination
"Easysocket\USBdrivers" and click the button Next.

The screen shown below shows the example of setting
C:\MELSEC\Easysocket\USBdrivers.


 The screen below appears to indicate completion of installation. Click the button Finish
to terminate installation.

2 – 72 MITSUBISHI ELECTRIC

Installing the USB Driver Installation

Fig. 2-67:
Locate Driver Files
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2.14.2 When Windows XP Professional and Windows XP Home Edition is
used

The following indicates the procedure for installing the USB driver when using Windows� XP
Professional or Windows� XP Home Edition.

� The screen below appears when you connect the personal computer and Q CPU
(Q mode) by the USB cable.
Choose "Install from a list or specific location [Advanced]" and click the button Next.

� As the screen below appears, choose "Include this location in the search".
Check "Include this location in the search" and set "Easysocket\USBDrivers" of the
folder where GX IEC Developer was installed.

After setting, click the button Next. The screen shown below shows the example of
setting
C: \MELSEC\Easysocket\USBDrivers.

NOTE If you use Windows� XP Professional and Windows� XP Home Edition with ServicePack 2,
please select the option “Don’t search. I will choose the driver to install.” in the dialogue
window shown above. The automatic search does not work with ServicePack 2.
Then select the USB driver from your installation root. If this is i.e. drive C, please select:
“C: \MELSEC\Easysocket\USBDrivers\ECUsbd.inf”
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Fig. 2-71:
Search and installation options



� As the screen below appears, click the button Continue Anyway.

NOTE Though the screen above appears during installation of the USB driver, we have confirmed
that the USB driver operates properly using Windows� XP Professional or Windows� XP
Home Edition. (No problem will occur after installation of the USB driver.)
Click Continue Anyway to continue the installation of the USB driver.

	 The screen below appears to indicate completion of installation.
Click the button Finish to terminate installation.
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Fig. 2-72:
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2.14.3 When Windows Vista is used

The following indicates the procedure for installing the USB driver when using Windows
Vista�.

� The screen below appears when you connect the personal computer to a Q CPU
(Q mode) or a FX CPU by the USB cable.
Choose "Locate and install driver software (recommended)" and and wait until
searching ends.

NOTE When the user account control is enabled, the following screen appears. Click the button
Continue to proceed.

� As the screen below appears, choose "Browse my computer for driver software
(advanced)".
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� The following screen appears. Set the installation location of GX IEC Developer,
"Easysocket\USBdrivers".

After setting, click the button Next. The screen shown below shows the example of
setting C: \MELSEC\Easysocket\USBDrivers.
If multiple MELSOFT products have been installed, refer to the installation location of
the first installed product.

	 Now the screen below appears. Select "Install this driver software anyway".


 The following screen appears. Click the button Close.

� The below screen appears when the installation ends. Click the Close to exit the setting.
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Fig. 2-77:
Surch for driver software

Fig. 2-78:
Windows Security

Fig. 2-79:
Completing the Found New Hardware
Wizard

Fig. 2-80:
MITSUBISHI Easysocket Driver installed



3 The User Interface

The illustration below shows the screen after loading a project. In this example, the PLC
configuration, a header and a body have all been opened in separate windows.
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Fig. 3-1: User Interface
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Item Description


 Application title bar

� Menu bar

� Toolbar

� Dialogue box

� Button

� Declaration table

� Object window

� Vertical scrollbar

� Editor (Body)

� Maximise button

� Minimise button

� Status bar

� Horizontal scrollbar

� Project Navigator window

Tab. 3-1: Explanation for User interface



3.1 The Title Bar

The title bar contains the name of the project and application, for example:
Garage - GX IEC Developer.

3.2 The Menu Bar

When you start GX IEC Developer only the following menus are displayed:

The complete menu bar with all the GX IEC Developer menus is not displayed until you open or
create a project. When you select one of the menu titles a drop-down list is displayed showing
the menu commands and options. The menu structure and the available options are
context-sensitive, changing depending on what you are currently doing in the program.
Options displayed in light grey are not currently available for selection.

NOTE A reference to the complete menu structure is provided at the end of this Reference Manual.

3.2.1 Menu Conventions
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Item Description


 Press the key corresponding to the underlined letter in the menu name.

�
Menu commands followed by a triangle symbol branch to a submenu with additional command
options, which is displayed as a pop-up menu box.

�
Depending on what you are doing, not all menu commands are available at all points in GX IEC
Developer. Menu commands displayed in light grey are currently unavailable.

�
Menu commands followed by three periods open dialogue boxes in which additional entries and
selections must be made.

�
In some cases, key combinations can be used to activate commands directly, without opening the
corresponding menu. When available, these key combinations are shown after the command in
the menu.

�
A check mark in front of a menu option shows that this option is currently activated. To deactivate
an activated option, simply select it again. The check mark disappears, indicating that the option
is now inactive.

Tab. 3-2: Menus conventions



3.2.2 Selecting menu commands

Using the mouse

� Point to the menu with the mouse pointer, click with the left mouse button and then
click on the desired command in the drop-down list that appears.
Or:
Click on the appropriate tool icon in the toolbar.

Using the keyboard

� Press � or � to activate the menu bar.

� Move the highlight to the desired menu with the cursor keys � and �, then select by
pressing �.
Or:
Press the key corresponding to the underlined letter in the menu name (e.g. L for the
Online menu).

� Move the highlight to the desired menu option in the drop-down list with the cursor keys
	 and 
, then press� to select.
Or:
Some menu commands can be selected directly, irrespective of which menu is currently
open, by pressing a key or key combination. These key combinations are shown after the
menu commands in the drop-down menus (e.g.�� for Quit in the Project menu).

NOTE All the available key combinations for menu commands are listed in the Appendix B to
this manual.
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3.3 The Toolbar

The toolbar enables you to select the most important menu commands directly by clicking on
the corresponding icons. The toolbar is context-sensitive, i.e. different tool icons are displayed
depending on what you are currently doing in GX IEC Developer. Tool icons can only be
selected with the mouse.

When you start GX IEC Developer, only the icon for opening a project is displayed. You can
switch the toolbar display on or off with the Toolbar option in the View menu.

NOTE A complete list of the available tools is provided at the end of this manual.

3.4 The Project Navigator Window and the Objects it
contains

The Project Navigator window is the ‘control centre’ of GX IEC Developer. It contains all the
objects belonging to the project you are working on. All operations on objects are executed
through this window.

The Project Navigator window is not displayed until you open a project. Closing the window
automatically closes the project it contains.

You can always activate the Project Navigator window via the menu item Navigator in the
Window menu.

Three different views can be selected for the project navigator via tabs below the navigator
window:

Project, Calltree, Used by

The Project Navigator window is not displayed until you open a project. Closing the window
automatically closes the project it contains.

3.4.1 Navigator views

Project

This view gives a total overview of the project. It contains all elements of the project.

Calltree

For this view, the corresponding root items are tasks or also POUs, if they are not related to a
specific task. As subitems all used POUs are shown. Additionally, it can be defined per object,
if used global variables should also be shown.

Used by

This view has exactly two root items.The first root item is the POU pool with its POUs as nodes.
Subitems of the POUs and global variables are always POUs calling respectively using the
corresponding POU or global variable.
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3.4.2 Objects in the Project Navigator window

The following standard objects are automatically generated in the Project Navigator window
for every newly-created project:

� The Library_Pool

� The PLC Parameters

� The Task_Pool

� The DUT_Pool

� Global Variables

� The POU_Pool

NOTE For a detailed description of these objects please refer to chapter 4.

3.4.3 How objects are displayed in the Project Navigator window

The entries in the Project Navigator window are arranged hierarchically. The first level is the
project. The entries for the standard objects are located on the second level, from which you
can branch to lower levels where they exist.

The symbol [+] before an entry in the Project Navigator window shows that the entry has
additional lower levels (e.g. [+] POU_Pool).

The symbol [–] before an entry in the Project Navigator window indicates that its subordinate
levels can be ‘collapsed’ so that they are no longer visible (e.g. [–] POU_Pool). This does not
apply for the entry that contains the project name, however.

How to display hidden Navigator hierarchy levels

� Double-click on the entry whose hidden levels you wish to display.
Or:
Select the entry and select the Expand command in the Tools menu.
Or:
Press the key combination [CTRL][+].
Or:
Select the entry and click on the Expand tool icon in the toolbar:
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Fig. 3-2: Tool for expanding collapsed Navigator hierarchy levels



This expands the next level of the hierarchy in the Project Navigator window.These levels can,
in turn, also contain hidden lower levels.

How to hide displayed Navigator hierarchy levels

� Double-click on the entry whose lower levels you wish to hide.
Or:
Select the entry and select Collapse in the Tools menu.
Or:
Press the key combination [CTRL][-].
Or:
Select the entry and click on the Collapse tool in the toolbar:

The selected level is collapsed and hidden from view.

NOTE There are two possible responses when you double-click on a POU name, depending on the
settings in the MMP703.INI file and in the menu Extras - Options - Zoom Header/Body -
Navigator Zoom (� Chapter 2).
- Show/hide header and body in the Project Navigator window
- Open Header and body

How to display additional object information in the Navigator

When you open a new project the additional object information is displayed by default.

� Select the Extended Information - Navigator command in the View menu.

Useful additional information is then displayed after each entry in the Project Navigator
window.

Information when ‘Extended Information - Navigator’ is not active:

� Tasks: Priority, Event

� POUs: Program class

� Body: Programming language
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Fig. 3-3:
Some of the lower levels in the Project Navigator
window are expanded.



Additional information when ‘Extended Information - Navigator’ is active:

All entries: Creation date and time

� Task_Pool, DUT_Pool, POU_Pool: Number of entries

� DUT, Global_Vars, Header: Number of variable entries

� POU: Programming language of the program body

NOTE In the Sequential Function Chart editor you can activate and deactivate additional
comments for steps with the menu View - Extended Information - SFC editor.

How to toggle between Symbolic Name and Address in LD/FBD

In LD and FBD you can switch between three different view modes:

� Standard Mode
All variables are shown by their names.

� Mitsubishi Address Mode
The variables are shown by their Mitsubishi address.

� IEC Address Mode
The variables are shown by their IEC address.

To toggle the address view mode select View Mode in the menu View.Here you can select one
of the three view modes. Alternatively you can click on Toggle or press ��
 to toggle
between the three view modes.

NOTES This function is only for view purposes. All editing/finding/tracking etc. functionalities refer to
variable names and not to addresses.

The selected mode is valid for the currently active editor window only and is not persistent.
When you close a window and open it again, the editor will be in Standard Mode again.
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In Mitsubishi Address Mode/IEC Address Mode the address of a variable that is not yet
known because the project has not been compiled yet, or the address cannot be evaluated for
other reasons, the name is shown preceded by an asterisk (‘*’).

In the case of an array element with non static index, i.e. the index part contains one or more
indices that do not represent a number, the whole array range is shown in the view mode
Mitsubishi Address Mode/IEC Address Mode.
The address ranges are shown as <start address>–<end address>. To avoid long address
range strings, the end address is shortened by the redundant first part, e.g.

� D122-25

� D100-152

� %MW19.3.17.2-3

� %MW19.3.17.2-18.3

NOTES For DUTs and ARRAY of DUTs no addresses but only symbolic names are shown, preceded
by an asterisk (‘*’).

The following elements are not toggled and are shown by their symbolic names:
- Index Registers like „X0Z0"
- Constants (VAR_CONSTANT/VAR_GLOBAL_CONSTANT)
- Labels
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The address view mode of the following elements can be toggled by the View Mode function:

While the editor is in an address mode (Mitsubishi or IEC) it is in the read only mode. If you try to
edit a variable the following message box will appear:

This message box is also shown when you perform a Find or Find & Replace action. If you
selects Yes in the message box the editor is switched to standard mode and the edit operation
is be performed, else the editor remains in the address mode and no change is made.

During a find operation in the view mode no change is made. The edit control that contains the
found text is highlighted. In the address view mode not the found text is shown but the address
is highlighted.
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Element IEC-Type(s) Remark

simple variable BOOL, DINT, DWORD, INT,
REAL, STRING[], TIME, WORD

array variable of simple type ARRAY of
BOOL, DINT, DWORD, INT,
REAL, STRING[], TIME, WORD

array and array elements

DUT members simple variable or array variable of
simple type (see above)

DUT members of Array of DUT
element

simple variable or array variable of
simple type (see above)

direct address — e.g. M16, K4M0, K4Y12 …

Tab. 3-3: Elements that can be toggled

Fig. 3-6:
Message box



If you start tracking of a variable and there are editors in an address mode the following
message box will appear.

If you select Yes in the message box, all editors are switched to standard mode before tracking
is started, else the view modes are not changed and tracking starts immediately in the
selected address view.

In Online-Mode you can also toggle between view modes.

3.4.4 Editing objects

The objects at the lowest level of each branch can be opened for editing. These levels are not
marked with [+] or [–] symbols (e.g. PLC_Parameter, Header, Body). Opening them displays
either a dialogue box (e.g. PLC_Parameter) or an object window (e.g. Header).

Most operations, such as opening, copying and deleting, can be performed directly in the
Project Navigator window with key combinations. The corresponding menu commands are in
the Object menu. For details on working with objects, see chapter 4.

NOTE All key combinations used for working with objects and the Project Navigator are listed and
explained in the Appendix B.
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Fig. 3-7:
Message box



3.5 The Status Bar

The status bar contains information on the current status of your project. You can enable or
disable its display and the information it contains is also configurable. The command for
switching the status bar display on and off is in the View menu.

How to configure the Status Bar

� Double-click in the status bar.
Or:
Select Configure Status bar in the View menu.

The following dialogue box is displayed:

Editor Info: Display the POU name and the number of variable entries in the header

Security Level: Display current security level

Online: Display online status

CpuType: Display the PLC CPU for which the project is configured

Conn Status: Display active connection to the PLC system: PLC state, current scan time.
Display depends on selection of monitoring mode and PLC status.

Error Status: Display PLC system error status.
Display depends on selection of monitoring mode and PLC status.

GuidedEditing: Display of the editing mode (OVR/INS)

Clock: Display time

Path: Directory path on which the current project is stored

System Resources: Free Windows system resources in %

Free Memory: Amount of available free memory (in bytes)

Redundant Info: For QnPRH PLCs only. The Status Bar will alternate between displaying the
operating mode (“Backup” or “Separate”) and the identity of the connected PLC (“Control
(System A)” or “Backup (System B)” or any combination thereof) when Monitoring Mode is
active. The interval between changes will depend on the poll rate set in Extras Options
Monitor Mode (see section 2.8.10).
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Fig. 3-8:
Status bar configuration



How to add status bar items

� Select the item to be displayed in the Possible Status Field list box.

� Click on the Add button to display the selected item in the Status bar.

� Repeat steps � and � for each additional item to be displayed in the status bar.

How to delete status bar items

� Select the item to be deleted in the Displayed fields list box.

� Click on the Delete button to delete the selected item from the Status bar..

� Repeat steps � and � for each item to be cleared from the status bar.

NOTE You can restore default status bar display settings at any time by clicking on the Defaults
button.

3 – 12 MITSUBISHI ELECTRIC

The Status Bar The User Interface



3.6 Working with Windows

This section only contains a short explanation of the various operations performed with screen
windows. For detailed instructions and definitions of the terms used, please refer to the
Windows User’s Guide. The procedures used with windows in Windows applications
programs are standardised and are not specific to GX IEC Developer.

The following window types are used in GX IEC Developer:

� The Project Navigator window

� Object Windows

� Dialogue Boxes

NOTE Although it is possible to display several different windows on the screen simultaneously,
only one window can be active for editing at any one time. The currently active window is
identified by a coloured title bar.
Please note that you can only open and edit one project, in one Project Navigator window.
But you can start GX IEC Developer several times to open and edit more than one project at
a time

3.6.1 Object windows

How to open windows

� In the Project Navigator window, double-click on the name of the object whose window
you wish to open.
Or:
Select the object in the Project Navigator window by moving the highlight with the
cursor keys 	 and 
, and then press � or select the Open command in the Object
menu.

The program opens the object window and displays it to the right of the Project Navigator
window. You can open several object windows at the same time.

NOTE When the object window of a body (header) is open you can open its header (body) with the
Open Header (Open Body) command in the Object menu.

How to select an open window

� Click anywhere in the window.
Or:
Select the desired window with the key combination ��.
Or:
Choose the window to be selected from the list of open windows shown in the Window
menu.

The title bar of a selected window is highlighted in color.
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How to close a window

� Double-click on the control menu box of the window you wish to close.
Or:
Select the Close command in the window’s control menu.
Or:
Select the window and press�� to activate its control menu Close command.
Or:
Select the window and select the Close command in the Object menu.

The program will ask you if you want to save any editing changes before closing the object
window.

NOTE You can close all opened windows at the same time with the Close All command in the
Window menu.

How to arrange windows without overlaps (tiling)

� Select the Tile Horizontally or Tile Vertically command in the Window menu.

The Project Navigator window is displayed on the left of the screen. The object
windows are arranged horizontally or vertically. The size of the object windows
depends on how many windows are currently open.

How to arrange windows with overlaps

� Select the Cascade command in the Window menu.

The Project Navigator window and all open object windows are overlapped across the
screen so that all the title bars are visible, starting at the top left corner.

3.6.2 Changing window display size

Buttons

Minimise window

Restore window

Maximise window

Window or Full-size window � Icon

Click on the Minimise button in the object window (in the upper right corner of the window title
bar), or select Minimise in the window’s control menu.

You can move and position the icons anywhere on the screen. The Arrange Icons command
in the Window menu arranges all the icons in a row at the lower edge of the screen.
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Fig. 3-9:
The object window icons



Icon Previous window size

Click on the Restore button of the icon you wish to open, or simply double-click on the icon.

Full-size window Previous window size

Click on the Restore button (in the upper right corner of the window title bar), or select the
Restore command in the control menu.

Window or Icon Full-size window

Click on the Maximise button (in the upper right corner of the window title bar), or select the
Maximise command in the control menu.

NOTE You can find a list of all the key combinations for working with windows in the Appendix B.
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3.6.3 Dialogue boxes

Dialogue boxes are displayed whenever additional user input is required, for example when
you select the menu commands that are followed by three periods
(e.g. Open … in the Project menu). In addition to asking you to make entries, dialogue boxes
can also contain important information and warnings.

How to select an open dialogue box

� Click anywhere within the dialogue box.
Or:
Select the desired box with the key combination ��.

The title bar of a selected dialogue box is displayed with color shading.

How to close dialogue boxes

� If you want to discard the entries or changes you have made in the box, double-click on the
control menu button of the dialogue box.
Or:
Select the Close command from the dialogue box’s control menu.
Or:
Click on the Cancel button.
Or:
Press the � key.

� If you want to accept the entries in the dialogue box, click on the OK button.
Or:
Select the OK button and press the� key.

NOTE You can find a list of all the key combinations for working with windows in the Appendix B.
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3.7 Special Functions and Dialogs of Redundant PLC
Systems

3.7.1 Rules for Redundant PLC Systems in Backup Mode

Depending on the accessibility of the PLCs in a redundant system the following rules apply for
online operations.

� If the system, which was selected as the target system in the menu Transfer Setup
Ports (see section 8.3.1), cannot be accessed:

– In all modes an error message will be displayed and the operation is aborted.

� If the system, which was selected as the target system in the menu Transfer Setup
Ports (see section 8.3.1), can be accessed:

– In Debug mode the operation is executed on the target system.

– In Separate mode the operation is executed on the target system.

– In Backup mode, if the other system can also be accessed, a confirmation dialogue
(� 3.7.2) will be displayed in which the execution on the target and/or the other
system can be advised.

– In Backup mode, if the other system cannot be accessed, an error message will be
displayed and the operation is aborted only for Online (Ex)Change. For other
operations a confirmation dialogue (� 3.7.2) will be displayed in which the
execution on the target system can be advised.

3.7.2 Confirmation Dialogue in Backup Mode

Before executing specific operations in backup mode of a redundant system the following
dialogue will be displayed. It shows the selected operation and the status of the redundant PLC
system.
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Fig. 3-11:
Confirmation Dialogue for
allowed on both PLCs only



If you choose Both on this dialogue (Fig. 3-11 and Fig. 3-12) the operation will be executed on
both systems.
If you choose Target (Fig. 3-12 and Fig. 3-13), the operation will only be executed on the
system specified in Transfer Setup. (For some functionalities this button will not be available.)
If you choose Cancel, the operation will not be executed on either system.

The following functionalities will use this dialogue with the Target button disabled (Fig. 3-11):

� Download to PLC

� Online Program (Ex)Change

� Copy Program Memory to Flash ROM

� Download Symbolic Information

� Online Verify

� Format Drive

� Defragment Drive

� PLC Clear � All

� PLC Clear � Latch
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Fig. 3-12:
Confirmation Dialogue for
allowed on either the target
or on both PLCs

Fig. 3-13:
Confirmation Dialogue if
the other system is not
accessible



The following functionalities will use this dialogue with the Target button enabled (Fig. 3-12):

� New PLC Keyword

� Delete PLC Keyword

If the PLC selected in Transfer Setup Ports is accessible, but the other system is not, the
dialogue shown in Fig. 3-13 will be displayed for the following operations. In this case the Both
button is disabled and the Target button is enabled.

� Download to PLC

� Copy Program Memory to Flash ROM

� Download Symbolic Information

� Online Verify

� Format Drive

� Defragment Drive

� New PLC Keyword

� Delete PLC Keyword

� PLC Clear � All

� PLC Clear � Latch
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3.7.3 PLC Redundancy Mode

For the QnPRH PLCs it is possible to switch between Backup and Separate mode remotely.
The following dialogue is opened by Online PLC Redundancy Mode and shows the
current status of both systems, and whether manual switching of the Control and Standby
systems is possible. It also provides the functionalities System Switch and the Memory
Copy.

NOTE The Set Operating Mode, System Switch and Memory Copy operations can only be
executed if the control system is the currently connected system.

3 – 20 MITSUBISHI ELECTRIC

Special Functions and Dialogs of Redundant PLC Systems The User Interface
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 Status information of redundant PLC

� Check to set Backup or Separate mode

� Click to set desired mode

� Click to re-read operating state information from the PLCs

� Click to switch Control and Standby systems manually

� Click to copy the program memory from the Control system to the Standby system

� Click to close the dialogue

Tab. 3-4: Details of the Redundancy Mode dialogue



System Switch

The System Switch operation manually switches control and standby systems. After
successfully executing system switch, the previous control system will become the standby
system, and the previous standby system will become the control system.The System Switch
functionality can only be executed if the appropriate special relay SM1592 is turned ON. If it is
OFF, the following dialogue will be displayed:

Memory Copy

The Memory Copy operation copies the program memory and the standard RAM from the
control system to the standby system. If the special relay SM1598 is turned OFF, it will also
copy the standard ROM. The following message will be displayed before executing this opera-
tion:
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Fig. 3-15: Confirmation dialogue for system switch

Fig. 3-16:
Confirmation dialogue for
memory copy



3.8 Customising the Screen Display

The View menu contains all the commands for customising the display for your personal
needs.

Toolbar, Status Bar, Horizontal Scrollbar and Grid

You can switch these display elements on and off with the corresponding options in the View
menu, or with the check boxes in the dialogue box that is displayed when you select the
Environment option.

The check mark in front of the menu command in the menu View identifies options that are
currently enabled. When you deactivate an option the check mark is no longer displayed.

How to set the screen zoom factor

� Select the Zoom... command in the View menu.

� Select one of the four standard zoom factors: 50%, 75%, 100%, 150%.

In addition to these four standard zoom factors you can also enter your own screen display
magnification by changing the display grid size setting.

� Select the Environment... command in the View menu.

� Enter a value between 4 and 128 in the Size of Grid field.

The standard zoom factors correspond to the following grid settings:

Zoom factor: 50% Grid size: 8
Zoom factor: 75% Grid size: 12
Zoom factor: 100% Grid size: 16
Zoom factor: 150% Grid size: 24
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Fig. 3-17:
The toolbar, status bar, horizontal scrollbar
and the grid can be activated or
deactivated with the check boxes
in the Environment dialogue box.
Grid display is enabled.



How to select the screen font

Select the Font command in the View menu.

Choose the font and style you wish to use for the screen display.

All GX IEC Developer texts will be displayed in the selected font. You can use all the fonts
installed in your Windows configuration.

NOTE The screen font setting is stored together with the project.
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Fig. 3-18:
Screen font selection



How to set the display colors

� Select the Colors command in the View menu.

� Select the screen element whose color you wish to change:

The Color dialogue box is displayed.

� Click on the color you want in the palette of basic colors.

The current color of the selected element is shown in the two-line palette below the basic
colors palette.

NOTE You can also define your own custom colors. For details please refer to the Windows User’s
Guide. The colors settings are stored with the project.

How to save the current Workspace

� Select the Save Workspace command in the View menu.

NOTE This command only saves the size, arrangement and display of the opened windows - with
the exception of the Project Navigator window - in the current workspace, ignoring the font
and color settings.The workspace is saved with the project in the file WORKSPACE.SYS.

How to load a previously saved Workspace

� Select the Load Workspace command in the View menu.

This command automatically loads the settings stored with the Save Workspace command by
loading the data from the WORKSPACE.SYS file.
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Background Monitoring

Selection Errors

Text Shade Left Top

Selected Text Shade Right Bottom

Read Only Text Grid

Locked Text Browser Items

Foreground SFC Raster Elements

Fig. 3-19:
Display color selection



How to load the system defaults

� Select the System Defaults command in the View menu.

When you create a new project the following system defaults are always selected
automatically:

� Toolbar display enabled

� Status bar display enabled

� Horizontal scrollbar display enabled

� Grid display enabled

� Zoom factor: 100 %

� Grid size: 16

� Extended information display in Project Navigator enabled

� Background: light grey, Selection: dark grey

� Text: black

� Selected Text: white

� Read Only Text: dark grey

� Locked Text: dark grey

� Foreground: light grey

� Monitoring: blue

� Errors: red

� Shade left top: white

� Shade right bottom: dark grey

� Grid: black
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3.9 Mouse and keyboard operation

All operations in GX IEC Developer can be performed both with the mouse and the keyboard.
In most cases, a single click with the left mouse button corresponds to the � key, and a
double-click corresponds to the� key.

The instructions below are primarily for working with the mouse, but special keyboard key
combinations are also included. All the key combinations for working with tables and the
editors are listed in the Appendix B of this manual.

NOTE For full details on using the mouse in Windows please refer to Windows Fundamentals
section in the Windows User’s Guide.

3.10 General editing functions

3.10.1 Using menu or keyboard operations

Most of the commands in the Edit menu are identical in all Windows application programs.

NOTE You can find detailed explanations of these commands in your Windows User’s Guide.

How to cut, copy and delete data

� Select the element you wish to edit (see following pages):

� Cell contents in a Declaration Table: Enable the editing mode in the cell and select the cell
text.

� Lines in a Declaration Table: Select one or more lines.

� Entire networks in the editors: Select the network bar to the left of the network you wish to
edit.

� Ranges (instruction, operand, lines) in the Instruction List:Select the range to be edited.

� Program elements in the graphical editors: Select the elements to be edited.

� Program elements in the Sequential Function Chart Language: Select the elements to be
edited. When you select a Step its corresponding Transition is automatically selected as
well.

� Select the editing command you wish to execute in the Edit menu.
Or:
Press the corresponding key combination:
Cut �

Copy �

Delete �

E
WARNING:
Deletions are performed directly, without prompting for confirmation. If you
inadvertently delete something you can restore the deleted data by selecting the Undo
command in the Edit menu. However, please note that this only works if you execute
Undo directly after performing the deletion!
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How to paste data

� Select the position at which you wish to insert an element:

� Cell contents in a Declaration Table: Activate editing mode in the cell in which you wish to
insert the text from the clipboard.

� Lines in a Declaration Table: Select a cell in the line before which you wish to insert the
lines from the clipboard, or select the lines you wish to overwrite with the data from the
clipboard.

� Entire networks in the editors: Select the network bar of the network before which you wish
to insert the network stored in the clipboard.

� Ranges (instruction, operand, lines) in the Instruction List: Position the cursor at the point
at which you wish to insert the text from the clipboard.

� Sequential Function Chart elements: Select the point in the sequence before which you
wish to insert the data from the clipboard.

� Select Paste in the Edit menu.
Or:
Press the corresponding key combination:
Paste ��

� Elements in the graphical editors: When you select the Paste command the mouse
pointer changes to a plus sign symbol. Position the pointer at the location at which you
wish to insert the elements from the clipboard.

NOTE Pasting Parameter data into a Q Remote I/O project from a non-Q Remote I/O project is not
be supported.Pasting Parameter data into a non-Q Remote I/O project from a Q Remote I/O
project is also not supported.

How to undo editing operations

� Select Undo or Redo in the Edit menu.
Or:
Press the corresponding key combination:

Undo � BACKSPACE
Redo � BACKSPACE

Undo undoes the effects of the last editing operation.
Redo undoes the effects of the last Undo operation.

Global Search and Replace

The Search and Replace functions can now be used globally to search the entire project
(Edit - Find/Replace menu).
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Fig. 3-20:
Search and replace dialogue



Find in:

This option enables you to search and replace in

the entire project (All objects)

individual objects selected in the Project Navigator

the current editor only

Find What / Replace With:

You can enter the following elements as find/replace arguments:

� Variable identifiers

� Data types

� Addresses

� Sequential function chart language step names

� Sequential function chart language transitions

� POU names

Find options:

Match whole word only: Search the entire word only

Match case: Search and replace operation for text exactly as entered, with upper/or lower
case characters

Search in comments: Activating this option extends the search and replace operation to
comment texts

NOTE You can replace function blocks in the graphical editors but no check is performed. Also, the
replace procedure cannot be reversed; the only way to restore the project to its original state
is by not saving it and reloading the old version from the disk.

Find Next / Replace:

By pressing the button Find Next or Replace, the next matching item will be searched and
highlighted.

When you selected the option Current editor only under Find in, and when the last matching
item was found and the button Find Next or Replace is pressed again, the following dialogue
will be shown.

Confirm by pressing Yes. Selecting No will close the dialogue box.
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3.11 Drag&Drop by mouse operation

Drag & Drop offers a more efficient way of editing which is based on mouse usage in
comparison to the equivalent necessary lengthy and various menu commands concerning
clipboard handling.
Basically there are two different kind of drag&drop actions which can be performed:

� copy objects

� move objects

3.11.1 Functional description and user interface

In GX IEC Developer, a drag operation is initiated, if the left mouse button is clicked and held
down, while the mouse is moved. When the mouse button is released, the drop operation is
executed. What happens then is very similar to copy/paste (resp. cut/paste).

We call the object(s), that are dragged (e.g. an object or a selection in the navigator) the
dragged item(s). The context where the dragged items come from is called drag source, while
the context, where the drop is executed is called drop target. More explanation on this will
follow below.

The dragged item and the drop target can be in different instances, but not all contexts can be
drag sources and/or drop targets.

When dragging objects over drop targets, the shape of the mouse cursor indicates which
operation (copy or move) would be performed, when dropped over this very target:

drop not possible on actual target

copy

move

For all objects (listed below) the decision between the two possible actions (copy or move) is
made by the context, except for those drop targets that don’t support move actions such as the
EDM for instance. The action (copy or move), decided by the context is called default action.

The default action can be overruled by the CTRL or the SHIFT key:

� Holding down the CTRL key, while a drop is executed, makes the drop result in a COPY
operation.

� Holding down the SHIFT key, while a drop is executed, makes the drop result in a MOVE
operation.

Until the moment the object is dropped (releasing of the left mouse button) you can decide
between the two methods by pressing or releasing the CTRL or the SHIFT key.

Pressing the ESC key after starting the drag & drop, but before executing the drop (ie. with the
mouse button still pressed) aborts the current drag & drop action. CTRL and SHIFT must be
released before pressing ESC, because these key combinations may have other effects (e.g.
CTRL+ESC brings up the Windows Start menu).When the drop is executed (the mouse button
is released), the ESC key has no effect anymore, but the Undo functionality may be used.

After drop, the drop target editor gets the focus in its application instance.

Undo and Redo are window oriented, i.e. if the drag & drop operation involves two editors, the
changes made in each editor may be undone by calling Undo in them separately. E.g. after a
move operation between two editors, calling Undo in the drop target editor deletes the newly
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inserted object, while calling Undo in the drag source editor undeletes the moved object.
Moving an object in its own editor can be undone in one step (because it happened in the same
window).

The following section describes the objects which are involved in the drag & drop process resp.
which objects can be dragged and which objects serve as valid dropping areas.

Furthermore the valid scope for the dragged objects will be discussed because this is the
decisive factor whether a dragged object will be moved or copied on default. The scope is the
area of an object, in which he is existing (e.g. POUs exist in the POU pool). If the scope of an
object is left during a drag & drop operation (e.g. drag & drop a POU to another project or to a
user library in a project), the default drag & drop operation (copy or move) may change.

Dragged objects and their valid scope inside one project

In general: If a dragged objects leaves its valid scope the default operation for the objects will
be a COPY operation.For the other case the object is simply MOVED.A MOVE operation is not
supported for these items if they are dragged out of the valid scope (SHIFT key has no effect).

Moreover, if multiple objects from different scopes are dragged together (e.g. a POU from the
POU pool and the GVL) only the COPY operation is supported. This is then exactly the same
operation as if copy/paste would have been made between the same source and target.

The following list gives an overview.

� POUs, DUTs and tasks cannot be moved in their respective scopes, because they are auto-
matically sorted and therefore changing their order cannot be made by dragging. The copy
operation however is supported also for their own scope, by holding down the CTRL key
when dropping.

� Actions cannot be moved at all, only the copy operation is supported for them.The copy ope-
ration however is supported also for their own scope, by holding down the CTRL key when
dropping.

� GVLs cannot be dropped in their own scope (neither the copy nor the move operation is sup-
ported). Outside their scope both operations are possible.
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Possible dragged items Scope

POU POU pool�

DUT DUT pool�

Task Task pool�

Action SFC POU�

GVL Project or user library�

Local declarations (selected in a POU header editor) POU header declaration editor

Global declarations (selected in any GVL editor) GVL declaration editor

Global declarations (selected in any GVL editor) POU header declaration editor

IL network IL body editor

LADDER network LADDER body editor

FBD network FBD body editor

SFC elements SFC body editor

Selected Text Textual body editor

EDM EDM declaration editor

IL Text IL-body editor

MELSEC IL Text MELSEC IL body editor

Tab. 3-5: Overview of possible dragged items



3.11.2 Valid dropping targets inside one project

After describing the items which can be dragged the following section will explain in detail
where these items can be dropped to and which preconditions have to exist for dropping.

The following tables give an overview on the drag/drop mechanism inside one project. All
drag/drop actions are only defined for the project view of the navigator.

Drag & Drop of objects in the navigator
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Dragged item Dropping target Action Precondition

POU Project Item will be inserted into project
POU pool

User needs WRITE access rights
for the project and the POU pool

POU pool of
project

Item will be inserted into project
POU pool

User needs WRITE access rights
for the project and the POU pool

POU pool of user
library

Item will be inserted into user
library POU pool

User needs WRITE access rights
for the library and its POU pool

Task Item will be inserted into the task.
The program is appended at the
end of the program list.

Task editor does not have to be
opened.

User needs WRITE access rights
for the task

MOVE action is not possible

DUT Project Item will be inserted into project
DUT pool

WRITE access rights

DUT pool of
project

Item will be inserted into project
DUT pool

DUT pool of user
library

Item will be inserted into user
library DUT pool

TASK Project Item will be inserted into project
TASK pool

WRITE access rights for the project
and TASK pool

Task pool

Action SFC POU Item will be inserted into the action
pool of the associated SFC POU

WRITE access rights to the SFC
POU and action pool

SFC action pool

GVL (a) Project GVL entries of (a) will be inserted
into the project GVL

WRITE access rights

Library GVL entries of (a) will be inserted
into the user library GVL

GVL (b) GVL entries of (a) will be appended
into the GVL (b)

Mixed objects Project Items will be inserted into the
project

WRITE access rights

MOVE action is not possible

Tab. 3-6: Drag & Drop of objects in the navigator



Drag & Drop of declarations

� Only those declarations will be inserted into the EDM that existed at the time the GVL was
last compiled. If the GVL was not compiled yet, no declarations will be inserted into the EDM.

� Only those declarations will be inserted into the EDM that existed at the time the POU was
last compiled. If the POU was not compiled yet, no declarations will be inserted into the
EDM.

Drag & Drop of body objects

� Single elements can’t be dragged;additional element(s) will be selected automatically in the
same way as with the Copy operation (i.e. if only a step is selected its related transition(s)
and step(s) will be selected and dragged with it automatically).
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Dragged item Dropping target Action Precondition

EDM entry EDM Entry will be inserted as new copy MOVE action is not possible

Local
declarations

POU Declaration will be inserted into the
associated header

WRITE access rights

POU body

Header in the
navigator

Declaration will be inserted into the
header

EDM Entry will be inserted into the EDM
(in POUName.VarName format)

MOVE action is not possible�

Global
declarations

POU Items will be declared as external
local in the associated header with
the appropriate class
(VAR_GLOBAL => VAR)

WRITE access rights

POU body

POU header (and
POU header
editor)

Any GVL (and
GVL editor)

Items will be inserted into the GVL

EDM Entry will be inserted into the EDM MOVE action is not possible�

Tab. 3-7: Drag & Drop of declarations

Dragged item Dropping target Action Precondition

IL network IL POU body
editor

Items will be inserted at that
position where the insertion cursor
will appear.

WRITE access rights

MELSEC IL
network

MELSEC IL POU
body editor

Items will be inserted at that
position where the insertion cursor
will appear.

WRITE access rights

Ladder network Ladder POU body
editor

Items will be inserted at that
position where the insertion cursor
will appear.

WRITE access rights

FBD network FBD POU body
editor

Items will be inserted at that
position where the insertion cursor
will appear.

WRITE access rights

Ladder POU body
editor

SFC element SFC POU body
editor

Items will be inserted at that
position where the insertion cursor
will appear.

WRITE access rights�

Selected text Textual POU
body editor

Items will be inserted at that
position where the insertion cursor
will appear.

WRITE access rights

Tab. 3-8: Drag & Drop of body objects



3.12 Working in tables

The following objects are managed and defined in tables:

� Global Variables

� Local Variables (Header)

� Data Unit Types (structured data types)

� Data Unit Variable Addresses

� Tasks

To open the table object window, double-click on the corresponding object in the Project
Navigator window. If the object window of a body is already open you can open its header by
selecting the Open Header command in the Object menu.

You cannot change the number or the arrangement of the columns. When you activate a new
table only line 0 is shown, in which you can enter the first variable.

NOTE You can also copy all the entries from the global variables list to the header of a POU by using
the clipboard. When you do this, the data fields are automatically placed in the correct
columns.
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Fig. 3-22: Global Variable List

��

Item Description


 Cell with the line number

� Table cell

� Global Variables Table

� Table Column Headings

� Type selection (dialogue box)

� Down arrow (list box)

Tab. 3-9: Variables table items



3.12.1 Editing in tables

How to select a table cell

� Click on the cell you wish to select.
Or:
Select the cell with the cursor keys.

Selected cells are identified with an outline box.

How to select a table line

� Click on the cell containing the line number.
Or:
Select any cell in the line and press the key combination � or ��.

The selected lines are highlighted in the display.

How to select multiple table lines

� Select the first line in the range to be selected:

Continuous range: Hold down the � key and click on the last line of the range to be
selected.
Or:
Hold down the � key and extend the selection to the lines above or below the first
selected line with the 	 or 
 keys.

Selecting groups of individual lines: Hold down the � key and click on the lines you
wish to select.

The selected lines are highlighted in the display.

How to activate editing mode

� Double-click on the cell in which you wish to edit.
Or:
Select the cell and press the � key.
Or:
Select a cell and type the text you wish to enter.

How to deactivate editing mode

� Click on another cell.
Or:
Press the � key.
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How to open a list box or dialogue box

� Double-click on the symbol on the right hand side of the cell.

� Select the appropriate entry from the list box or dialogue box.

Or:

� Select a cell with a symbol at its right hand side.

� Press the key combination �
.

� Select the appropriate entry with the 	 and 
 keys, then press� to transfer the entry
to the cell.

When editing mode is activated, the blinking text entry cursor appears in the cell and
the background color of the cell changes.

NOTE All the key combinations for working with tables are listed in the Appendix B.

How to change column widths of the text part

� Position the mouse pointer on the dividing line between the headings of the columns.

The pointer changes to a double-headed arrow symbol.

� Hold down the left mouse button and move the shaded column divider line so that the
column has the desired width.

Or:

Double-click the row header near the cell borders to autosize columns to fit the widest text.

How to change column widths of the button part

Position the mouse pointer near the division between the text and the button part. (There is no
dividing line between in the header row between the two parts.)

The pointer changes to a double-headed arrow symbol.

� Hold down the left mouse button and move the shaded column divider line so that the
column has the desired width.

How to insert a new line

� Select New Declaration in the Edit menu.

� Select the position at which the new line is to be inserted.
Top Inserts a new line at the top of the table
Before Inserts a new line directly before the selected line/cell
After Inserts a new line directly after the selected line/cell
Bottom Inserts a new line at the end of the table

Or:

� Select any cell in the last line of the table.

� Press the key combination ��.

The line numbering is automatically updated after the insertion operation.
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Fig. 3-23:
Double-headed arrow symbol



How to sort table entries

� Select Sort in the Tools menu.

� Select the sort key to be used for the alphabetical sort procedure:
Type Sort by data type
Class Sort by class
Identifier Sort by identifier

Or:

Click on the appropriate column header. The column header contains a sort indicator.

Example

�

E
WARNING:
The table should not contain any empty lines.

NOTE FUN and FB POU headers can’t be sorted either using the Tools -> Sort menu or by clicking
the appropriate column header. This functionality is disabled intentionally as the order of
Input and Output variables for FUN and FB POUs is critical and can therefore not changed
automatically.

3.12.2 Automatic copying of the contents of the preceding line
into the new line (Autoincrement)

When a new line is entered in a declaration table the contents of the preceding line are
automatically copied to the new fields. Identifiers and addresses are automatically
incremented by 1.

This function is only available when the Incremental New Declarations option in the Extras -
Options - Editing - Declaration Editor menu is enabled.

If you also wish to include the contents of the Type and Comment fields you must also activate
the Copy Comment and Type Fields option.
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Fig. 3-24:
Sort indicator

Fig. 3-25: Automatic copying and incrementing



3.12.3 Export and Import of Excel files

The export and import of a spreadsheet to a file of Excel version, Excel 97, Excel 2000, or
Excel 2002 (BIFF8 format), is available. Export will always save the whole spreadsheet.
Importing will always append new declarations to the list, preserving any existing declarations.

Export to Excel

The export to Excel is done by selecting the Export to Excel command in the Tools menu.

Import from Excel

The import from Excel is done by selecting the Import from Excel command in the Tools
menu.

During the import process the following checks are executed on the imported file:

� The imported file will be checked if it contains the columns required by the current editor. If
none of the required columns are present, the import process will be aborted. If some
columns are missing, you will be given the choice to continue, but the missing fields will be
left empty for all imported declarations.

� If the imported file contains no declarations, the import process will be aborted.

� If the imported file contains empty rows, you will be given a chance to discard the empty
rows, or import them anyway.

� All cells that contain longer text than is allowed by the actual field will be automatically
truncated.

� The validity of the imported declarations themselves will not be checked (eg. for syntax
errors, type mismatches, duplicate names, etc.).

� The imported file will be checked if it contains external variables. These variables will be
skipped. A warning is shown to inform you.

The affected editors and dialogues are:

� Task editor

� Data Unit Type editor

� Global Variable List editor

� POU Header editor

� Data unit variable addresses dialogue
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3.12.4 Selecting data types in the declaration table

Libraries

All data types (incl. Libraries)

<Project> All data types in the project

Manufacturer_Lib Reserved for functions to be added later

Standard_Lib Reserved for functions to be added later

Type Class

Data type class

Simple Types: Simple data types

Data Unit Types: Structured data types (DUT)

Function Blocks: Reserved for functions to be added later

Types

All existing data types, depends on the selections in the previous list fields.

3 – 38 MITSUBISHI ELECTRIC

Working in tables The User Interface

Fig. 3-27:
Data type selection



3.12.5 Automatic default data types in the declaration table

As soon as you enter an address the most likely data type for that address is automatically
displayed in the Type column.

Example Entry: X1
Default type: BOOL

Entry: D1
Default type: INT

�
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3.13 Working in the editors (Body)

The body contains the actual code of the PLC program. To open the body’s object window,
double-click on the Body entry in the Project Navigator window. If the object window of a
header is already open you can open its body with the Open Body command in the Object
window.
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Fig. 3-29:
Program body
in editor

� �

Item Description


 Network bar

� Editing area

Tab. 3-10: Body editor items



3.13.1 Networks

In the Sequential Function Chart, Ladder Diagram and Function Block Diagram languages,
the PLC program is always divided into a number of logical program units referred to as
‘networks’. These networks are numbered consecutively and can be given network labels
which can be used as destinations for jump (goto) instructions.

E
WARNING:
In the graphical editors (Ladder Diagram and Function Block Diagram) you can only
program a maximum of one circuit in each network.

How to enter a new network

� Select the New Network command in the Edit menu.

� Choose the position at which you wish to insert the network.
Top At the beginning of the program
Before Directly before the selected network
After Directly after the selected network
Bottom At the end of the program
MELSEC Before Insert a MELSEC network directly before the selected

network (only possible in Instruction List)

Or:

� Use the following tools:

Or:

� Insert new networks directly in the Network List.

NOTE In MELSEC networks you can only use MELSEC programming instructions; you cannot use
the IEC instructions. Also, you can only insert MELSEC networks in Instruction List
programs (� Appendix E).
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Tool Description Menu Item Shortcut

Inserts a new network directly
before the selected network.

Edit - New Network - Before
��

Inserts a new network directly after
the selected network.

Edit - New Network - After
��

Tab. 3-11: Tools for inserting new networks



How to assign network labels

� Double-click on the network bar.
Or:
Activate selection mode, position the mouse pointer over the network bar with the
cursor keys, and then press the � key.

A dialogue box is displayed in which you can enter the network label and title:

Label: The label must be terminated with a colon (:) and must consist of a maximum of 8
characters (including the colon). In MELSEC networks you can also assign absolute labels.An
absolute label is a specific pointer address, e.g. P20.

Title: This entry is optional. The title can have up to 20 characters.

NOTE Network labels and titles can also be entered directly in the Network List.

Network labels can be used as jump destinations in your PLC program, using the JMP
operator in the Instruction List language, and with the jump instruction in the Ladder Diagram
and Function Block Diagram languages.
Label1Label1Remember that every network label uses one system label and that the total
number of system labels is limited to a maximum of 256. Since system labels are also needed
for other elements in GX IEC Developer, you should only define labels to networks to which
you actually intend to perform a jump.

How to make the network area larger/smaller

� In select mode, position the mouse pointer on the lower horizontal edge of the network
bar.

The pointer changes to a double-headed arrow symbol.

� Hold down the left mouse button and drag the dividing line up or down as required.
Or:
Press the � key. Hold down the � key and drag the dividing line up or down with the
	 and 
 cursor keys.

When you release the mouse button or the� key the network is displayed in the new size.

NOTE You do not normally have to change network size manually as it is adjusted dynamically;
when you enter program elements or text the network is automatically enlarged as required.
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Fig. 3-30:
Assigning network labels and titles



Managing networks

The Network List is a powerful tool that gives you a clear overview of each POU’s networks,
enabling you to manage them easily and efficiently.

Select the Network List command in the Tools menu.

A list of all the networks with their labels and titles is shown on the left of the dialogue
box displayed. The dialogue box contains the following buttons:

Insert: :
You will be prompted for the label and title of the new network. A new network is then
inserted in the Network List and the body directly before the currently selected network.

Append:
You will be prompted for the label and title of the new network. A new network is then
inserted in the Network List and the body as the last network.

Edit:
Edit the label and title of the currently selected network.

Cut:
Cuts the currently selected network, deleting it from the Network List and the body and
inserting it in the clipboard.

Copy:
Copies the currently selected network to the clipboard.

Paste:
The network in the clipboard is inserted in the Network List and the body, directly
before the currently selected network.

Delete:
Deletes the currently selected network without copying it to the clipboard. If you
accidentally delete a network you can recover it by clicking on the Undo button.
However, please note that Undo only works if you execute it immediately after
performing the Delete command!

Undo:
Undoes the effects of the last command.

Redo:
Undoes the effects of the last Undo command.
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Fig. 3-31:
Network List



Find:
Allows you to find specific network labels in your program. Please note that the search
is case-sensitive and wildcard characters (? and *) are not supported.

Close:
Closes the dialogue box, accepting any changes made.

NOTE The standard Windows key combinations for Delete, Cut, Copy and Paste are not supported
in this dialogue box! You can only perform these operations with the buttons in the box.
However, the key combinations are supported for editing labels and titles.
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3.14 The ST editor

Operation of both the text editors – IEC Instruction List and MELSEC Instruction List – is
similar to that of a normal word processor.

The Instruction List consists of a sequence of controller instructions. Each controller
instruction must begin on a new line, and consists of an operator (operator, function or function
block) and one or more operands/variables. The operator and the operand must be separated
by a tab stop.
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Fig. 3-32: ST Editor

Fig. 3-33:
IEC Instruction List in text editor

�

��

���



NOTE See the chapter 6 for details on programming.
A detailed description on how to insert programming instructions and variables is given at
the end of this chapter.

All key combinations for working in Instruction List language are described in the
Appendix B.

3.14.1 Syntax colouring

While you are typing text in the ST editor the entered text is coloured depending on the kind of
input. The following groups are distinguished.

� Keywords

AND
BY
CASE
DO
ELSE
ELSIF
END_CASE
END_FOR
END_IF
END_REPEAT
END_WHILE
EXIT
FALSE
FOR
IF
MOD
NOT
OF
OR
REPEAT
RETURN
THEN
TO
TRUE
UNTIL
WHILE
XOR
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Item Description


 Network bar

� Editing Area

� Comment

� Column for operand(s)

� Operator column

� MELSEC network

Tab. 3-12: Text editor items



� Operators

-
&
*
**
/
+
<
<=
=
>
>=
;

� Comments with the following syntax:

(* <comment> *)

� Constant Numbers

IEC constants could contain single underscore characters between the digits of a numeric
literal (e.g. 1_2_3.4_5 for a REAL constant). IEC typed literals like DINT16#FF are not
supported by GX IEC Developer.

NOTE TRUE and FALSE are coloured like other keywords.

� Constant Strings

� Variables

Any variable or variable constant which is declared in the POU header.

Each group has a predefined color which can be changed by the user. Text, which does not
belong to one of the above groups, is displayed in the editor text color which could be changed
under View � Color � Text.
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IEC Mitsubishi Type
400000, -100 K400000, K-100 decimal
16#FFFF HFFFF hexadecimal
8#0745 octal
2#01010101 binary
1.2E-10 E1.2-10 REAL
T#3h10s3ms TIME

Tab. 3-13: Constant Numbers

IEC Mitsubishi
‘abc’ “abc”

Tab. 3-14:
Constant Strings



Color setting for syntax colouring

The color settings are valid for the current GX IEC Developer 7.03 project only. They are
available as new menu items under View � Colors with the following menu item text:

– ST Keywords…

– ST Operators…

– ST Comments…

– ST Constant Numbers....

– ST Constant Strings…

– ST Global Variables…

– ST Local Variables…

Default foreground colors:

If the menu item View � System Defaults is chosen, all syntax colors, which have the same
color as View � Colors � Text are changed to the Window setting for the foreground color of
a window.

3.14.2 Options in structured text

By the help of a seperat dialogue the following options for the ST-editor can be configurated:

Auto Indentation

After pressing <RETURN> in the ST-editor (in edit mode), tabulators are automatically
inserted at the beginning of the new line, if tabulators are existing at the beginning of the
current line.

The number of tabulators is automatically increased, when it is expected (e.g. after keyword
FOR).
The number of tabulators is automatically decreased, when it is expected (e.g. after keyword
END_FOR).

This behaviour can be enabled or disabled in the options dialogue.
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RGB Color
Keywords ( 0, 0, 255)
Operators ( 0, 0, 0)
Comments ( 0, 128, 0)
Constant Numbers ( 0, 0, 0)
Constant Strings ( 0, 0, 0)
Global/Local Variables ( 255, 0, 255)

Tab. 3-15: Default foreground colors



Auto identifier proposal

If you enter an identifier, the system searches in the corresponding header of the POU for a
variable or a variable constant which starts with the already entered characters. The compare
is done case insensitive.

If only one identifier exists, it is automatically inserted and selected. The selected part can be
overwritten or inserted by pressing <RETURN>. If you press <RETURN>, the cursor will be
placed behind the inserted identifier.

If several identifiers are existing, a list of all identifiers is shown which match the already
entered characters. You then can select one from the list or add additional characters.

If you confirm a suggested identifier with <RETURN> or select one from the list of identifiers
the already entered characters are deleted and the selected identifier is inserted. Therefor it is
possible to enter characters in any case and, after an identifier is selected, it is inserted as it is
written in the POU header.

The auto identifier proposal can be enabled or disabled in the options dialogue.

ToolTip on a variable-identifier

See section 3.19 for details.

Right mouse button

If the right mouse button is pressed, a context sensitive menu is shown.

Line number in the status bar

The current line number is shown in the status bar at the very left side in the format “Line: nnn”
where nnn is the current line number. The first line has the line number 1.

This behaviour can be enabled or disabled in the options dialogue.

ST Options

An additional property is available to configure the following options:

See section 2.8.11 for the design of the dialogue.

See section 3.19 for the tool tip configuration.

Background color

The background color of the editor (in edit mode) is the same as for all editors. It can be
changed with View � Colors � Background.

To make it obvious for the user, that the monitoring mode was activated, all colors of the syntax
colouring groups are changed to the current text color when the monitoring mode is switched
on.
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Option Default
Auto indentation ON
Auto identifier proposal ON
Line number in the status bar ON
Tab size (1 - 64) 4

Tab. 3-16:
ST Options



3.14.3 Monitor functionality in ST editor

There a three different monitoring possibilities in the ST editor.

ToolTip:
See section 3.19 for details.

Monitor boolean values:
The monitoring of boolean values in the source code window is done like in the IL editor. This
item is invoked by Online � Start Monitoring � Body.

A box is painted around a boolean variable or address in the monitor color. If the monitored
value is ON the box background is set to the monitoring color, if it is OFF it is shown as the
current background color of the editor.

Splitted body:
In addition to the monitoring of boolean values in the source window the ST body could be split
into source code window (left part) and variables / values window (right part) with configurable
border:

This item is invoked by Online \ Start Monitoring \ Split Window.

Modify Variable

By a double click on a variable name or by pressing the shortcut Ctrl + F9 when the edit cursor
is positioned in a variable name the value of the variable could be changed in the source code
window or variables / value window like in IL with functionality ‘ Modify Variable Value’. The
related menu item is Online � Modify Variable Value.

By pressing the shortcut Alt + F9 on a boolean variable the value is toggled. The related menu
item is Online � Toggle Variable.
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Fig. 3-34: Split Window



Show MELSEC Code Of Selection

In addition to the menu item ‘Show MELSEC Code Of Network’ the menu item ‘Show MELSEC
Code Of Selection’ is available.The MELSEC codes of the current selected lines are shown in
an extra window similar to the ‘Show MELSEC Code Of Network’.

The header off the window will show the selected lines. For example:

Example (* TestST [PRG] *)

(* MELSEC code of TestST, line 4 - 11 *)

(* Code generated at 17.07.02 09:16:56, 7 steps *)

�
It is not possible in the editor to select independent lines. All statements are taken completely,
even when only a part of a statement is selected.

Tracking

The tracking functionality is available in monitor mode.

Bookmarks

With the menu item Edit � Toggle Bookmark (Ctrl F7) a bookmark could be set or reset.

With the menu item Edit � Next Bookmark (F7) the cursor is positioned at the start of the line
of the next bookmark. If the line is currently not visible it is scrolled into view.

With the menu item Edit � Previous Bookmark (Shift F7) the cursor is positioned at the start
of the line of the previous bookmark. If the line is currently not visible it is scrolled into view.

With the menu item Edit � Delete all Bookmarks all bookmarks are deleted.

Bookmarks are saved to the project database (max. 100 items) when the body is saved. This
allows the reuse of set bookmarks at the next edit session.
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3.14.4 Limitations

The possible data type for Mitsubishi K and H constants is calculated for all IEC editors
depending on their device values:

As in former GX IEC Developer versions the Mitsubishi devices FX, FY and FD are not
supported in GX IEC Developer 7.03. Indirect devices like @D0 can also not be used except in
MELSEC IL networks.

As in former GX IEC Developer versions for the following MELSEC instructions no
Manufacturer Library function are defined in GX IEC Developer 7.03:

To start a timer in GX IEC Developer the functions TIMER_M or TIMER_H_M must be used
instead of the MELSEC instructions OUT or OUTH with two operands.
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Device Value IEC Data Type
K-32768 - K-1 INT | DINT
K0 - K32767 INT | WORD | DINT | DWORD
K32768 - K2147483647 DINT | DWORD
K-2147483648 - K-32769 DINT
H0 - HFFFF INT | WORD | DINT | DWORD
H10000 - HFFFF FFFF DINT | DWORD

Tab. 3-17: Calculation of constants

Constant Value IEC Data Type
-2147483648 - -32769 DINT
-32768 - -1 INT | DINT
0 - 32767 INT | WORD | DINT | DWORD
32768 - 65535 DINT | WORD | DWORD
65536 - 2147483647 DINT | DWORD
2147483648 - 4294967295 DWORD
16#0 - 16#FFFF INT | WORD | DINT | DWORD
16#10000 - 16#FFFF FFFF DINT | DWORD

Tab. 3-18: Calculation of constant values

LD LDI AND ANI OR ORI ANB

ORB NOP NOPLF PAGE CALL CALLP ECALL

ECALLP EFCALL EFCALLP FCALL FCALLP XCALL



3.14.5 Edit functions

How to activate editing mode

There are two ways to activate editing mode:

� By double-clicking in the editing area, or

� By clicking on the Edit Network tool:

Edit Network tool

The entry cursor is then displayed in the editing area.

How to change the column width

� In select mode, position the mouse pointer on the vertical line between the columns.

The pointer changes to a double-headed arrow.

� Hold down the left mouse button and drag the dividing line to the left or right as
required.
Or:
Hold down the � key and move the dividing line left or right with the � and � cursor
keys.

When you release the mouse button or the� key the dividing line is redisplayed in the new
position.

How to enter comments

� Position the cursor at the point where you wish to enter the comment.

You can insert comments anywhere in the Instruction List, i.e. in the third column or in
a new line.

� Comment text must always be enclosed by the characters (* and *).

How to insert a programming instruction and a variable

� page 3-69 and 3-71
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3.15 The graphical editors

Operation of the two graphical editors – Ladder Diagram and Function Block Diagram – is
comparable to working in a standard graphics program.The program elements used for writing
PLC programs are provided in the toolbar and the Tools menu.

NOTES See the chapter 6 for details on programming.
A detailed description on how to insert programming instructions and variables is given at
the end of this chapter.

All key combinations for working in graphical editors are described in the Appendix B.
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Fig. 3-35: Programs in graphical editor
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Item Description


 Ladder Diagram (LD)

� Function Block Diagram (FBD)

� Network bar

� Editing area

� Input variable (poll for signal status ‘1’)

� Input variable (negated, poll for signal status ‘0’)

� Function

� Output variable

� Output coil (Ladder Diagram only)

� Comment

� Input contact (poll for signal status ‘1’) (Ladder Diagram only)

� Power bar (Ladder Diagram only)

Tab. 3-19: Graphical editor items



3.15.1 Options

In the menu Extras - Options you can specify options which make handling operations in the
graphic editors easier.

FBD/LD

Declare New Identifiers: When you overwrite a dummy variable in a graphical editor with a
variable identifier name that has not yet been declared the Variable Selection (Mode
NewVar) dialogue box will be displayed automatically so that you can enter the declaration for
the new variable.

Pin Overwrite: When you create a connection to an empty variable connection in a graphical
editor the empty variable will be overwritten.

Automatic Input/Output Variables: The system will automatically create the input and output
variables when you insert a function block in a graphical editor.

Automatic ENO Variables: The system will automatically create the ENO output variable
when you insert a function block in a graphical editor. If the ENO output variable is not needed
this option has to be disabled.
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Fig. 3-36:
Extras - Options



3.15.2 Context menu

When edit mode is active you can display the context menu by clicking the right mouse button
or pressing�.

Line / Arrow (toggle function): Toggles between select mode and interconnect mode.

AutoConnect: Makes positioning and moving graphical elements simpler. When elements
are moved the connection lines are redrawn automatically (� page 3-59)

VarInput Pin: Insert input variable (same as Tools - Input Variable)

Contact (LD only): Insert input contact (same as Tools - Contact)

VarOutput Pin: Insert output variable (same as Tools - Output Variable)

Coil (LD only): Insert output coil (same as Tools - Coil)

FUN/FB: Opens Function Block Selection dialogue box for programming instruction
selection

Last 5 function blocks list: The last 5 function blocks inserted in the LD or FBD editors can
be reused directly by selecting them from the list at the bottom of the context menu.

3.15.3 Right mouse button or F2

Mouse pointer in editing mode / on block: Activates context menu

Mouse pointer on variable: Opens the Variable Selection dialogue box for selection of a
variable from the list.

Mouse pointer on a jump instruction: Opens the Label List dialogue box for selection of a
network label from the list.
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Fig. 3-37:
Editor context menu

Mouse Pointer Purpose

Select Mode

Interconnect Mode

Select Mode + AutoConnect

Interconnect Mode + AutoConnect

Guided Mode (see chapter 7)

Tab. 3-20: Editor mouse pointers



3.15.4 Program Elements

How to insert new program elements

Icons are provided in the toolbar for all the available program elements.

� Click on the tool for the element you wish to insert.
Or:
Select the menu command from the Tools menu, or press the corresponding key
combination.

The mouse pointer then changes to the symbol for the selected program element.

� Position the tip of the pointer at the point where you want to insert the element and
press the left mouse button or the � key.

How to select program elements

� Click on the program element.
Or:
Position the pointer over the program element with the cursor keys and then press the
� key.

Selected program elements are highlighted in a different color.
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Tool Program element Menu Command Key(s)

Lines (Interconnect Mode) Tools - Network Elements -
Interconnect Mode

��

Input contact
(Ladder Diagram only)

Tools - Network Elements -
Contact

�

Input contact negation
(Ladder Diagram only)

Tools - Network Elements -
Contact Negation

�

Input L-contact
(Ladder Diagram only)

Tools - Network Elements -
L-Connection Contact

�

Input L-contact negation
(Ladder Diagram only)

Tools - Network Elements -
L-Connection Contact Negation

�

Vertical line
(Ladder Diagram only)

Tools - Network Elements -
Vertical Line Segment

 

Horizontal line
(Ladder Diagram only)

Tools - Network Elements -
Horizontal Line Segment

!

Output coil
(Ladder Diagram only)

Tools - Network Elements -
Coil

"

Function block
(programming instruction)

Tools - Network Elements -
Function block

#

Input variable Tools - Network Elements -
Input Variable

$

Output variable Tools - Network Elements -
Output Variable

%

Tab. 3-21: Program elements



How to select more than one program element

� Selecting elements out of sequence: Hold down the � key and click on all the program
elements you wish to select.
Selecting elements in sequence: Position the mouse pointer outside the area to be
selected, hold down the left mouse button and drag the dotted rectangle around the
elements you wish to select.

Or:

� Selecting elements out of sequence: While holding down the� key, select the elements
one after another by positioning the mouse pointer over them with the cursor keys and
pressing�.
Selecting elements in sequence: Position the pointer outside the area to be marked. While
holding down the � key, use the cursor keys to drag the dotted rectangle around the
program elements you wish to select.

Selected program elements are highlighted in a different color.

NOTE You can only select multiple program elements within the same network.

How to increase and decrease editing area spacing

The Tools - Open Row/Open Column commands are used to increase and decrease the
horizontal and vertical spacing in the editing area.

� Select the menu command or the corresponding tool in the toolbar.

The pointer changes to a horizontal or vertical double-headed arrow.

� Position the pointer at the location where you wish to increase/decrease spacing.

� Increase spacing: Click with the mouse button or press the� key.
Decrease spacing: Hold down the� key while clicking or pressing the� key.

How to enter comments

You can enter comments at any point in the editing area.

� Select Comment in the Tools menu or the corresponding tool in the toolbar.

The pointer changes to a comment text symbol.

� Move the pointer to the position where you wish to insert the comment.

� Hold down the left mouse button and drag to create a comment field.
Or:
Hold down the� key and create a comment field with the cursor keys � and 
.

When you release the mouse button or the � key the blinking editing cursor appears
in the newly-created comment field.

	 Enter your comment text.

How to insert a programming instruction

� page 3-69
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3.15.5 AutoConnect

The AutoConnect function can be activated in the Tools menu or the context menu.

The AutoConnect mode makes moving and connecting graphical elements much easier.
When you move the elements the connecting lines are stretched and rerouted automatically,
so that you do not need to edit the lines by hand. To connect elements in the AutoConnect
mode you simply click on the start and end points and the lines are drawn automatically.

The mouse pointer has the following forms in AutoConnect mode:

Moving elements (rubber banding)

� Activate both select mode and AutoConnect.

� Click on the element you wish to move and drag it to the new position, holding the left
mouse button down.

� Release the mouse button when you reach the position at which you wish to place the
element.
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Mouse Pointer Purpose

Select Mode + AutoConnect

Interconnect Mode + AutoConnect

Tab. 3-22: Editor mouse pointers

Fig. 3-38:
The lower block MOV_M and its
associated connecting lines are
selected.

Fig. 3-39:
The block is dragged to its new
position. Temporary diagonal
connection lines are displayed while
you are repositioning the block.

Fig. 3-40:
The block has been moved to its new
position and the connecting lines have
been redrawn automatically. The
variables have also been moved
automatically, thus retaining their
positions relative to the function block.



If there is an anchor point on the connection line the lines will only be modified up to the
position of the first anchor point. The lines on the other side of the anchor point and the anchor
point itself all remain unchanged.

An error message will be displayed if you try to move an element to a position that GX IEC
Developer cannot calculate. You can then abort the move operation.

The Undo function is available as well.

Inserting connection lines (autorouting)

� Activate both Interconnect mode and AutoConnect.

� Click on the position for the starting point. Possible starting points are indicated by
black dots. This activates the connecting line, which follows the mouse pointer as you
move it.

� Position the mouse pointer at the end point.

	 Click on the end point.
The connecting line is drawn automatically.
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Fig. 3-41:
AutoConnect starting point

Fig. 3-42:
AutoConnect end point

Fig. 3-43:
"AutoConnected" line



Recalculate Line

The menu command Recalculate Line in the Tools menu helps to recalculate lines which
have already been drawn.

In the normal Interconnect Mode (AutoConnect is disabled) a connection with several lines
has been created.

� Activate the Interconnect Mode and AutoConnect.

� Click on the connection.
All lines of the connection will be marked.

� Activate the command Recalculate Line in the Tools menu.
The connection is recalculated.

Possible starting and end points

Try moving the connecting line over the various elements in the editing window. As you do so
black dots are displayed to indicate possible connection points.The connecting line is drawn to
the black dot under the tip of the pencil symbol when you click the mouse button.

Examples of possible connection points:

– Variable connections (without variables) on function blocks

– Between variables and variable connections (without variables) on function blocks

– Ends of lines

– Positions on lines

The positions of the connection points are dictated by the grid raster.

If you click on a position where no black connection dots are displayed the operation will be
aborted automatically, thus preventing the inadvertent creation of connection lines without
connected ends.
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Fig. 3-44:
Connecting line before
recalculation

Fig. 3-45:
Recalculated
connecting line

Fig. 3-46:
Starting and end points



Anchor points

Double-clicking on a potential connection point creates an anchor point. Anchor points are
indicated by small black squares.

When you move elements in the editing window the positions of the anchor points remain
unchanged.

Overwriting unassigned variable pins

If the starting or end point of a new line is an unassigned variable connection (pin) the
connection is overwritten automatically when the line is inserted. You can activate or
deactivate this function with the Extras - Options - Editing - Pin Overwrite option.

NOTES Restrictions for connecting lines
Do not try to insert connecting lines between variable pins for which different variable types
have been declared. This will result in an error message when you perform a check on the
POU.

Do not try to draw connecting lines through function blocks.
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Fig. 3-47:
Anchor point



3.15.6 Variables

How to configure input signals

Double-click on an input contact or on the connection of the input variable in a function block.
Or:
Position the pointer with the cursor keys on an input contact or on the connection of the input
variable in a function block and press the key combination [CTRL]+[ALT]+[S].

A dialogue box is displayed with the following options:
Normal Poll for signal status ‘1’
Negation Poll for signal status ‘0’

Make the appropriate selection in the dialogue box.

An input signal can also be configured directly:

� Click on the input contact or a function block to select it.

� Press the key combination [CTRL]+[ALT]+[S] to negate the input or press the key
combination [CTRL]+[ALT]+[C] to undo the negation.

Or:

� Click on the input contact or a function block to select it.

� In the menu Edit select Toggle Signal Configuration and click on the selected input.
The signal configuration of this input will be toggle.
If you select Edit - Signal Configuration, after clicking on the selected input the
Signal Configuration dialogue appears.
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Fig. 3-48:
Input signal configurations:
Normal and negated�

�

� �

Item Description


 Negated input variable

� Normal input variable

� Normal input contact

� Negated input contact

Tab. 3-23: Signal configurations items



How to configure output signals

� Double-click on an output coil or on the connection of the output variable in a function
block.
Or:
Position the pointer with the cursor keys on an output coil or on the connection of the
output variable in a function block and press the key combination [CTRL]+[ALT]+[S].

A dialogue box is displayed with the following options:
Normal Poll for signal status ‘1’
Negation Poll for signal status ‘0’
Set Set (output coil only)
Reset Reset (output coil only)

Make the appropriate selection in the dialogue box.

How to assign input and output variables to programming instructions

� Select Tools - Input Variable/Output Variable or the corresponding tool in the toolbar.

The pointer changes to an input variable or output variable symbol.

� Position the tip of the pointer over the connection of the function block.

� Click on this position.
Or:
Press the� key.

The variable is inserted. You must now assign the variable name.
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Fig. 3-49:
Output signal configurations:
Normal and negated

��

��

� �

Item Description


 Normal output coil

� Negated output coil

� Set output coil

� Reset output coil

� Normal output variable

� Negated output variable

Tab. 3-24: Signal configurations items



NOTE Most programming instructions have a specific number of input variables. However, in some
cases (e.g. ADD_E) the number of input variables can be increased. With these instructions
the Number of Pins field is activated in the programming instruction dialogue box.Enter the
required number (max. 28) in this field. Note that the EN input is not included in the total. For
example, if you enter 5 connections for the ADD_E function the resulting Block will have 5
real connections for the addition operation and one EN input.

How to insert a variable

� page 3-62

Adding and removing input variables

� Select a function block for which the number of input variables can be changed.

There are variety of different ways to add/remove input variable pins:

� Increment Pins / Decrement Pins options in the Edit menu

� + and - keys in the numeric keypad

� Toolbar icons:

Increment

Decrement

� Position the mouse pointer on the lower border of the function block. When the pointer
changes to a double arrow press the left button and drag down (increment) or up
(decrement).

Incrementing

If the Automatic Input/Output Box option in Extras - Options - Editing is activated empty
dummy variables are automatically inserted when you increment the number of variable pins.

Decrementing

The input variables will be deleted if they are still empty, i.e. if no variable has yet been
assigned to them. However, if variables have already been assigned to them they will not be
deleted.

GX IEC Developer Reference Manual 3 – 65

The User Interface The graphical editors

Fig. 3-50:
ADD_E function

�

�

Item Description


 One EN input

� Five addition connections

Tab. 3-25: Items of programming instructions



How to insert input and output variables in the graphical editors automatically

� Activate the Automatic Input/Output Box option in Extras - Options - Editing.

When this option is activated the input and output variables are automatically inserted
when you add a function block in the graphical editors. The dummy identifier ?
(question mark) is inserted in the variable name field.

Deleting variables

� Select the variable’s connecting line.

� Press �.

Or

� Select the question mark dummy or the variable name.

� Press �.

� Press the� key.

NOTE You do not need to delete the variables at the connecting pins before inserting lines in
AutoConnect mode. They are overwritten automatically.

Stepping through variables in a network

Pressing � and �� steps through all the variables in the current network forwards or
backwards, selecting them one after another.
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Fig. 3-51:
Function block



3.15.7 Jump and Return Instructions

How to configure jump instructions (label and signal)

A jump instruction executes a branch to a specified network, using the network label as the
destination.

� Click on the dummy label by the jump instruction symbol.
Or:

Position the pointer over the dummy label and press the� key.

� Enter the jump destination name.

� Double-click on the jump instruction symbol.
Or:

Position the pointer over the jump instruction symbol and press the� key.

A dialogue box is displayed with the following options:
Normal Poll for signal status ‘1’
Negation Poll for signal status ‘0’

	 Make the appropriate selection in the dialogue box.

NOTE The jump instruction corresponds to the JMP operator in the Instruction List.
Operator (IL) Program element (LD/FBD)
JMP Normal jump (poll for signal status ‘1’)
JMPN Negated jump (poll for signal status ‘0’)
JMPC Normal jump with input condition
JMPCN Negated jump with input condition

How to configure return instructions (signals)

The return instruction returns control from a function block to the program from which the
function block instance was called.

� Double-click on the return instruction symbol.
Or:
Position the pointer over the return instruction symbol and press the � key.

A dialogue box is displayed with the following options:
NormalPoll for signal status ‘1’
NegationPoll for signal status ‘0’

� Make the appropriate selection in the dialogue box.

NOTE The return instruction corresponds to the RET operator in Instruction List language (IL).
Operator (IL) Program element (LD/FBD)
RET Normal return instruction (Poll for signal status ‘1’)
RETN Negated return instruction (Poll for signal status ‘0’)
RETC Normal return instruction with input condition
RETCN Negated return instruction with input condition
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3.15.8 Graphic macros

Setting the number of graphic macros

You can create and store up to 25 graphic macros.

Number of Graphic macros in Extras - Options - Graphic
Enter the number of graphic macros you wish to use.

How to create graphic macros

� Select the area in the editing area that you wish to store as a graphic macro.

The selected area is highlighted.

� Select the Copy command in the Edit menu.

The selected area is copied to the clipboard.

� Select Define Graphic Macros in the Tools menu.

The Configure Custom Tools dialogue box appears on the screen.

	 Select the name under which you wish to store the macro.

If a macro is already stored under the selected name its contents are shown in the
Contents box.


 Click on the Paste button.

The contents of the clipboard are pasted into the Contents box.

� Click on the Close button to confirm your entries and close the dialogue box.

Selecting graphic macros

Tools - Custom: The names of the first five graphic macros are displayed in the menu and
they can also be selected by pressing� together with the corresponding number key.

Tools - More Custom: Enables you to select all available graphic macros.
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Fig. 3-52:
Creating graphic macros



3.16 Selecting Programming Instructions

Graphical editors:

� Menu: Tools - Network Elements - Function Block

� Toolbar icon

� FUN/FB context menu (right mouse key)

Text editors:

� Menu: Tools - List Operators/Operands

� � key

� Right mouse key

The Function Block Selection dialogue box is displayed. It remains open, active and visible
until it is explicitly closed. It is also closed automatically when you close the current body or
activate another window on the screen.

Libraries

: All programming instructions available for the PLC currently selected.

<Project>: Functions and function blocks created by the user (depends on the selection in the
Operator_Type field)

Manufacturer_Lib: All programming instructions in the manufacturer library

Standard_Lib: All programming instructions in the standard library

Last recently used

All recently-used programming instructions
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Operator Type

All Types: IEC operators, functions and function blocks

Operators: IEC operators

Functions: Functions

Function Blocks: Function blocks

Number of Pins

This field is activated when the instruction allows you to change the number of input contacts
(input pins).

Operators

All available programming instructions (depends on the selections in the previous fields). If you
enter the first letters of an instruction manually the highlight automatically jumps to the first
instruction beginning with that letter or letter combination.

APPLY button

Graphical editors: When you move the mouse pointer over the editing window it changes to a
pointer with a function block symbol. Simply click at the position where you wish to insert the
instruction.

Text editors: Enters the selected programming instruction in the editor window.

Getting help on specific programming instructions

Select the instruction in the Operators list field and then press the Help button.
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3.17 Variables

3.17.1 Selecting existing variables and declaring new variables

Before you open the Variable Selection dialogue box:

Graphical editors: Highlight the variable/instance dummy name

Text editors: Place the cursor in the variables column

Sequential function chart language: Highlight a transition definition

Then:

In the Task Information dialogue box: Event (F2 key only)

In both graphical and text editors:
- Tools - List Operators/Operands menu
-� key
- Right mouse button

The Variable Selection dialogue box is then displayed. This dialogue remains open and
visible on the screen and does not need to be closed when you perform other editing actions in
the program body. If you prefer to minimize the dialogue box automatically after applying a
declaration, activate the “Minimize Dialogue after apply” checkbox.

Scope

All of the project’s variables:

<Header>: All local variables in the header of the currently open POU

<Global Vars>: All global variables

Manufacturer_Lib: Reserved for functions to be added later

Standard_Lib: Reserved for functions to be added later
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Type

Depends on the selections in the Libraries and Type Class list fields:

Simple Types: Simple data types: ANY, ANY_BIT …

Data Unit Types: Structured data types (DUT)

Function Blocks: Function blocks

For existing variables the currently valid type is displayed.

Default settings:
- Graphic editor: Data type of formal parameter, contact/coil: BOOL
- Transition in SFC: BOOL

NOTE The variable selection dialogue includes a variable type filter.
The type list only includes variable types valid for the actual project and does not include
variable types that are not available for the used PLC type.

Type Class

Simple Types: Simple data types

Data Unit Types: Structured data types (DUT)

Function Blocks: Function blocks

For existing variables the currently valid type class is displayed.

Variables

Depends on the selections in the preceding list fields: All existing variables

When you enter the first letters of the variable name the highlight will automatically jump to the
first variable with this letter or letter combination.

APPLY button

Enters the selected variable into the selected variable dummy name in the editor (same effect
as double-clicking).
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NEW ON button

Selecting this button expands the dialogue box, displaying an additional area for the
declaration of new variables. The dialogue box title changes to Variable Selection (Mode
NewVar).

This dialogue box also appears:

� When you select the Tools - New Variable menu option (ALT + N).

� When you overwrite a dummy variable name in a graphical editor with the name of a
var iable that has not yet been declared. This automatic function can be
activated/deactivated with the option Extras - Options - Editing - Declare New
Identifiers.

The expanded dialogue box fields enable you to declare new variables of the type defined by
the selections in the Library, Type and Type Class fields.The entries are the same as those in
the variable declaration tables.

You can also declare instances, in the same way as in the declaration tables.

DEFINE or UPDATE button

Selecting this button confirms and accepts all your entries for the new or existing variable. The
button is inactive (greyed out) if your entries are incorrect or incomplete.

The new variable or the changes on a existing variable are automatically added to the corre-
sponding declaration table.

NEW OFF button

Shrinks the dialogue box back to its original size, hiding the new variable declaration fields
again.
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IEC 61131-3

This field displays all the available IEC information for the selected variable.

3.17.2 Find unused variables

By using the function Extras Find Unused Variables you can find and delete all unused
global and local variables that are declared but not used in a project. Unused global and local
variables will be detected in the whole project, excluding the user libraries.

NOTE Finding unused variables can only be performed if the project has been built and was not
changed since then. Otherwise a warning message will be displayed.

If the compiled code exists and is up to date, the project will be checked. When there are
unused variables in the project, the following dialogue will be displayed. It shows the name,
location and – optionally – additional information about the variables. By using this dialogue
you can remove the declaration of selected variables, or of all of them.

Each unused variable is listed under the container of its declaration: the Global Variable List for
global variables, or the corresponding POU for local variables.Only those containers are listed
where unused variables exist. For example, if there is no unused global variable, the Global
Variable List location will not be enlisted. Containers are written in bold text and appear at a
higher level than their contained items.
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Variables in containers to which no read-access is granted at the current security level are not
enlisted. Variables in containers to which no write-access is granted at the current security
level are displayed in a disabled state. These variables cannot be selected for deletion.

It is possible that a function (FUN) or function block (FB) POU has an unused variable with the
type VAR_INPUT, VAR_OUTPUT or VAR_INOUT. These kinds of variables serve as the inter-
face of the POU. Although an unused interface variable can be deleted, this deletion changes
the interface of the POU, and all callers of this POU have to be revised.For this reason, when at
least one interface variable is selected for deletion, the following confirmation message will be
displayed:

The progress of the deletion will be indicated in the left side of the status bar.
If all unused variables have been deleted, the dialogue (Fig.3-58) will be closed.Otherwise the
dialogue will be kept displayed showing the updated list of unused variables.
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3.18 Search and Replace

A new functionality to replace an object in Ladder and FBD is available.

If an operator, a function or a function block is marked in editors of the type LD and FBD and if
you select a new operator, function or function block (e.g. from the dialogue Function Block
Selection or from the pick list with the last recently used objects), the marked object is
replaced by the new object.

Example

After the operation:

�
No additional input or output boxes are inserted (regardless of whether the option Automatic
Input/Output Variables is enabled) and the already available connections to the replaced
operator, function or function block are automatically connected to the new one.
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If the height of the new object is greater than the old one, the functionality Open Row is
automatically applied to the lower border of the old object, before the new object is inserted. If
the width of the new object is greater than the old one, the functionality Open Column is
automatically applied to the right border of the old object, before the new object is inserted.

Example

After the operation:

�
If the size of the new object is equal or smaller than the old one, no change in the layout is done.
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The functionality to replace an object in Ladder and FBD is added to the search and replace
functionality, so that a manual replace functionality (Button Replace) and an automatic
replace functionality (Button Replace All) is available:

If the autoconnect mode is switched off, it will be switched on automatically in the background
during the operation.

If the name in the field Replace With is no valid operator, function or function block, the search
and replace operation will be aborted.
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3.19 Tooltips

Tooltips, which are provided for body editors of the type LD, FBD, ST, IL and MELSEC IL,
support the user during the programming and monitor activity.

If the user moves the mouse cursor over a variable, a Tooltip will appear after a short moment:

The provided information in the displayed Tooltip can be configured in the options dialogue
(see section ). The following items are available:

� Monitored value (is only shown in monitor mode)

� Class

� Mitsubishi address

� IEC address

� Type

� Initial value

� Comment (only the first 80 characters are shown)

� Remark (only the first 80 characters are shown)

An additional setting switches between single line (all items are separated by semicolons in
one line) and multi line (each item is displayed in a separate line).
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4 Projects and Objects

4.1 Projects

The project is the object at the top of the hierarchical structure used in GX IEC Developer. In
IEC 61131-3 terms, a project is comparable with a resource. In GX IEC Developer it corre-
sponds to one PLC system.

A project consists of considerably more than just one file. When you create a new project, GX
IEC Developer creates a separate subdirectory with the name of the project. All the files used
by the project are always stored in this directory.

4.1.1 The automatically-generated project files

� *.PRO: Project (all objects except libraries)

� *.BAK: Backup of the file *.PRO

� *.SAV: Extra backup copy of the file *.BAK generated when a restore is performed
(� page 4-15 )

� PLCDOKU: ASCII PLC configuration files when printing (PLC_Parameter)

� WORKSPACE.SYS: Workspace settings (View - Save Workspace)

� CUSTOM.SYS: Graphic Macros (Tools - Custom)

� LRUBOXES.SYS: All the programming instructions used in the project (Last recently
Used list box in the Function Block Selection dialogue box in the graphical editors)

� SFC.OBJ: Last program organisation unit created in the Sequential Function Chart
language (temporary file stored in a special format)

NOTE During the compilation and data transfer processes GX IEC Developer generates a number
of temporary files that should not be edited or tampered with in any way.See the Appendix D
for details.
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4.1.2 Files with standard extensions

� *.ASC Import/Export File

� *.EDM Entry Data Monitor Settings

� *.SED Setup for Entry Data Monitor

� *.PRN Print File

� *.XLS Excel File for Device Editor

� *.SUL User Library

� *.SCT Files for the Cross Reference data base

� *.SCX Automatic link of the SCT files to the SCX file when generating the
cross reference data base

4.2 What are the components of a project?

Projects consist of Objects. The following are all objects in GX IEC Developer:

� The libraries in the Library_Pool

� The PLC parameters

� The tasks in the Task_Pool

� The data unit types in the DUT_Pool

� The global variables

� The program organisation units in the POU_Pool, consisting of headers and bodies

These objects are displayed in the Project Navigator window, which is automatically
displayed when you open a project. The project name is displayed as the first entry in this
window.

The Project Navigator window is the ‘control centre’ or ‘starting point’ for all operations
performed on these objects.The relationships between the original objects are reflected in the
hierarchical structure of the Project Navigator tree.
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4.3 The Project Navigator and Objects

In the Navigator three different views can be selected via tabs: Project, Calltree, and Used by.
For details refer to section 3.4.1.

Q Remote I/O projects have only parameter data. The Navigator shows only the parameter
node and its sub-nodes.

Furthermore, the project navigator window has only the project view, because the Call Tree
and Used By views are not applicable for Q Remote I/O projects, as they have no program (and
therefore neither libraries, tasks, GVLs nor POUs).

4.3.1 Library Pool

The following libraries contain the programming instructions:

� Standard Library

� Manufacturer Library

� User Library

For more information on the library concept see page 4-8.
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4.3.2 Parameter

In the dialogue box PLC parameter you set and store the following PLC system parameters:

� Memory parameters

� Latch operand range

� Timers and Counters range

� I/O configuration

� Network link settings

� PLC setup data

� Special parameters

� System variables

� PLC CPU type selection

NOTE See chapter 5 for details on configuring your system.

4.3.3 Task Pool

Within a project, the task is the highest level in the hierarchy. The task contains the executable
program organisation units, which are the subprograms that go to make up a project. Tasks
can be either event-triggered or executed at preset intervals. Tasks are also assigned prior-
ities, which determine the execution hierarchy when tasks are executed under the same condi-
tions.

4.3.4 DUT Pool

Data unit types are structured data types consisting of collections of variables that can be of
different data types. Data unit types must be declared as global variables.
Values can be assigned to the individual elements (variables) of the data unit type in the body
of the POU (� Chapter 6).

A DUT can also be used as return type for a function. An ARRAY of DUT is not allowed as
function result if it is copied to another ARRAY of DUT.But it is possible when the function result
is assigned to the parameter of a FB macro.

If the same function is used twice as input parameter of e.g. a FB macro, a temporary variable
would be necessary because the second function call would overwrite the values of the first
function call. This is not supported for:

� A DUT as function result.

� An ARRAY of DUT as function result.

4.3.5 Global Variables

Global variables are declared for the entire project. They make it possible to exchange data
between all the individual subprograms that make up the project (� Chapter 6).
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4.3.6 POU Pool

The sorting criteria for the listing of the POUs in the POU pool can be toggled. Three different
sorting criteria are available:

� By name (alphabetically)

� By type

� By programming language (alphabetically)

Right-click on the POU pool to open the context menu and select Sorting Criteria. The Sort
Criteria Precedence dialogue will be opened. In this dialogue you can specify the precedence
of each sorting criteria via the Up and Down buttons.

All program organisation units (POUs) consist of a header and a body.

� Header : The header contains the declarations of the
Local Variables used in the POU.

� Body : The body contains the actual PLC program code
of the POU.

The entries after the POU name specify the Class:

� [PRG] : Program

� [FB] : Function Block

� [FUN:INT] : Function

The entry before the POU name specifies the compilation:

� * : The asterisk indicates that this POU has not
been compiled.

The entries after ‘Body’ specify the programming language in which the PLC program in the
body is written:

� [IL] : Instruction List

� [LD] : Ladder Diagram

� [FBD] : Function Block Diagram

� [SFC] : Sequential Function Chart

� [MELSEC IL] : MELSEC Instruction List

� [ST] : Structured Text

� Action_Pool (SFC only) : All the POU’s Actions
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4.4 The Program Organisation Unit (POU)

The ‘actual’ PLC program code is stored in the body of each POU. However, this no longer
consists of just one PLC program with its own subroutines. In GX IEC Developer you use
groups of subprograms – the program organisation units. These self-contained subprograms
are administrated by tasks; together, they make up the complete PLC program.

A program organisation unit always consists of a header and a body. The header contains the
variables, which are only available within this POU. The body contains the executable PLC
program code.

NOTE An introduction to the IEC 61131-3 standard and the basic principles of this new
programming concept is provided in the Beginner’s Manual in the chapter ‘The IEC 61131-3
Standard’. For tips on writing PLC sequential control programs in the various programming
languages (editors), please refer to chapter 6 in this Reference Manual.
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4.5 Preparation Before You Start Programming

Structured programming …

To work really effectively with GX IEC Developer it is very important to analyse and plan the
task to be programmed in as much detail as possible before you actually begin to write the
code. Divide the entire machine process into small sub-processes, and treat each
sub-process as an independent unit. Implement each of these sub-processes as a Program
Organisation Unit.

… and program management

Develop a sequential structure showing how the individual sub-processes are to be executed.
The program organisation units are called via Tasks (triggered either by events or at defined
intervals).

Global Variables

Draw up a list of your Global Variables, i.e. the variables whose hardware addresses must be
known, and which must be available to all the components of the program (e.g. inputs, outputs,
operands for possible later visual display of the process or operator guidance, analog inputs,
etc). The global variables should be declared before you start developing the program so that
each sub-program can access them. Of course, you can also add to the list in the course of
program development, if necessary.

Reusable subroutines

Program frequently-used processes as Functions or Function Blocks. The functions and
function blocks are stored in a library and can be used at any point in the project where they are
needed.

NOTE To be able to call a function block you must create an ‘instance’ of it, in a process known as
‘instancing’ or ‘instantiation’ (� Chapter 6).

Data Unit Types

Create Data Unit Types for parts of the process where the same constellations of variables
must be accessed again and again. The creation of data unit types corresponds to the
instantiation of function blocks (� Chapter 6).

Graphical or textual based programming

The best editor type to use for your project, graphical or textual, depends on the type and
scope of the programming task. As a rule of thumb, Ladder Diagram and Function Block
Diagram are best for most applications because of their simple entry options and clear repre-
sentation of the program. These graphical editors make programming functions and function
blocks particularly simple. The Instruction List language allows more flexible programming,
but it also requires knowledge of the underlying syntax, for example for calling functions and
function blocks or for programming Arrays. The Sequential Function Chart and the Struc-
tured Text languages are special cases; strictly speaking, they actually are no programming
languages at all, but rather structuring tools. It makes it very easy to see and follow the program
sequence. Individual logical sections of the program (sub-processes) can be programmed as
macros (� Chapter 6).
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4.6 Library Concept

A distinction is made between the following three types of library:

� Standard Library

� Manufacturer Library

� User Library

Standard Library

The Standard Library is for information purposes only. It contains the following elements:

� DUT_Pool : Irrelevant for programming purposes

� Global_Vars : Irrelevant for programming purposes

� POU_Pool : The POU_Pool contains the standard IEC programming
instructions supported in GX IEC Developer. You can view the
variable declarations in the header, but you cannot edit them.

NOTE The SLIB.LIB contains the contents of the Standard Library in packed format.

Manufacturer Library

The Manufacturer Library is also for information purposes only. It contains the following
elements:

� DUT_Pool : Irrelevant for programming purposes

� Global_Vars : Irrelevant for programming purposes

� POU_Pool : The POU_Pool contains all the ‘Adapted’ MELSEC
programming instructions with nomenclature modified for the
IEC editors (� ‘Programming Instructions’ in Appendix E).
You can view the variable declarations in the header but you
cannot edit them.

NOTE The file MLIB.LIB contains the contents of the Manufacturer Library in packed format.

User Libraries

A user library gives you the possibility of creating functions and program segments which can
be used on a supra-project basis. The program segments are grouped in a library and can be
used in any project. Following updating, changes made to the library can be applied to other
projects.

A user library can contain all the objects that are also available in a project: Global Variables
List, Data Unit Types, Arrays and Program Organisation Units. You can assign a password to
protect the know-how in the library.

The name of the user library file has the file extension SUL.

NOTE The MMP703.INI initialisation file contains the LIBRARIES section, where you can make
directory settings (� Chapter 2).
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How to create a new user library

� Select the Install/Create User Library command in the Edit menu.

The following dialogue window is displayed:

� Click on the Browse Lib. button. The Select Library Path dialogue window appears.

� Choose the directory in which the library is to be stored.

	 Enter a new name for the library.


 Confirm with OK.

The entries are transferred to the Install/Create User Library dialogue window, where
they can also be changed.

� Confirm the library entries with OK.

The new library appears in the Navigator, along with the Standard Library and the
Manufacturer Library.

The Install/Create User Library dialogue window

Library Path: Directory in which the library file is to be created. This can be any directory,
although it is sensible to choose a central directory for the User Libraries.

Library Name: Descriptive name for the library, max. 32 characters.

Help Path: Directory and file name for the Help file. A separate Help file can be created for
each User Library.

Browse LRU...: A window is opened which displays the most recently used User Libraries.
You can select a library from this window.

Browse Lib...: A window is opened for you to select a directory and enter a library file. A User
Library is given the file extension SUL.

Browse Help...: A window is opened for you to select a directory and enter a Help file. A Help
file is given the file extension HLP.

View Help: The Help file is opened.
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How to protect the User Library with a password

� Select the desired User Library in the Navigator.

� Select the User Library - Change Password command in the Edit menu.

This opens a dialogue window containing the following items:

Old Password: When changing an existing password, the old password must first be entered
here. If you are assigning a password for the first time, you must skip this field by pressing
[ENTER].

New Password: Entry of the new password.

Confirmation: Repeat entry of the new password.

Access rights

Allow read access for closed library: If this option is checked, the body for all POUs
of the corresponding user library is shown in the navigator and the body can be
opened in read-only mode.

NOTES A protected User Library can only be opened and edited if the password is known.As long as the
User Library is closed and the password is not known, it is impossible to make any unauthorised
changes. Only the header of the POU can be viewed, the body cannot be opened.

If the option Allow read access for closed library is activated, the body (and the header)
for all POUs of the corresponding user library is shown in the navigator and the body can be
opened in read-only mode:
- from the navigator
- from the header of the POU
- from other POU bodies (with a function or a function block of this user library)
- from the browser window
- from the dialogue ‘Compile/Check Messages’
- from the system error dialogue

Remove/Delete User Library

Remove: The Remove User Library command removes the User Library selected in the
Navigator from the project. The library must be open at the time. The file is not deleted by this
operation.

Delete: The Delete User Library command physically deletes the User Library selected in the
Navigator, along with the associated library file.

Update User Library

Every User Library can be used and modified in various projects. If, however, a change is made
in Project_1, this change is not available in Project_2 until the Update Libraries command has
been executed in the Edit menu.

E
WARNING:
It may, however, also be advisable not to update the library in a particular project.
Consequently,you should always take a look at the associated Help texts of the libraries
before performing an update!
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Browse for User Libraries

If User Libraries which are not found in the specified path are accessed (e.g. open User
Library, export project), the Userlib not found dialogue opens where you can browse for
them.From this dialogue you can also create new User Libraries and save the information from
the project to them.

This function does not depend on the current status of the User Libraries (opened, closed,
changed, not changed, password, no password).

Under the following conditions a new User Library has to be created:

� When opening the User Library (transition from installed to opened status)

� When saving the user-library (transition from changed to opened status)

� When exporting a project with user-libraries (no transition)

If such a condition is recognised, a dialogue is opened where you either can:

� Create a new User Library at the original place

� Browse for the User Library

� Create the User Library at any proper place

	 Cancel the new creation of the User Library

Check for new library versions when opening a project

When opening a project with libraries, an automatic check for new available versions is
executed. If a new version is found, the library and the corresponding file are listed in the
following dialogue:

When updating the selected libraries, opened libraries are closed and for changed libraries
you will be asked to save.
Updated libraries are removed from this list.
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4.7 Working with Projects

How to Create a New Project

� Select New in the Project menu. The dialogue box Select PLC Type is displayed.

� Select the CPU for which you are programming from the list box.

� Confirm your selection with OK.

The dialogue box New Project is displayed.

	 Select a directory for your project or type in the path in the Project Path field. If you
wish, you can also enter a directory that does not yet exist; GX IEC Developer will then
create it for you automatically.


 Enter the name of the project at the end of the project path.

� Click on the Create button.

The program displays the Wizard dialogue box.

� Select the required project option and confirm with OK.

The program will then create the project database on the disk.

NOTE In case of creating a new project for a FX CPU a warning comes up, that warns you of
existing limitations concerning the Online Program Change function for the FX series (�
8.7.3). So you should avoid making changes in the program that cannot be carried out by
online program change, if you want to use this function later on.
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The project creation process is documented in an information box (loading the programming
instructions from the libraries, opening the project).

When it generates a new project GX IEC Developer doesn’t create a single file but a subdi-
rectory with the project name. This subdirectory contains all the files that make up the project.
The two libraries – the Standard Library and the Manufacturer Library – are always loaded with
every new project that is created. When you begin, they are displayed in the Project Navigator
window with the various pools, which are still ‘empty’.

The Wizard

The Wizard is a special tool. When the new project has been generated the following dialogue
appears.

NOTE The project wizard will not show up when creating a Q Remote I/O project, because the
project does not have any program.

Select the desired startup option for your project:

Ladder Diagram: Creates a simple project consisting of one task and optionally a Sub task.
Each task contains one Ladder Diagram POU (Program Organisation Unit).

MELSEC IL: Creates a simple project consisting of one task and optionally a Sub task. Each
task contains one MELSEC IL (MELSEC Instruction List) POU. You enter the MELSEC mode.
Only the programming language MELSEC IL is available in the project. IEC POUs can not be
added.

Project Structure: Starts the interactive Project Structure Builder Assistant. You are guided
through several steps, creating tasks and POUs depending on your selections,

Empty Project: Does not use any assistance.Creates an empty project containing no tasks or
POUs.

NOTE If you do not wish to use the Wizard’s support you can deactivate it by editing the Wizard
setting in the MMP703.INI file (� Chapter 2).
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How to open an existing project

� Select Open in the Project menu, or click on the corresponding tool in the Toolbar.

Tool for opening an existing project

The Open Project dialogue box is displayed.

� Select the drive, the directory and the project name.

� Click on the Open button.

NOTE Please note that you can only open and edit one project, in one Project Navigator window.
But you can start GX IEC Developer several times to open and edit more than one project at
a time.

How to recover a project

GX IEC Developer has a facility for recovering projects that were not closed properly because
of a power failure or some other problem.These projects are identified by a ”cracked” directory
path symbol in the Open Project dialogue box.

� Click on the ”cracked” directory symbol.

A dialogue box is displayed with three options: Recover, Use Backup and Cancel

Recover: This option restores all the project’s data so that nothing is lost. The system
restores the exact editing status of the project at the point the unplanned termination
happened.

Use Backup: Loads the status of the project as it was the last time you loaded it for
editing. All changes made between then and the unplanned termination are lost. An
additional backup copy of the project is generated and stored in the file *.SAV.

Cancel: Cancels the procedure and closes the dialogue box.

� Click on the appropriate button.
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Fig. 4-9:
Projects are easy to identify in the directory list – their path symbols
are displayed in yellow.
If the project was not stored properly because of a power failure or
because it was not closed correctly a ‘cracked’ yellow path symbol is
displayed next to the project name. Usually, such projects can be
restored.



NOTES When you create a new project the files *.PRO and *.BAK are created automatically. All
editing changes and entries you make are stored in the PRO file.

When you open an existing project that was closed correctly GX IEC Developer loads *.PRO
and creates *.BAK. Here too, all the entries and editing changes you make are stored in the
PRO file. The BAK file stores the status of the project at the point it was loaded.

As you can imagine, when you select Recover, the system loads the PRO file in which all the
editing changes up to the termination point are stored.

By the same token, selecting Use Backup loads the BAK file. This means that if you first
created the project in the editing session in which the termination occurred the BAK file will
be empty!!! If you loaded an existing project in the last editing session the BAK file contains
the status of the project from the point when you began the editing session. Whenever a
*.BAK file is loaded an automatic additional backup copy of the project is generated and
stored in the file *.SAV.

How to open the SAV file

� Open the File Manager.

� Create a new directory.

� Copy the SAV file into this new directory.

	 Rename the file *.SAV into *.PRO.


 Open this PRO file in GX IEC Developer.

How to close a project

� Select Close in the Project menu.
Or:
Close the Project Navigator window with the Close command in its control menu (key
combination ��), or by double-clicking on the control menu button.

A prompt will be displayed asking you if you wish to save the project. If object windows (e.g.
headers or bodies) with unsaved editing changes are open a separate prompt will be displayed
for each window.

How to Save a Project

� Saving your project with the current name: Select Save in the Project menu, or click on
the corresponding tool in the Toolbar.

Tool for saving the current project

Saving under a new project name: Select Save As in the Project menu. Select the
desired subdirectory and assign a new project name.

When you save the project the backup file is updated automatically.
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How to delete a project

� In the Project menu open the Other submenu and select Delete.

The Delete Project dialogue box is displayed.

� Select the drive, directory and project name.

GX IEC Developer projects are identified by a yellow path symbol next to the directory name.

� Click on the Delete button.

NOTE You cannot delete a project while it is open!

How to rename a project

� In the Project menu open the Other submenu and select Rename.

The Rename Project dialogue box is displayed.

� Select the drive, directory and project name.

GX IEC Developer projects are identified by a yellow path symbol next to the directory name.

� Enter the new project name in the New Project Name field.

The project name can have a maximum of 8 characters. You can also enter the name of a
directory that does not yet exist, and GX IEC Developer will create it for you automatically.

	 Click on the Rename button.

NOTE You cannot rename a project while it is open.

How to copy a project

� In the Project menu open the Other submenu and select Copy.

The Copy Project dialogue box is displayed, with two list boxes.

� Select the drive, directory and name of the project to be copied in the left list box.

GX IEC Developer projects are identified by a yellow path symbol next to the directory name.

� Creating a copy with the same name: Simply select the target drive and directory in the
list box on the right. Creating a copy with a new name: Select the target drive and
directory in the right hand list box, and then enter a new name at the end of the path. The
new project name can have a maximum of 8 characters. You can also enter the name of
a directory that does not yet exist; GX IEC Developer will then create it for you
automatically. Overwriting an existing project with a copy: Select an existing project in the
right hand list box.

	 Click on the Copy button.

NOTE You cannot copy or overwrite a project while it is open. Please also have a look at the functions
provided by the Import and Export commands in the Project - Other menu (� Chapter 8).
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How to back up a project

The command Extras - Backup Project packs the project files and stores them to a medium
on the selected drive. External data media such as floppy disks are supported. If the resulting
project file is larger than the capacity of the disks it is automatically split across the necessary
number of disks.

� Select Backup Project in the Extras menu. The following dialogue box is displayed.

� Select the format for the backup operation:

Packed project database: File format *.PCD: The complete database (already
compiled) and the libraries will be packed.

Packed export format: File format: *.PCE: The project data (without compilation,
without libraries) will be exported and packed. When restoring a PCE file you have to
compile the project again.

� Select the target drive and directory, then enter a name for the target file.

	 Click on the OK button to pack the project and copy it to the selected drive.


 If the target drive is a floppy disk drive you will be prompted to insert the first disk. If the
packed file is too large to fit on the disk it will be automatically split across the necessary
number of disks. You will be prompted to change disks when necessary.

NOTES The Backup Project command can only be executed for the project currently opened.

With the Export function in the Project - Other menu the project data are exported into an
ASCII file only, without being compiled or split across the necessary number of disks.
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Fig. 4-10:
Project backup dialogue



How to restore a project

The command Extras - Restore Project is used to restore a backed up project from a packed
file. After being unpacked the project is automatically opened.

� In the Extras menu select Project Restore.
The following dialogue box is displayed.

� In the upper line select the PCD or PCE file which you wish to unpack and open.

� In the lower line select the target drive and directory and enter a name for the target
project.

	 Click on the OK button to unpack and open the project.

NOTE The name for the target project is not a file, but a directory.

How to reorganize a project database

The command Tools - Reorganize Database... is used to reorganize a project database.This
function fixes possible defragmentation problems in GX IEC Developer 32-bit *.pro project
files and repairs damaged database records. The menu item is available only if no project is
opened.

� Select Tools - Reorganize Database....
A standard file open dialogue is displayed.

� Select the desired *.pro file to be reorganized and click on the Open button.
The project file is reorganized while the progress status is indicated.
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Fig. 4-11:
Restore project dialogue



4.8 Working with Objects

How to open objects

� Double-click on the object in the Project Navigator window.
Or:
Select the object in the Navigator and then click on Open in the Object menu.

The window or dialogue box of the selected object will then be opened.

NOTE There are two possible responses when you double-click on a POU name, depending on the
settings in the MMP703.INI file and in the menu Extras - Options - Zoom Header/Body -
Navigator Zoom (� Chapter 2).
- Show/hide header and body in the Project Navigator window
- Open Header and body

How to close objects

� Close the object window.

� Before the operation is executed a prompt will be displayed asking you if you wish to
save any editing changes. Click on Yes if you wish to save the changes.

NOTE The various different ways of closing windows are explained in chapter 3.

How to create new objects

� In the Toolbar, select the tool for the object you wish to create.
Or:
Select New in the Object menu, then select the desired object type from the pop-up list
displayed (POU, DUT, Task or Action).

� Make the necessary entries in the dialogue box. Enter the name of the object. In the
case of program organisation units you must also specify the POU’s class (Program,
Function Block or Function) and the programming language. In the case of actions you
must select the programming language.

The newly-created object is displayed in the Project Navigator window. You can now open the
object to edit it, if necessary.

How to save objects

� Select the window of the object you wish to save.

� Select Save in the Object menu.
Or:
Press the following key combination:
Save �&
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How to rename objects

� Select the object to be renamed in the Project Navigator window.

� Select Rename in the Object menu.

� Enter the new name in the dialogue box.

The new name of the object will then be displayed in the Project Navigator window.

NOTE You can only rename closed objects.

How to cut, copy or delete objects

� In the Project Navigator window, select the object that you wish to cut, copy or delete.

� Select the appropriate command in the Edit menu.
Or:
Press the corresponding key combination:
Cut ��

Copy ��

Delete �

NOTE The Cut operation deletes the data from its original position and stores it in the clipboard.
The Copy operation copies the data to the clipboard without changing it in its original
location.
The Delete operation deletes the data from its present location without copying it to the
clipboard. This means that any data that was in the clipboard prior to the delete operation
remains unchanged.
Objects can only be deleted if the corresponding object windows are closed (e.g. header
and body in the case of POUs)

How to paste objects

� Activate the Project Navigator window.

� Select Paste in the Edit menu.
Or:
Press the following key combination:
Paste ��

NOTE Please note that the system does not prompt you for a new name before inserting the data.
Objects in the clipboard are inserted in the new location with their original names. You must
then rename the new objects manually with Edit - Rename, and it may also be necessary to
perform editing to eliminate double variable declarations (in the case of POUs).
The Copy and Paste functions can also be used to copy and paste objects between
projects, not just within the current project.

4 – 20 MITSUBISHI ELECTRIC

Working with Objects Projects and Objects



How to copy objects from the current project to another project

� Select the object or objects to be copied in the Project Navigator window.

� Select Copy in the Edit menu.
Or:
Press the following key combination:
Copy ��

A copy of the data is now in the clipboard.

� Close the current project, then open the project into which you wish to copy the objects.

	 Activate the Project Navigator window.


 Select Paste in the Edit menu.
Or:
Press the following key combination:
Paste ��

The data from the clipboard are inserted in the Project Navigator window.

NOTE You can also exchange objects between projects with the Import and Export functions
(Project - Other - Export/Import).

How to enter comments

� In the Project Navigator window, select the object for which you wish to enter a
comment.
Or:
Activate the object window.

� Select Comment in the Object menu.

� Type your comment text in the left field.

How to copy, cut and paste comments

� Select the text to copy or cut.

You can use the standard Windows mouse operations and key combinations for selecting
text.

� Click on the Cut, Copy or Paste button.

NOTE You can also use the standard Windows key combinations for these operations:
Cut �'

Copy ��

Paste �(
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How to view the object information

� In the Project Navigator window, select the object whose information you wish to view.
Or:
Activate the corresponding object window.

� Select Information in the Object menu.
Or:
Press the key combination ��.

A dialogue box is opened showing attributes of the selected object.

General Options

Additional Options for Body Objects

E
WARNING:
The system will allow you to change the programming language of a POU, but if you do
this you will lose all the codes in the body! A message will be displayed.
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Fig. 4-12:
Name: Name of the selected object
Size: Size of the selected object in bytes
Type: Type of the selected object
Last Change:
Data and time of the last editing change
Security Level: Current security level
Read Access:
Read access for lower security levels
Comment: Comment text

Fig. 4-13:
Language: Programming language



Additional Options for Functions

Additional options for Function Blocks
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Fig. 4-14:
Result Type: Result data type
(displayed when you change the
program class)
Use with EN/ENO: If you change the
program class to Function this field
allows you to specify whether the
function is to have a Boolean input and
output.
Type: Program class
Language: Programming language
used in the body

Fig. 4-15:
Macrocode: Macrocode execution of
the function block (� page 6-61)
MC-MCR: MC-MCR execution of the
function block (� page 6-61)
Use with EN/ENO: If you change the
program class to FB (Function Block)
this field allows you to specify whether
the function block is to have a Boolean
input and output.
Type: Program class
Language: Programming language
used in the body



Additional Options for Task Objects

NOTE Task attributes can only be set in this dialogue box.

How to display an object’s Call Tree (subordinate objects)

� Select the object whose Call Tree you wish to display.

� In the Object menu, select Show and then select Call Tree from the submenu
displayed.

An information box is opened showing all the objects used in the selected object.

� Task Call Tree: All associated POUs and all the global variables used in the POUs

� POU, Body and Header Call Trees: All function block instances and all global variables

How to display an object’s Reference List (superordinate objects)

� Select the object whose Reference List you wish to display.

� In the Object menu, select Show and then select Reference List from the submenu
displayed.

An information box is opened showing all the objects in which the selected object is used.

� Function Block Reference List: The headers in which the instances of the function block
were generated

� POU Reference List: The associated task
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Fig. 4-16:
Event: Event-triggered

Interval: Interval-triggered

Priority: Priority level of the task

Timer/Output Control: MC-MCR
execution of the task (� page 6-2 )



4.9 Protecting Your Data

4.9.1 Project security

GX IEC Developer has a eight-level data security system.You can assign a different password
to each level, and you can assign security levels to both the entire project and each individual
object within the project.The security level assigned to any object will be inherited to all its child
objects provided their security level is not higher.

For example, if you assign a security level of 5 to the project you can edit all objects with
security levels 0 through five. Objects with security levels 6 and 7 are not editable, but you can
view their contents. The names of protected objects are displayed in grey in the Project
Navigator window.POUs that are both read and write protected also do not allow you to branch
into their headers and bodies in the Project Navigator window.

How to assign security level passwords

� Select Change Passwords in the Project menu.

� Select the security level to which you wish to assign a password.

� Enter the current password in the Old Password field. If you have not yet entered a
password for this level, simply leave this field empty.

	 Enter the new password in the New Password field.


 Confirm your entry by re-entering the same new password in the Re-enter Password
field.

� Click on the Change button to enter the password.

A message will be displayed telling you whether the system has accepted the old and new
passwords.

How to change the project’s security level

� Select Change Security Level in the Project menu.

� Select the desired security level.

� Enter the valid password for this security level in the Password field.

An error message will be displayed if you enter the password incorrectly.
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Fig. 4-17:
As an additional security measure asterisks are
displayed on the screen instead of the characters
you enter.



How to assign read and write protection to objects

� Select the object to be protected in the Project Navigator window.

� Select Information in the Object menu.
Or:
Press the key combination ��.

� Click on the desired security level.

	 Write protection: Click on a security level higher than the current level in order to
protect the object against unauthorised editing.


 Read protection: Deactivate the Allow Read Access For Lower Levels check box to
prevent read access to the object.

NOTE If the project has security level 5 and the object has already been assigned security level 6 you
cannot change the security level of the object in this dialogue box. Security levels that cannot
be selected are displayed in light grey. To change the security level of such objects you must
first change the level of the project; for instance, in this example, you would have to change the
project security level to 6. This is only possible if you know the password of this security level,
of course. Action: Check and enter PLC keyword for access to the PLC CPU.

4 – 26 MITSUBISHI ELECTRIC

Protecting Your Data Projects and Objects

Fig. 4-18:
The Object Information dialogue box is
displayed.



How to protect the PLC program

Access to the PLC CPU can be restricted by entering a PLC keyword to prevent unauthorised
persons from transferring programs from the CPU.

The user is prompted to enter the password once before every Online operation. The
password is also checked internally before execution of every subsequent Online operation.

NOTE In case of QnPRH PLCs in Backup mode the user is asked if he wants to set or delete the
keyword for both PLCs. You will be asked to enter the keyword for the Control system first.
GX IEC Developer will attempt to use the same keyword for the Standby system as well.
If it fails, you will be asked to enter the keyword for the Standby system as well.
If different keywords are used for the control and the standby system, both keywords will be
stored and automatically used for any further operations.

� In the Online menu select the PLC keyword command, then select Current, New or
Delete.

� Enter the appropriate PLC keywords in the corresponding fields. You can move from
field to field with the [TAB] key. For security, all the characters you enter are displayed
as asterisks on the screen.

1st and 2nd keyword/Protection level (only FX3U)

If the PLC is protected with two keywords, it is possible to modify the protection level
without changing the keywords. If both of the old keywords are entered correctly, and
neither new keyword is specified, the protection level will be changed to the selected
setting, and the keywords will be kept.

The Protection level selection group will be enabled only if both new keywords are
specified or both old keywords are specified and neither or both new keywords are
specified.
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Fig. 4-19:
Entering a new PLC keyword

Fig. 4-20:
Entering a new PLC
keyword for a FX3U PLC



Old keyword: Enter the old keyword (8 characters from range 0 to 9 and A to F).

New keyword: Enter the new keyword (8 characters from range 0 to 9 and A to F).

Verify: Enter the new keyword once again(8 characters from range 0 to 9 and A to F).

� Confirm your entries with OK.

Meaning of the different commands under the submenu PLC keyword

Current: Enter current PLC keyword for access to the Online functions.

New: If an old PLC keyword has already been entered you must first enter it for confirmation.
Then enter the new PLC keyword in the next field, after which you must enter it again for confir-
mation in the last field.

Delete: Delete the current PLC keyword for the PLC CPU.

Disable Protection (only FX3U): You will be offered to specify the first or both keywords in the
PLC Keyword dialogue.

If only the first keyword is specified, the validity of the keyword will not be verified directly. It will
be checked when the first attempt is made to access protected data. In that case, if the
currently specified keyword is wrong, it will be asked again.

If both keywords are specified, the validity of the keywords will be verified directly. In case the
keywords are incorrect, they will be asked again. In case the keywords are correct, the protec-
tion of the PLC will be immediately disabled. A warning will be given that the protection will be
enabled again only when it is explicitly enabled or the PLC is reset.

Enable Protection (only FX3U): By calling this menu command the disabled keyword protec-
tion can be re-enabled. The following success message will be displayed after performing the
operation.
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Fig. 4-21:
Entering one or both PLC
keywords for a FX3U PLC

Fig. 4-22:
Enabling Protection



When the project is about to be closed, and all of the following conditions are met, you will be
warned that the PLC is likely to be in an unprotected state, and you will be offered to re-protect
the PLC:

� the PLC is protected with two keywords

� keyword protection was disabled at least once while the project was open

� keyword protection was not re-enabled after the last disablement by:

– calling the menu item Online PLC Keyword Enable Protection

– registering new keywords

4.9.2 Protected Symbolic Information

The symbolic project information of a project for the A/QnA/Q series cannot be protected by
the PLC keyword. Using the function of password protection for symbolic information enables
the user to prevent access to these data by unauthorized users.

NOTES The use of password protection for symbolic data increases the time to download/upload of
the symbolic information by 30–35 % on an average configuration.

Symbolic information download to a FX PLC is not supported by GX IEC Developer.

When downloading symbolic information to the PLC, the user is asked to enter a password that
will be required later to upload the symbolic information from the PLC again. This password
may be the same as the PLC keyword, but there is no correspondence between those two
passwords. Changing the PLC keyword does not effect the symbolic information password,
and vice versa.
The set password even is not related to the project (it is not stored in the project file), it is only
related to the symbolic information on the PLC.

NOTE Only the read access is password protected. Symbolic information can still be deleted or
overwritten on the PLC without a password, since the PLC keyword does not protect those
actions. This protection can only be achieved by hardware protection. Of course the
symbolic information files can be read from the PLC as well, but they have no meaning to a
user not knowing the password and the encryption algorithm.

Symbolic information can be downloaded by the following functionalities:

� Download project (� section 8.6.8)

� Online change (� section 8.7.3)

� Download symbolic information to PLC (� section 8.6.2)
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Fig. 4-23: Warning that the PLC is likely to be in an unprotected state



When using any of the three functionalities, the user is asked to enter a password.

Password: Entry of the new password.

Re-type password: Repeat entry of the new password.

Use this password while this project is open: Select this option to activate the entered
password for the time the project is opened.

The user may choose to use the entered password during the project is open, i.e. the password
will not be asked for every download until another project is opened.
This remembrance possibility suppresses the password dialogue for every download or online
change, so users that download changes to their projects frequently will not have to enter the
password every time during one session.
When uploading symbolic information, the password is always asked for.

It is still possible to download symbolic information without protection. If the user does not
enter a password, a warning will be displayed to confirm that the user really does not want to
protect the symbolic data.

There is the option to disable this warning for the rest of the GX IEC Developer session. In that
case an empty password will be accepted without requestion.

When uploading protected symbolic information from the PLC, the password has to be entered
by the user.
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Fig. 4-24:
Symbolic Information Password

Fig. 4-25:
Warning

Fig. 4-26:
Dialogbox to query the required password



If the correct password is entered, the symbolic information will be uploaded. Otherwise
symbolic upload cannot be executed and binary upload will be offered instead.
If the PLC’s program is protected by keyword (PLC keyword) and this keyword has not been
input since the project was opened, the user will be prompted to enter the PLC keyword
(standard operation for binary upload) (� page 4-27).

NOTE The protection of the symbolic information files results in changed file formats, which older
GX IEC Developer versions cannot handle. The file format of unprotected symbolic
information is the same as in older versions.

The following message will be displayed in an older GX IEC Developer version if attempting to
upload protected symbolic information:

Improved Import/Export security

In case a project contains protected POUs and the user wants to make a symbolic download of
the project, the following mechanisms are applied.

The dialogue contains two edit fields for entering the passwords, and the two entered pass-
words have to match to be accepted. Otherwise the user is asked to enter them again.

Normally, when exporting project elements to a file or the clipboard, the objects with a higher
security level than the actual state are not included in the export stream and no warning will be
given to the user.This behaviour does not break security, but it may lead to misunderstandings.
But symbolic information download (which is based on export) would export every needed
object, including the ones the user has no access to. This behaviour clearly would break
security. A person not having access to some objects could download symbolic project infor-
mation to a PLC, and then upload it to a new project, making the formerly protected objects
accessible.

For this reason file and clipboard export are working as follows:

� If the actual security level is lower than the needed security level to export every object, a
warning will be displayed to inform the user about this issue. The user will be asked if he
wants to change the security level.
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Fig. 4-27:
System Message

Fig. 4-28: Security level warning



� When the user chooses Yes, the following dialogue will be shown to change the security
level.

� If the user chooses No in the message box shown in Fig.4-28, the inaccessible objects will
not be exported.

� Choosing Cancel in in the message box shown in Fig. 4-28, the process using the export
functionality will be cancelled.

If the user decides to change the security level, but then cancels the Change Security Level
dialogue or sets a security level still not high enough to export every object, the message box
shown in Fig. 4- will be displayed again, until the needed security level is set or No is chosen in
this message box.

NOTE Drag & drop will not display the question message box, because it is a “silent” operation.
Showing a message box after starting to drag would interrupt the drag & drop process and
the drop could not be executed. Export in this case is based on the actual security level.
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Fig. 4-29:
Change Security Level



4.10 Printing Out Project Data

How to configure the printer

� Select Printer Setup in the Project menu. This opens the Windows Print Setup
dialogue box showing the current default printer and its parameters. The changes and
settings you can make in this dialogue box depend on the printer connected to your
computer.

NOTE For full details, consult the Windows User’s Guide and your printer manual.

How to print an object

� Select any object in the Project Navigator or open the window of the object to be
printed.

� Select Print Preview in the Object menu to open the print preview display. The display
gives you quite a precise preview of what the printout will look like. If the printout
includes more than one page, you can navigate through the pages via the Page
buttons. You can Zoom In (increase) or Zoom Out (decrease) the view size via the
Zoom buttons. You can cancel printing by clicking the Close button.

� Click the Print button.
Or:
Press the key combination�).

The Print dialogue box is displayed.

	 Select the appropriate print options.

Selecting the Setup button opens the Print Setup dialogue box, in which you can set
the parameters of the default printer or select another printer.


 Start the printout with the OK button.

If you do not need to preview the printout, you can directly print any selected or opened object.
In the Object menu select Print.

How to print project data

� Select Print Preview in the Project menu to open the print preview display. The display
gives you quite a precise preview of what the printout will look like. If the printout
includes more than one page, you can navigate through the pages via the Page
buttons. You can Zoom In (increase) or Zoom Out (decrease) the view size via the
Zoom buttons. You can cancel printing by clicking the Close button.

� Click the Print button.
Or:
Press the key combination �).

The Print dialogue box is displayed.

� Select the appropriate print options.

Selecting the Setup button opens the Print Setup dialogue box, in which you can set
the parameters of the default printer or select another printer.

	 Start the printout with the OK button.

If you do not need to preview the printout, you can directly print any selected or opened object.
In the Project menu select Print.
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4.10.1 Print options for project data

The content and layout of the project data printout can be customised extensively. Different
print options settings can be saved as profiles. In the Project menu select Print Options to
open the Print Options dialogue.

Dialogue items

Object: Select whether only the current Project Tree or the currently Selected Items
according to the current profile are printed.

Current Profile: Type or select (from the combo box) the name of the profile that you want to
load, save, set as default, or delete.

Loaded Profile: Displays the currently loaded profile. If this field remains blank, the loaded
profile was changed and not yet saved.

Default Profile: Displays the default profile for every printout. The default profile can be
specified via the Set Default button.

Watch: Indicates whether any property setting of the loaded profile was changed, but the
current profile is not saved. In this case the Loaded Profile field remains blank.

Save: If any property setting of the loaded profile was changed, this button becomes active.
Click the Save button to save the current profile under the name entered in the Current Profile
box.

Delete: Deletes the profile entered in the Current Profile box. If the currently entered profile
does not exist, an error message is returned.

Set Default: Sets the profile entered in the Current Profile box to the default profile. If the
currently entered profile does not exist, an error message is returned.

Load: Loads the profile entered in the Current Profile box. The loaded profile is indicated in
the Loaded Profile box.

Properties...: Opens the Document Configuration dialogue where you can change the
property settings of the loaded profile (for details see below). If any property setting of the loaded
profile was changed, this button becomes active and the Loaded Profile box is cleared.

List...: Opens the Checked Properties List where the specified property settings are
summarized in a list.

Document Configuration

In the Document Configuration dialogue all property settings of the loaded profile for the
project data printout can be specified.
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Fig. 4-30:
Print Options



How to open the Document Configuration dialogue:

� In the Project menu select Print Options.... to open the Print Options dialogue.

� In the Print Options dialogue click on the Properties... button.

The Document Configuration dialogue opens:

The Document Configuration dialogue includes the following property sheet tabs:

Scope

Selects the object class to be documented. This configured scope is related primarily with the
selected objects in the main view.

The following objects can be selected for the printout:

� Cover Page

� Table of Contents

� Project Tree

� Cross Reference

POUs (FBD, IL/MELSEC IL, LD, SFC, ST): If FBD, IL, SFC and/or LD are checked, only the
selected objects of this type will be documented.

The scope defined by each selection may be restricted through the detailed configuration of
the items. The items may be configured via the other tabs.

Global Variable List: Check the option Print Global Variable List to print the Global Variable
List.

When you choose the option Print Global Variable List for printing or previewing of Array of
DUT variables, only basic informations about the addresses of the array members are shown:

� WORD start address – address of first array element’s first non-Boolean member

� WORD offset – address difference between two array elements’ WORD start addresses

� Bit designation – whether to store Boolean members mapped onto non-Boolean devices

� BIT start address – address of first array element’s first Boolean member

� BIT offset – address difference between two array elements’ BIT start addresses
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Fig. 4-31:
Document Configuration for printouts



Additionally checking the print option Expand array of DUT addresses provides the possi-
bility to print the addresses of every member of an Array of DUT variable.
By default the option is turned off, because the listing of all the addresses will make the list very
long.

Cross Reference

The following objects can be selected for the printout:

� Call Tree

� Global Variables
The following selections are possible if Global Variables is selected:
a) Used Read/Write variables (the cross reference for used read/write variables can be
documented either for variable names or all addresses or a user-specified address range).
b) External declarations

General/Project Tree

The following options can be selected for the printout:

� General: Zoom condensed or normal

� Project Tree: Actual State or Expanded

� LD and FBD: Not separated input/output pin directly connected.
If activated: After the calculation of the layout in FBD and LD an additional calculation will
determine all functions and function blocks which have formal input or output pins (only
input or output elements directly connected). This option avoids a page break within the
function and ensures that the input or output will print the function and function block with
their input or output elements on the next page.

Frame Logos

You can specify several bitmap graphics files (*.bmp) and a title for the printout appearing on
every page in the header and footer:

� Header: Logo Left, Logo Right, Title
Enter or browse for a bitmap graphics file to be printed.

� Footer: Logo Bottom
Enter or browse for a bitmap graphics file to be printed.

Cover Page

You can specify several text entries and a logo (*.bmp) for the printout appearing on the cover
page:

� Logo: Enter or browse for a bitmap graphics file (*.bmp) to be printed.

� Project, Comment, Prj. Number, Prj. Manager, PLC Type: Enter text for the respective entry
fields.

4 – 36 MITSUBISHI ELECTRIC

Printing Out Project Data Projects and Objects



Left Footer

The following fields can be edited directly for the printout:

� Rev, Change, Date, Name

� Date, Drawn, Appr., Rel.

The captions for the entry fields can be edited by clicking on the respective caption button.

Right Footer

Enter any information into the blank entry fields.

POUs

The following options can be selected for the printout:

� Header
If selected, the POU header for each selected POU will be printed.

� Local Cross Reference
If selected the local reference for each selected POU will be printed.

� Body
If selected, the following objects can be selected from the section Networks: Network
Cross Reference, Network Variable Lists, Cross ref./var. list after network

� Either Multiple object on a page or Each object on a page

� Use local variables in Cross Reference

� Show header occurrences in Cross Reference

Page Numbers

The following options can be selected for the printout:

� Show page number in cross reference
(Variable page reference)

� Show page number in split reference

SFC

The following objects can be selected for the printout:

� Main Network

� Macros

� Steps

� Transitions

� Actions

� Table of Content

� More steps/actions/transitions on one sheet
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4.11 Cross Reference

The Cross Reference function generates a database listing of all the project variables.
Relationships become clearer, it is easier to find certain variables, and unused variables can
be identified.

Default settings in the MMP703.INI initialisation file

[CrossReference]

GenerateSCT=TRUE

TRUE: cross reference function enabled.
FALSE: cross reference function disabled.

Cross reference options

In the Extras - Options - Cross Reference menu you can set the cross reference options.

Generate *.SCT files while checking a project: Activates generation of the SCT files during
project checks

Automatically link the *.SCT files to the *.SCX file after ‘Rebuild All’: Activates automatic
linking of the SCT files to the SCX file after compiling the project

Automatically link the *.SCT files to the .SCX file after ‘Build’: Activates automatic linking
of the SCT files to the SCX file after building the project

To create a cross reference database

� Compile the entire project.

� In the Project menu choose the command Make Cross Reference.

The program now compiles all the details required for the cross reference database.
The procedure is documented in the status window Cross Reference Linker. The time
needed for this procedure depends on the project length.

4 – 38 MITSUBISHI ELECTRIC

Cross Reference Projects and Objects

Fig. 4-32:
Options -
Cross Reference



� Choose Browse in the Project menu.

The Browser dialogue box is presented, prompting you to enter the search criteria.

Query

Set the search criteria:

Variable / Address: Contains <ALL> if searching for all or input an identifier

Search for: The search for the identifier is for variables and addresses, or only for variables
and only for addresses.

Name Space: Object name; e.g. Program Organisation Unit, Global Variable List

Data Type: e.g. BOOL, INT

Scope: Class; e.g. VAR, VAR_GLOBAL

Button: Search: Starts the search. The result of the search is presented in the windows.

hits: Number of matches found
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Fig. 4-33:
Creating the cross reference database



Search result in window

All records that have been found are listed alphabetically.

Declares/References

Depending on the element that is marked in the left-hand window after a search, further details
are listed in the right-hand window and in the Variable Info List. You can set further search
filters for these details.

Filters

Namespace: Object name

Access: Tells you how the variable is accessed in the projects

Search result in window

Declaration: Program organisation units in which the variable was declared

References: Program organisation units in which the variable was inserted

Search result in the Variable Info List

Name: Name of variable

Type: Data type

Scope: Class; e.g. VAR, VAR_GLOBAL

Access: Access type; e.g. Read, Write, Read and Write

Editor: Programming language, network number in editor

NOTES The browser functionality regarding search of variables is performed by their hardware
address in Mitsubishi format and their address ranges. The search for a hardware address
finds all variables that share the searched address.

In the case of an array element with non static index, i.e. the index part contains one or more
indices that do not represent a number, the whole array range is used for the address
search.

DUT or ARRAY of DUT can only be searched for the start address.

Functions that have address ranges passed by start address and block size like in BMOV,
FMOV, FROM, TO, or BXCH can only be searched for the start address.

4 – 40 MITSUBISHI ELECTRIC

Cross Reference Projects and Objects



4.12 Double Coil Check

The tool can be used to find potential problems in the project, as it looks for duplicate outputs to
the same bit device or bit of a word device.

NOTE This function is not available for Remote I/O projects.

This function scans the generated code of a program. The following instructions and devices
will be detected as a duplicate coil usage.

 : Applicable !: Not applicable

When you call the menu command Extras Double Coil Check, it is checked if the project is
compiled and the generated code is up to date.

A message will be displayed if the check cannot be performed because the code is not up to
date. The check then is not performed.
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OUT(H) SET,
RST SFT(P) PLS,

PLF MC

Y, M, L, B, F      

T, C  ! ! ! !

Tab. 4-1: With the A series

OUT(H) SET,
RST SFT(P) PLS,

PLF
EGP,
EGF MC FF DELTA(P)

X, Y, M, L, B, F,
SM, DY, SB,
Jn/X, Jn/Y,
Jn/B, Jn/SB

    !   !

DY     !    

D, SD, W,
SW, R, ZR,

Jn/W, Jn/SW,
Un/G

    !   !

T, ST, C  ! ! ! ! ! ! !

V ! ! ! !  ! ! !

Tab. 4-2: With the Q/QnA series

OUT SET,
RST

PLS,
PLF MC

Y, M     

D
(FX3U(C) only)   ! !

S   ! !

T, C  ! ! !

Tab. 4-3: With the FX series



If the check can be performed, the project is scanned for duplicate coils.
If no duplicate coils exist in the code, the following message is displayed:

If duplicate coils are found in the project, a modeless dialog will be opened to display the
results.

Initially the items in the list are ordered by the name of the device.
Items corresponding to the same device will be sub-ordered by their occurrence in the gener-
ated code:

� first the MAIN program

� then the SUB program and the SFC program

– and within those in ascending step number order

Duplicate coils

Device: Column to display the device that is written

Program: Column to display the program where the device is written

Step: Column to display the position where the device is written

Source: Column to display the name of POU, action or transition where the device writing orig-
inates from

Call tree: Column to display the call tree of the POU where the device writing originates from

4 – 42 MITSUBISHI ELECTRIC

Double Coil Check Projects and Objects

Fig. 4-35:
Dialogue box, when no
duplicate coils exist

Fig. 4-36: Example of the dialogue window, when duplicate coils exist



Filter by instruction

Filter results by taking coils into account only when used with the selected instructions.
Check one or more checkboxes for activating the desired instructions.

The set of available check boxes varies with the PLC family.

NOTES The state of the OUT checkbox affects results for both the OUT and the OUTH instructions.

The state of the SFT checkbox affects results for both the SFT and the SFTP instructions.

The state of the DELTA checkbox affects results for both the DELTA and the DELTAP
instructions.

All: Check all checkboxes

None: Uncheck all checkboxes

Minimize dialog after Show: Minimizes the window when the Show button is clicked

Re-check: Re-executes the check. Since the dialogue is modeless, the project can be
changed after displaying the results. Using the button Re-check enables you to perform the
check again and update the results.

Show: Jumps to the location of the marked coil in the source

Close: Close the dialogue window

NOTES Other windows can be used, while the dialogue Double Coil Check is opened.

When selecting the menu command Extras Double Coil Check again, while the
dialogue Double Coil Check is already opened, the dialogue will be activated (shown in the
foreground).

If the dialogue is closed and opened again via the menu command Extras Double Coil
Check, it will be displayed in the same state as it was before being closed (i.e. the results of a
former check will be displayed). But if the project was closed or built, or the PLC type of the
project was changed while the dialogue was not open, a re-check will be automatically
performed.

The dialogue will be automatically closed if the project is closed or the PLC type of the
project is changed.
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Fig. 4-37: Available check boxes for the Q and QnA series

Fig. 4-38: Available check boxes for the A series

Fig. 4-39: Available check boxes for the FX series



4.12.1 Filtering the Results

Using the set of checkboxes below the result table, the results can be filtered by displaying the
occurrences of only those duplicate coils that are used with the specified instructions.
Since the filtering works on the results, there is no need to execute the check again. The result
table will be immediately refreshed when the filter settings are changed.

NOTE Initially all checkboxes are checked, but the changes made in the filter options will be
preserved after the dialogue is closed, even after GX IEC Developer is exited.

Example For example, in the following simple POU Y0, Y1 and Y2 are written more than once using
normal, set, and reset coils.The normal coil corresponds to the OUT instruction, while the set-
and reset coils correspond to the SET and RST instructions, respectively.
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Fig. 4-40:
Example for a simple POU



When executing Double Coil Check, and turning on all filter checkboxes, all duplicate coils
will be shown in the result table.

If the filter is reduced to only the OUT instruction, the result table will show only the coils that
write the same device using the OUT instruction.
In this case these are only the coils that write the Y0 device. Although Y2 is also written u sing
the OUT instruction, it will not be displayed in the results, because an OUT instruction is used
only once with Y2. The other two coils use SET and RST, which are filtered out in this case.

�
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Fig. 4-41: Double Coil Check result, if all checkboxes are set

Fig. 4-42: Double Coil Check result, if only the checkbox OUT is set



NOTE When the functionality is started or a re-check is performed, it can happen that although
there are duplicate coils in the project, none of them is visible in the result list, because they
are filtered out.
In such a situation you will be informed by the following message.

4.12.2 Sorting the Results

It will be possible to sort the results by clicking on any of the column headers. The following
table lists the sorting criteria used when clicking a header:
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Column Criteria

Device Sorted by device names in alphabetic order, and within that by program and occurrence order
(default)

Program
Sorted by program type (MAIN � SUB � SFC) and within that by occurrence order

Step

Source Sorted by object names in alphabetic order, and within that by occurrence order

Call tree Sorted by call tree strings in alphabetic order, and within that by occurrence order

Tab. 4-4: Sorting criteria of each column

Fig. 4-43: Dialogue box with warning message



4.12.3 Showing the Location of the Coil in the Source

The following methods are provided to show the location of the coil in the source code:

� Selecting a row and clicking the Show button

� Selecting a row and pressing the Enter key

� Double-clicking a row

The location of the coil can be displayed on the following detail level in the various body, action
and transition languages:
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Language Position

LD / FBD The body will be opened and the network will be marked.

IL / MELSEC IL The body will be opened and the line will be marked.

ST The body will be opened and the line will be marked.

SFC The body will be opened.

Tab. 4-5: Displaying the location of a coil

Fig. 4-44: Showing the location of the coil in the source code



NOTES Since the dialogue is modeless, it is possible to change the project after displaying the
results. In this case there is a chance that the original location of the coil is moved or deleted,
so jumping to that point in the source code will produce false results.
A confirmation message will be displayed when you want to see the location of the coil, but
the project was changed since the check.

In case of the SFC program in A-series projects no location information will be available.
The device name and program name will be displayed, but the fields Step, Source and Call
tree will include a dash (—) only, and the button Show will be grayed.

There are situations in which the location of the coil cannot be shown (e.g. because of
security settings or because the container body is in a closed library, etc.).
In this case the corresponding editor will display a message explaining the reason, and the
Double Coil Check dialogue will be kept active.
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4.13 Verifying Projects

By using the function of verifying projects you can verify an opened project with an other
project. This function is based on the functionality of Verify in the menu Project - Transfer
(see also section 8.7.2).

While the functionality of online verify compares the opened project to the one downloaded to
the PLC, the functionality of project verify will compare the currently opened project to another
project on the PC, selected by the user.

To verify two projects choose the menu Project, the sub menu Other and then Verify. In the
opened dialogue box select the desired project to be compared with the current project.

The following project elements will be verified:

� Boot settings (boot files) (if the PLC is of the Q/QnA series, except Q Remote I/O projects)

� PLC-Parameters

� Main program

� Sub program (if allowed for the PLC type)

� SFC program (if allowed for the PLC type)

� SFC program file header (if SFC is allowed for the PLC type, and it is of the Q/QnA series)

� Timer initial values of main and sub program (if the PLC is of the A series)

� Counter initial values of main and sub program (if the PLC is of the A series)

The opened project will not be closed (only its database file will be closed). Therefore you do
not have to save the project before starting the comparison.

The comparison is separated into two parts: the PLC-parameter and the program. Both
projects have to include parameters to start the parameter verification, otherwise the parame-
ters are incomparable.

NOTES The program comparison is not only based on the compiled code, so the two projects do not
have to be compiled to start the program verification. The projects will also be considered to
have been changed if unsaved changes exist in any open editors.The user will be warned, if
either project has been changed since last build.

The for comparison selected project may not be opened in the current or another GX IEC
Developer instance. Consequently a project cannot be compared to itself.

An improperly closed project cannot be compared to the opened project. It must be repaired
first by opening it in GX IEC Developer normally.

A project last saved with a newer version of GX IEC Developer cannot be compared to the
currently opened project.

A project last saved with a version of GX IEC Developer older than 4.00 cannot be compared
to the currently opened project. It must be converted first by opening it in GX IEC Developer
normally.

Parameters of a project last saved with a version of GX IEC Developer older than 6.00
cannot be compared to the current project’s parameters.The project must be converted first
by opening it in GX IEC Developer normally.

Only projects for the same CPU type can be compared.
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NOTE In case of a Q Remote I/O project, the verify function compares only parameters, because a
Q Remote I/O project does not have program data. If the comparison is successful (no error
happens), the possible results are:
� PLC-Parameter identical
� PLC-Parameter not identical
If the parameters cannot be compared due to an error, the error will be displayed in a
message box and the Verify Result Messages dialogue will not be shown.

After the chosen project is read, the comparison results will be displayed in the dialogue Verify
Result Messages shown below. This is the same dialogue as for online verify (see also
section 8.7.2).

The PLC parameters are compared in whole (having the incomparable blocks removed), so
there may be two cases: identical or not identical. The program will be compared part-by-part
(e.g.main program, SFC program, etc.), and for each not identical part a message is displayed
in the dialogue. If the comparison shows no difference in any of the program's elements, then
only the message "Program identical" is displayed.Additionally, there are messages indicating
if an element exists in either project but not in the other.

The following table lists the messages related to the various project elements. These
messages are the same as for online verify.
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Fig. 4-45:
Dialogue box

Element “Identical” message “Not identical” message

Boot file "Boot file identical" "Boot file not identical"

Parameter "PLC-Parameter identical" "PLC-Parameter not identical"

Main program

"Program identical"

"Main-Program not identical"

Sub program "Sub-Program not identical"

SFC program "SFC-Program not identical"

SFC program file header "SFC-Program file header not
identical"

Timer initial values (main program) "Timer-setting Values of
Main-Program not identical"

Timer initial values (sub program) "Timer-setting Values of
Sub-Program not identical"

Counter initial values
(main program)

"Counter-setting Values of
Main-Program not identical"

Counter initial values
(sub program)

"Counter-setting Values of
Sub-Program not identical"

Tab. 4-6: List of Messages related to the command Verify



The following table lists the messages displayed if an element is missing from either or both
projects. These messages are the same as for online verify.

Detected differences in the program code can be shown in a Main or Sub Program Differ-
ence window via the Show button. The verify results are listed as recompiled MELSEC IL, the
differences are highlighted in the error color.The left part of the window lists the current project
code, the right part of the window lists the selected project code.

When the Main or Sub Program Difference window is opened the following menu items are
available in the Tools menu:

Next Difference: Next Difference or the tabulator key will position the text in the window so
that the first line of the next difference is the top most line. The top most line will be selected.
The according calltree, number of network and for IL and ST the line in the network of the
selected line are shown in the status bar. If no next difference exists, the menu item is greyed.

Previous Difference:Previous Difference or the shift tabulator key will position the text in the
window so that the first line of the previous difference is the top most line. The top most line will
be selected. The according calltree, number of network and for IL and ST the line in the
network of the selected line are shown in the status bar. If no previous difference exists, the
menu item is greyed.
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Element Absence Message Remark

Boot file Missing from either
or both projects "Boot file incomparable"

If the selected project is older
than version 6.00 or the boot
file of either project was
deleted.

If an error happens at the
reading of one of the boot
files because the boot file is
corrupted.

If the parameter of one of the
projects is security protected.

Parameter Missing from chosen
project "PLC-Parameter incomparable"

It is impossible to open a
project without parameters,
so the parameters are never
missing in the currently open
project.

Main program Missing from either
or both projects "Program incomparable"

If there is no main program in
either or both projects a
comparison is not possible.

Sub program Missing from either
project

"Sub-Program exists in current, but
not in selected project" or
"Sub-Program exists in selected, but
not in current project"

If there is no sub program in
either of the projects a
comparison is not possible.

Sub program Missing from both
projects —

If there is no sub program in
both of the projects a
comparison will not be
performed.

SFC program Missing from either
project

"SFC-Program exists in current, but
not in selected project" or
"SFC-Program exists in selected, but
not in current project"

If there is no SFC program in
either of the projects a
comparison is not possible.

SFC program Missing from both
projects —

If there is no SFC program in
both of the projects a
comparison will not be
performed.

SFC program
file header Not covered —

A SFC program header
always exists in Q/QnA
projects if a SFC program
exists.

Timer/counter
initial values Not covered —

These initial values always
exist in projects for A series
CPUs.

Tab. 4-7: List of Messages displayed if an element is missing



Goto Editor: Goto Editor or a double click on a selected line will open the according POU
body. In IL/ST the according line and in LD/FBD the according network is positioned to the
visible area and marked with the browser colour in the network column.
If no POU body relates to the selected line a message window is opened to inform you of this
circumstance. The message text is “The selected line belongs to code generated for task or
program handling. No editor could be opened.”

Show Step Number: This menu item is checked as default. If it is checked, the step number for
each instruction for the code of the current project and the selected project are displayed.
If it is not checked, the step numbers are not displayed. If a line is selected and the step number
is not displayed, the line is marked with a small box in front of the instruction.
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5 Parameters

5.1 PLC Parameter

The command Parameter - PLC in the Project Navigator provides options for configuring your
system.

The CPU type can be changed by selecting the command Change PLC Type in the Project

menu or by clicking on the icon.

In the dialogbox Change PLC Type you can select a PLC series and a PLC type.

� If you change the PLC series and/or the PLC type and confirm with OK, all parameters for
the new PLC type will be reset to defaults.

� If you do not change the PLC series/PLC type but want all previous parameter changes to
become inactive, confirm with OK.

� If you do not want to change anything, click Cancel.

The default settings produce trouble-free program performance for most applications. If you
are using a network you must configure it with Parameter - Network before starting work,
however. If the configuration parameter settings lead to problems in your project, GX IEC
Developer will display an explanatory warning message.

NOTE The PLC parameters are set automatically for the PLC type you select. Some of the
parameters explained below are not relevant for all PLC types, and they are thus not
displayed when some specific PLC types are selected.

For any information or particular explanation required for parameter setting, refer to the corre-
sponding CPU user's manual and programming manual to pre-design them. The setting items
are assigned to the tab screen purpose-by-purpose.
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5.1.1 Setting the PLC Parameters

The following table lists the PLC parameter setting items on a series basis.Set the parameters
as required.

5.1.2 Common Notes on Parameters

Parameter display

This part describes the setting item tabs and network parameter setting items.

Example

�
The meanings of the symbols are the same also when displayed with network parameters.

� Red: The PLC does not operate until data is set. (Data is not set.)

� Blue: Data is set.

� Magenta: The PLC operates without setting data or with the default. (Data is set.)

� Dark blue: Data is set.
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A QnA
System Q

FXQ00J/Q00/
Q01 QnH QnUDH QnPH QnPRH Remote

I/O

PLC name !       !  

PLC system (1)          

PLC system (2) ! ! ! ! ! ! ! !  

Positioning ! ! ! ! ! ! ! !  

PLC file !       ! !

PLC RAS (1)         !

PLC RAS (2) ! ! !     ! !

Device        !  

Program !       ! !

Boot file !       ! !

SFC !       ! !

I/O assignment          

Memory capacity  ! ! ! ! ! ! !  

Operational
settings ! ! ! ! ! ! !  !

Serial ! !  ! ! ! ! ! !

Tab. 5-1: PLC parameter setting items

Fig. 5-2: QnA Parameter



Common buttons for parameters

This part describes the settings common to PLC and network parameters.

Default button
This button returns all of the set items or values to the previous settings.This button is available
only for the currently open tab.

Check button
Use this button to check the set items or values to see if they are correct. This button is avail-
able only for the currently open tab.

End setup
The End button defines the set items or values and terminates the setting.

Cancel button
Cancels the set items and terminates editing.

Acknowledge X/Y Assignment button
This button is available for the models A2ACPU(S1), A3ACPU, A2AS(S1), A2AS-S30,
A2AS-S60, A2UCPU(S1), A2USCPU(S1), A2USHCPU(S1), A3UCPU, and QnACPU,
QCPU(Q mode). It is used to confirm the X/Y assignment numbers of the data set in the I/O
assignment setting.
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Fig. 5-3: Common buttons for parameters

Fig. 5-4: XY Assignment



The priority of display is shown below:

� I/O assignment (AnACPU, AnUCPU, Q/QnA series)

� Fourth MELSECNET network refresh parameter (AnUCPU, Q/QnA series)

� Third MELSECNET network refresh parameter (AnUCPU, Q/QnA series)

	 Second MELSECNET network refresh parameter (AnUCPU, Q/QnA series)


 First MELSECNET network refresh parameter (AnUCPU, Q/QnA series)

� MELSECNET/MINI refresh (AnACPU, AnUCPU, QCPU (A mode)/QnA series)

� CC-Link remote I/O (Q/QnA series)

The Duplicate Error area displays the first duplicate item detected in checking the items
according to the priority.

5 – 4 MITSUBISHI ELECTRIC

PLC Parameter Parameters

Display Description

I/O assignment Displays I/O assignment information.

MINI Displays I/O assignment information and MINI automatic refresh setting information.

CC-Link Displays I/O assignment information and CC-Link automatic refresh setting information.

NET (II) Master station: Displays I/O assignment information and refresh parameter
information.

Local Station: Displays I/O assignment information and refresh parameter
information.

NET/10 PLC-to-PLC network,
remote I/O network:

Displays network parameter information.

Tab. 5-2: Display by type



Multiple CPU setting button
Setting cannot be made for Q00J/Q00/Q01CPU and remote I/O projects.

No. of PLC
Clicking the Default button in I/O assignment keeps the multiple PLC setting unchanged.
When the set number of PLCs is one, a multiple CPU system configuration is not set.

Host CPU setting
When the modules are not grouped, they are all put under the control PLC of the PLC No. 1.
OPERATION ERROR appears if access is made to any module outside the groups.

Communication area setting (Refresh setting)
The maximum input range of each module is 0 to 2048 points.
Set the total number of all modules to within 4096 points.

Multiple CPU high speed transmission area setting
Set the total number of all modules to within 12k points.

Assignment confirmation button
Click this button to open a window showing a schematic diagram of the division of the PLCs'
shared memory.
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Multiple CPU settings

No. Of PLC
Set one to four modules.

Host CPU number
Set the number of the Host CPU.

Operating mode
Set the operation (stop) at a PLC stop error.

I/O sharing when using Multiple CPUs
Specify the shared I/Os.

Online module change
Make setting when performing online module change.

Multiple CPU synchronous startup setting
Set the target PLC.

Communication area setting
Set the CPU shared memory G between multiple CPUs.
Usable devices: B, M, Y, D, W, R, ZR

Multiple CPU high speed transmission area setting
(QnU CPU only, except Q02U)
Make settings to use Multiple CPU high speed transmission

Fig. 5-5: Multiple PLC setting



5.1.3 PLC Parameter Item Lists

PLC parameter item list of the Qn(H) and QnU(D)(E)(H)
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PLC Parameter Parameters

PLC name

Device Label
Set the CPU label.

Comment
Set the CPU comment.

PLC file

File register
Set the file register file to be used.

Comment file used in a command
Set the comment file to be used in a
command.

Device initial value
Set the device initial value file to be
used.

File for local device
Set the local device file to be used.

PLC system

Timer limit setup
Set the time limits of the low-/high-speed timers.

RUN-PAUSE contacts
Make setting to control RUN/PAUSE of the CPU.

Remote reset
Set enable/disable of remote reset operation.

Output mode at STOP to RUN
Set the output mode at STOP to RUN.

Floating point arithmetic processing (QnH CPU only)
Make setting to perform floating point arithmetic operation
at high speed.

Intelligent functional module setting
Set the assignment of the interrupt pointers (I50 to I255) and
the first I/O No. and first SI No. of the intelligent function unit.

Common pointer
Set the first No. of the common pointers.

Number of empty slots
Set the number of empty slots.

System interrupt settings
Set the first No. of the interrupt counters (QnH CPU only) and
the fixed scan intervals of the interrupt pointers.

Device

Dev. Point
Set the number of device points to be
used.

Latch [1] start
Set the latch range valid for latch
clear key operation.

Latch [2] start
Set the latch range invalid for latch
clear key operation.

Local dev. Start
Set the range of the device used as a
local device.

Interrupt program/Fixed scan program setting
Set whether the interrupt/fixed scan program is run at high
speed or not.

Modul synchronization
Set whether the start of the Q CPU is synchronized with that
of the intelligent function unit.

Compatibility with A-PLC
Set whether the special relays/special registers for MELSEC-A
series (SM1000/SD1000 and later) are used or not.

(QnH CPU only)

Latch data backup operation valid contact
(QnU CPU only)
Make setting for contact to trigger latch data backup.

Service processing setting
Set the service processing time.

(QnU CPU only)

File used for SP.DEVST/S.DEVLD
instruction (QnU CPU only)
Set whether and if which file is used.

Latch setting of file register
(QnU CPU only)
Set the latched range for the file register.

Indexing setting of ZR device

Specify 32-bit indexing of file register
after a given Z device.

(QnU CPU only)

Fig. 5-6: PLC parameter item list of the QnH, QnU (1)
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WDT [Watchdog timer] setup

WDT setting

Initial execution

Low speed execution (QnH CPU only)
Make WDT settings of the CPU.

PLC RAS

Error check
Set whether the specified error is to be detected or not.

Operating mode when there is an error
Set the display mode of the CPU on detection of an error.

Constant scanning
Set the constant scan time.

Low speed program execution time
Set the time for execution of a low-speed program.

(QnH CPU only)

Breakdown history
Set the storage target of the CPU's breakdown history.

(QnH CPU only)

Program

Program
Set the execution type for use of multiple programs.

Boot file

Boot file setup
Set the boot-run file, etc.

SFC

SFC
Make various settings needed for an
SFC program.

I/O assignment

I/O assignment
Set each unit loading status of the
system.
Make switch settings of the
intelligent function module.
Reserve the multiple CPUs.
(Refer to the items common to the
PLC parameters for the multiple
PLC setting.)

Base setting
Set the base model, power supply
module model, etc.

Built-in Ethernet port
(QnUDE(H) CPU only)

IP address
Set the IP address etc.

Communication data code
Set binary code or ASCII code.

Fig. 5-6: PLC parameter item list of the QnH , QnU (2)



PLC parameter item list of the QnPH
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PLC Parameter Parameters

PLC name

Device Label
Set the CPU label.

Comment
Set the CPU comment.

PLC file

File register
Set the file register file to be used.

Comment file used in a command
Set the comment file to be used in a
command.

Device initial value
Set the device initial value file to be
used.

File for local device
Set the local device file to be used.

PLC system

Timer limit setup
Set the time limits of the low-/high-speed timers.

RUN-PAUSE contacts
Make setting to control RUN/PAUSE of the CPU.

Remote reset
Set enable/disable of remote reset operation.

Output mode at STOP to RUN
Set the output mode at STOP to RUN.

Floating point arithmetic processing
Make setting to perform floating point arithmetic operation
at high speed.

Intelligent functional module setting
Set the assignment of the interrupt pointers (I50 to I255) and
the first I/O No. and first SI No. of the intelligent function unit.

Common pointer
Set the first No. of the common pointers.

Number of empty slots
Set the number of empty slots.

System interrupt settings
Set the first No. of the interrupt counters and the fixed scan
intervals of the interrupt pointers.

Device

Dev. Point
Set the number of device points to be
used.

Latch [1] start
Set the latch range valid for latch
clear key operation.

Latch [2] start
Set the latch range invalid for latch
clear key operation.

Local dev. Start
Set the range of the device used as a
local device.

Interrupt program/Fixed scan program setting
Set whether the interrupt/fixed scan program is run at high
speed or not.

Unit synchronization
Set whether the start of the QCPU is synchronized with that
of the intelligent function unit.

Compatibility with A-PLC
Set whether the special relays/special registers for MELSEC-A
series (SM1000/SD1000 and later) are used or not.

Fig. 5-7: PLC parameter item list of the QnPH (1)
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WDT [Watchdog timer] setup

WDT setting

Initial execution

Low speed execution
Make WDT settings of the CPU.

PLC RAS (1)

Error check
Set whether the specified error is to be detected or not.

Operating mode when there is an error
Set the display mode of the CPU on detection of an error.

Constant scanning
Set the constant scan time.

Low speed program execution time
Set the time for execution of a low-speed program.

Breakdown history
Set the storage target of the CPU's breakdown history.

PLC RAS (2)

Memory check
Set whether a program memory check will be made or not.

SFC

SFC
Make various settings needed for an
SFC program.

I/O assignment

I/O assignment
Set each unit loading status of the
system.
Make switch settings of the
intelligent function module.
Reserve the multiple CPUs.
(Refer to the items common to the
PLC parameters for the multiple
PLC setting.)

Standard setting
Set the base model, power supply
module model, etc.

Program

Program
Set the execution type for use of multiple programs.

Boot file

Boot file setup
Set the boot-run file, etc.

Fig. 5-7: PLC parameter item list of the QnPH (2)



PLC parameter item list of the QnPRH
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PLC Parameter Parameters

PLC name

Device Label
Set the CPU label.

Comment
Set the CPU comment.

PLC file

File register
Set the file register file to be used.

Comment file used in a command
Set the comment file to be used in a
command.

Device initial value
Set the device initial value file to be
used.

File for local device
Set the local device file to be used.

PLC system

Timer limit setup
Set the time limits of the low-/high-speed timers.

RUN-PAUSE contacts
Make setting to control RUN/PAUSE of the CPU.

Remote reset
Set enable/disable of remote reset operation.

Output mode at STOP to RUN
Set the output mode at STOP to RUN.

Floating point arithmetic processing
Make setting to perform floating point arithmetic operation
at high speed.

Intelligent functional module setting
Set the assignment of the interrupt pointers (I50 to I255) and
the first I/O No. and first SI No. of the intelligent function unit.

Common pointer
Set the first No. of the common pointers.

Number of empty slots
Set the number of empty slots.

System interrupt settings
Set the first No. of the interrupt counters and the fixed scan
intervals of the interrupt pointers.

Device

Dev. Point
Set the number of device points to be
used.

Latch [1] start
Set the latch range valid for latch
clear key operation.

Latch [2] start
Set the latch range invalid for latch
clear key operation.

Local dev. Start
Set the range of the device used as a
local device.

Interrupt program/Fixed scan program setting
Set whether the interrupt/fixed scan program is run at high
speed or not.

Unit synchronization
Set whether the start of the QCPU is synchronized with that
of the intelligent function unit.

Compatibility with A-PLC
Set whether the special relays/special registers for MELSEC-A
series (SM1000/SD1000 and later) are used or not.

Fig. 5-8: PLC parameter item list of the QnPRH (1)
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WDT [Watchdog timer] setup

WDT setting

Initial execution

Low speed execution
Make WDT settings of the CPU.

PLC RAS (1)

Error check
Set whether the specified error is to be detected or not.

Operating mode when there is an error
Set the display mode of the CPU on detection of an error.

Constant scanning
Set the constant scan time.

Breakdown history
Set the storage target of the CPU's breakdown history.

PLC RAS (2)

Memory check
Set whether a program memory check will be made or not.

SFC

SFC
Make various settings needed for an
SFC program.

I/O assignment

I/O assignment
Set each unit loading status of the
system.
Make switch settings of the
intelligent function module.

Standard setting
Set the base model, power supply
module model, etc.

Program

Program
Set the execution type for use of multiple programs.

Boot file

Boot file setup
Set the boot-run file, etc.

Fig. 5-8: PLC parameter item list of the QnPRH (2)



PLC parameter item list for Q series remote I/O station
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PLC Parameter Parameters

PLC system settings

Number of vacant slot points
Set the number of vacant slot points.

Module synchronization setting
Set whether a QCPU startup is synchronized
with an intelligent function module startup or not.

PLC RAS settings

Error check
Set whether the specified error will be detected or not.

Operating mode when there is an error
Set whether operation will be stopped or not at occurrence
of a fuse blown or I/O module comparison error.

Operation settings

Remote I/O station switch settings
Set cyclic communication error-time output hold and
output hold designation enable.

Inter-device transfer parameters
Set the link device range, etc. for communication with
the I/O and special function modules of each remote I/O station.

I/O assignment settings

I/O assignment settings
Set the module loading states of the system.
Make the switch settings of the intelligent
function module.

Basic settings
Set the base type, power supply module type,
etc.

Fig. 5-9: PLC parameter item list for Q series remote I/O station



PLC parameter item list of the Q00J/Q00/Q01CPU
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PLC name

Device Label
Set the CPU label.

Comment
Set the CPU comment.

PLC file (Setting is disabled for Q00J)

File register
Set the file register file to be used.
(Setting is fixed)

Device

Dev. Point
Set the number of device points to be
used.

Latch [1] start
Set the latch range valid for latch
clear key operation.

Latch [2] start

PLC system

Timer limit setup
Set the time limits of the low-/high-speed timers.

RUN-PAUSE contacts
Make setting to control RUN/PAUSE of the CPU.

Remote reset
Set enable/disable of remote reset operation.

Output mode at STOP to RUN
Set the output mode at STOP to RUN.

Number of empty slots
Set the number of empty slots.

System interrupt settings
Set the first No. of the interrupt counters and the fixed scan
intervals of the interrupt pointers.

Interrupt program/Fixed scan program setting
Set whether the interrupt/fixed scan program is run at high
speed or not.

Unit synchronization
Set whether the start of the QCPU is synchronized with that
of the intelligent function unit.

PLC RAS

WDT [Watchdog timer] setup
WDT setting

Make WDT settings of the CPU.

Error check
Set whether the specified error is to be detected or not.

Operating mode when there is an error
Set the display mode of the CPU on detection of an error.

Constant scanning
Set the constant scan time.

Boot file

Boot file setup
Set the boot-run file, etc.

I/O assignment

I/O assignment
Set each unit loading status of the
system.
Make switch settings of the
intelligent function module.
Reserve the multiple CPUs.

Standard setting
Set the base model, power supply
module model, etc.

Serial

Baud rate
Set the baud rate.

Sum check
Set the sum check.

Transmission wait time
Set the transmission wait time.

RUN write setting
Set whether online program
change can be made or not.

(Setting is disabled for Q00J)

Fig. 5-10: PLC parameter item list of the Q00J/Q00/Q01CPU



PLC parameter item list of the QnA series
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PLC name

Device label
Set the CPU label.

Comment
Set the CPU comment.

PLC system

Timer limit setup
Set the time limits of the low-/high-speed timers.

RUN-PAUSE contacts
Make setting to control RUN/PAUSE of the CPU.

Remote reset
Set enable/disable of remote reset operation.

Output mode at STOP to RUN
Set the output mode at STOP to RUN.

General data processing
Set the number of units to be handled by single general data
processing.

Common pointer
Set the first No. of the common pointers.

Number of empty slots
Set the number of empty slots.

System interrupt settings
Set the first No. of the interrupt counters and the fixed scan
intervals of the interrupt pointers.

PLC file

File register
Set the file register file to be used.

Comment file used in a command
Set the comment file to be used in a
command.

Device initial value
Set the device initial value file to be
used.

File for local device
Set the local device file to be used.

Device

Dev. Point
Set the number of device points to be
used.

Latch [1] start
Set the latch range valid for latch
clear key operation.

Latch [2] start
Set the latch range invalid for latch
clear key operation.

Local dev. Start
Set the range of the device used as a
local device.

PLC RAS

WDT [Watchdog timer] setup

WDT setting

Initial execution

Low speed execution
Set the WDT timers of the CPU.

Error check
Set whether the specified error is to be detected or not.

Operating mode when there is an error
Set the display mode of the CPU on detection of an error.

Constant scanning
Set the constant scan time.

Low speed program execution time
Set the time for execution of a low-speed program.

Annunciator display mode

Display F No.

Display comment

Display occurrence time
Set the display mode established when the annunciator
has turned on.

Breakdown history
Set the storage target of the CPU's breakdown history.

SFC

SFC
Make various settings needed for an
SFC program.

I/O assignment

I/O assignment
Set each unit loading status of the
system.

Standard setting
Set the base model, power supply
unit model, etc.

Program

Program
Set the execution type for use
of multiple programs.

Boot file

Boot file setup
Set the boot-run file, etc.

Fig. 5-11: PLC parameter item list of the QnA series



PLC parameter item list of the A series
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Parameters PLC Parameter

Memory capacity

Program capacity
Set the main, sub, microcomputer and other
capacities.

Comment
Set the comment capacity.

Expanded comment
Set the extended comment capacity.

File register
Set the file register capacity.

Capacity for debugging
Set the sampling trace and status latch capacities.

Memory capacity information
Display the total of memory to be used.

PLC RAS

WDT setup
Set the WDT.

Operating mode when there is an error
Set whether operation will be stopped or continued
at occurrence of a fuse blow, operation error,
I/O unit verify error or special unit access error.

Annunciator display mode
Set whether annunciator display is provided or not.

PLC system

RUN-PAUSE contacts
Set the contacts which control RUN/PAUSE of
the CPU.

System interrupt setup
Set the range of the counter used in an interrupt
program.

Output mode at STOP to RUN
Set the output status at STOP to RUN.

Data communications request batch
processing
Set whether the transient communications
request is processed or not in the END
processing of its scan.

Remote I/O setting for A2C PLC
Set the occupied slot count and remote I/O
assignment of each station when the
A2C/A2CJCPU is selected.

I/O assignment

I/O assignment
Set the type (empty, input, output, special),
model and points.

Device

Device setup
Set the points and latch range of each device
used in a sequence program.

Fig. 5-12: PLC parameter item list of the A series



PLC parameter item list of the FX series
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PLC Parameter Parameters

Memory capacity

Memory capacity
Set the memory capacity that the PLC has.

Comment capacity
Set the comment capacity.

File register capacity
Set the file register capacity.

Program capacity
Set the sequence program capacity.

Device

Device setup
Set the latch range.

PLC name

PLC name
Comment the PLC program.

PLC system (2)

Protocol
Set the communication protocol.

Data length
Set the data length.

Parity
Set the parity.

Stop bit
Set the stop bit.

Transmission speed
Set the transmission speed.

Header
Set the header.

Terminator
Set when making the terminator valid.

Control line
Set when making the control line valid.

H/W type
Normally choose RS-232C or RS-485.

Control mode
Display the control mode data.

Sum check
Set when adding sum check.

Transmission control procedure
Choose format 1/format 4.

Station number setting
Make station number setting.

Time out judge time
Set the time-out period.

I/O assignment

I/O assignment
Set the first/last values of the I/O relays.

PLC system (1)

Battery less mode
Make this setting when performing operation
without the memory backup battery of the FX2N,

or FX3UC PLC.FX2NC,

MODEM initialized
Set the modem initialization command when
making remote access to the FX1S, FX1N, FX2N,
FX1NC, FX2NC, or FX3UC PLC
.
RUN terminal input
When using the input (X) of the

as the external
RUN/STOP terminal, set its input number.

FX1S, FX1N, FX2N,
FX1NC, FX2NC, or FX3UC PLC

Positioning

Make common settings (single entry
for each axis) and detailed settings
(multiple entries for each axis) in the
parameter table of positioning control.

Fig. 5-13: PLC parameter item list of the FX series



5.1.4 Reading of PLC Parameter from the PLC

It is also possible to read the PLC parameter from the PLC to the Project.

Read PLC data button
This button is located on the I/O assignment tab.

For Q series:
The implementation status is read if the parameter file exists in the PLC. If the unit model, first
X/Y, base model, power supply unit model, extension cable model and slot count have been
set on the Personal computer, the data will be deleted.
If the parameters have been set on GX IEC Developer, the following dialogue box appears to
ask you if the parameter data may be overwritten.

For QnA series:
When the parameter file exists in the PLC, the parameter file is read.
When the parameter file does not exist in the PLC (implementation read):
After deleting the parameter file in the PLC, set the PLC from RESET to RUN and read the PLC
data. If the unit model, first X/Y, base, power supply unit and extension cable have been set on
the Personal computer, the data will be deleted.
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Fig. 5-14: Note when reading the PLC data



5.2 Parameters for Redundant PLCs

The command Parameter - Redundant PLC in the Project Navigator provides options for
configuring a redundant system.

Redundant PLC parameter item list of the QnPRH
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Parameters for Redundant PLCs Parameters

Fig. 5-15:
The Project Navigator window
for the QnPRH CPU

Redundant Parameters

Operation settings

Tracking settings

Tracking device settings
Set the tracking transfer setting data.

Tracking characteristics settings
Set the transfer mode.

Start mode setting
Set the device status when the system is powered on/reset.

Standby system watch setting
Check for a stanby system fault.
If a fault occurs, error check can be made using the PLC diagnostics.

Debug mode setting
Set a start in the debug mode.

Backup mode setting
Set the same type of operating status consistency.

Fig. 5-16: Redundant PLC parameter item list of the QnPRH



5.3 Network Parameters

The command Parameter - Network in the Project Navigator provides options for configuring
your networks. Clicking on Parameter - Network opens the following dialogbox.

If the network parameter settings lead to problems in your project, GX IEC Developer will
display an explanatory warning message.

NOTE The PLC parameters are set automatically for the PLC type you select. Some of the
parameters explained below are not relevant for all PLC types, and they are thus not
displayed when some specific PLC types are selected.

For any information or particular explanation required for network parameter setting, refer to
the corresponding CPU user's manual and programming manual to pre-design them. The
setting items are assigned to the tab screen purpose-by-purpose.

5.3.1 Setting the Network Parameters

The following table lists the network parameter setting items on a series basis.Set the parame-
ters as required.
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Fig. 5-17:
Dialogbox Network parameter

Network

A

QnA

System Q

AnNCPU AnACPU
AnUCPU

QCPU
(A mode)

CPU Remote I/O

MELSECNET     ! !

MELSECNET II !    ! !

MELSECNET/10 ! !    !

MELSECNET/10H ! ! ! !  !

MELSECNET/MINI  !   ! !

CC-Link ! ! !    

CC-Link Ver. 2 ! ! ! !   

ETHERNET ! ! !    

Tab. 5-3: Network parameter setting items



5.3.2 Common Notes on Parameters

About Items Common to the Network Parameters

This section describes operations common to the setting of data link system and network
system parameters.

The following operations cannot be performed as those common to the parameters.

� Cut, copy, paste

� Home and End keys are invalid.

The meanings of the symbols are the same also when displayed with PLC parameters.

� Red: The PLC does not operate until data is set. (Data is not set.)

� Blue: Data is set.

� Magenta: The PLC operates without setting data or with the default. (Data is set.)

� Dark blue: Data is set.

Example MELSECNET II combined (master station) network range assignment parameter setting
window

�
Check button
Use this button to check the set items or values to see if they are correct. This button is avail-
able only for the currently open tab.

End setup
The End button defines the set items or values and terminates the setting.

Cancel button
Cancels the set items and terminates editing.
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Fig. 5-18: MELSECNET II combined (master station) network range



Acknowledge X/Y Assignment button
This button is available for the models A2ACPU(S1), A3ACPU, A2AS(S1), A2AS-S30,
A2AS-S60, A2UCPU(S1), A2USCPU(S1), A2USHCPU(S1), A3UCPU, and QnACPU,
QCPU(Q mode). It is used to confirm the X/Y assignment numbers of the data set in the I/O
assignment setting.

Routing Parameters button
Set the routing parameters in the following dialogbox, that is opened by clicking the button.

Interlink Transmission Parameters button
Set the interlink transmission parameters in the following dialogbox, that is opened by clicking
the button.
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Fig. 5-19:
Routing parameters

Fig. 5-20: Interlink Transmission Parameters



Assignment image button
The following dialogue is opened.
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Fig. 5-21: Assignment image



5.3.3 Network Parameter Item Lists

Network parameter items of the Q series

For the remote I/O project, only Ethernet or CC-Link may be set.
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MELSECNET/10
MELSECNET/H

Network type
Specify the MELSECNET/H·MELSECNET/10
mode,MELSECNET/10 or Ethernet.

Starting I/O No.
Set the first I/O No.

Network No.
Set the network No.

Total stations
Set the total number of (slave) stations.

Group No.
Set the group No.

Mode
Set the mode.

Network range type (Common parameters)

I/O Master station specification
Set the I/O master station on the LX/LY
setting screen.

Reserved station specification
Specify the reserved station.

Equal assignment
Set when assigning the link device points
of the specified stations equally.

Identical point assignment
Set the same points according to the
preset total number of stations.

Supplementary s
etspeed cyclic and

other settings.

tings
Make the transient, low-

Station inherent parameters
Set the station inherent parameters.

Refresh parameters
Set the refresh parameters.

Interrupt settings
Set the device code, detection method, interrupt
condition, interrupt (SI) No., Etc.

MELSECNET/H
Remote I/O

Network type
Specify the MELSECNET/H (remote master).

Starting I/O No.
Set the starting I/O No.

Network No.
Set the network No.

Total stations
Set the total number of (slave) stations.

Mode
Set the mode.

Network range type (Common parameters)

Reserved station specification
Specify the reserved station.

Equal assignment
Set when assigning the link device points of
the specified stations equally.

Supplementary settings
Make the constant scan and the max. Number
of return stations in one scan.

Refresh parameters
Set the refresh parameters.

Interrupt settings
Set the device code, detection method, interrupt
condition, interrupt (SI) No., Etc.

Fig. 5-22: Network parameter items of the Q series (1)
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CC-Link Ethernet

Unit count
Set the number of units. (1 to 4 units)

Operational settings
Set the parameter name and data link abnormal station.

Type
Set the master/local/standby master station, etc.

Master station data link type
Fixed to "PLC parameter auto start".

Mode
Set the mode.

All connectcount
Set the number of slave stations connected.
(1 to 64 stations)

Remote input [RX]
Set the bit devices to be batch-refreshed.

Remote output [RY]
Set the bit devices to be batch-refreshed.

Remote register [Rwr]
Set the word devices to be batch-refreshed.

Network type
Specify the MELSECNET/10H mode or
Ethernet.

Starting I/O No.
Set the starting I/O No.

Network No.
Set the network No.

Group No.
Set the group No.

Station No.
Set the station number.

Mode
Set the mode.

Operational settings
Make the communications data code
setting, initial timing setting and IP
address setting.

Initial settings
Make the timer setting and DNS setting.

Open settings
Make the open settings.

Remote register [Rww]
Set the word devices to be batch-refreshed.

Special relay [SB]
Set the bit devices to be batch-refreshed.

Special register [SW]
Set the bit devices to be batch-refreshed.

Retry count
Set the number of transmission retries.

Automatic reconnection station count
Set the number of stations automatically reconnected
during 1 scan.

Wait master station No.
Set the station number of the standby master station.

PLC down select
Set whether data link is continued or stopped at a stop
of the CPU.

Scan mode setting
Set whether sequence scans are synchronized or not.

Delay information settings
Set the link scan interval delay time.

Station information settings
Set the station type, number of occupied stations, etc.

Remote device station initial
Set the corresponding station number and procedure
registration (operation, execution and other conditions).

Interrupt settings
Set the device code, detection method, interrupt condition, etc.

Routing information
Set the router relay function, sub-net
mask pattern, default router IP address, etc.

MNET/10 routing information
Set the MNET/10 routing system, net
mask pattern, etc.

FTP Parameters
Set the login name, password,
command input watchdog timer, CPU
watchdog timer, etc.

E-mail settings

General setting
Set the password, mail address, etc.

Mail server name
Set the SMTP server name and
IP address.

Mail receive setting
Set the POP server name and IP address.

Send mail address setting
Set the mail address.

News setting
Set the condition device, monitor
condition, etc.

Interrupt settings
Set the detection method, interrupt condition,
interrupt (SI) No., Etc.

Fig. 5-22: Network parameter items of the Q series (2)



Network parameter items of the QnA series
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MELSECNET/10 Ethernet

Network type
Specify the MELSECNET (II, /10).

Starting I/O No.
Set the first I/O No.

Network No.
Set the network No.

Total stations
Set the total number of (slave) stations.

Network range type (Common parameters)

I/O Master station specification
Set the I/O master station on the LX/LY
setting screen.

Reserved station specification
Specify the reserved station.

Equal assignment
Set when assigning the link device points
of the specified stations equally.

Identical point assignment
Set the same points according to the
preset total number of stations.

Supplementary settings
Make the transient, low-speed cyclic and
other settings.

Station inherent parameters
Set the station inherent parameters.

Refresh parameters
Set the refresh parameters.

Network type
Specify Ethernet.

Starting I/O No.
Set the first I/O No.

Network No.
Set the network No.

Group No.
Set the group No.

Station No.
Set the station number.

IP Address Settings
Set the IP address of the Ethernet unit.

MNET/10 routing information
Set the MNET/10 routing system, net
mask pattern, etc.

FTP Parameters
Set the login name, password,
command input watchdog timer, CPU
watchdog timer, etc.

Routing information
Set the router relay function, sub-net
mask pattern, default router IP address, etc.

Fig. 5-23: Network parameter items of the QnA series (1)



NOTE CC-Link parameters cannot be set to the Q4ARCPU.
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MELSECNET/MINI CC-Link

Unit count
Set the number of units. (1 to 8 units)

Model name
Set the model name of the
MELSECNET/MINI(S3) loaded.

Station count
Set the total number of remote I/O
stations.

Batch refresh receive data
Set the receive data for batch refresh.

Batch refresh send data
Set the send data for batch refresh.

Retry
Set the number of retries made to the
remote I/O station where a
communications fault occurred.

Response
Set whether access to the master unit
buffer memory is assigned to "link"
priority or "CPU" priority.

Unit count
Set the number of units. (1 to 4 units)

Operational settings
Set the parameter name and data link abnormal station.

Type
Set the master/local/standby master station, etc.

Master station data link type
Fixed to "PLC parameter auto start".

Mode
Set the mode.

All connectcount
Set the number of slave stations connected. (1 to 64 stations)

Remote input [RX]
Set the bit devices to be batch-refreshed.

Remote output [RY]
Set the bit devices to be batch-refreshed.

Remote register [Rwr]
Set the word devices to be batch-refreshed.

Remote register [Rww]
Set the word devices to be batch-refreshed.

Error data clear
Set whether the data of the station in
communications error is cleared or held.

Abnormal station detection bit data
Set the device where the abnormal station
detection data will be stored.

Abnormal communication remote
Set the device where the error code at
error occurrence will be stored.

Circuit error check
Set the transmission status at occurrence
of a circuit error.

STOP time operation
Set whether link is stopped or continued
at STOP of the CPU.

Special relay [SB]
Set the bit devices to be batch-refreshed.

Special register [SW]
Set the bit devices to be batch-refreshed.

Retry count
Set the number of transmission retries.

Automatic reconnection station count
Set the number of stations automatically reconnected
during 1 scan.

Wait master station No.
Set the station number of the standby master station.

PLC down select
Set whether data link is continued or stopped at a stop
of the CPU.

Scan mode setting
Set whether sequence scans are synchronized or not.

Delay information settings
Set the link scan interval delay time.

Station information settings
Set the station type, number of occupied stations, etc.

Fig. 5-23: Network parameter items of the QnA series (2)



Network parameter items of the A series
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MELSECNET (II, /10) MELSECNET/MINI

Network type
Specify the MELSECNET (II, /10).

Starting I/O No.
Set the first I/O No.

Network No.
Set the network No.

Total stations
Set the total number of (slave) stations.

Network range type (Common parameters)

I/O Master station specification
Set the I/O master station on the LX/LY
setting screen.

Reserved station specification
Specify the reserved station.

Equal assignment
Set when assigning the link device points
of the specified stations equally.

Identical point assignment
Set the same points according to the
preset total number of stations.

Supplementary settings
Make the transient, link start indication and
other settings.

Station inherent parameters
Set the station inherent parameters.

Refresh parameters
Set the refresh parameters.

Unit count
Set the number of units. (1 to 8 units)

Model name
Set the model name of the MELSECNET/MINI(S3)
loaded.

Station count
Set the total number of remote I/O stations.

Batch refresh receive data
Set the receive data for batch refresh.

Batch refresh send data
Set the send data for batch refresh.

Retry
Set the number of retries made to the remote I/O
station where a communications fault occurred.

Response
Set whether access to the master unit buffer
memory is assigned to "link" priority or "CPU" priority.

Error data clear
Set whether the data of the station in communications
error is cleared or held.

Abnormal station detection bit data
Set the device where the abnormal station detection
data will be stored.

Abnormal communication remote
Set the device where the error code at error
occurrence will be stored.

Circuit error check
Set the transmission status at occurrence of a circuit
error.

STOP time operation
Cannot be set for the A series.

Fig. 5-24: Network parameter items of the A series



5.3.4 Explanations for Network Parameter Setting Screen

The following items are related to network parameter setting.

� Unit valid for other station access

This setting is made valid when there are multiple units which are used without
specifying the network No. or when the network No. has not been set for access to the
other station.

� Read PLC data button

Reads the implementation status.

– For QnA series
Always delete the parameter file of the PLC before reading the implementation
status. The parameter file is read if the parameter file exists in the PLC.

� Remote I/O project

You can set up to four Ethernet modules and CC-Link modules, respectively.

� MELSOFT connection on Ethernet connection (Q Series only)

This setting is used when connecting multiple MELSOFT products such as GX IEC
Developer (a maximum of 17 units) using the TCP/IP communication system.

– Setting procedure:
Ethernet � Open settings � Protocol (TCP) � Open system (MELSOFT
connection)
The screen below gives a setting example when user connections 14 to 16 are used
to connect MELSOFT products, while connections 1 to 5 are used to communicate
with non-MELSOFT products via a MC protocol communication, fixed-buffer
communication, etc.

NOTE For the Q series, Read PLC data is not available for the network parameters.
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products



5.4 Memory Parameters

5.4.1 Memory Parameters (MELSEC A)

This dialogue box contains all the settings for the assignment and allocation of memory. In
addition, you can also set further parameters.

Program capacity: Allocation of MAIN program sequence memory
1 step = 2 bytes
The program checks the maximum value automatically. After compilation the memory actually
required is shown in Memory capacity information.

Sub sequence: Allocation of SUB program sequence memory
1 step = 2 bytes
The program checks the maximum value automatically. After compilation the memory actually
required is shown in parentheses after this entry.

Microcomputer: Allocation of memory for microcomputer programs
This option is only relevant for Sequential Function Chart programs for the PLC CPUs of the
AnN series. The memory for these programs must be allocated in steps of 2 kByte.

File register: Allocation of memory for the file registers
The available memory depends on the type of memory cassette installed.

Comment/Extended comment: Allocation of memory for the comments

Capacity for debugging: Allocation of memory for debugging
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Fig. 5-26: Memory parameters of the A series



5.4.2 Memory Parameters (MELSEC FX)

This dialogue box contains all the settings for the assignment and allocation of memory. In
addition, you can also set further parameters.

Memory capacity: Allocation of program memory. Set the memory capacity of the PLC.

Comments capacity: Allocation of memory for the comments.

File register capacity: Allocation of memory for the file registers.

Program capacity: Allocation of sequence program memory.

Special Function Memory capacity (FX3U only): Select the special extension module/block
initial value setting or positioning setting.
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Fig. 5-27: Memory parameters of the FX3U



5.4.3 Memory Parameters (MELSEC Q/QnA)

In addition to showing the program size parameters for the selected CPU this dialogue box is
also used to define the number of file registers you wish to use.

File Register

If you wish to use file registers in Q/QnA series CPUs you have to define the number you wish
to use here first. The Q00J CPU does not support file registers.

Capacity: Specify the number of file registers you wish to use (units: k points). The Q/QnA
CPU can handle a maximum of 1024 addresses (i.e. 1MB). However, since a few addresses
are also used for making the file registers available you can only actually use a maximum of
1018 addresses. The Q00 and Q01 CPUs are fixed to 32 kPoints.

Corresponding memory: Specify the number of the drive corresponding to the external
memory card you wish to use for the file registers (not available for Q00(J), Q01 CPUs).
Valid entries in the pull-down list:

IC Card A(RAM): RAM in the card in the first slot
IC Card A(ROM): ROM in the card in the first slot (QnA only)
IC Card B(RAM): RAM in the card in the second slot
IC Card B(ROM): ROM in the card in the second slot (QnA only)

NOTE File registers can not be created in the flash card ROM of a Q CPU under GX IEC Developer.
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5.5 Latch Ranges

The PLC Parameter settings include a check mechanism. If a setting in the System Variables
overlaps with the corresponding setting in the Latch Range, an overlap warning will be
displayed. You can ignore this warning and continue or modify the settings.

5.5.1 Latch Ranges (MELSEC A)

This dialogue box includes all the settings available for the division and allocation of the
retentive, battery-powered memory ranges. The data in these ranges is then stored in the
event of a power failure or a system reset. Please note that the settings you make here have
nothing to do with the Status Latch settings in the Debug menu!

Latch Relays / Link Relays: Device range for the memory-resident latch and link relays. The
parameter values must be entered in hexadecimal format.

Timers: Device range for the 10 ms and 100 ms timers

Counters: Counter device range

Data/Link Registers: Register device range

Extended Timers: Device range for extended timers

Extended Counters: Device range for extended counters
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Fig. 5-29: The values for parameters followed by an H in parentheses
(H) must be entered in hexadecimal format.



5.6 Device Settings

5.6.1 Device Settings (MELSEC Q/QnA)

This dialogue box is used to define the devices to be used in the project. You can also specify
whether the latch operation is to be performed or not for the non-volatile device ranges with
battery backup.
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The following table shows the correspondences between the devices in the A series and the
Q/QnA series:

5 – 34 MITSUBISHI ELECTRIC

Device Settings Parameters

MELSEC A Devices MELSEC Q/QnA Devices

Accumulators A0 and A1 Diagnostics link registers SD718 and SD719

Link registers B

Counters C

Data registers D0 - D8191

Special registers D9000 - D9255 Diagnostics link registers SD1000 - SD1255

Annunciators F

Hexadecimal constants H

Interrupt pointers I

Constants K

Latch relays L0 - L8191

Internal Relays M0 - M8191

Special relays M9000 - M9255 Diagnostics link relays SM1000 - SM1255

Nesting N

Pointers P

File registers R

Step relays S0 - S8191

Timers T (low-speed 100ms)

Timer T (high-speed 10ms)

Accumulator (retentive) timers T Accumulator timers ST

Index registers V, V1, V2, ..... Index registers Z7, Z8, Z9 …

Link registers W

Input relays X

Output relays Y

Index registers Z, Z1, Z2, ... Index registers Z0, Z1, Z2, ...

Tab. 5-4: Correspondences between A series and Q series devices



RAD

Input format (10 = decimal, 16 = hexadecimal)

Devices

Enter the number of devices you wish to use in your project in this column. The device types
with no entry fields have a fixed range which cannot be changed by the user:

� Input relays X
Q00J, Q00, Q01 = 2 K, Others = 8 K

� Output relays Y
Q00J, Q00, Q01 = 2 K, Others = 8K

� Diagnostics link relays SB
Q00J, Q00, Q01 = 1 K, Others = 2K

� Step relays S
Q00J, Q00, Q01 = 2 K, Others = 8K

� Diagnostics link registers SW
Q00J, Q00, Q01 = 1 K, Others = 2K

Maximum Input Limits
Maximum value for bit devices: 32K address points
Maximum number of all bit devices: 64K address points
Maximum total number of devices: 29K words

Number of bits per word/kWord
1 word = 16 bits
1Kword = 1,024 words = 16,384 bits

Number of bits per address
X, Y, M, L, B, F, SB, V, S : 1 address = 1 bit
D, W, SW: 1 address = 16 bits = 1 word
T, ST, C: 1 address = 18 bits = 1 word + 2 bits
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5.6.2 Devices in a Redundant System

A feature called Tracking makes it possible, that in a redundant system devices have the same
values on both PLCs. This is vital for consistent continuation after a system switch. The
following devices are synchronized (tracked) between the Control and Standby systems auto-
matically at every scan by default.

The tracking settings can also be set manually (for max 100 kW devices) in the Parameters.
This may be helpful to

� reduce the number of tracked devices, reducing the delay in the scan time caused by the
tracking, or

� track devices that are not tracked by default (e.g. File Register).

Modifying device values on the Standby system does not have the same effect as on a regular
system, since any modification can be overwritten with the device value from the Control
system by the tracking functionality.Therefore modifying device values on the Standby system
is not supported by default.

This affects the following functionalities:

� Monitoring in a POU body

� Monitoring in the EDM

� The Online Modify Variable Value functionality

� The EDM’s Write to PLC functionality

� The Device Edit’s Write to PLC functionality

� Monitoring in the Buffer Memory Batch Monitor

When attempting to execute any of these operations on the Standby system, an error message
will be displayed.

NOTE It is possible to enable modifying devices on the Standby system on the Extras � Options
� Redundancy option page. Please see sec. 2.9.4 for details.
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Device Default tracking range

Input X0 to X1FFF

Output Y0 to Y1FFF

Internal Relay M0 to M8191

Latch Relay L0 to L8191

Step Relay S0 to S8191

Edge Relay V0 to V2047

Link Relay B0 to B1FFF

Timer T0 to T2047

Counter C0 to C1023

Data Register D0 to D 12287

Link Register W0 to W1FFF

Index Register Z0 to Z15

Tab. 5-5: List of devices being synchronized in a
redundant system



5.7 Boot Settings (MELSEC Q/QnA (except Q25SS
(SX Controller))

In the Boot settings PLC behaviour on booting are specified. Here a system area can be
created to speed up monitoring or for Multiple Block Online Change (MBOC).

Clear PLC RAM: Clears the program memory before booting, if selected.

System area assumed steps: Select size of system area for high-speed monitoring from
other stations. Range: 0 – 15 kSteps. Only available, if Clear program memory is selected.

Boot file setting: Set the boot-run file, etc.

Do boot from Standard ROM: Do boot from Standard RAM, if selected.

NOTE See sec. 8.6.1 for Boot Settings concerning the Intelligent Parameter File of the Q series.
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Fig. 5-32:
Boot setting (Q00(J), Q01 CPU)



5.8 PLC System (FX2N)

In this dialogue box the communication settings between computer link and protocol type is
enabled, disabled, and setup. The settings are stored in the project database.

Operate communication setting: Enables or disables the use of communication settings.

Protocol: Select the protocol for communication. Only available, if Operate communication
setting is selected.

Data length: Select the data length for communication. Only available, if Operate communi-
cation setting is selected.

Parity: Select the parity for communication. Only available, if Operate communication
setting is selected.

Stop bit: Select the number of stop bits for communication.Only available, if Operate communi-
cation setting is selected.

Baud rate: Select the baud rate for communication. Only available, if Operate communication
setting is selected.

Header: Enables or disables the use of a header in the transmission. Only available, if
Operate communication setting is selected.

Terminator: Enables or disables the use of a terminator in the transmission. Only available, if
Operate communication setting is selected.

Control line: Use handshaking recognized by the Non procedural protocol. Only available,
if Operate communication setting and Non procedural protocol are selected.

H/W type:Select the hardware type for the transmission.Only available, if Operate communi-
cation setting is selected.

Control mode: Indication of control mode.
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Sum check: Enables or disables the sum check for the transmission using Dedicated
protocol. Only available, if Operate communication setting and Dedicated protocol are
selected.

Transmission control procedure: Select the format for Dedicated protocol.Only available,
if Operate communication setting and Dedicated protocol are selected.

Station number setting: Specify a station number to use within networks. Only available, if
Operate communication setting is selected.

Time out judge time: Specify a time when to judge a time out of the transmission. Only
available, if Operate communication setting is selected.
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5.9 I/O Configuration

5.9.1 I/O Configuration (MELSEC A)

All the modules, their slot numbers and I/O address number ranges are entered in this
dialogue box. A PLC system can consist of up to 8 base units with 8 slots each, thus providing
up to a maximum of 64 slot numbers.

Entering the configuration data is particularly important for:

� AnA and AnU systems.With these systems certain commands for specific special function
modules can only be executed if the configuration has been explicitly defined.

� Systems for which address ranges different from the current configuration need to be
defined to reserve addresses for future expansions.

I/O Slot: Number of the base unit slot in which the module is installed

I/O Type: Module type: Input, Output or Special Function Module

I/O Range: Number of addresses allocated in the base unit

Mode name: List of the MITSUBISHI modules that can be used. Depends on the settings
made in I/O Type and I/O Range.
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Fig. 5-34: Input and output configuration



5.9.2 I/O Configuration (MELSEC A2C)

The A2C is configured in MINI NET mode. You can install a maximum of 14 stations in the A2C
network. The station numbers to be allocated depend on the address numbers of the modules
used in the configuration.

Remote I/O setting for A2C PLC

Total number of remote stations (1–64): Set the occupied slot count.

Online Mode The Online Mode parameter defines the CPUs operating mode.

Setting of each station

Start station No.: Starting address of the station. The calculation of the number must be
performed by the user. The first address is always station number 1. For example, you must
add 4 station numbers for each module occupying 32 addresses; the starting address for
module 2 would thus be 5.

Protocol

MINIstandard: MINI NET protocol, normally used in most situations.

Non procedural: If you are using the AJ35PTF RS-232 module select the non procedural
protocol to transfer freely-defined protocols (texts).
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5.9.3 I/O Configuration (MELSEC QnA)

This dialogue box is used to enter all the modules and extension units installed in the system.

I/O Assignment

Slot List: All slots (max. 64)

Slot: Selected slot

Type: Input module, output module, special function module or spare slot

Points: Number of addresses occupied by the slot

StartXY: Starting address of the module in units of 16 addresses

Model name: List of supported MITSUBISHI modules

Standard setting

Extension List: 1 base unit and up to a maximum of 7 extension units

Base model name: Designation of the base unit

Power model name: Designation of the power supply

Extension cable: Designation of the extension cable
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5.9.4 I/O Configuration (MELSEC Q)

This dialogue box is used to enter all the modules and extension units installed in the system.

I/O Assignment

Slot List: All slots (max. 64)

Slot: Selected slot

Type: Input module, output module, special function module or spare slot

Points: Number of addresses occupied by the slot

StartXY: Starting address of the module in units of 16 addresses

Model name: List of supported MITSUBISHI modules

Standard setting

Extension List: 1 base unit and up to a maximum of 7 extension units

Base model name: Designation of the base unit

Power model name: Designation of the power supply

Extension cable: Designation of the extension cable
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Switch setting

This button opens the following dialogue:

Switch 1 – 5: Settings for switching operations. Device range: 0000h – FFFFh.
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Detailed setting

This button opens the following dialogue:

Error time output mode: Select whether to clear or hold the output value in case of an error.

H/W error time PLC operation mode: Select whether to stop or continue the operation in
case of an error.

I/O response time: Select the response time after which the I/O values have reached a valid
value.

Control PLC: For Multiple PLC operation (see section 5.14). Assign a selected control PLC
from the drop down list to the selected Intelligent Function Module. The control PLC stores the
program to control the Intelligent Function Module.
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5.10 MELSECNET / Ethernet

The MELSECNET/Ethernet settings define the hardware, communications addresses and
paths in a network.The dialogues differ depending on the selected CPU module.The FX family
CPUs do not support network communications. For details refer to the manuals of the network
modules.

5.10.1 A series

GX IEC Developer supports MELSECNET/10, MELSECNET (II) and MELSECNET/MINI
connections to the AnU CPU and A2US CPU modules.

MELSECNET/10, MELSECNET (II)

Module No. 1...4: Here you select the connection type for the network module.

Network type: Select the desired network type.

Start I/O No.: Enter the first I/O number for the network module in hexadecimal format.

Network No.: Enter the network number for MELSECNET/10.

Total stations: Enter the total number of stations.

Group No.: Enter the group number.

Station No.: Enter the station number.

Network range assignment: Opens a dialogue to enter and edit the network range assign-
ment.

Station inherent parameters: Opens a dialogue to enter and edit the station inherent param-
eters.

Refresh parameters: Opens a dialogue to enter and edit the refresh parameters of the
network module for the MELSEC network.
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5.10.2 QnA series

GX IEC Developer supports MELSECNET/10, MELSECNET (II), and Ethernet connections to
the QnA CPU module.

Restrictions:

� The total number of network modules (MELSECNET modules + Ethernet modules) must
not exceed four.

� The communication via Ethernet to the QnA series is fixed to the binary protocol.

� The communication via a Computer Link module to the QnA series is fixed to the format 1.

� The communication via Ethernet and MELSECNET (II) to the QnA series is not supported.

MELSECNET/10, MELSECNET (II)

Module No. 1...4: Here you select the connection type for the network module.

Network type: Select the desired network type.

Start I/O No.: Enter the first I/O number for the network module in hexadecimal format.

Network No.: Enter the network number for MELSECNET/10.

Total stations: Enter the total number of stations.

Group No.: Enter the group number.

Station No.: Enter the station number.

Network range assignment: Opens a dialogue to enter and edit the network range assign-
ment.

Station inherent parameters: Opens a dialogue to enter and edit the station inherent param-
eters.

Refresh parameters: Opens a dialogue to enter and edit the refresh parameters of the
network module for the MELSEC network.
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Stand by station compatible module: Opens a dialogue to enter the standby station
compatible module.

Remote station compatible module: Opens a dialogue to enter the remote station compat-
ible module.

Ethernet Settings

Module No. 1...4: Here you select the connection type for the network module.

Network type: Select the desired network type.

Start I/O No.: Enter the first I/O number for the network module in hexadecimal format.

Network No.: Enter the network number for Ethernet.

Total stations: Enter the total number of stations.

Group No.: Enter the group number.

Station No.: Enter the station number.

IP address DEC: Opens a dialogue to enter the IP address in decimal coding. Each part may
contain a value from 0 – 255.

Station No. <-> IP information: Opens a dialogue to enter and edit system for the relation
between station No. and IP information.

FTP parameters: Opens a dialogue to enter and edit the FTP parameters.

Router relays parameters: Opens a dialogue to enter and edit router relay parameters.

After the Ethernet settings have been set up successfully the modules will be sorted according
to their first I/O numbers.
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NOTES The connection to the PLC via Ethernet is only supported for the AJ71QE71/A1SJ71QE71
from version B or higher and the QnA or QnAS CPU. The product version is printed on the
device label. For details refer to the hardware manual of the device.

Do not apply a Windows Forced Close Operation (CTRL + ALT + DEL) during the
communication between GX IEC Developer and the PLC or an communication error will
occur when starting GX IEC Developer the next time. In this case restart Microsoft Windows.
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5.10.3 Q series

GX IEC Developer supports MELSECNET/H, MELSECNET/10, Ethernet and CC-Link
connections to the Q CPU module.

MELSECNET/H / MELSECNET/10 parameters

Module No. 1...4: Here you select the connection type for the network module.

Network type: Select the desired network type.

Start I/O No.: Range: 0 – FFF. Enter the starting I/O number for the network module in hexa-
decimal format. The starting I/O number must be a multiple of 16 (10h). The starting I/O
numbers must not overlap even with defined Ethernet modules and keep a gap of at least 20h.

Network No.: Range: 1 – 239. Enter the network number. The network number must not
overlap with other defined modules.

Total stations: Enter the total number of stations.

Group No.: Range: 0 – 32. Enter the group number.

Station No.: Enter the station number.

Mode: Select the desired mode.

Network range assignment: Opens a dialogue to enter and edit the network range assign-
ment.

Refresh parameters: Opens a dialogue to enter and edit the refresh parameters of the
network module for the MELSEC network.

Interrupt settings: Opens a dialogue to enter and edit the interrupt settings for the selected
module (not for Q00(J), Q01).
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Interrupt settings (not for Q00(J), Q01)

In this dialogue you edit the MELSECNET interrupt settings.

Refresh parameters

In this dialogue you edit the refresh parameters for a selected Q module.
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Common parameters

I/O Master station specification: Using Switch screens to choose LX/LY settings enables
the I/O master station to be specified. To set the I/O master station, specify the station number
with the cursor and click I/O Master station specification.

Reserved station specification: Specify the reserved station No. and click this button.

Equal assignment: Used to assign the link device points of all stations equally. The first and
last stations can be set within the number of stations between the first and last equally
assigned station numbers (total number of link stations - (first station number - 1)).

Identical point assignment: Used to make simple assignment with the same points
according to the preset total number of stations.

Supplementary settings: Used to set the constant scan, max. number of reconnected
stations during 1 scan, multiple transmission, communications error setting and transient
setting.

Clear: Used to default the parameter settings.

Check: Used to check the preset parameter data.

End setup: Clicking this button at the end of data setting returns to the network setting screen.
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Ethernet parameters

Module No.1...4: Here you select the connection type for the network module.

Network type: Select the desired network type from the drop-down list.Select “None” to clear
the parameter set.

Start I/O No.: Range: 0 – FFF. Enter the starting I/O number for the network module in hexa-
decimal format. The starting I/O number must be a multiple of 16 (10h). The starting I/O
numbers must not overlap even with defined MELSECNET modules and keep a gap of at least
20h.

Network No.: Range: 1 – 239. Enter the network number. The network number must not
overlap with other defined modules.

Total stations: Enter the total number of stations.

Group No.: Range: 0 – 32. Enter the group number.

Station No.: Range: 0 – 64. Enter the station number.

Operational settings: Opens a dialogue to enter the Ethernet operations like the IP address in
decimal coding.

Initial settings: Opens a dialogue to enter the Timer and DNS settings.

Open settings: Opens a dialogue to enter settings when connecting multiple MELSOFT
products such as GX IEC Developer (a maximum of 17 units) using the TCP/IP communication
system. See also section 5.3.4.

Router relay settings: Opens a dialogue to enter the router relay settings.

Station No. <-> IP information: Opens a dialogue to enter and edit system for the relation
between station No. and IP information.

FTP parameters: Opens a dialogue to enter and edit the FTP parameters.

Router relays parameters: Opens a dialogue to enter and edit router relay parameters.

E-mail settings: Opens a dialogue to enter the settings for sending and receiving e-mails.

Interrupt settings: Opens a dialogue to edit the Ethernet interrupt settings (not for Q00(J),
Q01).
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5.10.4 Qn(H) series and QnU(D)(E)(H) series

The CC-Link IE Controller Network is supported only by Qn(H) series and QnU(D)(E)(H)
series PLCs.

CC IE Control (Control station) and CC IE Control (Normal station) parameters

Module No. 1...4: Here you select the connection type for the network module.

Network type: Select the desired network type.

Start I/O No.: Range: 0 – FFF. Enter the starting I/O number for the network module in hexa-
decimal format. The starting I/O number must be a multiple of 16 (10h). The starting I/O
numbers must not overlap even with defined Ethernet modules and keep a gap of at least 20h.

Network No.: Range: 1 – 239. Enter the network number. The network number must not
overlap with other defined modules.

Total stations: Enter the total number of stations.

Group No.: Range: 0 – 32. Enter the group number.

Station No.: Enter the station number.

Mode: Select the desired mode.

Network range assignment: Opens a dialogue to enter and edit the network range assign-
ment.

Refresh parameters: Opens a dialogue to enter and edit the refresh parameters of the
network module for the MELSEC network.

Interrupt settings: Opens a dialogue to enter and edit the interrupt settings for the selected
module.

Specify station No. by parameter / Specify station No. by program: Select the desired
setting.
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Interrupt settings (not for Q00(J), Q01)

In this dialogue you edit the MELSECNET interrupt settings.

Refresh parameters

In this dialogue you edit the refresh parameters for a selected Qn(H) or QnU(D)(E)(H) module.
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Common parameters

I/O Master station specification: Using Switch screens to choose LX/LY settings enables
the I/O master station to be specified. To set the I/O master station, specify the station number
with the cursor and click I/O Master station specification.

Reserved station specification: Specify the reserved station No. and click this button.

Equal assignment: Used to assign the link device points of all stations equally. The first and
last stations can be set within the number of stations between the first and last equally
assigned station numbers (total number of link stations - (first station number - 1)).

Identical point assignment: Used to make simple assignment with the same points
according to the preset total number of stations.

Help - Network setting: Clicking this button opens a dialogue that presents help for the
network settings.
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Shared group setting: Used to set shared group selection for setting check/edit.

Supplementary settings: Used to set the constant scan, max. number of reconnected
stations during 1 scan, multiple transmission, communications error setting and transient
setting.

Station inherent parameters: Used to change the network unit storage locations of the link
devices assigned to each station in the common parameters.

Clear: Used to default the parameter settings.

Check: Used to check the preset parameter data.

End setup: Clicking this button at the end of data setting returns to the network setting screen.

GX IEC Developer Reference Manual 5 – 57

Parameters MELSECNET / Ethernet

Fig. 5-53:
CC IE Control shared group



5.11 PLC Setup

5.11.1 PLC Setup (MELSEC A)

RUN-PAUSE Contacts: These fields are used for entering the inputs (X) used for
controlling the PLC’s operating mode.
Run The PLC is set to RUN mode as soon as this input is on.
Pause When this input is on the PLC is switched to PAUSE mode.

Relay M9040 must be set for this to be possible.

System interrupt setting: Set the range of the counter used in an interrupt program.

Output mode at STOP to RUN: Behaviour of the PLC CPU after a system stop and restart of
the process.
Previous State Resume process
Recalculate State Recalculate

Data communications request batch processing: Set whether the transient communica-
tions request is processed or not in the END processing of its scan.
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5.11.2 PLC Setup (MELSEC Q/QnA)

WDT Setting: Setting for the watchdog timer.
Range: 10 - 2,000 ms in units of 10 ms
(only for Q25SS (SX Controller)
Range: 10 - 5,000 ms in units of 10 ms)

Error Check: Enables you to activate/deactivate the following error checking functions:

� Battery

� Fuse

� I/O modules

Operation Mode at Error: These options enable you to specify whether the CPU is to pause
or continue working when the following error conditions are registered:

� Calculation error

� Extended Ins

� Fuse blown

� I/O unit compare error

� Special function unit access error

� IC card access error (not for Q00(J), Q01)

� IC card operation error (not for Q00(J), Q01)
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Constant Scanning: Enter the constant scan cycle period here.
Range: 5 - 2,000 ms in units of 5 ms

Number of free slots: Enter the number of addresses occupied by a free slot in this field.
Range: 0 - 1024 in units of 16

Annunciator display mode: Set the display mode established when the annunciator has
turned on.

Breakdown history: Set the storage target of the CPU's breakdown history.

Timer limit setting: Used to set the intervals for the high-speed and low-speed timers. The
timers will then act as high-speed or low-speed timers when they are activated by the appro-
priate instructions in the PLC program.

Low-speed timer instructions: TIMER (IEC editor), OUT (MELSEC editor)

High-speed timer instructions: TIMER_H (IEC editor), OUT_H (MELSEC editor)

Low-speed timer range: 10 - 1,000ms in units of 10ms

High-speed timer range: 1 - 100ms in units of 1ms

RUN-PAUSE Contacts: Enter the inputs to be used to control the operating mode of the
PLC here.

Range: X0 - X1FFF (QnA series)

The PLC will be switched to RUN or PAUSE mode as soon as the corresponding input is set.
When using the PAUSE contact the diagnostics link relay SM206 (QnA series) must also be
set.

Remote reset: Set enable/disable of remote reset operation.
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Output mode at STOP to RUN: Behaviour of the PLC CPU after a system stop and restart of
the process.
Previous State Resume process
Recalculate State Recalculate

Common pointer: Set the first No. of the common pointers.

Number of empty slots: Set the number of empty slots.

System interrupt setting:These fields enable you to specify the counters you wish to allocate
to the system interrupt signals. A total of 32 interrupts are available (I0 - I31).

1st Int Counter: The first interrupt counter can be an address from the following counter range:
C0 - [sum of all counters minus 48]

Example:
Assuming you have set 1K of addresses for the counters in the Device Settings dialogue box
you have 1,024 counter addresses available (C0 - C1023).

A possible entry for the first interrupt counter would thus be:
C0 - 1024 minus 48, which gives you
C0 - C976

I28 / I29 / I30 / I31 Const Interval: You can set constant interrupt intervals for
interrupts I28 - I31.
Range: 5 - 1,000ms in units of 5ms
(only for Q25SS (SX Controller)
Range: 100 - 1,000 ms in units of 10 ms)
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5.12 CC-Link (MELSEC Q/QnA)

The CC-Link settings define the hardware, communications addresses and paths in a
network. For details refer to the manuals of the network modules.

Number of boards within modules: Before you can edit the CC-Link settings you have to
select the number of CC-Link boards from the drop-down list. Up to 8 boards can be edited in
individual dialogue boxes. Each dialogue box can be selected via tabs.

Start I/O No.: Enter the start I/O number in multiples of 10h. The start I/O number of the indi-
vidual boards must not overlap. Value Range: 0000 – 0FE0.

Operational setting: Enter the parameter name and data link abnormal station.

Type: Enter the master/local/standby master station, etc.
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Fig. 5-57: CC-Link settings
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Master station data link type: Fixed to "PLC parameter auto start".

Mode: Set the mode.

All connect count: Enter the number of slave stations connected. (1 to 64 stations)

Remote input [RX]: Enter the bit devices to be batch-refreshed.

Remote output [RY]: Enter the bit devices to be batch-refreshed.

Remote register [Rwr]: Enter the word devices to be batch-refreshed.

Remote register [Rww]: Enter the word devices to be batch-refreshed.

Special relay [SB]: Enter the word devices to be batch-refreshed.

Special register [SW]: Enter the word devices to be batch-refreshed.

Retry count: Enter the number of transmission retries.

Automatic reconnection station count: Enter the number of stations automatically recon-
nected during 1 scan.

Standby master station No.: Enter the station number of the standby master station.

PLC down select: Select Stop (default) or Continue for CC-Link communications in case the
PLC has stopped.

Scan mode setting: Enter whether sequence scans are synchronized or not. Select Asyn-
chronous (default) or Synchronous scan mode.

Delay information settings: Enter the link scan interval delay time.

Station information settings: This button opens the CC-Link station information dialogue
(see below). Enter the station type, number of occupied stations, etc.

Remote device station initial setting: This button opens the Remote device station initial
setting dialogue (see below).Enter the corresponding station number and procedure registra-
tion (operation, execution and other conditions).

Interrupt settings: Opens the Interrupt settings dialogue (see below) to edit the Ethernet
interrupt settings (not for Q00(J), Q01).
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5.12.1 CC-Link station information

In the CC-Link setting dialogue click on the Station information button to open the following
dialogue.

The total number of CC-Link stations you specified in the CC-Link setting dialogue in the field
All connect count are listed.Click on any station number to select a station entry and edit it via
the drop-down lists and entry fields on top.

Station type: Select the station type.

Exclusive station count: Select a number for the exclusive station.

Reserve/invalid station select: Enter the station status.

Intelligent buffer select: Enter the buffer sizes. Value ranges: 0 – 4096

Default: This button resets the selected station number to default values.

Check: This button checks the settings of the selected station number for errors.
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5.12.2 Remote device station initial setting

In the CC-Link setting dialogue click on the Initial settings button to open the following
dialogue.

Target number: Lists the number of the registered target station.

Target station No.: Enter a number for the target station to be registered or edited. Value
range: 1– 64.

Regist procedure: This button opens the procedure registration dialogue (see below) for a
target station either selected from the list or entered in the Register target station field.

Clear: This button deletes all entered data.

Check: This button checks a selected entry for setting errors.
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Procedure registration dialogue

In the Remote device station initial setting dialogue click on the Regist procedure button to
open the following dialogue.

The procedures for the target station are listed. Click on any procedure entry to select and edit
it via the drop-down lists and entry fields on top.

Execute flag: Select to set the execute flag.

Operational condition: Select Same as prev. set or Set new.

Condition device: Select a condition device from the drop-down list.

Device number: Enter address of the condition device.

Execute condition: Select from drop-down list.

Write device: Select from drop-down list.

Device number: Enter address of the write device.

Write data: Select ON or OFF from the drop-down list.

Default: This button resets a selected entry to default values.

Check: This button checks a selected entry for setting errors.
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5.12.3 Interrupt settings

In the CC-Link setting dialogue click on the Interrupt settings button to open the following
dialogue.

The interrupt settings for the selected CC-Link board are listed.Click on any entry to select and
edit it via the drop-down lists and entry fields on top.

Device code: Select a device code from the drop-down list.

Device No.: Enter a device number. Value range: 0000 – 07FF.

Detection method: Select a detection method from the drop-down list.

Interrupt condition: Select an interrupt condition from the drop-down list.

Word device: Setting value: Enter a setting value for word devices.
Value range: 0 – 65535

Board No.: Enter the board number.

Interrupt (SI) No.: Enter value. Value range: 0 – 15.

Clear: This button deletes all entered data.

Check: This button checks a selected entry for setting errors.
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5.13 MELSECNET/MINI

5.13.1 MELSECNET/MINI (MELSEC A/QnA)

The settings for the MiniNet are made in the table. The line above the buttons displays either a
note on correct entry or an error message, depending on the cell selected in the table.

Start I/O No.: Enter the first I/O number for the network module in hexadecimal format.

Model name: Selection of the network type: MiniNet or MiniNet-S3

Batch refresh receive data: Definition of the operands for refreshing receive data. The
following operands are valid: X, M, L, S, B, T, C, D, W, R

Batch refresh send data: Definition of the operands for refreshing send data. The following
operands are valid: X, M, L, S, B, T, C, D, W, R

Retry: Enter the number of communications error retries within the range of 0–32.

Response: Select which device has FROM/TO command buffer memory access priority
rights, the link or the PLC.

Error data clear: The status of data transmission in the event of a communication error.
The following entries are possible:
TEST Output of a test string
OFF Transmission of a 00 string to the remote I/O station
HOLD Sends data to the remote I/O station shortly before communication

Abnormal station detection bit data: Enter the M, L, S, B, T, C, D, W, or R device name.

Abnormal communication remote: Enter the T, C, D, W, or R device name.
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Circuit error check: Select either line error check test memo, OFF data or hold data.

STOP time operation: Specifies the operating status of the MELSECNET/MINI when the
PLC was stopped:
RESUME: MELSECNET/MINI continues operation
PAUSE: MELSECNET/MINI suspends operation
Valid only for QnA.
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5.14 Multiple PLC settings (Q series only, except Q00(J))

Up to four Q series CPUs can be combined on one base unit to increase the overall PLC perfor-
mance by sharing different controller tasks to different CPUs.

No. of PLC
Clicking the Default button in I/O assignment keeps the multiple PLC setting unchanged.
When the set number of PLCs is one, a multiple CPU system configuration is not set.

Out of group input/output settings
When the modules are not grouped, they are all put under the control PLC of the PLC No. 1.
OPERATION ERROR appears if access is made to any module outside the groups.

Refresh settings
The maximum input range of each module is 0 to 2048 points.
Set the total number of all modules to within 4096 points.

Diversion of multiple PLC parameter button
Specify the project to be diverted from the Open Project screen. Setting the source project
shows the multiple PLC parameter diversion dialogue box.Confirm the message and execute.
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5.15 Serial (Q00 and Q01 only)

The dialogue Internal serial communication is used to enable, disable, and setup the
communications with the PLC as Computer Link Module via the serial port. The settings are
stored in the project database.

Use serial communication: Enables or disables the use of the serial communication settings
for Computer Link communications. Default: Disabled.

Baud Rate: Selects a baud rate. Default: 19200. Setting range: 9600 – 115200.

Sum Check: Enables or disables a sum check for the transmission. Default: Enabled.

Transmission wait time: Selects a wait time for the transmission.
Default: 0. Setting range: 0 – 150.

RUN write setting: Enables or disables online changes during the transmission.
Default: Disabled.
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5.16 CPU Type Selection

The CPU type can be changed by selecting the command Change PLC Type in the Project

menu or by clicking on the icon.

In the dialogbox Change PLC Type you can select a PLC series and a PLC type. To change
the CPU type, open the list box, select the new CPU type and confirm with OK.

NOTE When you change the CPU GX IEC Developer deletes the old libraries and regenerates the
Standard and Manufacturer libraries for the new PLC type. This process can take a while as
all the instructions for the new CPU must be integrated in the libraries.

The following table lists all supported CPU types.
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PLC Series CPU Type

AnN A1N, A2C, A2N, A3N

AnS A1S, A1S-S1, A2S, A2S-S1

AnSH A1SH / A1SJH, A2SH, A2SH-S1

AnA / AnU A2A, A2A-S1, A3A, A2U, A2U-S1, A3U

A2AS / A2US A2AS, A2AS-S1, A2US, A2US-S1, A2AS-S30, A2US-S30,
A2AS-S60, A2US-S60, A2USH-S1

FX FX / FX2, FX0 / FX0S, FX0N, FX1S, FX1N, FX2N / FX2NC,
FXU / FX2U / FX2C, FX3U

QnA Q2A(H), Q2AS(H), Q2A(H)-S1, Q2AS(H)-S1, Q3A,
Q4A, Q4AR (from version 0012B)

Q Q00, Q00J, Q01, Q02(H), Q06H, Q12H, Q25H,
Q25SS (SX Controller), Q Remote I/O,
Q02U, Q03UD, Q03UDE, Q04UDH, Q04UDEH, Q06UDH, Q06UDEH,
Q13UDH, Q13UDEH, Q26UDH, Q26UDEH

QnPH Q12PH, Q25PH

QnPRH Q12PRH, Q25PRH

Tab. 5-6: Supported CPU-types



6 Programming

6.1 The Structure of GX IEC Developer Programs

6.2 Tasks

The Task Pool is the ‘control centre’ for the execution of your programs.You must define at least
one task for the project in the Task Pool. In turn, each task contains one or more PRG
(program) type POUs. Each POU can only be defined once in any one task in the Task Pool.
The tasks in the Task Pool are polled cyclically.

NOTE You cannot directly manage either function blocks or their instances in tasks.

The execution of tasks is controlled by the following three parameters:

� Event

� Interval

� Priority

All tasks are either event-triggered or interval-triggered.

NOTE In order to address the SUB memory range with the A3 CPUs you must create a special task
called MELSEC_SUB or use the prefix "SUB_" (not case sensitive).

GX IEC Developer Reference Manual 6 – 1

Programming The Structure of GX IEC Developer Programs
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6.2.1 Event-triggered Tasks

Events can have the following Boolean values:

� TRUE/FALSE: Tasks with the event value TRUE are always executed. The TRUE or
FALSE parameter is automatically converted to UPPER CASE letters!

� Interrupts: Interrupt-triggered execution control is only possible with input modules that
support this function. The task will be executed when the interrupt polled is set. The
interrupt number (e.g.: I20) is entered after Event in the task attributes in the Task
Information dialogue box.

NOTE Remember that the EI instruction (Enable Interrupt) must be programmed in a MELSEC
network or the function EI_M must be used within the project when using interrupt-triggered
tasks.
POUs assigned to interrupt triggered tasks must not be programmed in SFC language.

� Relays: The task is executed when the corresponding relay is set (e.g.: M100).

� I/Os: The task is executed if the status conditions of the corresponding inputs or outputs
are satisfied (e.g.: X0).

� Global variables: All global variables of data type BOOL could be used to control a task.
Elements of arrays or components of data unit variables could not be used.

NOTE For every event or interval-triggered task one system label is allocated (� page 2-51).

6.2.2 Event-triggered tasks with Timer/Output Control (MC-MCR execution)

If you enter a Boolean device as an event or a time interval you can then select the Timer /
Output Control option.
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Series A FX Q QnA

Usable interrupts I0–I31 I000–I899 I0–I255 I0–I31

Tab. 6-1: Interrupt ranges for each CPU series



The following table explains how this option influences the processing of the task.

6.2.3 Interval-triggered Tasks

The intervals are entered as time constants. If a task is to be executed at intervals you must
enter FALSE for the Event parameter in the Task Information dialogue box.

Syntax: T#[Time]

[Time] This is the value for the interval duration.
Example: 12h30m, 5s, 100ms

You can also use a global variable of data type TIME as interval of a task.Elements of arrays or
components of data unit variables could not be used.

E
WARNING:
You must consider the program cycle period when defining the interval duration!
Defining intervals shorter than the program cycle period can lead to unpredictable
results. When in doubt, always calculate the cycle period of the task using the
instruction execution times listed in the controller manual.
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Timer / Output Control not activated Timer / Output Control activated

Execution mode Normal execution MC-MCR execution

Task event X10 X100

Execution sequence LDI X10
CJ      End of Task
POU Code
End of Task

LDI X100
ANI    MC Relay
CJ      End of Task
LD X100
MC N0 MC Relay
POU Code
MCR N0
End of Task

Behaviour when event is
active

If X10 is set the POU associated with the
task is executed.
If X10 is not set the PLC program jumps
to the end of the task.

If X100 is set execution of the program
sequence between the MC and MCR
instructions begins.

Behaviour when event is
not active

The program jumps to the end of the
task but some of the device statuses are
preserved:
- Timers: continue to run (A, FX) or with

Timer scheduler for Q, QnA
- Timers: stop running for Q, QnA

without Timer scheduler
- Retentive/accumulator timers

and counters: status preserved
- Devices in OUT instructions:

status preserved

If X100 is not set the program sequence
between the MC and MCR instructions is
executed once with the MC relay set to
FALSE.
If the MC relay is also not set the PLC
program jumps to the end of the task.
The statuses of the devices are reset:
- Timer: Count value reset to 0, contacts

remain off
- Retentive timers and counters:

count value and input contact status
preserved, output contact is reset

- Devices in OUT instructions: outputs
are reset

- Devices in SET, RST, SFT
instructions: current status preserved

Tab. 6-2: Effect of Timer / Output Control option



6.2.4 Priority-controlled Tasks

The task with the lowest priority value has priority and it will call its associated programs first.
You can assign priority values between 0 and 31.

How to define task execution attributes

� In the Project Navigator window, select the name of the task you wish to edit.

� Press the key combination �� to open the Task Information dialogue box.

� Enter your values for the task attributes.

	 Confirm with OK.

The attribute settings are shown in parentheses behind the name of the task in the Project
Navigator window.

NOTE The procedure for creating a new task is described in chapter 4.

6.2.5 Special task MELSEC_FIRST

If you name a task MELSEC_FIRST (not case sensitive), it is handled with its assigned POUs
in a special way:

� The assigned POUs will be the first ones in the MAIN sequence program.

� All internal code parts from the code generator which must be positioned at the beginning
of the MAIN sequence program will be positioned behind this task.

The following checks are performed during the code generation and will cause an error on
occurrence:

� Interrupt events are not possible for this task.

� Because SFC POUs must be initialised in the first scan before they are used, they could
not be assigned to this task.

� The SFC control functions SFC_CTRL and SFC_PAUSE use a semaphore which is reset
at the beginning of the MAIN sequence (now after MELSEC_FIRST). Therefore this
functions could not be used directly by programs assigned to MELSEC_FIRST or within
their calltree.

The task priority is ignored for MELSEC_FIRST – you are informed of this circumstance by a
warning. All errors or warnings are displayed in the error listbox.
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Fig. 6-3:
Tasks in order of their execution priority:
– Event-triggered via Interrupt I0
– Event-triggered via M100
– Event-triggered via X10
– Always executed
– Interval-triggered, every 10 ms



6.3 Variables

6.3.1 Global and Local Variables

Variables are similar to operands. They contain the values of inputs, outputs or internal
memory locations in the PLC. There are two types of variables:

� Global Variables

� Local Variables

Global Variables

Global variables are defined for the entire project. They are accessible from any POU body,
action or transition, and they make it possible to exchange data between all the sub-programs
that go to make up the project.

Local Variables

Local variables (VAR) are only accessible within the one specific program organisation unit
(POU) in which they are declared. Thus, they cannot be used for exchanging data between
POUs.

NOTE When there is a local variable declared in a POU with the same name as a global variable,
the global variable is hidden, i.e. it is not possible to read or write the value of that global
variable – always the local variable is referenced instead. (See also section 2.9.2.)

6.3.2 Variable declarations

Each variable declaration has the following elements:

� Class,

� Identifier,

� Data type,

� Initial value (automatically),

� Comment (optional),

� Remark (optional).
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6.3.3 Class

The class keyword assigns the variable a specific property that defines how it is to be used in
the project.

6.3.4 Identifiers and Absolute Addresses

Each variable is given a symbolic address, i.e. a name. This is referred to as the identifier; it
consists of a string of alphanumeric characters and underline characters. The identifier must
always begin with a letter or an underline character. Spaces and mathematical operator
characters (e.g. +, -, *) are not permitted.

Examples of identifiers: FAULT
ZEROSIG
LIM_SW_5

When global variables are declared absolute addresses can be assigned that reference the
memory location of the variable in the CPU or a physical input or output.

When local variables are declared in the header of the POU they are automatically assigned a
suitable memory location in the CPU.

You can use either the IEC syntax (IEC-Addr.) or the MITSUBISHI syntax (MIT-Addr.) to assign
the absolute addresses. Two address columns are available.

As soon as you have entered an address in one of these columns, the other address also
appears. You can enter either of the two address formats in both columns. If, for instance, you
enter a MITSUBISHI address in the IEC column, GX IEC Developer identifies it immediately,
places it in the correct column and produces the matching IEC address in the other column.

Use upper case letters only and no spaces or mathematical operator characters
(e.g. +, -, *) in addresses.
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Class
Use in POUs:

Meaning
PRG FUN FB

VAR X X X Variable that is only used within the POU

VAR_CONSTANT X X X Local variable with unchangeable initial value used
within the POU

VAR_INPUT — X X Variable passed from outside that cannot be altered
within the POU

VAR_OUTPUT — — X Variable passed (output) by the POU

VAR_IN_OUT — — X Local variable passed from outside and passes
(output) by the POU, can be altered within the POU

VAR_GLOBAL X — X Global variable declared in the Global Variable List

VAR_GLOBAL_CONSTANT X — X Global variable with unchangeable initial value
declared in the Global Variable List

Tab. 6-3: Use of classes in POUs



When you define global variables you must specify the hardware addresses for each individual
variable. The address declarations are shown in the table below.
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MITSUBISHI
Address

IEC
Address

Size 
 Range Example

X %I X X0
X1F
X37
X7FFF

↔
↔
↔
↔

%IX0
%IX31 �

%IX31 	

%IX32767 


Y %Q X Y0
Y1F
Y37
Y7FFF

↔
↔
↔
↔

%QX0
%QX31 �

%QX31 	

%QX32767 


D %M W, D 0 D450
D501+
D502

↔

↔

%MW0.450

%MD0.501

%M X 
 0 D0.5
D100.F

↔
↔

%MX0.0.5
%MX0.100.15

W �
 %M W, D 1 W35F
W301+
W302

↔

↔

%MW1.863

%MD1.769

%M X 
 1 W35F.5
W35F.F

↔
↔

%MX1.863.5
%MX1.863.15

R �
 %M W, D 2 R450
R501+
R502

↔

↔

%MW2.450

%MD2.501

%M X 5 2 R450.5
R450.F

↔
↔

%MX2.450.5
%MX2.450.15

M / L / S �� %M X 0 M0
M1024

↔
↔

%MX0.0
%MX0.1024

B �
 %M X 1 B3F ↔ %MX1.63

S � %M X 2 S10 ↔ %MX2.10

T Contact � %M X 3 TS10 ↔ %MX3.10

T Value %M W 3 TN40 ↔ %MW3.40

C Contact %M X 4 CS10 ↔ %MX4.10

C Value %M W, D 4 CN10
CN210

↔
↔

%MW4.10
%MD4.210 	

T Coil %M X 5 TC20 ↔ %MX5.20

C Coil %M X 6 CC20 ↔ %MX6.20

A � %M W,D 5 A0
A0+
A1

↔

↔

%MW5.0

%MD5.0

V �� %M W,D 6 V1
V2+
Z2

↔

↔

%MW6.1

%MD6.2

Z %M W 7 Z2 ↔ %MW7.2

%M X 
 7 Z2.5
Z2.F

↔
↔

%MX7.2.5
%MX7.2.15

F %M X 7 F20 ↔ %MX7.20

L 
 %M X 8 L30 ↔ %MX8.30

V 
 %M X 9 V47 ↔ %MX9.47

N Not permitted in IEC

P Cf. network label

I Only allowed in event-triggered tasks

Tab. 6-4: Address declarations for variables (1)
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MITSUBISHI
Address

IEC
Address

Size 
 Range Example

K K0 ↔ 0

H 16# HFF ↔ 16#FF

SM 
 %M X 10 SM1024 ↔ %MX10.1024

SD 
 %M W, D 10 SD450 ↔ %MW10.450

%M X 10 SD45.5
SD45.F

↔
↔

%MX10.45.5
%MX10.45.15

SB 
 %M X 11 SB3F ↔ %MX11.63

SW 
 %M W, D 11 SW35F ↔ %MW11.863

%M X 11 SW5F.5
SW5F.F

↔
↔

%MX11.95.5
%MX11.95.15

ZR 
 %M W, D 12 ZR327
ZR40501 +
ZR40502

↔

↔

%MW12.327

%MD12.40501

%M X 12 ZR27.5
ZR27.F

↔
↔

%MX12.27.5
%MX12.27.15

ST Contact 
� %M X 13 STS10 ↔ %MX8.10

ST Value 
 %M W 13 STN40 ↔ %MW8.40

U \G 
 %M W, D 14 U1\G8
U2\G10 +
U2\G11

↔

↔

%MW14.1.8

%MD14.2.10

%M X 14 U1\G8.5
U1\G8.F

↔
↔

%MX14.1.8.5
%MX14.1.8.15

ST Coil 
 %M X 15 STC20 ↔ %MX9.20

J \X 
 %I X 16 J1\X1F ↔ %IX16.1.31

J \Y 
 %Q X 16 J1\Y1F ↔ %QX16.1.31

J \B 
 %M X 16. .1 J2\B1F ↔ %MX16.2.1.31

J \SB 
 %M X 16. .1 J2\SB1F ↔ %MX16.2.11.31

J \W 
 %M W, D 16. .1 J1\W35F
J1\W301 +
J1\W302

↔

↔

%MW16.1.1.863
%MD16.1.1.769

%M X 16. .1 J1\W5F.5
J1\W5F.F

↔
↔

%MX16.1.1.95.5%MX16.1.1.
95.15

J \SW 
 %M W, D 16. .11 J1\SW35F
J1\SW301 +
J1\SW302

↔

↔

%MW16.1.11.863
%MD16.1.11.769

%M X 16. .11 J1\SW5F.5
J1\SW5F.F

↔
↔

%MX16.1.11.95.5
%MX16.1.11.95.15

BL 
 %M W 17 BL319 ↔ %MW17.319

TR 
 %M X 18 TR511 ↔ %MX18.511

DX 
 %I X 1 DX1F ↔ %IX1.31

DY 
 %Q X 1 DY1F ↔ %QX1.31

FX 
 Not needed in IEC
corresponds to VAR_INPUT

FY 
 Not needed in IEC
corresponds to VAR_OUTPUT or function result

FD 
 Not needed in IEC
corresponds to VAR_OUTPUT, VAR_INOUT or
function result

J 
 Not permitted in IEC

U 
 Not permitted in IEC

Tab. 6-4: Address declarations for variables (2)



Table notes

� M, L and S devices are not compatible to old MEDOC projects. The system does not check
whether latch relay devices L (e.g. L100) are within the latch range of the relay devices M.
Memory-buffered M relays are not displayed as L latch relays.
L and S relays are handled differently in the Q/QnA series.

� In the A series CPUs the step status devices S are treated in the same way as M relay devi-
ces. For example, this means that M100 and S100 are identical.
In the F and Q/QnA series CPUs the S devices are treated as step status devices
The devices S can not be used by the user program.

� Applies for A series controllers only
	 Applies for F series controllers only

 Applies for Q/QnA series controllers only
� The size prefix is optional, i.e. the entries %IX10 and %I10 are effectively identical.

Prefixes:
X Bit device
W Word device
D Double word device

� The following types of MITSUBISHI devices are used for timers and counters:
STS, TS, CS Contact (Timer, Counter)
STC, TC, CC Coil (Timer, Counter)
STN, TN, CN, T, C Value (Timer, Counter)

6.3.5 Initial Value

The initial values are set automatically by the system and cannot be changed by the user.

6.3.6 Comment

You can add a comment up to 64 k characters long for each variable.

6.3.7 Remark

You can add additional user information.
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6.3.8 Data Types

The data type of a variable defines the number of bits it contains, how they are processed and
the variable’s value range. The following data types are available.

� You can set the default value for the number of characters in string variables with the option
Extras - Options - General - Default String Length (characters).

NOTES The data type STRING with a maximum length of 50 characters is only available for
MELSEC Q/QnA series.

When using the data type STRING with the A series or the FX series (only FX2, FX2C, and
FX2N(C)) a maximum length of 8 characters is alowed.
With these CPU series the string cannot be manipulated using dedicated instructions.

Data unit types (DUT) are structured, derived data types containing a collection of variables
which can be of different data types (� page 6-66).
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Data type Value range Size

BOOL Boolean 0 (FALSE), 1 (TRUE) 1 Bit

INT Integer -32768 to 32 767 16 Bit

DINT Double integer -2147483648 to 2147483647 32 Bit

WORD Bit string 16 0 to 65535 16 Bit

DWORD Bit string 32 0 to 4294967295 32 Bit

REAL Floating-point value 3.4 E +/- 38 (7 digits) 32 Bit

TIME Time value T#-24d-0h31m23s648.00ms
to

T#24d20h31m23s647.00ms
32 Bit

STRING � Character string max. 50 characters

Tab. 6-5: Data types



Data types hierarchy ANY

Data types hierarchy ANY16 and ANY32
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ANY

ANY_SIMPLE

ANY_NUM

ANY_INT

ANY_BIT

ANY_REAL

TIME STRING

ARRAY DUT

INT

BOOL

DINT

WORD

DWORD

REAL

Fig. 6-4: Data types hierarchy ANY

ANY_16

INTWORD

ANY_32

DINTDWORD

Fig. 6-5:
Data types
hierarchy ANY16
and ANY32



6.3.9 Address Batch Replace

The Address Batch Replace function is available for the global variable list of the project and in
the global variable lists of the included libraries.

This function replaces an existing address range by a new address range.

In the Tools menu select Address Batch Replace to open the following dialogue.

The address range can be entered in either IEC or Mitsubishi format.Both formats must not be
combined.

The greyed last entry field is calculated automatically.

Example

The variables with the addresses D100 – D199 are replaced by the addresses D200 – D299.A
variable with the address D100.0 will be changed to D200.0.

�

NOTE The Undo function is not supported for the Address Batch Replace.

6.3.10 Auto Update

Global and local variables can be updated automatically by the Auto Update function. This
function can be activated via the menu Extras - Options - Editing (refer to 2.8.3).

The following changes of a variable declaration are updated: Class, Identifier, Address, Type,
Initial. All changes made in the GVL will also be executed in the POUs. When you change a
POU header, its body will also be changed automatically. The variables are updated after the
declaration editor changes have been saved.

Via the menu Extras - Update Variables all references of the selected local variables are
updated, if the name of the local variable has been changed.For every reference to be updated
a message box appears where you can decide to update the reference or not.
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Fig. 6-6:
Address batch replace

Fig. 6-7:
Address batch replace settings



6.4 Programming Languages

6.4.1 Networks

Programming is done in ‘networks’ in all programming languages except Sequential Function
Chart (SFC) and Structured Text (ST). You can define multiple networks, each of which is
identified with a network label. It is then possible to switch from one network to another within
the PLC program by using jump instructions in the program code. For a detailed description of
this please refer to chapter 3.

Network labels can have a maximum of eight characters and must always be terminated with a
colon (:). You can also assign a title to each network. These network titles can be descriptive
names up to 22 characters long, and using them makes handling large projects with many
networks a great deal easier.

NOTE Remember that every network label uses one system label and that the total number of
system labels is limited to a maximum of 256. Since system labels are also needed for other
elements in GX IEC Developer (� page 2-51), you should only define labels to networks to
which you actually intend to perform a jump.

The Network List

The networks in your program organisation units are managed in the Network List, which you
can only open when the body window of the corresponding POU is open. The list window
contains all the POUs networks with their labels and titles. In the window you can add more
networks and edit existing ones. A search function (Find) is provided for finding specific
networks quickly (� Chapter 3).

E
WARNING:
For all practical purposes it is not possible to change the programming language of a
POU once you have selected it. The system will allow you to make the switch, but if you
do this you will lose all the code in the body. You should thus only switch the
programming language of bodies that do not contain any code!
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6.4.2 Text Editors

Instruction List (IL)

Programming in Instruction List is performed with a simple text editor.

An Instruction List program consists of a sequence of controller instructions. Each controller
instruction must contain an operator or a function or function block and one or more
operands/variables. Each controller instruction must begin in a new line. You can also add
optional comments to each instruction.All the programming elements in the individual instruc-
tions must be separated by tab stops.

MELSEC Instruction List

The user interface for programming in MELSEC IL is identical to that for IEC IL. However, only
the ‘Pure’ MELSEC instruction set is supported (� Appendix E); you cannot write IEC
standard programs in the MELSEC IL editor. The functionality of the MELSEC IL language
corresponds to that of the MELSEC MEDOC programming and documentation system. This
enables you to easily import programs developed with MELSEC MEDOC and integrate them
into your GX IEC Developer programs
(� Chapter 8).

IEC Instruction List

The user interface for programming in IEC IL is identical to that for MELSEC IL.There are just a
few differences in programming:

� MELSEC Networks in IEC IL
You can also integrate MELSEC networks in IEC IL programs, thus effectively giving you
access to the ‘Pure’ MELSEC programming instructions.

� The Accumulator
The accumulator is a result management system often used in high-level languages. The
result of every operation is stored in the accumulator directly after execution of the
instruction. The accumulator thus always contains the operation result of the last
instruction executed. You do not need to program any input conditions (execution
conditions) for the operations; execution always depends on the contents of the
accumulator.

NOTE The difference between programming in the MELSEC editor (with execution condition) and
in the IEC editor (with accumulator) is described in the Beginner’s Manual (� Chapter 3).

Structured Text (ST)

ST is a text-oriented editor (programming language), similar to PASCAL and supports mathe-
matical functions and a simple creation of loops.

ST body does not contain a network list because it always consists of only one network.

ST is an editor from the IEC 61131 programming standard. The Structured Text editor is
compatible to the IEC 61131-3.

All IEC 61131 (IEC 61131-3: PART3-1992) standard functions are supported.

All MELSEC instructions are supported.
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6.4.3 Graphical Editors

Ladder Diagram (LD)

In Ladder Diagram you can use both IEC and MELSEC programming instructions in every
network. A Ladder Diagram program consists of contacts (break and make), coils, function
blocks and functions. These elements are connected with horizontal and vertical lines called
interconnects. The circuits always begin at the power bar on the left.

Functions and function blocks are displayed as graphical blocks. In addition to their input and
output parameters, some blocks also have a Boolean input (EN = ENable) and a Boolean
output (ENO = ENable Out). The status of the output always corresponds to that at the input.

E
WARNING:
You must normally create a separate network for each circuit in a Ladder Diagram
program. However, you can also create an additional power bar parallel to the standard
one provided by the editor, connecting the two at one point. This option makes it
possible to perform programming in just one network where this is more convenient.

Function Block Diagram (FBD)

In Function Block Diagram language, as in Ladder Diagram language, you can use both IEC
and MELSEC programming instructions in every network (� Appendix E). All instructions are
implemented using graphical blocks, which are connected with one another with horizontal
and vertical connecting lines. There are no power bars (rails) in Function Block Diagram
language.

Functions and function blocks are displayed as graphical blocks. In addition to their input and
output parameters, some blocks also have a Boolean input (EN = ENable) and a Boolean
output (ENO = ENable Out). The status of the output always corresponds to that at the input.

E
WARNING:
In Function Block Diagram language you must create a separate network for each
circuit.
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6.4.4 Sequential Function Chart (SFC)

Sequential Function Chart is a graphical language. Strictly speaking it is not really a genuine
programming language but rather a structural tool which allows a clear representation of
processes.

The program (PRG) is the only program organisation unit supported in SFC.

SFC language has two basic elements, Steps and Transitions (continue conditions). A SFC
program sequence consists of a series of steps separated by transitions.Only one step can be
active at any one time in such a program sequence except in parallel branches. The next step
in the sequence is activated when the preceding step/steps is/are active and the transition
condition is satisfied.

Steps and Actions

Several actions can be assigned to one step. An action can be a Boolean output variable or a
piece of program, which can be written in any of the editors, including Sequential Function
Chart itself. All actions are listed in the Action Pool in the Project Navigator window. A step to
which no action is assigned is treated as a wait loop that stops execution until the following
transition condition is fulfilled. A step is activated when the transition condition (continue
condition) immediately preceding it is fulfilled.

Steps are represented graphically as rectangles containing a name (descriptor).

Macro Steps

Each step can be declared as a macro step, which in turn consists of a sequential structure. The
only limitation on the nesting depth of such structures is the memory capacity of the controller
used.

Macro steps are identified by two additional horizontal lines within the step rectangle.

Transitions

Each transition has a transition condition. Transition conditions can be programmed in the
Instruction List, Ladder Diagram, Function Block Diagram, MELSEC IL and ST language. It is
also possible to use a Boolean variable, direct address, or constant.

Like the steps, the transitions are also listed in the Project Navigator window.

Transitions are displayed in the editor with a small box lying on the vertical connecting line
between the steps.

Initial Step

An SFC sequence always begins with an initial step. The initial step does not have to be at the
beginning, however – it can also be placed at another point in the sequence.

NOTE The initial step is always the first step that is executed in an SFC program, even if it is not
placed at the physical beginning of the sequence.

The initial step is identified by a double outline.
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Branching

SFC programs support both selective and parallel branching. Selective branches divide into
two or more transition conditions. Parallel branches are always inserted after transitions, and
they can activate actions or jumps.

Selective branching

In a selectively-branched sequence not more than one step can be active simultaneously. If
the transition conditions of two or more transitions in a selectively-branched sequence are
active at the same time the execution priority is determined on the basis of the order of the
sequences from left to right.This means that only the sequence that is furthest to the left will be
executed. The sequences to the right of this sequence will not be executed, even if their
transition conditions evaluate true.

Selective branches are displayed as single horizontal lines.

Parallel branching

Parallel-branched sequences allow the activation of multiple steps simultaneously. The steps
leading off the parallel branch become active as soon as the preceding step and the transition
condition are satisfied.

Several processes can be executed simultaneously in parallel branches.

Parallel branches are displayed as double horizontal lines.

pJumps

Each jump destination is always directly followed by a step. You can thus only insert a jump
destination when the step which is to follow it is selected. The jump must always be
programmed after a transition, as it replaces the step that would normally come in this position.
This means that no further steps or transitions can follow a jump, which is thus also the final
instance within its SFC sequence. The relationship between the jump and jump destination is
established by using the same label (name) for both of them.

When you program a jump instruction pressing� displays a list of all the labels (i.e. potential
jump destinations) that have already been defined. You can then simply select the appropriate
label from the list and confirm to enter it.

NOTE You will find examples of the sequencing rules described here on the following pages.
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EMERGENCY OFF for FX Series

For the FX series PLCs it is possible to integrate an EMERGENCY OFF switch in an SFC
program. All step relays in the sequence are reset as soon as the EMERGENCY OFF switch is
activated. The calculated values in the steps are not lost when this happens. The program
process branches back to the initial step. This does not mean that the complete sequence is
re-initialized, however – the sequence is only interrupted. You should always exercise caution
when restarting processes.

The SFC reset variable (in the following example it is a local variable called
EMERGENC_OFF) can be either a local or a global variable with the type BOOL or ARRAY OF
BOOL. When an ARRAY OF BOOL variable is given, its first element will be used as the reset
variable.

The assignment of the SFC reset variable to the SFC POU is introduced in the POU informa-
tion dialogue. When you call Object Information for the marked SFC POU (in this example
called POU_SFC_01), the following dialogue provides the setting for the SFC reset variable.
Input the identifier of the required local or global variable in the field SFC reset.

When pressing OK in this dialogue, the syntax of the entered name will be checked, but it will
not be verified whether the entered name specifies an existing variable. When the POU or the
project is checked (or built), and the SFC reset setting does not specify a valid variable, an
error will be added to the list of errors and warnings in the Compile/check messages
dialogue.
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Fig. 6-8: EMERGENCY OFF

Fig. 6-9:
Entering the variable identifier for
the SFC reset variable

Fig. 6-10:
Warning message in case of a
syntax error



6.5 Programming in Sequential Function Chart
Language

Programming in SFC language calls for systematic analysis of the control sequence before
you start. The algorithm for implementing the control task should be drawn up in a systematic
step-by-step procedure.SFC programs are planned on the basis of statuses and status transi-
tions. One starts by identifying all the statuses in the process and connecting them with status
transitions. The general statuses formulated in the first program development phase can then
be gradually made more precise. In the final phase each status is implemented in a step and
each status transition in a transition.

For the use of SFC programs you can set some CPU specific parameters (� Chapter 5).

The PLC holds an active information table to be able to activate the active steps of the SFC
POUs after a switch from Stop to Run. For this the SFC program start mode has to be set to
Resume start (on the page SFC in the PLC's parameters).

When the entry AdjustSFCActiveInfoTable in the [OPTIONS] section of the MMP703.INI file
(� Section 2.6) is set to TRUE, the active step information table is updated during download
for QnA and Q PLCs. If it is set to FALSE in the MMP703.INI file the active step information
table is not updated and the PLC will raise an error when the offset of the active steps have
been changed or a new SFC POU has been added or one has been deleted.

If AdjustSFCActiveInfoTable is set to TRUE the following updates are done during
download:

� The offsets of the active steps are adjusted when the SFC program has been changed.

� The information of a SFC block, which corresponds to a SFC POU, is deleted from the
active step information table of the PLC when the SFC POU has been deleted.

If a SFC POU has been added, the active step information table is expanded.The initial step of
the new SFC POU is automatically activated.

NOTES In the Beginner’s Manual (� Chapter 6) you will learn step by step how to create an SFC
program and to use the tools in the SFC editor.

The Q25SS (SX Controller) CPUs do not support the SFC language.
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6.5.1 Sequential Function Chart Language Program Structure

The body of a newly-generated SFC POU always consists of the initial step, a transition and
the final step.

NOTE When you are first trying out the SFC editor it’s a good idea to keep an eye on the active tools
in the Toolbar.Only the elements whose tool icons are active can be inserted at the selected
position. Create a test program to experiment with all the available ways of using SFC
language elements.

The following basic rules of thumb will help you with writing your first SFC programs:

� Each step must always be followed by a transition, each transition by a step.
The only exceptions to this rule are exit and entry steps (jumps and jump destinations).
Both of them ‘replace’ steps, and they must thus always be programmed directly after
transitions. Entry steps (jump destinations) must logically always be followed by a step that
can be executed. An exit step (jump) must always be programmed after a transition that is not
followed by a step.

� Selective branches can only be inserted before transitions.
Since a selective branch polls a variety of conditions before executing a step these
conditions must be placed in transitions directly after the branch.

� Parallel branches can only be inserted after transitions.
This is because a parallel branch has the effect that two or more steps are performed
simultaneously after a common transition.

� You must assign a transition condition to every transition in the program.
A transition condition is a program, Boolean variable, address or constant that defines the
conditions under which the transition to the next step is to be enabled.

� You can assign an action to every step in the program.
An action can be either a program or a Boolean output variable. Please note that an
action’s program is not a POU, however!
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6.5.2 Sequence rules and examples

Simple sequences

Divergence into selective sequences

Convergence from selective sequences
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STEP_1

TRAN_1

Fig. 6-11:
A simple sequence consists of a series of alternating ‘Step – Transition’
pairs.

Example:
The transition from STEP_1 to STEP_2 is only executed if STEP_1 has
been executed and transition condition TRAN_1 evaluates true.

STEP_2

STEP_1

TRAN_1 TRAN_2

Fig. 6-12:
Branching to a selection of alternative sequences
(divergence) is programmed by programming one
transition beneath the horizontal line for each alternative
sequence to be included in the selection. Note that if
several transition conditions evaluate true at the same
time only the sequence that is furthest to the left will
actually be executed! Example:
The transition from STEP_1 to STEP_2 only takes place
when STEP_1 has been executed and transition
condition TRAN_1 evaluates true. The transition from
STEP_1 to STEP_3 only takes place when STEP_1 has
been executed, TRAN_2 evaluates true and TRAN_1
evaluates false.

STEP_2 STEP_3

TRAN_1 TRAN_2

STEP_3

Fig. 6-13:
The end of a selectively branched sequence is converged
again by programming one transition above the horizontal
line for each branch sequence to be terminated.
Example:
The transition from STEP_1 to STEP_3 only takes place
when STEP_1 has been executed and transition
condition TRAN_1 evaluates true. The transition from
STEP_2 to STEP_3 only takes place when STEP_2 has
been executed and TRAN_2 evaluates true.

STEP_1 STEP_2



Divergence into parallel sequences

Convergence of parallel sequences

Empty branches
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STEP_1

TRAN_1

Fig. 6-14:
You can only program one transition directly above the
double horizontal synchronisation line.
Example:
The transition from STEP_1 to STEP_2 and STEP_3 only
takes place when STEP_1 has been executed and
transition condition TRAN_1 evaluates true. Following
simultaneous activation of STEP_2 and STEP_3 the two
sequences are executed in parallel, independently of one
another.

STEP_2 STEP_3

TRAN_1

STEP_3

Fig. 6-15:
You can only program one common transition beneath the
double horizontal synchronisation line.

Example:
The transition from STEP_1 and STEP_2 to STEP_3 only
takes place when both STEP_1 and STEP_2 have been
executed and are connected by the double horizontal line
above the transition. The transition condition TRAN_1 must
also evaluate true.

STEP_1 STEP_2

STEP_1

TRAN_1 TRAN_2

TRAN_3

TRAN_4

Fig. 6-16:
This is a special form of selective branching in
which one or more alternative branches contain
no steps.

Example:
If and only if TRAN_1 is false and TRAN_2 is
true the transition runs from STEP_1 to STEP_4,
skipping STEP_2 and STEP_3.

STEP_2

STEP_3

STEP_4



Exit and Entry Steps (Jumps)
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STEP_1

TRAN_1

LABEL_1 �

TRAN_2

TRAN_3 TRAN_4

LABEL_2 


Fig. 6-17:
A transition condition can be followed by an exit
step instead of a step. The label of the exit
step references the corresponding entry step ,
which can be placed anywhere in a sequence
directly before an executable step. The exit and
entry steps must have the same designators
(names). This structure can be used to program
loop constructs.

Example:
The sequence is processed up to STEP_3. Then,
if STEP_3 has been executed, TRAN_3 evaluates
false and TRAN_4 evaluates true, execution
performs a jump back to STEP_2 via LABEL_1.

STEP_2

STEP_3

STEP_4




�

�

�

�

�

�

�

�

Fig. 6-18:
Creating a Sample Program

Operations and Order of Procedure:

Step and Transition

Parallel Branch (Divergence)

Convergence

Step and Transition

Selective Branch (Divergence)

Step and Transition

Step and Transition

Step and Transition

Convergence

The illustration shows the creation of an
example program in nine steps. The
shaded areas show the position of the
selection highlight for insertion of the
corresponding element.



6.5.3 Editing elements in the SFC language

You can edit all the elements in an SFC sequence. The commands for editing elements are
accessed in the Edit menu under Modify.Here too, only the commands that can be performed
for the current selection are active:

� Initial step

� Final step

� Macro step

� Entry step

� Exit step

6.5.4 Content indication in SFC editor

The content of a body or transition in an SFC can be indicated by a filling in a user-definable
color. The color can be defined in the menu View - Colors - SFC Raster Elements.

The filling indicates that

� A step includes an assigned action

� A transition includes an assigned condition

6.5.5 Zoom functions

Zoom functions for transitions

If you have not yet created a transition double-clicking on the transition symbol opens the New
Transition dialogue box for the definition of a new transition.

If the transition has already been defined double-clicking on the transition symbol opens the
editor for the creation of the corresponding PLC program.

Zoom functions for steps

The Step Zoom Into option in Extras - Options - Zoom Header/Body enables you to define
which dialogue box is to be opened when you double-click on a step symbol.

Step Action Association:Action Association dialogue box:Association of an action to a step

First Action If Any: If at least one action is already associated to the step the PLC program of
the first action in the list is opened for editing.

Comment: Dialogue box Comment: Enables you to enter a comment text. If you want the
comment text to be displayed on the screen in the step box you must activate the Extended
Information feature in the View menu.This will also display additional information in the Project
Navigator window (� page 3-7).
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6.5.6 Assigning Actions to Steps

You can assign actions to every step. An action is a program that can be written in Instruction
List (IEC or MELSEC), Ladder Diagram, Function Block Diagram, or MELSEC ST language.
These programs are all listed in the Action Pool in the Project Navigator window.

How to associate actions to steps

� Select the step to which you wish to assign an action.

� Select Edit Action Association in the Tools menu to open the Action Association
dialogue box.

� Press� to open the Action Name List, which shows all the programs in the Action Pool.

NOTE The procedure for creating a new action is described in chapter 4 (‘How to create new
objects’).

	 Select the required action and confirm with OK. The name is then displayed in the
Action Association field.


 Press� to close the dialogue box.

The selection of actions from the Action Name List as described in step � is for the associ-
ation of programs already stored in the Action Pool. If no actions have yet been created a
message is displayed when you press�.

The action associated with a step does not have to be a program; you can also associate steps
with direct operands, effectively defining the operand as an action.

NOTE Steps that have already been associated with actions are shown shaded in the editor.
If the background colour and the SFC grid element colour are the same, which is set as the
default, it is not visible!
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6.5.7 Assigning Transition Conditions

Each transition must be associated with a transition condition. A transition condition can be

� a program written in the IL, ST, LD or FBD languages

� a ST expression written in a transition condition window

� a constant TRUE or FALSE

� a Boolean variable with the value of FALSE or TRUE

How to assign transition conditions

� Open the body of the SFC POU.

� Select the transition symbol to which you wish to assign a condition.

� Enter the name of the condition.

	 Select Zoom Body from the Tools menu. The New Transition dialogue box is
displayed with the new transition name.


 Select the programming language you wish to use for the transition program.

� Confirm your selection with OK.

The editing window of the selected language editor is then opened, and the name of the new
transition is displayed below the Body entry of the SFC POU in the Project Navigator window.
You can now write the program for the transition condition.

Transitions that have been assigned a name are shown shaded in the sequence chart, even if
the associated program has not yet been created. This means that the identification feature
that applies for steps does not apply for transitions; you can only check whether the associated
program has been created by looking in the Project Navigator window. If the program has been
created the name of the transition will appear under the Body entry in the Navigator.

Programming Transition Conditions

Programming a transition condition is the same as programming any other POU. However, the
program must be written in a network. Also, you are only allowed to use one output variable,
and this variable must have the name of the transition or the name TRAN.
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6.5.8 Enhanced Display

If you need information about the actions contained in a step or programs contained in a
transition you can automatically open and arrange the respective windows via the Enhanced
Display function. If an SFC body is monitored, the monitor mode is automatically activated for
the opened bodies.

How to activate the enhanced display

� In an SFC body click on a step or transition to select it.

� To open the Enhanced Display context menu
right-click on the SFC body or press [Shift]+[F10].

� From the context menu select Enhanced Display - Open action / transition.

	 The action and the transition of the selected item are opened and arranged as shown
below. The monitor mode is automatically activated.

The body of the action is displayed in the upper right section of the SFC body.
The body of the transition is displayed in the lower right section of the SFC body.

If a step was selected, the first action of this step and the body of the following transition are
opened.

If a transition was selected, the body of the first action of the previous step and the body of this
transition are opened. If more than one previous step is available (parallel sequences) the
leftmost located step is displayed.

Actions and transitions which were already opened will be closed before the Enhanced
Display.

The menu item Enhanced Display - Close windows closes all windows which were opened
and arranged automatically.
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Fig. 6-19: Enhanced display



6.5.9 Comments in Sequential Function Chart Language

You can now enter an additional comment for each step in the SFC editor. Each comment can
be up to 256 characters long.

Entering comments

� Optionally activate the Extended Information - SFC editor option in the View menu to
increase the size of the step display in SFC language.

� Select the step in the sequence for which you wish to enter a comment. Take care to
only mark the step itself and not its name.

� Activate the Edit Step Comment option in the Tools menu to display the comment entry
dialogue box.

	 Enter the text of your comment.


 Press�� to insert the comment text into the box representing the step.

� You can suppress the comment text display by deactivating the Extended Information -
SFC editor option in the View menu.

NOTE See also the Comment option in Extras - Options - Zoom Header/Body - Step Zoom Into
(� Chapter 2).
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Fig. 6-20:
Entering comment text

Fig. 6-21:
Inserted comment text



6.5.10 Manual SFC Control

Via the manual SFC control a machine can be controlled by manual operation of the SFC
sequence.

By mouse or menu operation the selected steps can either be set or reset. Alternatively, all
active steps are reset and all selected steps are set.

Before the corresponding command will be executed, a message box appears including one of
the following warnings:

� All selected steps are set.

� All selected steps are reset.

� All active steps are reset and all selected steps are set.

You can execute or cancel the selected command.

Step selection

It is possible to select a step either via the mouse or the keyboard. If you want to select more
than one step, you can click on the corresponding steps while pressing the [CTRL] key.
Multiple selections via the keyboard are not possible.

Availability

If an SFC body is opened, the sub menu of Debug - SFC Control is enabled.

The submenu SFC Control is also available in a context menu which can be opened either via
the key [SHIFT]+[F10] or a right-click on the SFC body.

The submenu SFC Control includes the following menu items:

Set selected steps...: All selected steps are set.

Reset selected steps...: All selected steps are reset.

Replace active by selected steps...: All active steps are reset and all selected steps are set.

The submenu SFC Control is available only if the monitor mode is enabled. If the monitor
mode is disabled, the submenu is greyed, I. e. not available.

Limitations

If you select more than one step at time and then call the set or replace function, it will not be
checked whether the SFC configuration is valid or executable.

The manual SFC control is not available for selected macro steps.

Code generation for manual SFC control

The step flags of every SFC block can be influenced by automatically generated code.
For details refer to 2.9.1.
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6.5.11 Sequence errors

The following examples illustrate two typical errors in SFC programs.

An ‘unsafe’ sequence

An ‘inaccessible’ sequence
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S_1

T_1

T_2 T_3

T_4

T_6

T_5

T_7

Fig. 6-22:
Transition T_4 can only be polled when both S_2 and
S_4 have been executed. However, as soon as T_2 is
false and T_3 is true, sequence execution continues
with S_5. The result is that it is possible for the
process to restart without S_4 being active and
without it being possible to execute S_6.
This type of process is referred to as ‘unsafe’.

S_2 S_3

S_5S_4

S_6 S_7

T_6

T_5T_4

T_2 T_3

T_1

S_1
Fig. 6-23:
This sequence suffers from a similar problem. In
this case, T_6 is completely inaccessible when the
sequence containing steps S_5 and S_7 is
executed. T_6 can only be polled if both S_6 and
S_7 are active. S_6 can never be active, however,
because T_4 can only be polled and execute its
transition when S_2 and S_4 are active.

S_2 S_3

S_4 S_5

S_6 S_7



6.5.12 Start, stop, and initialise SFC for QnA and System Q CPUs

To control SFCs in a project from other program parts, GX IEC Developer provides the
following functions: Start, stop, and initialise.

Additionally, a function including inverse logic is available.

SFC control functions

All SFC control functions are declared as manufacturer functions in the Manufacturer Library
(MLIB). These SFC control functions can be used for QnA and System Q CPUs. They are
realised as functions which are not called, but directly expanded by the code generator at the
locations where they are used.

Functions:

SFC_START
SFC_PAUSE, SFC_PAUSED
SFC_STOP, SFC_STOPPED
SFC_CTRL

The names used for SFC POUs and SFC steps must be valid. If they are invalid, an error
message appears.

Additionally, the used SFC POUs must be assigned to a task. If they are not assigned to a task,
an error message appears.

NOTE Never use SFC_START after SFC_STOP for the same POU. Always use SFC_START
before SFC_STOP or interlock the execution of SFC_START so that both functions can not
be executed within the same program scan.
Otherwise, errors like multiple active steps might occur.

SFC_START

Via SFC_START a paused SFC POU is started again. The step name is not used for paused
SFC POUs.

Via SFC_START also a stopped SFC POU can be started again. If a Step_name is given, the
POU is started at the specified step. If several steps should be activated, several SFC_START
functions have to be used.

If a paused SFC POU should continue with the last active step, the empty string must be used.
A stopped SFC POU will be started with its initial step.
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Fig. 6-24:
SFC_START

Fig. 6-25:
SFC_START



SFC_PAUSE

When the input EN is TRUE the SFC POU given with SFC_name is paused when it is not
already paused.

When the input parameter OUT_mode is TRUE the output of all coils, which are used with an
OUT instruction at the step being executed when the SFC POU will be paused, are maintained.
When it is FALSE they are switched off.

The OUT_mode behaviour is realised with the special relay SM325. The SFC POU is paused
when its according block is not executed. The value of SM325 is used to decide how to handle
the coils.

To avoid the influence of other SFC_PAUSE functions with a different OUT_mode set, an
additional “Pause-is-Currently-Executed-Flag” is used to pause in one scan all SFC POUs
with the same OUT_mode set. At the next scan all SFC POUs will be effected where the
OUT_mode has the opposite setting. Therefore for the EN and OUT_mode inputs of the
SFC_PAUSE no pulsed devices should be used.

SFC_PAUSED

The status of the given SFC POU is assigned to the output parameter Paused. If the SFC POU
is paused, the output parameter Paused is TRUE. If the SFC POU is not paused, the output
parameter Paused is FALSE.

SFC_STOP

Via SFC_STOP the specified SFC POU is stopped. All steps are reset and the status of the
output of all coils are switched off.
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Fig. 6-26:
SFC_PAUSE

Fig. 6-27:
SFC_PAUSED

Fig. 6-28:
SFC_STOP



SFC_STOPPED

Via SFC_STOPPED the status of the given SFC POU is assigned to the output parameter
Stopped. The output parameter Stopped is TRUE when the SFC POU is stopped. The output
parameter Stopped is FALSE when the SFC POU is not stopped.

SFC_CTRL

The function SFC_CTRL is activated via the EN input. If EN is TRUE, the SFC POU is influ-
enced.

If EN is FALSE, the SFC POU is not influenced.

As long as SFC_ON is TRUE the specified SFC POU will be executed.

If SFC_ON is FALSE, the SFC POU is paused. The output of all coils depends on the input
parameter OUT_mode at the step being executed when the SFC POU will be paused.

If SFC_INI is TRUE, the specified SFC POU is stopped.All steps are reset and the output of all
coils is switched off at the step being executed when the SFC POU will be stopped.

If SFC_INI is FALSE again and SFC_ON is TRUE, the SFC POU is started with the initial step.

If SFC_ON and SFC_INI are both active, the SFC POU is paused and reset.

The SFC_CTRL can be used within the SFC POU which is controlled by the SFC_CTRL. In
this case the SFC_CTRL is executed only when the step containing the action including the
SFC_CTRL function is active. When the SFC POU is paused or reset the SFC_CTRL must be
started outside of the SFC POU.

Conditions of using SFC control functions

The control functions SFC_PAUSE and SFC_CTRL, which include “OUT_Mode” influence the
relay SM325. This special relay controls the OUT instruction behaviour of SFC POUs.

Since SFC POUs are also paused when they are assigned to a conditioned task, only one of
both methods to control the OUT instruction behaviour is allowed to be active at the same time.
This is not checked or guaranteed by the code generator, but must be done by the user.
Therefore, you should use only one method at a time to avoid problems.
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Fig. 6-29:
SFC_STOPPED

Fig. 6-30:
SFC_CTRL



NOTE The SFC_STOP function resets a SFC POU to its initial step.The reset of all active steps of a
SFC POU is done by resetting the according block device of the SFC POU. The reset of the
active steps is then done by the SFC program handler, when the SFC block should be
executed.

This could lead to a problem, when after a SFC_STOP the SFC_START function is activated
for the same SFC POU in the same scan.The SFC_START function sets the according block
device again and continues or starts the SFC POU. It is also possible to parameterise a step
name of the SFC POU, which is activated in addition.

While the block device is set again, the reset of the active steps is not done by the SFC
program handler anymore, because the block device has not changed from ON to OFF.
Furthermore SFC_START could activate a step in addition to the currently active steps.

To avoid this problems, in MM+ 3.00 SP2.5 and GX IEC Developer 4.00 and up:
� SFC_START should not be used after SFC_STOP for the same SFC POU.
� Or the execution of SFC_START should be interlocked, so that both functions could not

be executed in the same scan.
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6.5.13 ST for Boolean transitions

The permanently visible direct variable name or transition name has been expanded by a
window, which is shown below the conditions. In this window IEC 61131-3 ST Boolean arith-
metic for the Transition Condition can be edited in textual form. These Boolean expressions
meet the IEC 61131-3 standard. The transition is executed according to the Boolean
expression.

Normally this window will show one line consisting of approx.25 characters (depending on the
selected font, scrollable).A line not completely visible can be indicated by dots. If the transition
or the step before is selected (or if it is active in monitor mode), a window of appropriate size is
displayed. If text is added into the window, slider bars might appear. The window is not shown
when the transition or the step is selected in offline or monitoring mode.

Tools

The command Edit Transition Condition

The command Edit Transition Condition is included in the SFC toolbar and in the menu
Tools.

Edit Transition Condition is available if the SFC editor is active and a transition is selected.
The SFC editor is active if a transition rectangle is marked at the moment. Otherwise the SFC
editor is disabled.

The function of this command depends on the current status of the transition or on the current
content of the transition’s rectangle respectively.

a) Transition rectangle is empty (no transition defined yet)

� Create a new transition: name="", language = ST.

� Open the Transition Condition editor.

b) Transition rectangle contains a name which is no variable, no transition name,
and not TRUE or FALSE

� Create a new transition: name="", language = ST.

� Set transition rectangle to “”.

� Open the Transition Condition editor.

c) Transition is a Boolean variable whose direct address is TRUE or FALSE

� You are asked whether you want to convert the direct variable into a Transition Condition:

“Do you really want to replace ‘varX’ by a Transition Condition?”

– NO: nothing is done, exit function

– YES: continues

� Create a new transition: name=""; language = ST.

� Clear the old transition’s rectangle name.

� Transform the Boolean variable or direct address into the ST format.

� Open the Transition Condition editor.

GX IEC Developer Reference Manual 6 – 35

Programming Programming in Sequential Function Chart Language



d) Transition is already a Transition Condition

Open the Transition Condition editor.

e) Transition is a standard transition including a body in any language

� You are asked:

“There is a body defined for this transition! Do you want to delete this body?”

– NO: nothing is done, exit function

– YES: continues

� Delete the existing transition body.

� Create a new transition: name=""; language = ST.

� Open the Transition Condition editor.

The command Zoom Body

The command Zoom Body opens the Transition Condition editor if the corresponding
transition is already a Transition Condition.Otherwise the appropriate editor will be opened (as
before).

� If the current transition is a valid device or variable, nothing will happen.

� If the transition is empty (new definition), it depends on settings of the Transition
Conditions (Extras - Options - General Options - Transition Condition).

The command Zoom Into

The command Zoom Out works also in the Transition Condition editor. Changes will be stored
to the database.

The command Zoom Out

The command Zoom Out works also in the Transition Condition editor. Changes will be stored
to the database.

The command End Edit

The command End Edit behaves like Zoom Out.

The command List Operands

The command List Operands opens the dialogue Variable Selection, which can be called by
means of the menu command, the toolbar icon, or by pressing the key F2 within the TC editor.

The command List Operators

The command List Operators opens the dialogue Function Block Selection, which can be
called by means of the menu command, the toolbar icon, or by pressing the key SHIFT+F2
within the TC editor.

The command New variable

The command New Variable opens the dialogue Variable Selection in the NewVar mode.
This dialogue can also be called by pressing ALT+N.
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Transition rectangle

Display

The transition rectangle display contains the beginning (if there is not enough space to display
the complete Transition Condition) of the Transition Condition in brackets with a leading ‘=’.

‘...’ shows that there is not enough space to display the complete condition.

Example TC: (X10 AND X11) OR (aBool1 OR aBool2)

Transition Display: =[(X10 AND X11) OR ((aBoo...]

In the display carriage returns, line feed, and tabs will be replaced by spaces.

�

Edit field of the Transition name

When leaving the edit field of the Transition name, additional checks will be performed. There
are the following situations:

a) A Transition Condition exists and has been replaced by a Boolean variable or
address.

� You are asked whether you want to delete the existing Transition Condition.

– Yes: Delete the corresponding ST Transition
Set the given variable into the Transition’s rectangle

– No: Nothing will be done, exit function

b) A Transition Condition exists and will be replaced by an identifier not yet defined

� You are asked whether you want to delete the existing Transition Condition.

– Yes: Delete the corresponding ST Transition
Set the given identifier into the Transition’s rectangle

– No: Nothing will be done, exit function
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Fig. 6-31:
Confirmation of
Transition Condition
deletion

Fig. 6-32:
Confirmation of Transition
Condition deletion



Double-click behaviour

A double click on the Transition’s rectangle has the same effect as using the commands Zoom
Into or Zoom Body.

The double click opens the Transition Condition editor if the corresponding Transition is
already a Transition Condition. Otherwise the appropriate editor will be opened.

If the current transition is a valid device or variable, nothing will happen.

If the transition is empty (new definition), it depends on settings of the Transition Conditions
(Extras - Options - General Options - Transition Condition).

Edit window

The left upper corner of the edit window is located at the right upper corner of the transition
rectangle.

The edit window has a maximum and a minimum size.Within this range the window is adapted
to the current size of its content.

Syntax

ST Boolean expressions can be entered. All types of IEC 61131-3 ST expressions resulting in
a Boolean value can be entered.

The following table shows the IEC 61131-3 ST operators and to their priority level.
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Fig. 6-33:
Edit window for Transition Conditions

Priority level Operation Operator symbol Comments
1 Brackets ( )
2 Function call Fun( )
3 Exponentiation **

4
Negation

Complement

-

NOT
Unary minus

5

Multiplication

Division

Modulo

*

/

MOD

Remainder of integer division

6
Addition

Subtraction

+

-
Binary minus

7 Comparison <, >, <=, >=

8
Equality

Inequality

=

< >
9 Logical AND AND, &
10 Logical Exclusive OR XOR
11 Logical OR OR

Tab. 6-6: IEC 61131-3 ST operators



It is also possible to enter only the pure expression in the SFC transition (ST Boolean expres-
sions):

X1 AND X2

ST Boolean expressions are nameless. Therefore they are not displayed in the project
navigator.

Navigator

Cut, Copy, Paste

Since the TC bodies are not visible for the user, there is no possibility to cut, copy, paste these
bodies explicitly.

Cut, copy, and paste the complete SFC POU also include the TC bodies.

SFC UNDO

The SFC UNDO function handles the Transition Conditions in a similar way as standard transi-
tions.

Transition body

a) Blank transition before defining a new TC

Take the following steps:

� Delete the created ST body.

� Delete the internal SFC transition body.

b) Direct transition before defining a new TC

A direct transition can be TRUE or FALSE, a direct Boolean variable, or a direct Boolean
address.

Take the following steps:

� Delete the created ST body.

� Delete the internal SFC transition body.

� Restore the old direct transition name.

c) Standard transition before defining a new TC

Take the following steps:

� Delete the created ST body.

� Delete the internal SFC transition body.

� Restore the old transition name.
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Replace an existing TC

a) Direct transition

To replace an existing TC by a direct transition,

� clear the name of the direct transition.

Remark

Step 1 is not implemented because this feature is not available when replacing a standard
transition body.

b) Transition name

To replace an existing TC by a transition name,

� clear the name of the transition body name.

Remark

Step 1 is not implemented because this feature is not available when replacing a standard
transition body.

Unused transitions

When leaving the SFC editor without saving the changes problems may occur.

In the following situations unused ST bodies will be left:

� Replace a direct transition by a Transition Condition

� Leave the SFC editor and cancel the saving of the changes

� Open the SFC editor. The direct transition is displayed again, but the corresponding
transition body still exists in the database

The situations described above are also valid for standard transition bodies, but standard
transition bodies are visible for the user. You can delete unused transitions by yourself.

Since Transition Conditions are hidden in the navigator, it is not allowed to create unused ST
bodies.
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Monitoring

What is monitored?

GX IEC Developer provides a monitoring feature splitting the Transition Conditions into several
Boolean expression parts monitored separately. The splitting is done by the Boolean
operators, except for NOT (see evaluate in the following table). If a Boolean operator is
included in an expression, the expression is split into two expression parts (one part on the left
and one part on the right of the operator).For all parts this algorithm is used recursively, until no
more Boolean operators can be found in any part. Brackets will be handled according to the
arithmetic rules.

The Boolean operator NOT will be handled uniformly. NOT will be evaluated with the inverted
expression if this is a single monitoring expression (it will be monitored separately). If the
inverted expression cannot be monitored because it includes ignored operators for example,
the complete expression part including NOT will not be monitored neither.

All parts will be searched for comparison operators (see evaluate in the following table). If a
comparison operator is found, it will be compared with a Boolean value and monitored.

If an expression part includes any other operator, this expression part will be ignored and not
monitored (see ignored in the following table).

The following examples show how transitions are monitored. The underlined parts will be
monitored as one Boolean value.

Example 1 X1 AND X2 OR X3

Example 2 (D1 < 0) OR ((D2 > 0) AND (D3 > 0))

Example 3 X1 AND (X2 OR X3) AND ((D0 0) OR X3)

Example 4 NOT (D1 < D2)

Example 5 NOT ((D5 > 0) AND (D3 < 0))

Example 6 NOT (D1 < D2) AND (D3 > D4 + D5)

Example 7 (M1 AND M2) OR (M3 AND M4)

Example 8 NOT M1 AND M2 OR M3 XOR M4
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Priority level Operation Operator symbol When monitoring
1 Brackets ( ) handled
2 Function call Fun( ) ignored
3 Exponentiation ** ignored

4
Negation

Complement

-

NOT

ignored

evaluate

5

Multiplication

Division

Modulo

*

/

MOD

ignored

ignored

ignored

6
Addition

Subtraction

+

-

ignored

ignored
7 Comparison <, >, <=, >= evaluate

8
Equality

Inequality

=

< >

evaluate

evaluate
9 Logical AND AND, & separator
10 Logical Exclusive OR XOR separator
11 Logical OR OR separator

Tab. 6-7: Priority levels of monitored operations



Display

There are three possible display modes: the edit mode, the online mode, and the monitoring mode.

a) Edit mode

Edit control

The edit control opens when the online mode is not active.When the online mode is closed, the
edit control opens automatically.

See sections above

b) Online mode

The edit mode is closed. The content of the Transition Conditions is displayed using the
standard background colour of the editor.
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Fig. 6-34:
Edit mode

Fig. 6-35:
Online mode



c) Monitoring mode

The edit mode is closed. The content of the Transition Conditions is displayed using the
standard background colour of the editor. The state of the Boolean variables and direct
addresses is displayed additionally.

Values which cannot be indicated completely within the window will not be monitored.

Starting or stopping the Transition Condition monitor automatically

Starting the Transition Condition monitor

The Transition Condition monitor starts automatically when the SFC body is monitored.

Stopping the Transition Condition monitor

The Transition Condition monitor stops when

� the Transition Condition editor has been closed.

� the SFC body monitor has been stopped.

� the online mode has been left.

Multiple monitors

Only one Transition Condition monitor can be active per SFC editor.However, it is possible that
more TCs can be monitored at the same time if they are included in different SFCs.
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Fig. 6-36:
Monitoring mode



Value modification in the SFC TC editor

When an address or variable is double-clicked in a transition condition editor during moni-
toring, then the Modify Variable Value dialogue is opened, and it initializes with the name
under the cursor.
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Fig. 6-37: Modify Variable Value



6.5.14 SV instruction for QnA

Definitions

SV program PLC program for supervision (SV)

SV table Table containing inputs for the SV program

General concept

An array of help memories includes the information when to start an SV and where the infor-
mation is located in an SV table. If a Help Memory Cell is set to ON, a supervised output is set to
ON and the SV starts. All necessary supervision parameters are included in a relative place of
the memory cell in the array. The index indicates the reference to an element in an SV table
(see below).

If the acknowledge Stop input does not get its expected value within the supervision time, a
TimeOut memory cell is activated.

Help Memory Cells SV table in the PLC

Example: If the Run input of an OUT_SV function block is active, the according Help Memory
Cell (here M1002) is switched to ON, i.e. that the SV program fetches all data from line 2 of the
SV table. If the SV times out, the TimeOut memory cell (here M1504), is switched to ON. The
values in the SV table are not coded correctly.

Besides F devices the TimeOut column can contain also the device values of other M memory
cells, which can be used as trigger for other user program parts.

The Margin fields are reserved for future use.

Each register of the SV table contains only a value, i.e. no memory cell or pointer can be
included. The possibilities to code SV table elements are described in section “Coding of the
SV table elements” (see page 6-49).
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M-cell Time Stop Out TimeOut Margin
0 M1000 0 100 X56 Y200 F600 12
1 M1001 1 80 XE2 Y10F M1700 25
2 M1002 ON 2 140 X10 Y100 M1504 25
3 M1003 3 160 X8F Y135 F601 50

4
5

. . . . . .

. . . . . .

. . . . . .
998
999



SV library

GX IEC Developer includes an SV library containing all necessary items for supervising:

� OUT_SV, OUT_SV2 – OUT_SV6
Function blocks to activate outputs and start supervising stop inputs

� SV
Supervising program

To enable the SV functionality in GX IEC Developer, the new library must be specified in the file
MMP703.INI and loaded project into an existing GX IEC Developer via Project - Other -
Update Libraries.

When creating a new project, use pre-packed projects already containing the User and the
Standard libraries for the specified CPU type. After the menu command Project - New ... has
been executed, the file MMP703.INI is scanned automatically in order to check whether
additional libraries must be included into the new project.You have the possibility to update the
libraries of your new project.

Code generation for OUT_SV

At each step where an OUT_SV is used, the code generator of GX IEC Developer sets the
according Help Memory Cell to ON to enable the supervision.

The GX IEC Developer code generator maintains an internal code generator SV table
including information about all used supervisions. This table collects all static SV parameters
during compiling. From the code generator SV table the SV table of the PLC is created and
downloaded to the PLC when the program is transferred to the PLC.During online changes the
internal code generator SV table and the PLC SV table are updated.

For the OUT_SV a predefined function block instance must be used. This is necessary
because OUT_SV has three outputs which cannot be used together with a function.The same
predefined function block instances should be used for different TimeOuts. It is also possible to
define only one global OUT_SV function block instance and to use it at several locations.

The following table shows the possible parameters.

For all parameters except Run only a direct connection to a constant or a variable is allowed.
The parameter Stop can also be used negatively. The parameters Out or TimeOut cannot be
used negatively.

For the parameter _Time only a direct constant or a VAR_INPUT of a function block can be used.

6 – 46 MITSUBISHI ELECTRIC

Programming in Sequential Function Chart Language Programming

Name Type Input range
Run BOOL Any Boolean expression
Stop BOOL X, M, B
_Time INT 0 – 32767 (0,0 – 3276,7 sec) or a VAR_INPUT if it is used

in an FB
Margin INT (constant) 0 (to disable teach in) / 12/ 25/ 50/ 100 %
Out BOOL Y, M, B
T_O (* TimeOut *) BOOL Any M or F address

Tab. 6-8: Possible parameters for OUT_SV



VAR_CONSTANT or VAR_GLOBAL_CONSTANT are not allowed to be constants. For a
VAR_INPUT code is produced, which writes the value to the SV table.For each variable a new
line is inserted into the SV table to be independent of other entries using constants for the
parameter _Time.

For the parameter Margin only direct constants are allowed. To be able to use OUT_SV in a
macro FB with VAR_INPUT for the parameter Margin, the code generator checks whether a
constant is used.

The parameter of OUT_SV cannot be used directly in other instructions, e.g. ST
InstOUT_SV.Margin is not allowed.

For the parameters Stop and Out all local variables, global variables, or direct addresses can
be used if they meet the address range restrictions described in the section “Coding of the SV
table elements” (see page 6-49).

For the output parameter TimeOut only M or F devices can be used. In this case direct
addresses, global variables, or local variables are allowed. If any other device type is used for
the TimeOut, an error is generated during compiling.

The following figure shows a code which has been programmed manually in an editor.

The second network shows an example in which stop has been negated (set with a double
click in the OUT_SV box near the stop parameter).

Codes generated for the first network:

LD X0
AND X1
OUT Help Memory Cell
ANI X100
OUT Y200

No interlocking is made when the Help Memory Cell is already activated.

It is not necessary to set a Help Memory Cell, because the Help Memory Cell is activated by
the SV program. After the activation the value of the Help Memory Cell can change without
influencing the SV program.

Codes generated for the second network:

LD X0
AND X1
OUT Help Memory Cell
AND X300
OUT Y300
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Fig. 6-38:
Sample
programs
for
OUT_SV



The SV parameters in the code generation SV table are updated for all networks during
compiling.

For each Stop/ Out/ TimeOut combination a new line is added to the internal code generation
SV table. If a Stop/ Out/ TimeOut combination is already included in this table, Time and
Margin must be the same. Otherwise an error is generated during compiling.

To allow several Stop/ TimeOut combinations to be used with the same Time and Margin,
additional OUT_SV function blocks can be used.They must be defined as new function blocks
including their own names, because GX IEC Developer does not support extended output
parameters. OUT_SV2 allows two Stop/TimeOut combinations, OUT_SV3 allows three
combinations, etc.

For each Stop/ TimeOut combination the code generator does the same as for OUT_SV, but it
uses the same Time and Margin for the SV table.

Example for OUT_SV6

Generated codes:

LD X0
AND X1
OUT Help Memory Cell 1

: :

OUT Help Memory Cell 6
LDI X100
ORI X20
ORI M10
ORI B2F
ORI MotorOff
ORI M20
ANB
OUT Y200

For the parameter TimeOut output M and F devices can be mixed.
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Fig. 6-39: Example for OUT_SV6



F devices and User Error file

If F devices are used as TimeOut parameters for OUT_SV, the SV will activate the F devices if
the Stop input does not get its specified value within the specified time. Via Debug - User
Errors a list box can be opened in GX IEC Developer displaying the active F devices.

If the project directory includes the file USER_ERR.TXT, the project directory is scanned for
user defined error texts. For this, the text lines in the file must have the following format:

[F Device Value] [Space or ‘,’ or Tab]1-n [Error text]

Example 1 Error text for user error 1

10 Go to Motor 12 and check whether it is running

11, Robot 10 did not reach the target B

�
A line can include 260 characters maximum and the error text 255 characters maximum.

Interface of the SV program

To enable the supervision, assign the SV program to an task always running. It is not possible
to include a predefined task in a library in GX IEC Developer. If you program some OUT_SV
without assigning the SV program to a task, a warning will be generated.

The SV program uses fixed addresses.The fixed addresses will be defined as global variables
in the SV library as a reference for the user that these addresses are reserved.They cannot be
changed by the user. Internally these addresses will be used directly due to some restrictions
of the MELSEC networks concerning symbolic programming and in order to have a quick base
for testing. In a second step the SV program will be changed to symbolic programming.

Coding of the SV table elements
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Name Type Offset (hex) Input range Expected
status Number

Stop M
B
X

M
B
X

0
3000
6000

8000
B000
E000

0 - 2FFF
3000 - 5FFF
6000 - 7FFF

8000 - AFFF
B000 - DFFF
E000 - FFFF

1
1
1

0
0
0

12288
12288

8192

12288
12288

8192
Supervision Time K 0 - 32767 -
Teach In Margin K 0

12/ 25/ 50/ 100
no Teach In
-

Out Y
M
B

0
2000
A000

0 - 1FFF
2000 - 8FFF
A000 - FFFF

1
1
1

8192
32768
24576

TimeOut Memory Cell M

F

0

8000

0 - 7FFF

8000 - FFFF
-
-

32768

32768

Tab. 6-9: Coding of the SV table elements



Additional menu commands

The additional menu commands

Extras - SV - Update Time
Extras - SV - Options

are enabled only when the SV library is present, i.e.when the SV library is part of the project.

The values which can be edited by the user are set in the dialogue Option.

If the number of the Help Memory Cells is not a multiple of 32, it is adjusted to the next lower
value which can be divided by 32. If a value for the number of the SV Help Memory Cells is
entered, which is too high, it is adjusted automatically. The maximum value will result from the
length of the SV table. The default value will be 160 = 5 x 32 blocks.

When compiling the project, the addresses of the specified Help Memory Cells are allocated
and reserved in the system address range of the project. By this, these addresses will not be
used directly anywhere else in the project.

The values of the SV Options are exported or imported respectively together with the PLC
configuration.

All necessary inputs for the SV program will be set by GX IEC Developer via symbolic
VAR_GLOBAL_CONSTANTs in the SV library. The user cannot change the values of the
constants.

The constants will be updated when the user has changed the value in the dialogue SV
Options or when new addresses have been allocated by the compiler.

When SV_HELP_START or SV_HELP_BLOCKS are changed, the SV program and all GX
IEC Developer objects, which use OUT_SV – OUT_SV6, are set to Must be compiled.
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Fig. 6-40:
SV Options

Symbolic name Content set by GX IEC Developer

SV_HELP_START Start of SV Help Memory Cells (e.g. 1234 to start at M1234) Automatically
calculated by GX IEC Developer.

SV_HELP_BLOCKS Number of 32 bit blocks of SV Help Memory Cells

Tab. 6-10: Contents of symbolic constants



6.6 Programming Functions

Programming the header and body of a function is not different from programming a program
POU. You can program functions in the following editors:

� Instruction List (IL)

� Ladder Diagram (LD)

� Structured Text (ST)

� Function Block Diagram (FBD)

The two main characteristics of functions are that they output exactly one data element when
they are processed and that they always deliver the same output values in response to the
same input values. Functions do not have any memory, and although they can contain more
than one data element (arrays) they can only output one data element. Functions are thus
independent program blocks; they have the same functionality as normal programming
instructions, and can be replaced and used in other program sections at will.

NOTE Each user-defined function uses one system label, irrespective of how often the function
is called (� page 2-51).

6.6.1 Using timers in functions

If you are not careful, programming timers in subprograms, functions and function blocks can
lead to problems. You should always remember that once a timer has been triggered it just
goes on counting independently, irrespective of whether the condition that triggered the
branch to the subprogram, function or function block is still true or not. It is thus better to avoid
using timers in this way if possible, and if you can’t avoid it you should make allowances for this
behaviour in the code of your program.
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6.6.2 Declarations

The first step in creating a function is to declare it as a program organisation unit.

Header

In the header you must declare all the variables used in the function.Function variables can be
either of the type VAR, VAR_INPUT or VAR_CONSTANT. The function itself can be one of the
data types (BOOL, INT, DINT, WORD, DWORD, TIME, REAL).

The variables declared in the header are also referred to as formal parameters.

Body

The body contains the program code to be performed on the variables declared in the header.
The result of the function must be explicitly assigned to the function name.

NOTE The procedure for creating a new function is described in section 4.8, ‘How to create new
objects’.
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Fig. 6-41: User created function block

Formal
parameters

The result is
assigned to
the function
name



6.6.3 Calling functions in the text editor

NOTE All variables must be assigned when a function is called; the parameter list must be
complete.

When you call a function in Instruction List language you must first load the first parameter into
the accumulator with the Load instruction (LD). The next program line then contains the refer-
ences to the function’s name, as the operator, and to the other variables declared in the
header. When this statement is executed actual parameters – i.e. specific values – are passed
to the remaining formal parameters defined in the header.The result of the function is stored in
the accumulator.

The value 10 is loaded into the accumulator. This is then followed by the function call FUN_1.
The value in the accumulator is added to Factor_A and multiplied by Factor_B. The result is
stored both in D100 and the accumulator.

NOTE Please note that you must always assign the values to the variables in the correct order as
dictated by the syntax!

Using the editing support function

� Position the cursor in the first column and enter the name of the function.

INSERT

� Press� and �. The parameters are inserted automatically, with dummy variable
question marks and the data type in the actual parameter positions.

LD ?STRING
INSERT ?STRING,

?INT
ST ?STRING

� Overwrite the dummy variable names with a direct address or a variable name.
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Fig. 6-42:
Function call in text editor



6.6.4 Calling functions in the graphical editors

The same procedure is used for calling functions in Ladder Diagram and Function Block
Diagram.

How to call functions in the graphical editors

� Open the POU body

� Select Function Block in the Tools menu. This opens the Function Block Selection
dialogue box.

� Select the required function’s name.

	 Confirm with OK.


 The mouse pointer changes to a function ‘block’ symbol. Position it at the required
location in the editing area and press�. The graphical block representing the function is
inserted at the pointer location. The names of the variables are shown at the function,
inside the block representing the function. The name of the function itself is shown at the
output, which is also inside the function ‘block’ symbol.

� Allocate actual parameters (outside) to the formal parameters (inside).
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Fig. 6-43:
Function call in graphical editor
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6.7 Programming Function Blocks

Programming the headers and bodies of function blocks is no different from programming
normal program POUs. You can program function blocks with the following languages:

� Instruction List (IL)

� Ladder Diagram (LD)

� Structured Text (ST)

� Function Block Diagram (FBD)

Function blocks can have one or more outputs and can produce one or more different output
values for the same input values. The results are stored after the function block has been
processed, and these values are used the next time the function block is called. Function
blocks must be instantiated before they can be called in a POU.

6.7.1 Using timers in function blocks

If you are not careful, programming timers in subprograms, functions and function blocks can
lead to problems. You should always remember that once a timer has been triggered it just
goes on counting independently, irrespective of whether the condition that triggered the
branch to the subprogram, function or function block is still true or not. It is thus better to avoid
using timers in this way if possible, and if you can’t avoid it you should make allowances for this
behaviour in the code of your program.

NOTE The instruction Timer_FB_M uses one Timer for each instance.

GX IEC Developer Reference Manual 6 – 55

Programming Programming Function Blocks



6.7.2 Declaration

The first step in creating a function block is to declare it as a program organisation unit.

Header

All the variables used in the function block’s code must be declared in the header. Variables in
function blocks can be of the types VAR, VAR_IN_OUT, VAR_INPUT, VAR_OUTPUT,
VAR_CONSTANT, VAR_GLOBAL or VAR_GLOBAL_CONSTANT. The result of the function
can be one of the data types (BOOL, INT, DINT, WORD, DWORD, TIME, REAL).

Body

The body contains the program code to be performed on the variables declared in the header.
Direct programming of hardware addresses is not permitted.

Example The function block COUNTER stores the duration of a process. The header contains declara-
tions of three output variables (Hours, Minutes, Seconds), one input variable (Process) and
one global variable (SecClck) that addresses relay M9032, which switches once per second.

NOTE The procedure for creating a new function block is described in section 4.8, ‘How to create
new objects’.

Header of the function block
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Fig. 6-44:
Function block header



Body of the function block

As soon as an input signal is registered the variable ‘Seconds’ is incremented once per
second.
When the value of ‘Seconds’reaches 60 ‘Minutes’is incremented by 1 and ‘Seconds’is reset to 0.
When the value of ‘Minutes’reaches 60 ‘Hours’ is incremented by 1 and ‘Minutes’ is reset to 0.

�

6.7.3 Instantiation

Function blocks cannot be called directly, they must be called as ‘instances’. When a function
block is ‘instantiated’, an instance or copy of it is created in the header declaration table of the
POU under consideration. The instance is declared as a variable VAR, for which any identifier
can be used. The ‘Type’ is the name of the function block.

NOTES You can make multiple instances of one function block. However, remember that each
instance you create uses up one system label (� section 2.9.6).

When using the macro code no label is required.

Example In this example, the COUNTER function block programmed above is instantiated in the MAIN
program POU as PROCESS_TIME.

�
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Fig. 6-45:
Function
block body

Fig. 6-46: Instantiation example



6.7.4 Calling function blocks in the text editor

You do not have to assign all the variables in the parameter list when you call a function block.
The old register values are used for those parameters not assigned in the call.

Function blocks are called with the following instructions

CAL (Call)
CALC (CallConditional: conditional call)
CALCN (CallConditionalNot: negated conditional call)

Calling with a list of input parameters:

Syntax:

CAL Instance Name ( Formal parameter := Actual parameter , ...)

Example The instance name of the function block is PROCESS_TIME. In this example, the actual
parameters X0, D1, D2 and D3 are assigned to the formal parameters ‘Process’, ‘Seconds’,
‘Minutes’ and ‘Hours’.

CAL Process_Time(Process:=X0, Seconds:=D1, Minutes:=D2, Hours:=D3)

�

Call with input parameter load/store:

Syntax:

LD Actual parameter
ST Formal parameter
CAL FBName()
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Example The instance name of the function block is PROCESS_TIME. In this example, the actual
parameters X0, D100, D200 and D300 are assigned to the formal parameters ‘Process’,
‘Seconds’, ‘Minutes’ and ‘Hours’.

LD X0
ST Process
LD D100
ST Seconds
LD D200
ST Minutes
LD D300
ST Hours
CAL Process_Time()

�

Using the editing support function

� Position the cursor in the first column and enter the CAL instruction.

� Position the cursor in the second column and press �.

� Select the function block instance (FB_INST in the example) from the Variable
Selection dialogue box.
CAL FB_INST

	 Press � and �. The parameters are inserted automatically. The names of the internal
function block variables are entered as the formal parameters. Dummy variable
question marks and the data type are displayed in the actual parameter positions.

CAL FB_INST(IN1:=?BOOL,
IN2:=?BOOL,
IN3:=?BOOL)


 Overwrite the dummy names with either a direct address or a variable name. Tip: If you
select the dummy name (?BOOL) and press � you can select the variable directly from
the list displayed. Select Apply to enter the variable.

CAL FB_INST(IN1:=X1,
IN2:=VAR_EIN1,
IN3:=VAR_EIN2)
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6.7.5 Calling function blocks in the graphical editors

How to call function blocks in the graphical editors

� Open the body of the program POU in which you wish to call the function block.

� Select Function Block in the Tools menu. This opens the Function Block Selection
dialogue box.

� Select the required function block’s name and confirm with OK.

	 Move the mouse pointer to the desired position in the editing window and press the
Space Bar to insert the function block.


 Press� for a list of the instance names declared in the header.

� Select the appropriate instance name and confirm with OK. The name is then used as
the identifier for the function block instance.

� Terminate the procedure by pressing�.

" Assign the actual parameters (outside) to the formal parameters (inside).

6.7.6 Multiple use of a single instance

You can use the same instance of a function block in several different places within a POU, or, if
it is defined globally, in several different places within the same PLC program.

NOTE If the EN of an FB or an FUN is zero, the output is not defined.

6.7.7 Combine several steps and transitions to create a macro

You can combine selected ranges in the SFC body and define them as macros.
This places all the steps and transitions within one Macro. In complex SFC programs, macros
facilitate control and make it easier to keep track of the sequence structure.

Select the desired steps and transitions in the SFC body and call the menu command Edit
Macro. The selected area is then automatically redused to one macro. To return this step you
call the menu command Edit Zoom Macro.

A macro is a “mini program” that is accessible for use in your project.
It is important to understand that macros are not subprograms – subprograms are routines
that only exist once within your main program and are accessed and executed by performing a
jump.
In contrast, macros are simply “reused code” that become part of the main program. They do
not reduce the number of steps in a program, they just make programming easier.
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Fig. 6-47:
The names of the formal parameters
are shown in the function block.
The function block type is
COUNTER, the instance name is
‘Process_Time’ (� Header).

Actual
parameters

Formal
parameters



6.7.8 Execution of Function Blocks

Function blocks can be executed in different ways:

� Macrocode execution

� MC-MCR execution

� Use with EN/ENO

The execution mode is selected in the Function Information dialogue box.

How to set the execution option

� Select the function block in the Project Navigator window.

� Display the Function Information dialogue box by pressing ��.

� Activate the check box. The Use MC-MCR option can only be activated when the other
two options have already been activated.

This does not make any changes to instantiation and the programming of instances in the
various programming languages.
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Fig. 6-48:
Function block information



Macrocode execution

� Standard execution: The function block is called via a system label

� Macrocode execution: The function block is expanded internally

� To set the system labels parameter select Extras - Options and then click on System Vari-
ables (� page 2-51).

Macrocode execution, MC-MCR execution, Use with EN/ENO

The function blocks FB_1 through FB_5 and the corresponding instances i_FB_1 through
i_FB_5 show the different execution possibilities.
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With Macro Code Without Macro Code (standard execution)

No internal system labels are needed to
execute a function block instance.

Each instance uses internal system labels (pointers). �

Consequence: The number of function
blocks you can use is only limited by the
size of the PLC memory as function blocks
are independent of system labels.

Consequence: Since the number of available system labels is
limited (FX: 128, A: 256, Q: 1024) you cannot use more than a
theoretical limited number of function blocks. In practice this number
is even smaller as system labels are also required for other internal
processes.

User-oriented execution of the function
block

Implementation of the function block construct in conformity with the
IEC 61131-3 standard

No restrictions on the handling of timers
and coils within the function block.

Restrictions on the handling of timers and coils within the function
block (subroutines).

Tab. 6-11: Macrocode execution

Fig. 6-49:
System Variables

The maximum permitted
number of system labels
(internal pointers) is
limited by the used
PLC CPU.



The function block

Use of the function block
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Fig. 6-50:
Function block for
macrocode
execution

Fig. 6-51:
Function block instance



Macrocode execution options
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FB_1 FB_2 FB_3 FB_4 FB_5

Macro NO YES NO YES YES

MC-MCR NO NO NO NO YES

EN-ENO NO NO YES YES YES

Generated
Code

LD X10
OUT M4096
LD X11
OUT M4097
LD SM400
CALL P2048
LD SM400
MOV D6144
D10

LD X20
AND X21
INCP D20

LD M3
OUT M4098
AND X30
SET M4099
LD M4098
ANI X30
RST M4099
LD M4098
AND X31
SET M4100
LD M4098
ANI X31
RST M4100
LD M4098
OUT M4101
CALL P2049
LD M4101
OUT M31
LD SM400
MOV D6145 D30

LD M4
OUT M41
LDI M4
CJ P2050
LD X40
AND X41
INCP D40P2050

LD M5
OUT M51
MC N0
M4103
LD X50
AND X51
INCP D50
MCR N0

Instance
(no macro)

LD M4096
AND M4097
INCP D6144
RET

LD M4099
AND M4100
INCP D6145
RET

System labels 1 System label
(no macro)

No system labels
(macro)

1 System label
(no macro)

1 System label
(EN/ENO and
jump)

No system labels
(macro and
MC/MCR)

Behaviour of:
- Timers
- Counters
- Outputs

The function
block is always
executed. The
timers, counters
and outputs are
thus controlled
by the program.

The function
block is always
executed. The
timers, counters
and outputs are
thus controlled
by the program.

The function block
is only executed if
the EN input is set.
This means that
the timers,
counters and
outputs retain their
status from the last
execution. Timers
continue to run.
The status of
counters,
accumulator/retenti
ve  timers and
outputs in OUT
instructions is
preserved.

The function
block is only
executed if the
EN input is set.
This means that
the timers,
counters and
outputs retain
their status from
the last
execution. Timers
continue to run.
The status of
counters,
accumulator/reten
tive  timers and
outputs in OUT
instructions is
preserved.

The statuses of
the devices are
reset:
- Timer: Count

value reset to 0,
contacts remain
off

- Retentive
timers and
counters: count
value and input
contact status
preserved,
output contact is
reset

- Devices in OUT
instructions:
outputs are
reset

- Devices in SET,
RST, SFT
instructions:
current status
preserved

Tab. 6-12: Macrocode execution options



6.7.9 Global Function Blocks

Function blocks allow global instancing, so that the same instance can be used in different
program organisation units.

How to create a global instance

� Create a program organisation unit as a function block (in our example: MAIN).

� Create an instance (Main_Instance1) of this function block (MAIN) in the Global
Variable List.

� Call up the function block in the body, and allocate to it the name of the instance.
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Fig. 6-52: Created instance

Fig. 6-53:
Function block allocated to instance



6.8 Programming Data Unit Types

Data unit types (DUT) are structured, derived data types containing a collection of variables
which can be of different data types. Data unit types can be declared as global or as local
variables.

NOTE Data unit types can only be used in the IEC editors. DUT components or arrays can not be
used in MELSEC IL

6.8.1 Declaration

Data unit types must be defined in the DUT_Pool.

All the variables in the DUT structure must be declared in a special declaration table. After this
you must then create one or more instances of the data unit type in the global variables decla-
ration table.

How to declare a data unit type

� In the Object menu select New, then select Data Unit Type.

� Enter a name for the new DUT (max. 32 characters) and confirm with OK. The name of
the new DUT is displayed in the DUT_Pool of the Project Navigator window.

� Double-click on the name of the new DUT in the Project Navigator window to open its
special declaration table.

	 Enter a name (identifier) for the variable in the first field.


 Select the data type for this variable in the second field.

� The default initial value (Initial) is added automatically. If you wish, you can also enter an
optional comment for the variable.

� Repeat steps � – � until all the variables of the data unit type are defined.

Example The following example shows the creation of a data unit type called SiloType. The variable
collection of SiloType contains two variables of the type INT and one variable of the type
BOOL.

� Enter the following lines in the declaration table for the data unit type:

� Save your entries.

�
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Fig. 6-54: Declaring variables of a data unit type



6.8.2 Use of the DUT as global variable

How to declare the DUT

� Double-click on Global_Vars in the Project Navigator window.

� Enter the following lines in the global variables declaration table:

Silo1 and Silo2 are the names of the variable of data type Silo_Type. Since the elements
in type SiloType can have different data types the address assignment is handled automati-
cally by the PLC, and no default initial values are shown.

Example You have created a Data Unit type called SiloType. Two variables of the type SiloType,
Silo1 and Silo2, have now been declared in the global variables list.The structure of both is
identical, so to reference the individual variables of each DUT you only needs to prefix their
names with the name of the respective global variable.

In Silo1 the values for the temperature and volume variables are determined by the contents
of registers D0 and D1, in Silo2 by D10 and D11. In Silo1 the Emergency Off (EmergOFF
variable) switch is controlled by the status of input X0, in Silo2 by input X1.

The variables are stored in the Global Variable List. If you apply an element of an instance of a
DUT or FB (e. g. Motor.Status) from the Global Variable List to an editor via the Variable
Selection dialogue, the corresponding DUT or FB is automatically inserted in the header of
the editor. Like for simple data types the library <Global Variables> must be selected in the
Variable Selection dialogue.

Instruction List:
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Fig. 6-55: Declaring the data unit type as global variable

SILO1 SILO2
LD D0
ST Silo1.Temperature
LD D1
ST Silo1.Volume
LD X0
ST Silo1.EmergOff

LD D10
ST Silo2.Temperature
LD D11
ST Silo2.Volume
LD X1
ST Silo2.EmergOff



Ladder Diagram and Function Block Diagram:

In the Ladder Diagram version of the example a function block of the type ‘Monitoring’ has
been programmed for assigning the register values and the Boolean input to the elements of
the DUTs. Two separate instances (Silo_1 and Silo_2) of this function block were then
created for the two silos.

�

Define direct addresses for data unit variables

The GVL has been extended to define addresses for all elements of a data unit variable. Not
defined addresses are handled by the system.

Appearance and handling

In the GVL data unit variables will display their IEC and Mitsubishi address fields in controls
similar to push buttons. On these controls the elements for which an address is defined will be
displayed in the form ‘element: address’.
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Fig. 6-56: Ladder Diagram and Function Block Diagram

Fig. 6-57: Control elements of data unit types



To view all definitions at once (if more than one definition is available), DUT entries in the GVL
can be expanded by double-clicking the row number field.

Editing

It is not possible to edit the addresses directly in the GVL. To edit the EC and Mitsubishi
addresses, click on a DUV’s IEC or Mitsubishi address field. Then a separate dialogue (appli-
cation modal) will appear and you can edit the addresses for each DUV element.

After you have selected an element you can edit this element like in other address fields in the
GVL (e.g. by. double clicking or pressing the space key).

When the two edit fields are displayed, the focus can be moved between them by clicking on
one of the fields or pressing the TAB key. By pressing ENTER or clicking outside of the edit
fields the editing will be finished and the modifications accepted. By pressing ESC the editing
will also be finished, but the modifications are cancelled.

If you activate the Automatic filling checkbox, when entering a address all variables of the
same type that are not yet addressed will be addressed automatically.

MELSEC Q/QnA only:

If the function Automatic filling is activated the additional function All types is available.

If you activate the All types function, when entering an address all addresses of all variable
types are filled automatically.

For timers and counters the All types function is not available, addresses of these types are
not filled automatically neither.
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Fig. 6-58: Expanded DUT entries in the GVL

Fig. 6-59: Opened editing dialogue for data unit variables



6.8.3 Use of the DUT as local variable

Data unit types can also be passed directly as variables:

– As input and output parameters in function blocks

– As input parameters in functions

Create the Control function block

The function block processes the input variables and passes the results to the output
variables. The input variables IN_Temperature, IN_Volume and IN_EmergOff are
declared in the header, along with the output variable Silo_Output. Silo_Output is
declared as the data unit type Silo_Type.

Calling the Control_Use function block and passing the data unit type directly as
an output parameter

The function block Control is called in the program organisation unit Control_Use,
creating the instance Silo_FB_1.

The input variables of the function block obtain their values from devices D0, D1 and X0.

The output variables of Silo_Output are passed to the data unit type Silo_DUT_1.
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Fig. 6-60:
Declaring variables for the
control function block

Fig. 6-61:
Control function block



6.9 Programming Arrays

An array is a collection of variables of the same data type. GX IEC Developer supports arrays
with up to a maximum of three dimensions.

NOTE Arrays are only supported in the IEC editors.

6.9.1 Declaration

Arrays are declared in the header of the program POU.They can be declared as local or global
variables.

Example This example shows the definition of a one-dimensional array called ArrSingle with three
elements of the type INT, and a two-dimensional array called ArrDoublewith three elements
of the type INT in the first dimension and five elements of the type INT in the second dimension.

� Open the header of a POU.

� Add a new line to the table with the following entries:

VAR: Definition of the array as a local variable in the program organisation unit ‘P_12’.

ArrSingle/ArrayDouble: Names of the arrays.

ARRAY [0..2] OF INT: The one-dimensional array has three elements (0 – 2) of the type
integer (INT)

ARRAY [0..2, 0..4] OF INT: This array is two-dimensional.The second dimension is separated
by a comma between the braces. In this example the first dimension of ArrDouble has three
elements (0 – 2) and the second dimension has five elements (0 – 4).

3(0): Number of elements (3) with the default value 0 (0)

15(0): Number of elements (3 x 5 = 15) with the default value 0 (0)

�
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Fig. 6-62: Declaring arrays in the program header



6.9.2 Calling

Instruction List:

� One-dimensional arrays

LD Actual parameter
ST Array Name [ Element ]

� Two-dimensional arrays

LD Actual parameter
ST Array Name [ Element of 1st Dimension ,

Element of 2nd Dimension ]

Example A two-dimensional array called ArrDouble has been defined with three elements in the first
dimension and five elements in the second dimension.

The data registers D0 and D1 are assigned to the following elements:

D0: Position 1 in the first dimension I, position 2 in the second dimension II

D1: Position 2 in the first dimension I, position 3 in the second dimension II

Instruction List:

LD D0
ST ArrDouble[1,2]
LD D1
ST ArrDouble[2,3]

Ladder Diagram and Function Block Diagram:

�
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0

1

2

3

4

210

D0

D1

I

II
Fig. 6-63:
Two-dimensional array:
"ArrDouble"

Fig. 6-64:
Ladder and Function Block Diagram
for arrays



6.9.3 Accessing an Array of BOOL as 16 or 32 bit Data Type

For a global or local Array of BOOL variable the first elements of the array could be accessed
as WORD/ INT or as DWORD/ DINT by using a prefix before the name of the variable.

The prefix Kn can be used to access the array elements in groups of 4 bit.
n can be 1 - 8:

� K1ArrBool accesses the array elements 1 - 4 as WORD or INT

� K2ArrBool accesses the array elements 1 - 8 as WORD or INT

� K3ArrBool accesses the array elements 1 - 12 as WORD or INT

� K4ArrBool accesses the array elements 1 - 16 as WORD or INT

� K5ArrBool accesses the array elements 1 - 20 as DORD or DINT

� K6ArrBool accesses the array elements 1 - 24 as DORD or DINT

� K7ArrBool accesses the array elements 1 - 28 as DORD or DINT

� K8ArrBool accesses the array elements 1 - 32 as DORD or DINT

To access the first elements of an Array of BOOL in a DUT the prefix Kn must be used before
the name of the array member, e.g. as MyDUTVar.K4ArrBool.

GX IEC Developer Reference Manual 6 – 73

Programming Programming Arrays

Fig. 6-65: Example for declaring ArrBool ARRAY [1..32] OF BOOL



6.10 Programming Timers and Counters

6.10.1 TIMER and COUNTER Functions

The timer and counter functions are stored in the manufacturer library.

Timers and counters always have the following four elements:

NOTE The use of the various functions is illustrated below using a timer as an example. Counters
are used in exactly the same way.

The TIMER_M function

NOTE A detailed example of the use of the TIMER_M function is provided in the Beginner’s
Manual.

The TIMER_M function both passes the set point value and starts the timer TC (TCoil).The set
point value is passed to TValue. With normal timers the set point value is passed directly. With
extended timers the passed set point value is assigned to the timer and the set point value
register (see below).
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Timer Functions Counter Functions Operands Action

TIMER_M COUNTER_M
Normal timers/counters
and extended
timers/counters

Pass set point value and
call (start) timer/counter

TIMER_VALUE_M COUNTER_VALUE_M Extended timers/
counters only

Pass set point value

TIMER_START_M COUNTER_START_M Call (start) timer/counter

TIMER_H_M - MELSEC Q/QnA series’
high-speed timer

Pass set point value and
call (start) timer
Set timer intervals by
parameters

Tab. 6-13: TIMER and COUNTER functions

Timer Counter

Set point value TValue CValue

Actual value TN CN

Output coil TC CC

Input contact (status) TS CS

Tab. 6-14: TIMER and COUNTER elements

Fig. 6-66:
TIMER_M
Use of the normal timer TC20

Use of the extended timer TC256



The TIMER_VALUE_M and TIMER_START_M functions

Using TIMER_VALUE_M and TIMER_START_M together provides exactly the same
functionality as TIMER_M. The only difference is that the parameter passing and timer start
operations are handled separately, which makes it possible to use them at different points in
the PLC program. TIMER_VALUE_M and TIMER_START_M can only be used with the
extended timers, and you must define the set point values registers for the extended timers.

Defining the reference value registers for extended timers and counters

You must always define and set a number of parameters when you use timers or counters.See
Section 2.9.6 System Variables for the setting of Timer and Counter.

6.10.2 TIMER and COUNTER Function Blocks

A selection of new standard function blocks are provided for programming local timers and
counters. The system automatically uses free timers and counters from the system range.

Advantages: No direct timer and counter addresses are required. You can create any number
of instances – depends on the number of system timers – with different timers from just one
function block.

The following function blocks are provided:
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Fig. 6-67:
TIMER_VALUE_M
Passes the
reference value to
the extended timer
TC256

TIMER_START_M
Starts timer TC256

Function Blocks Meaning Comment

TIMER_10_FB_M 10-ms-Timer

TIMER_100_FB_M 100-ms-Timer

TIMER_CONT_FB_M retentive timer

TIMER_HIGH_FB_M high-speed timer MELSEC Q/QnA series only

TIMER_LOW_FB_M low-speed timer MELSEC Q/QnA series only

TIMER_CONTHFB_M retentive high-speed timer MELSEC Q/QnA series only

COUNTER_FB_M counter

Tab. 6-15: TIMER and COUNTER Function Blocks



MELSEC Q/QnA series’ timers

The timers will act as high-speed or low-speed timers when they are activated by the appro-
priate instructions in the PLC program.

The timer intervals for the high-speed and low-speed range can be set in the PLC Setup
dialogue box (� page 5-50). In order to be compatible to A series projects, the function blocks
TIMER_10_FB_M and TIMER_100_FB_M are available in the MELSEC Q/QnA series as
well. In a MELSEC Q/QnA series project they are the same as the function blocks
TIMER_HIGH_FB_M and TIMER_LOW_FB_M.But in this case, they are no longer 10-ms and
100-ms timers. Instead the timer interval set by the parameters is valid.

Defining the system range

You must define the system range before attempting to use local timers or counters. The
system then automatically selects a free timer or counter from this range. A compile error will
be displayed if you try to use these new function blocks without previously defining the corre-
sponding system range.

� Open the System Variables dialogue box (Extras – Options – System Variables).

� Define the necessary system range in the System Timers or System Counters fields.
This disables access to these addresses by other applications using direct addressing.
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MELSEC A/AnS MELSEC Q/QnA Comment

TIMER_10_FB_M TIMER_HIGH_FB_M For the MELSEC Q/QnA series, it is not the intervals 10 ms
and 100 ms which are valid, but the timer interval set by the
parameters.TIMER_100_FB_M TIMER_LOW_FB_M

Tab. 6-16: MELSEC Q/QnA timers

Fig. 6-68:
System timer
System counter



Instantiation

The use of these new function blocks is illustrated below using a 10 ms timer as an example.

� Declare the following variables in the header:

� Select function block TIMER_10_FB_M in the body.

The timer function block has the following input and output variables:
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Fig. 6-69:
TIMER_XYZ is the instance of
function block TIMER_10_FB_M
Timer start address

Fig. 6-70:
Selecting the timer function block

Fig. 6-71:
The timer function block TIMER_10_FB_M for 10 msec
timers
TIMER_10_FB_M for 10-ms-Timer

Designation in the Function Meaning

Coil Coil Activation condition for the timer process

Preset Set point value

ValueIn Initial value (Normally: 0)
➜ Note

ValueOut Actual value

Status Output contact The output contact is set when execution of the function
block is complete.

Tab. 6-17: Timer function block designations



� Assign the instance names defined in the header to the function block and allocate the
necessary input and output variables.

NOTES If you do not need one of the parameters for your application, e.g. ValueIn in the example,
you can simply leave the contact unassigned. In this case, no program code will be
generated.

For MELSEC FX series controllers the ValueIn parameter must be left unassigned!
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Fig. 6-72:
Instance TIMER_XYZ of function block
TIMER_10_FB_M



6.11 The EN input and ENO output

Some programming instructions have an EN input and an ENO output in addition to the normal
input and output variables.These instructions are identified in the standard library by the suffix
_E, e.g. ABS_E, BCD_TO_DINT_E . The functions in the manufacturer library do not have this
suffix as they are all automatically provided with an EN input and an ENO output.

Functionality

The EN input controls the execution of the instruction.

There are several different ways to connect the EN input:
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Fig. 6-73: Different EN input connections




�

�

�

�

�

�

�

Item Description

� Direct connection of the EN input to the power bar at the left (LD only). The EN input is then always on
and the instruction is always executed. When ADD_E is used like this it will produce exactly the same
result as ADD without the EN input.

� Link the EN input to a Boolean input variable. The instruction is then only executed when Variable_1 is
active.

� Connect the Boolean result of a an operation to the EN input. The instruction is then only executed when
the result of the operation is TRUE.

� Connect the EN input to the ENO output of the preceding instruction. The three instructions are then only
executed when Variable_1 is active.

� The ENO output does not have to be connected; it can be left unconnected if it is not needed.

Tab. 6-18: EN input items



6.11.1 Execution with and without EN and ENO

User function WITH_EN_ENO

Execution of the function is controlled by relay M4 (when the input EN is processed).

M4 = 1 (TRUE):

– The function is executed.

– The result of the operation is written to D56.

– A new value is always written to D56.

M4 = 0 (FALSE):

– The function is not executed.

– No new value is written to D56. The value stored in D56 remains unchanged, it is not
reset.

User function WITHOUT_EN_ENO

– The function is executed continuously.

– The result of the operation is written to D57.

– A new value is always written to D57.
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Fig. 6-74:
User-written function WITH_EN_ENO:

With EN input and ENO output

User-written function WITHOUT_EN_ENO:

Without EN input and ENO output



7 Guided Ladder Editor

7.1 Main Features

The following are the main features of the Guided Ladder Editor:

Implementation of an additional programming mode, Guided Mode.

� Guided ladder circuit editing

� Character Mode programming

� Auto Comment feature

� Ladder Editing Settings

Enhancement for the ease of ladder programming

� Additional functionalities

� User-friendly hotkeys

� Enhanced program component variable name display

Each item of the main features is explained in detail in the following sections.
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7.1.1 Guided Mode

The Guided Mode is an additional ladder-programming mode considering the possibility of
programming mainly using the keyboard, and to reduce the mouse operations.

Guided Editing (Guided ladder circuit editing), Character Mode (Character programming
mode) and Auto comment functions are collectively known as Guided Mode and Guided
Mode is just a name for the new ladder circuit-editing mode.

Guided Mode can be accessed from the following menu:
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Fig. 7-1: Menu Guided mode

� �

�

�

�

�

No. Explanation

� Guided Mode

� Guided editing

� Overwrite Mode

� Insert Mode

� Line Mode

� Auto Comment

Tab. 7-1: Explanation for Fig. 7-1



NOTE The circuits created in Select Mode or Inter connect Mode are not affected when the user
changes the current editing mode to Guided Mode.
The circuit created in Select Mode or Inter connect Mode can be edited in Guided Mode.
Character Mode is an internal functionality of Guided Mode and it cannot be accessed
directly from the menu.But, Guided Editing and Auto Comment can be accessed from the
user menu items.
Guided Editing and Auto Comment can also be accessed using their hotkeys and menu
short cuts.

The following are the menu items and hotkeys related to Guided Mode.

7.1.2 Guided Editing Modes & Cursors

There are 3 types of Guided Editing Modes.

Insert Mode

Inserts a program component when Insert key is activated.

Overwrite Mode

Overwrites an existing program component when Insert key is not activated.

Line Mode

Draws connecting line between program components and handles the function block
placement in a network.
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No. Menu Item Hotkey

1 [Tools]-[Guided Mode]- [Guided Editing] CTRL+G

2 [Tools]- [Guided Mode]- [Insert Mode] INSERT

3 [Tools]- [Guided Mode]-[Line Mode] CTRL+L

4 [Tools]-[Guided Mode]-[Auto Comment] CTRL+SHIFT+A

5 [View]-[Colors]-[Overwrite Mode Cursor] —

6 [View]-[Colors]-[Insert Mode Cursor] —

7 [View]-[Colors]-[Line Mode Cursor] —

8 [View]-[Colors]-[Cursor Fill] —

9 [Tools]-[Network Elements]-[Delete Line] CTRL + SHIFT + DEL

Tab. 7- 2: Menu items for Guided mode



The Guided Editing Modes and their associated cursors are as follows:

a) Normal cursor or Overwrite Mode cursor

The Normal cursor is a red (RGB = 255, 0, 0 by default) rectangle of 5 Grids of width and 4
Grids of height. The color of the cursor can be changed using the View - Colors - Overwrite
cursor menu. The View - Colors - Overwrite Cursor will display a color selection dialogue
same as the dialogue for changing the color of the Grid or Background in the previous versions
of GX IEC Developer.

b) Insertion cursor or Insert Mode cursor

The Insertion cursor is a blue (RGB = 0, 0, 255 by default) rectangle of 5 Grids of width and 4
Grids of height. The color of the cursor can be changed using the View - Colors - Insert
cursor menu. The View - Colors - Insert Cursor will display a color selection dialogue same
as the dialogue for changing the color of the Grid or Background in the previous versions of GX
IEC Developer.
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Fig. 7-2: Normal cursor

�

�

�

No. Explanation

� 5 Grids

� 4 Grids

� Thickness of the cursor line is 4 Pts.

Tab. 7-3: Explanation for Fig. 7-2

Fig. 7-3: Insertion cursor

�

�

�

No. Explanation

� 5 Grids

� 4 Grids

� Thickness of the cursor line is 4 Pts.

Tab. 7-4: Explanation for Fig. 7-3



The Grid cursor is a minimized form of the Normal cursor or Overwrite cursor.

When the Tools - Guided Mode - Line Mode menu item is selected, the Grid cursor will
appear at the top left corner of the current cursor position of the Normal cursor.

c) Grid cursor or Line Mode cursor

The Grid cursor is a green (RGB = 0, 255, 0 by default) square of 1 Grid size on each side.The
color of the cursor can be changed using the View - Colors - Grid cursor menu. The View -
Colors - Grid Cursor will display a color selection dialogue same as the dialogue for changing
the color of the Grid or Background in the previous versions of GX IEC Developer.

NOTE The Normal cursor or Overwrite cursor will appear on the screen but it cannot be used
when Grid cursor is displayed.
In the following sections the word “Cursor” implies that the Normal or Insertion cursor is
used. It is not applicable to Grid Cursor if not mentioned explicitly.
Clicking a different location in the network can also move the cursor and it is applicable to all
kind of cursors used in Guided Mode.
Displaying and hiding the cursor raster is possible using the View - Grid Menu.
The Grid menu can enable or disable both the Grid and Cursor raster.
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Fig. 7-4: Grid cursor

�

� �

� �

Fig. 7-5: Grid cursor in Normal cursor

No. Explanation

� 1 Grid

� Thickness of the cursor line is 2 Pts.

Tab. 7-5: Explanation for Fig. 7-4

No. Explanation

Grid cursor

Normal cursor area

Tab. 7-6: Explanation for Fig.7-5



Behaviour of Grid Cursor

Cursor movements & Keyboard shortcuts

The normal cursor or insertion cursor can be moved in 4 directions, left, right, top and
bottom using the left, right, top and bottom arrow keys of the standard keyboard.

NOTE After selecting a function block, if the user presses the Space key and an arrow key, it will
move the Function block by 1 grid position respectively to the arrow key pressed.

The other key operations with the normal cursor or insertion cursor are as follows:
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Key Operation

Arrow keys Moves the Grid cursor according to the Up, Down, Left, Right arrow key pressed.

5 Draws a vertical line at the left side of the Grid cursor.

6 Draws a horizontal line at the bottom of the Grid cursor.

9 Places an input variable of a FB at the left side of the Grid cursor.

0 Places an input variable of a FB at the right side of the Grid cursor.

Delete Deletes horizontal or vertical line that exactly fits with the size of Grid cursor

Tab. 7-7: Behaviour of Grid Cursor

Fig. 7-6: Cursor movements

Left Right

Up

Down



Selection of normal cursor or insertion cursor area

When some consecutive cursor areas are selected with SHIFT Key, the selected area will
appear as shown below:

The user can change the color of the cursor using the View - Colors - Cursor Fill menu. The
View - Colors - Cursor Fill will display a color selection dialogue same as the dialogue for
changing the color of the Grid or Background in the previous version of GX IEC Developer.
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Fig. 7-7: Selected cursor area

By default, solid fill with Blue color (RGB= 0,0,255),

Key Operation

HOME Move the cursor to the first element position of the row

END Move the cursor to the last element position of the row, only if circuit wrapping
is set

CTRL + HOME Move the cursor to the first element position of the first row

CTRL + END Move the cursor to the first element position of the last row

SHIFT+HOME Select all grids from the current position to the first element position of the row.

SHIFT+END
Select all grids from the current position to the last element position of the row,
only if circuit wrapping is set. This has no effect when circuit-wrapping position
is not set.

SHIFT + <Arrow key> Selects the consecutive program components from the current cursor location
in the direction of cursor movement until the arrow key is released.

ENTER Displays the instruction and the device name/variable name in the Character
Mode Input dialogue.

CTRL + C or

CTRL + INSERT
Copies the program components in the cursor selected area

CTRL + V or

SHIFT + INSERT
Pastes the copied program components at the current cursor location

INSERT Toggles between Overwrite Mode and Insert Mode

CTRL+L Activates Line Mode

SPACE Selects/deselects the function block, if the cursor is over FB.

SPACE + <Arrow key> Moves the function block by 1 grid position in arrow key direction.

DELETE Deletes the program component at the current cursor location, except function
block or deletes the function block only if it is selected with SPACE key.

CTRL+DOWN Adds a new row to the end of the current network

CTRL+UP Deletes the last empty row of the current network

Tab. 7-8: Keyboard shortcuts



Color Selection Dialogue

The Color selection dialogue same as the following will be displayed for all the cursor related
color selection menu items. The user can change or set the color using this dialogue.

Cursor and the program components

Contact:

Horizontal lines will be added left and right of the contact, to fit the size of the cursor.

Coil:

Horizontal lines will be added only at the left of the coil, to fit the size of the cursor.

NOTE There is no horizontal line at the right of the coil to avoid compiler errors.
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Fig. 7-8: Color Selection Dialogue

Fig. 7-9: Contact

Current Size Modified SizeModified SizeCurrent Size

Expanded to fit to the size of cursorExpanded to fit to the size of cursor

Fig. 7-10: Coil

Modified SizeCurrent Size

Expanded to fit to the size of cursor



Function block:

There is no change in the size of the function block.

Horizontal line:

A line with a width of a grid will be added at the right side of the horizontal line, to fit the size of
the cursor.

Vertical line:

A line of grid width will be added at the bottom of the vertical line, to fit the size of the cursor.

NOTES The above mentioned changes in the size of the program components do not change the
sizes of the program components of other modes.

The expansion of the size of program components should be made as the method of adding
lines with the program components in Interconnect or moving the program components
when Auto connect feature is enabled, so that there is no difference between the current
sizes of the program components, internally.
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Fig. 7-11: Function block

Modified SizeCurrent Size

No changes in size

Fig. 7-12: Horizontal line

Modified SizeCurrent Size
Expanded to fit to the size of cursor

Fig. 7-13: Vertical line

Modified SizeCurrent Size

Expanded to fit to the size of cursor



7.1.3 Guided editing

Guided Editing allows the user to edit a program using simple keyboard operations.

The main features of Guided Editing are:

� Programming using keyboard

� Automatic ladder circuit wrapping at the user defined location

� Selection of program components with keyboard

� Insertion and deletion of program components

� Positioning of function blocks

Programming using keyboard

In Guided Mode, a ladder circuit can be created, simply by pressing the hotkeys of the
program components in a sequence. The program component will be placed at the current
cursor location and after placing the program component the cursor will be moved to the next
position, horizontally. If the next position is exceeding the user defined wrapping location, the
cursor will be shifted to the position where the next program component can be placed.

� Short cut key

� Current cursor position

The above circuit can be created in 3 steps as given below:

� Step 1: Press the keys 1-1-1-7 and 1-1 in sequence.

� Step 2: Move the cursor to the top of the vertical connecting line position.

� Step 3: Press the key 6.

NOTE The above method is applicable when the user does not check the Do not allow “?” as a
variable name of Ladder Editing settings. If it is checked, the user has to set the variable
name using the Variable Selection dialogue.
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Fig. 7-14: Programming using keyboard

1 1 1 7 �

1 1

6

�



Automatic ladder circuit wrapping at the user defined location

The following operations will be carried out, if the ladder circuit wrapping is active.

� Wrapping of circuit:

If the ladder circuit exceeds the user-defined location, it will be wrapped. Refer to Wrap after
setting in the Ladder option window.

NOTES The wrapping is adapted from the current Inter connect mode or moving the program
components when auto connect feature be enabled.

The user-defined wrapping location is valid only for the program component that is going to
be placed in the network and it will not have any effect on pre-created networks or already
positioned program components.

In active wrapping mode it is possible to shift the elements beyond the wrapping position. In the
following example, a new contact is inserted. The user will be prompted to disable the
wrapping for this action.
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Fig. 7-15: Wrapping of circuit

Fig. 7-16: A new contact is inserted in an already filled line

Fig. 7-17:
Displayed
warning



If the ladder circuit wrapping is temporarily disabled, the contact will be inserted although it
exceeds the user-defined location:

� Positioning of coil

If the ladder circuit does not exceed the user-defined location and it has a coil at the end, the
coil will be positioned and placed according to the user-defined wrapping location.

Insertion and deletion of program components

A program component can be inserted or deleted after selecting it. Insertion and deletion of
program components can be done as an Overwrite or as an Insertion according to the activa-
tion of the Insert key of the standard keyboard.

According to the activation of the Insert key, the menu item Insert Mode or Overwrite Mode of
the Guided Mode menu will be checked or not checked.
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Fig. 7-18: Insertion of a contact

Fig. 7-19: Positioning of coil

Fig. 7-20: Guided Mode menu

� �

No. Explanation

No check mark on Insert Mode means that Overwrite Mode is selected (check mark on Overwrite Mode)

Insert Mode – Can be activated by Insert key.

Tab. 7-9: Explanation for Fig. 7-20



Insertion and deletion with no Insert key activation - Overwrite Mode

� Insertion

� Deletion
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Fig. 7-21: Insertion

The cursor is here and 1 key is
pressed to insert new contact.

The contact is overwritten.
The vertical line is not deleted.

Fig. 7-22: Deletion

The cursor is here and
Delete key is pressed to
delete this contact.

The contact at this position is
deleted.



Insertion and deletion with Insert key activation - Insert Mode

� Insertion

� Deletion

Deleting single selected elements

All elements inside the cursor rectangle (except FB) are selected automatically.Specific selec-
tion of single elements is possible by pressing the SPACE-key.With each SPACE, the selection
changes to the next element which is completely or partially inside the grid.
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SPACE SPACE

Fig. 7-23: Insertion

The contact is inserted and
the cursor is moved along
with the contact at the
inserted position.

The cursor is here and 1 key
is pressed to insert new
contact.

Fig. 7-24: Deletion

The contact and vertical line
at this position are deleted
and it replaced with a
horizontal line.

The cursor is here and
Delete key is pressed to
delete this contact.

Fig. 7-25: Selection of a single element



Deletion of connecting lines

Deletion of only connecting lines is also possible using the Delete Line menu item under the
menu Tools - Network Elements.

After selecting the Delete Line menu item (not the delete key), if the cursor is moved over the
network, the connecting lines will be deleted. Delete Line will not delete any program compo-
nents.

Open Row and Open Column in Guided Mode

Open Row and Open Column menu items under the Tools menu can be used to add a new
cursor row, cursor column respectively at the cursor position.

� Open Row:

If Open Row is executed at the above cursor position, the circuit will be changed as shown
below.
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Fig. 7-26: Deletion of connecting lines

Using Delete line, only these
connecting lines can be
deleted.

Fig. 7-27: Open Row

Fig. 7-28: Open Row



� Open Column:

If Open column is executed at the above cursor position, the circuit will be changed as shown
below.

NOTES During insertion and deletion with no Insert key activation, Normal cursor will be displayed.
(Ref. Cursor for Guided Mode)

During insertion and deletion with Insert key activation, Insertion cursor will be displayed.
(Ref. Cursor for Guided Mode)

The status of activation of the Insert key will be displayed on status bar. “OVR” will be
displayed when Insert key is not pressed, “INS” will be displayed when Insert key is pressed
and it will be empty for all other modes.User can add or delete the status panel of the OVR or
INS display from the status bar, using the View - Configure Status Bar menu.

Deleting of multiple program components is also possible, if they are selected with the
cursor.

The insertion of program components at the last cursor position from the point of user
defined wrapping location is not allowed. But the overwrite or the deletion of program
component at the last cursor position from the point of user defined wrapping location is
allowed.

Insertion & User-defined circuit wrapping :
In general, when a program component is inserted, the circuit will be expanded horizontally.
But, the circuit cannot be expanded or wrapped after the user-defined wrapping settings.

The insert key activation and deactivation is common to all ladder networks in the project.
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Fig. 7-29: Open Column

Fig. 7-30: Open Column



NOTES Wrapping is not possible when inserting a program component, if the circuit has some
user-defined location and there is no more space to insert a new component. In that case, a
dialogue will be displayed to choose if the wrapping should be temporarily disabled.

Open column is also not possible if the inserted column exceeds the circuit wrapping
setting.

Refer to the Wrap after setting in the Ladder option window.
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Positioning of function blocks

If the user tries to place a function block in the Guided Mode, the Function Block Selection
dialogue will be displayed.The user has to select the function block from the operators list box
and then press the Apply button to place a function block in the network.

Minimum cursor area needed for a function block

For placing a function block, a minimum cursor area is needed. It is calculated as follow:

7 – 18 MITSUBISHI ELECTRIC

Main Features Guided Ladder Editor

Fig. 7-31:
Function Block Selection

Fig. 7-32: Minimum cursor area needed for a function block

�

�

�

No. Explanation

� Current Cursor location

� Required Width of FB (RWFB)

� Required Height of FB (RHFB)

Tab. 7-10: Explanation for Fig. 7-32



In general,

Required Height of Function Block = Actual Height of Function Block

+

cursor area at the bottom of function Block

Required Width of Function Block = Actual Width of Function Block

+

1 cursor area on both left and right of the Function Block

More precise, it can be calculated as given below:

Calculating Required Height of FB (RHFB)

If (AHFB Mod 5) not equal to 0

RHFB = (((AHFB – (AHFB Mod 5)) /5)+ 2) * 5

If (AHFB Mod 5) equal to 0

RHFB = ((AHFB /5)+ 1) * 5

Where,

AHFB = Actual Height of Function Block

RHFB = Required Height of Function Block

Calculating Required Width of FB (RWFB)

If (AWFB Mod 5) not equal to 0

RWFB = (((AWFB – (AWFB Mod 5)) /5)+ 3) * 5

If (AWFB Mod 5) equal to 0

RWFB = ((AWFB /5)+ 2) * 5

Where,

AWFB = Actual Width of Function Block

RWFB = Required Width of Function Block

NOTES If there is no minimum cursor area in the circuit, the function block cannot be placed in a
network. An error message as shown below will be displayed if there is no minimum cursor
area.

Consecutive placement of FB/FUN is possible, if the FB/FUN to be placed does not hide any
element or exceeds the user defined network wrap settings.
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Variable name of function block

The first 8 characters of the variable name of the function block will be displayed in the circuit.
While placing the function block, it will be positioned automatically to secure the space for a 8
characters length variable name. The variable name should be scrolled to view the characters
after the 8th position. The variable name will be displayed with “>”mark at the end (as shown
below) if it exceeds 8 characters.

NOTES If there are no program components at the left or right side of a function block, the input
variable or output variable will be added to the function block.

The input or output variable of a function block will be removed automatically, if the user
places some connecting lines between the function block and other program component.

The horizontal connecting lines of circuit may get disconnected because of placing a
function block in an existing circuit.
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Fig. 7-33: Variable name of function block

�

�

��

�

� �

No. Explanation

� Exceeding 8 characters

� User has to create this part after placing FB

� Space for 8 characters size variable name

� A cursor row is deleted here to make FB in adjacent rows.

Tab. 7-11: Explanation for Fig. 7-33



Function block related operations

Connecting Function block pins with some other program component

Placing the input and output variables of a function block

In Line Mode, the user can place the input or output variable of a function block using menu
items or the hotkeys. The input or output variables of a function block cannot be placed in
Insert and Overwrite modes.
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No. Operation Implementation Details

1

Placement of FB

At the Top Left corner of a
network 1 It will be treated same as placing a function block by clicking at

the Top Left grid of the network.

At the Top Right corner of a
network

1 It will be treated same as placing a function block by clicking at
the Top grid row of the network.

2 The current cursor location should be at 2 cursor locations prior
to the Right end of the current cursor row.

At the Bottom Left corner of a
network 1 It will be treated same as placing a function block by clicking at

the Bottom Left grid of the network.

At the Bottom Right corner of a
network

1 It will be treated same as placing a function block by clicking at
the Bottom grid row of the network.

2 The current cursor location should be at 2 cursor locations prior
to the Right end of the current cursor row.

At the left end or the first cursor
column of the network 1 It will be treated same as placing a function block by clicking at

the Left most grid of the network.

2 Moving a function block

1 The function block should be selected with Space Key.

2
After selecting the function block, it can be moved using arrow
keys while Space key is pressed. Each pressing of the arrow
key will move the function block by one grid position.

3 Inserting a function block or
placing FB next to a contact 1 It will be treated same as placing a function block by clicking at

the Left most grid of the network.

4 Deleting a function block

1 The function block should be selected with Space Key.

2
After selecting the function block, it can be deleted by pressing
the Delete key.

Tab. 7-12: Function block related operations

Fig. 7-34: Connecting Function block pins

Connecting FB pins with the other part of a program
component can be drawn using Grid cursor



Creating connected and unconnected crossing

To make an unconnected crossing after M2 and M11, the Vertical line key (Hotkey 5) should
be pressed after selecting the cursor area of contact M3, cursor area next to contact M8 and
the cursor area next to contact M11 using the Shift and Arrow keys or dragging the cursor
using the mouse.

To make a connected crossing, the Vertical line key (Hotkey 5) should be pressed at two
locations, at cursor area of contact M3 and cursor area next to contact M8.

7 – 22 MITSUBISHI ELECTRIC

Main Features Guided Ladder Editor

Fig. 7-35: Start

Fig. 7-36: Unconnected crossing

Unconnected crossing

Fig. 7-37: Connected crossing

Connected crossing



7.1.4 Character mode

The Character Mode is a function implemented inside the Guided Mode. It can be accessed
by typing the direct instructions for the placement of program components in the Guided Mode
and it cannot be accessed directly from the menu.

The placement of program components in a network is possible by typing the direct
instructions. The program component will be inserted at the current cursor position.

The following is the list of instructions that can be used to access Character Mode in Guided
Mode. (The items in bold letters in the following table are the instructions.)
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No. Instruction Program Component Remarks

1 LD Device/Variable name Contact

Program component with valid device/variable
name can be entered directly. In case of
unknown variable name, the Variable Selection
dialogue will be displayed.

2 DI Device/Variable name Contact negation

Program component with valid device/variable
name can be entered directly. In case of
unknown variable name, the Variable Selection
dialogue will be displayed.

3 OUT Device/Variable name Coil

Program component with valid device/variable
name can be entered directly. In case of
unknown variable name, the Variable Selection
dialogue will be displayed.

4 FB [Function block name] Function Block

If a valid ‘Function block name’ is entered, the
function block will be placed. Otherwise, the
Function Block Selection dialogue will be
displayed.

5 HL Count Horizontal Line Draws horizontal lines according to the value set
in Count.

6 VL Count Vertical Line Draws vertical lines according to the value set in
Count.

7 LDL Device/Variable name L Connection Contact

Program component with valid device/variable
name can be entered directly. In case of
unknown variable name, the Variable Selection
dialogue will be displayed.

8 LDI L Device/Variable
name

L Connection Contact
negation

Program component with valid device/variable
name can be entered directly. In case of
unknown variable name, the Variable Selection
dialogue will be displayed.

9 JMP Label Jump

10 IV Device/Variable name Input Variable

Program component with valid device/variable
name can be entered directly. In case of
unknown variable name, the Variable Selection
dialogue will be displayed.

11 OV Device/Variable name Output Variable

Program component with valid device/variable
name can be entered directly. In case of
unknown variable name, the Variable Selection
dialogue will be displayed.

12 RET Return

Tab. 7-13: Character mode



Character Mode input

In Guided Mode, if the user presses any of the alphabet keys or just the Enter key, the
Character Mode Input dialogue will be displayed.

In the Character Mode the user can directly input instructions in any of the 2 methods:

� Select the instruction from the combo box and type the device/variable name.

� Type the instruction and device/variable name in the Edit box itself.

After inputting the direct instruction, the user has to press the Enter button or Enter key of the
keyboard to update it to the network. To close the Character mode input dialogue, the Close
button or ESC key of the keyboard should be pressed. Some help information to type the
instruction will be displayed if the user presses the [?] button or F1 key of the keyboard.

The character mode input dialogue will be closed after every successful direct command input
and it will appear again if the user presses any of the alphabet keys or just the Enter key.

If there is no instruction or ‘FB’selected in the combo box and characters are typed into the edit
field, a list opens automatically at the bottom of the edit field. This list selects the first function
block, which matches the entered character combination.By pressing the cursor down key, the
list can be entered as the proper function block and can be selected to the edit field by the
ENTER key.
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Fig. 7-38: Character Mode input

��
� �

�

No. Explanation

� Combo box for selecting the instruction

� Space for typing the instruction

� Update the contents

� Close the dialogue

� Instruction help information

Tab. 7-14: Explanation for Fig. 7-38

Fig. 7-39: Character mode input



The function block name can be extended with all valid variable names, separated by SPACE.
These variables are automatically added to the function block. If there are more input/output
pins left than variables and ‘Automatic Input/Output Variables’ is active, ‘?’ is selected as
variable name. If the function block is placed next to a horizontal line, the corresponding input
pin is connected to this line and an assigned variable is ignored.

As soon as a valid function is recognised by a following SPACE, a ToolTip window appears,
showing the variable definition from the corresponding header.The current edited variable will
be highlighted in the ToolTip window.
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Fig. 7-40: Function block name

Fig. 7-41: Input of a variable

Fig. 7-42: Inserted function block



NOTE If the variable name of the user typed instruction is not present in the Global, Local header
settings, Variable Selection dialogue will be displayed automatically.
The user has to set the variable name using the Variable Selection dialogue before the
program component is placed in the network.

NOTES An error will be displayed if there is any error in the instruction, the device, the variable, or
function block name typed in the Character Mode Input dialogue.

Variable selection dialogue will be displayed, if the user presses the F2 key after clicking the
space for typing instructions of the Character Mode Input dialogue. The variable selected in
the Variable Selection dialogue will appear in the Character Mode Input dialogue, if the user
presses the Apply button of the Variable Selection dialogue.

If Enter key is pressed and there is some program component at the location of the Guided
mode cursor, the Character Mode Input dialogue will be opened and the direct instruction
for the program component will be displayed. (IV & OV instructions are available only in Line
Mode.)

The user can overwrite or insert an element using Character Mode Input dialogue, but
incase of FB it is possible only if there is a Minimum cursor area for a function block.

7.1.5 Auto comment

Auto Comment is an option available in Guided Mode. The purpose of Auto comment is to
induce the user to insert a comment into the network that is created in Guided Mode.

The properties of Auto Comment are:

� It will insert a comment block at the beginning of a new network created using Edit - New
Network menu item in Guided Mode.

� It will also insert a comment block at the beginning of the network if the placement of the
very first program component is made in Guided Mode, even if network is created newly in
Select Mode or Interconnect Mode.

� Auto Comment option does not have any effect on the networks created by placing the
very first program component in Select Mode or Interconnect Mode. The comment
blocks will not be added for those networks.

� The number of characters per Comment line depends on the Auto Comment block width
value in the Ladder Option settings. The height of the comment block will be grown or
expanded, if the number characters in a comment line exceed the Auto Comment block
width.
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Fig. 7-43:
Variable selection



� Auto comment will be disabled if Esc key is pressed and no new auto comment blocks will
be added for the new network created using Edit-New Network menu item or the
placement of the very first program component is made in Guided Mode. It is effective only
for the active project.

� Auto Comment will be enabled when the user selects Guided Mode in a new project.

� When Auto Comment is enabled, the very first program component will be placed at the
second Guided Mode cursor row from the top of the active network.

� When the height of the Auto Comment block exceeds the height of the Guided Mode
cursor, a new Guided Mode cursor row will be inserted at the bottom of the current
comment block to make it grow further.

� In Guided Mode, the user can edit an Auto Comment block by placing the Guided Mode
cursor over it and pressing the Enter key.
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Fig. 7-44: Comment block

�

�
�

No. Explanation

� Comment block

� Equal to the value set in the Comment block width settings

� Grow with Comment

Tab. 7-15: Explanation for Fig. 7-44

Fig 7-45: Second cursor row

Second cursor row

Fig. 7-46: Height of the Auto Comment block



� The maximum number of characters in a comment block is that of Select Mode and there
is no change in Guided Mode.
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Fig. 7-47: Placing the Guided Mode cursor



7.1.6 Characteristics of guided mode

Changing in & out of Guided Mode

Changing into Guided Mode or changing out of Guided Mode to some other mode can be
done easily with the mouse click on toolbar buttons or using the menu or menu short cuts.

Toolbar Button:

Menu:

Please refer to section 7.3 User-friendly hotkeys for the proper hotkeys of the above menu
items.

Masked functions in Guided Mode

The functions available in other mode but not needed in Guided Mode will be masked and they
cannot be used in Guided Mode.

The following functions will be masked in Guided Mode (in all Overwrite, Insert and Line
Mode):

� [Tools]-[Auto Connect]

� [Tools]-[Recalculate Line]

The following functions will be masked in Overwrite and Insert Mode but available in Line
Mode:

� [Tools]-[Network Elements]-[Input Variable]

� [Tools]-[Network Elements]-[Output Variable]
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Fig. 7-48: Icons

�

�

�

No. Explanation

� Select mode

� Interconnect Mode

� Guided editing

Tab. 7-16: Explanation for Fig. 7-48

Fig. 7-49:
Menu



Functions specific to Guided Mode

The following menu items are specific to Guided Mode:

[Guided Mode]- [Insert Mode]

[Guided Mode]-[Line Mode]

[Guided Mode]-[Auto Comment]

[Tools]-[Network Elements]-[Delete Line]

Right Click Menu items

In Guided Mode, the user can access the following menu items using right click on the ladder
editor window. The right click menu items are dependent of the current user selection Mode
and will change accordingly.

NOTE The menu item Guided Editing will be added with the current right click menu of the Select
Mode or Interconnect Mode. The user can activate the Guided Mode from Select or
Interconnect Mode, by clicking the Guided Editing right click menu item.
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Right click menu item Remarks

Select Mode Changes to the Select Mode

Interconnect Mode Changes to the Interconnect Mode

Insert Mode Toggles Insert and Overwrite Mode

Line Mode Changes to Line Mode

Auto Comment Toggles Auto Comment

———————————————- A separator

Open Row Inserts a new cursor row at the current cursor location

Open Column Inserts a new cursor column at the current cursor location

Delete Line Activate/deactivate the delete line function

Disable Circuit wrapping Disables the circuit wrapping settings. (Displayed only when
the user has made the circuit wrapping settings.)

Input Variable
Places an input variable of a function block.
(Displayed only in Line Mode.)

Output Variable
Places an output variable of a function block.
(Displayed only in Line Mode.)

Tab. 7-17: Right Click Menu items



7.1.7 Editing a pre-created circuit in Guided Mode

The following circuit locations cannot be edited in Guided Mode. The Guided mode cursor
can scroll over the location but does not have any effect on it.

A part of a multiline variable name

The cursor can scroll over the variable name but the variable name can be edited only if the
cursor is over a program component and not over a part of a variable name.

A part of a function block

NOTES The following operations can be done at the part of a function block.

� The function block can be deleted, if it is already selected.

� Horizontal and vertical lines can be drawn using Grid cursor.
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Fig. 7-50: Editing a pre-created circuit

This portion can be scrolled but cannot edited

This portion can be scrolled and edited

Fig. 7-51: Scrolled function block



7.1.8 Ladder option settings

Ladder Editing Option settings can be accessed using Extras - Options menu.

LD-Variable Name option

The options related to Ladder variable name can be changed using the LD-Variable Name
option.

No Multiline variable naming: No multilane variable naming.

Display the variable name in n Lines: Wrap or fold the variable name in n (n=1 to 4 lines
(maximum allowable variable length is 32 (4 x 8 characters)) lines in the network display.

Do not allow “?” as a variable name: Do not allow the user to give the “?” mark as variable
name in Guided Mode. When this option is checked, the user must specify a proper variable
name whenever a new program component is placed in the network.
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Fig. 7-52:
Options menu



LD-Guided Mode Option

The options related to Ladder Guided Mode can be changed using LD-Guided Mode option.

Do not wrap: Do not wrap the ladder circuit. This setting is applicable for the circuit that is
going to be edited after making this setting and not for the pre-created circuits.

Wrap after: Wrap if the ladder circuit exceeds the nth (n=2 to 100) component position. This
setting is applicable for the circuit that is going to be edited after making this setting and not for
the pre-created circuits.

Auto comment block width: Set the auto comment block with a width of n (n=1 to 100)
components in the network.

Set Guided Mode as a default-editing mode: The project should be always opened in
Guided Mode.

Allow Hotkey repeater: Hotkey repeater window will be displayed whenever the Horizontal or
Vertical Line hotkey is pressed or accessed through the menu.

NOTE The above mentioned setting information will be stored in the .ini file.
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Fig. 7-53:
Options menu



7.2 Enhanced functionalities

7.2.1 Additional functionalities

The following are the additional functionalities:

Contact Negation

To place a negated Contact, so far the user had to change the Signal Configuration of the
contact after placing it in the network. This additional functionality allows the direct placement
of a negated Contact in the network.

L-Connection Contact

To place a L-Connection Contact, so far the user had to draw the connections after placing the
contact in the network. This additional functionality allows the direct placement of a
L-Connection Contact in the network. In case of Guided Mode, the size of the vertical line
depends on the variable name wrapping settings.

L-Connection Contact Negation

Similar to L-Connection Contact, this functionality is used to place a direct L-Connection
Contact Negation in the network. In case of Guided Mode, the size of the vertical line depends
on the variable name wrapping settings.
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Fig. 7-54: Contact Negation

Contact Negation

Fig. 7-55: L-Connection Contact

�

�

No. Explanation

� This height will change with the multiline var. settings

� L-Connection Contact

Tab. 7-18: Explanation for Fig. 7-55

Fig. 7-56: L-Connection Contact Negation

�

�

No. Explanation

� This height will change with the multiline var. settings

� L-Connection Contact

Tab. 7-19: Explanation for Fig. 7-56



7.2.2 Modified functionalities

The following functionalities that had been available in GX IEC Developer before version 7.00
were modified as shown below.

Hotkey repeater for Horizontal line

When the user pressed the hotkey or menu item of a horizontal line, a horizontal line was
placed at the mouse click location. Since version 7.00 the following dialogue is displayed
before placing the horizontal line in a network.

By default the count for Horizontal line is 1. But the user can draw more than 1 horizontal line
from a cursor location, just by increasing the count value.

Hotkey repeater for Vertical line

When the user pressed the hotkey or menu item of a vertical line, a vertical line was placed at
the mouse click location. Since version 7.00 the following dialogue is displayed before placing
the vertical line in a network.

By default the count for Vertical line is 1. But the user can draw more than 1 vertical line from a
cursor location, just by increasing the count value.
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Fig. 7-57: Hotkey repeater for Horizontal line

� � � �

No. Explanation

� Count for Horizontal line

� Enter Horizontal line

� Close or cancel the dialogue

� Display some help information

Tab. 7-20: Explanation for Fig. 7-57

Fig. 7-58: Hotkey repeater for Vertical line

� � � �

No. Explanation

� Count for Vertical line

� Enter Vertical line

� Close or cancel the dialogue

� Display some help information

Tab. 7-21: Explanation for Fig. 7-58



7.3 User-friendly hotkeys

The following are the user-friendly hotkeys of GX IEC Developer.

The location of the following toolbar buttons for program components is shown in Fig. 7-59.

The above hotkeys for program components are revised or allocated according to the MEDOC
standards.

The Label/Title dialogue is displayed if the user presses the Label of the network button.
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Fig. 7-59: Hotkey icons

Guided Editing

� ����

�����

No. Symbol

� Contact (Hot Key = 1)

� Contact Negation (Hot Key = 2)

� L-Connection Contact (Hot Key = 3)

� L-Connection Contact Negation (Hot Key = 4)

� Vertical line (Hot Key = 5)

� Horizontal line (Hot Key = 6)

� Coil (Hot Key = 7)

� Function Block (Hot Key = 8)

� Input Variable (Hot Key = 9)

� Output Variable (Hot Key = 0)

Tab. 7-22: Explanation for Fig. 7-59

Fig. 7-60: Icons

�

�

�

No. Description

� Auto comment

� Label of the network

� Delete Line

Tab. 7-23: Explanation for Fig. 7-60



Menu and the Hotkeys

Tools - Network Elements

Tools - Guided Mode
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Fig. 7-61:
Menu

Fig. 7-62:
Menu



Toolbar buttons and Mouse cursors

The following mouse cursors are displayed when the toolbar buttons or the menu items are
accessed. But there is no mouse cursor displayed for the functions related to Guided Mode
and for functions that do not need a specialized mouse cursor for their operations (e.g.Label of
a network).
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No. Function Name Mouse cursor Remarks

1 Contact Negation

2 L-Connection Contact

3 L-Connection Contact Negation

4 Horizontal Line Segment Same as GID Ver. 5 Only the tool button is added

5 Vertical Line Segment Same as GID Ver. 5 Only the tool button is added

6 Guided Editing No mouse cursor needed

7 Label of a network No mouse cursor needed

8 Auto Comment No mouse cursor needed

9 Delete Line No mouse cursor needed

Tab. 7-24: Toolbar buttons and Mouse cursors



7.3.1 Enhanced program component variable name display

For a proper display the variable name of the program components in a network had to be
adjusted manually. Now the variable names will be arranged automatically before they are
displayed.

Multiline variable naming

The variable name displayed above a program component can be wrapped/folded according
to the Display variable name in ** lines setting of the Ladder Editing settings.

The rules for variable name wrapping are:

� Each line in the variable name can accept a maximum of 8 characters

� The remaining part of the variable name that does not appear in the display can be
viewed by scrolling the variable name. (In the above example the last 3 characters
[XYZ] of [ABCDEFGHabcdefgh12345678XYZ] can be viewed by scrolling it.)

Multiline variable naming and the Behaviour of Guided Mode cursor

The cursor can scroll over the variable name but the variable name can be edited only if the
cursor is over a program component and not over a part of a variable name. But the user can
edit the part of a multiline variable name in Select or Inter connect mode.

NOTE If multiline variable name is allowed/selected and the variable name has more than 8
characters, a new cursor row will be added above the current cursor.
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Fig. 7-63: Multiline variable naming

A lengthy variable name,
Example:
[ABCDEFGHabcdefgh12345678XYZ]
will be displayed like this, if it is made to be
displayed in 3 lines

Fig. 7-64: Cursor row

Cursor row



Alignment of variable name in Guided Mode

All variable name displays are centre aligned in each line and the variable name is bottom
aligned in the variable name box. If the variable name is 27 characters long and the „Display
variable name in n lines“ is set to 8, the variable name will be displayed as shown below.

NOTES Regardless of the mode of ladder editing, the variable name display is centre aligned in each
line and the variable name is bottom aligned in the variable name box.

The width of the variable name display changes with the type of the font set for the Body. So
to implement the enhanced display of the variable name, the font for the Body must be set
with a fixed size font like Courier new font always.

Example The width of the variable name changes with the font.

�
About scrolling a multiline variable name:
No scrollbars appear inside the Edit control. The user can scroll down until reaching the end
of the variable name. Behind the end of scrolling region the cursor inside the edit box will not
move down any further.Since the default settings for the variable name wrapping is 3 lines (3
x 8 characters), even if the user sets a variable name of 32 characters length, scrolling down
only two lines is possible.
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Fig. 7-65: Alignment of variable name

Space for 4 lines of variable name and no program
component is allowed to place over this row.

Fig. 7-66: Example

Width of the variable name display is
same for all cases

Width of the variable name display is not
same for all cases

Courier new font
Arial font



7.3.2 Ladder circuit printout

In general, there are no changes in the printing settings of the current GX IEC Developer.

Regarding the printing of a ladder circuit, the following point should be taken care of:

Since the Courier New font is used for creating the ladder circuit in Guided Mode, there is a
necessity to maintain the same font in printing also. In Guided Mode, if the user changes the
default font settings from Courier New font to some other font, the variable names in the ladder
circuit may get overlapped on both the computer screen as well as in the printout.
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8 Compiling and Downloading
Programs

8.1 Error Check

Before compiling your project it is advisable to perform an error check on the project or
individual objects. The following checks are carried out:

Header

Checks of all the variable declarations (unique descriptors, addressing etc).

Body

The following checks are performed in the editors:

Graphical editors

� Validity of the data types

� Variable names (declarations)

� Validity of the IEC addresses

� Validity of the MITSUBISHI addresses

� Definition of the input variables

� Recursions

� Interconnects

� Label syntax

Text editors

� Syntax of the operators and operands

� Number of operands

� Recursions

� Jumps

� Comments

Errors and warnings are displayed in the Compiler/Check Messages status window with
explanations.

NOTE When you double-click on an error message or warning in the status window GX IEC
Developer automatically opens the corresponding object, moves the point in the program
where the error was found and highlights the error in a different colour. The jumped to
position in for example an editor of IL, MELSEC IL or ST may not be the exact position of the
error cause. Look for the error cause in the jumped to line or in the lines above.
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How to perform an error check on an object

� Select Check in the Object menu.
Or:
Click with the left mouse button on the Check tool:

NOTE You do not have to save your editing changes in open objects before selecting the Check
option. If changes have been made the object is saved automatically before Check is
executed.

How to specify the max. number of errors and warnings

� Select the option Stop Check By in the Extras - Options - General menu.

� Enter the maximum number of errors and warnings. The check operation will be
stopped when the number of errors and warnings exceeds the limit specified here.
Range: 0 - 2,000.

8.1.1 Execution order

In some cases the execution order in a ladder or FBD network is not clear, for example if
complex connections between different elements are established.

The scanner for ladder / FBD networks recognises these critical networks. In this case a
warning is indicated in the dialogue Compile / Check Messages.

On demand the generated MELSEC IL code of the respective network will be displayed if the
POU has been compiled. To do so take the following steps:

� Select one or multiple networks.

� Select the menu item Tools → Show MELSEC Code Of Network.
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8.2 Compiling

The compilation process translates the project written in GX IEC Developer into code that the
PLC CPU can execute. This translation process must be performed before downloading the
program to the PLC system.

How to compile the complete project

Select Rebuild All in the Project menu.

GX IEC Developer first performs checks on all the objects in the project and displays any errors
or warnings in the Compiler/Check Messages status window. If no errors are displayed this
means that the program code has been compiled without errors.

Once the project has been compiled, the Compiler/Check Messages status window can be
opened any time via the menu item Window - Show Compile/Check Messages.

In the status window occurred errors and warnings can be browsed via the following Window
menu items:

� Show Next Error Hotkey: [F4]

� Show Previous Error Hotkey: [SHIFT] + [F4]

� Show Next Warning

� Show Previous Warning
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Fig. 8-1:
Compiler/Check Messages



How to compile only modified objects

POUs that have not yet been compiled are identified in the Project Navigator with an asterisk.
POUs marked in this way were either created after the last compilation or are not part of a task.

� Select Build in the Project menu.

Only the new objects which have not yet been compiled and the project elements which
depend on the changes will be compiled.

NOTE When you double-click on an error message or warning in the status window GX IEC
Developer automatically opens the corresponding object, moves the point in the program
where the error was found and highlights the error in a different colour.

E
WARNING:
Please note that only those Program POUs that you have included in your tasks are
checked and compiled!

Projects generated with program versions of MM+

You must completely recompile projects generated with program versions of MM+ (Compile
Project) before you can use the Build function on them to compile only changes made in the
editing session.
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Fig. 8-2:

Already compiled

Not yet compiled



8.3 Downloading Projects to the CPU

8.3.1 Transfer Setup - Ports

You can only download compiled projects to the CPU. Before making your first download,
check that the port and its parameters are configured correctly.

NOTE See chapter 2 and the manuals of your MELSEC hardware for details on connecting the
controller to your computer.

How to configure the communications port

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

The Transfer Setup menu has moved to the top of the Online menu.
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Fig. 8-3:
Transfer Setup



A dialogue box will be opened with the following options:
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Fig. 8-4: Transfer Setup (1)
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Fig. 8-4: Transfer Setup for QnPRH CPU (2)

�
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Fig. 8-4: Transfer Setup for FX3U CPU (3)

�

Fig. 8-4: Transfer Setup for Q Remote I/O (4)

�



� For a redundant PLC system some functionalities are not available with all of these settings.
For the following functionalities it is necessary to select Not specified, System A or Sys-
tem B to function properly:
� In Cycle Monitoring (� 9.13)
� Online Module Change (� 9.8)
� Forced Input Output Registration / Cancellation (� 9.11.1)
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Number Description

�
PC side I/F
Choose the I/F for the connection of the PC to the PLC.

�
PLC side I/F
Choose the unit to be connected with the personal computer.

�
Other station
Choose no network or one of the specified network types.

�
Network route
Choose the network type, network No., station number and first I/O No. to be accessed. The setting
items depend on the network type that has been set.

�

Coexistence network route
Choose this when making access to the network different from the one where the personal computer
is connected. Choose the network type, network No., station number and first I/O No. to be accessed.
The setting items depend on the network type that has been set.

�
Multiple PLC setting
Specify when the access target is multiple CPUs. You can connect up to four PLC CPUs. In this
option you decide which CPU is to be connected.

�
Connection channel list…
Lists possible connection modes and their image. You can set the connection target while looking at
the Connection channel list.

�
PLC direct coupled setting
By clicking this button you change from Other station to the own station.

�

Connection test
Tests whether proper access can be made to the PLC set as the access target on the Connection
Setup screen. If proper access can be made, the model name of the PLC as the access target
appears in the CPU type field.

�

Target System
Specifies the connection destination for redundant PLC systems.

�
System image
Here you see an image of the setup system.

�
Line connected (Q/A6TEL, C24)... / TEL (FXCPU)...
Clicking on this button opens a dialogue to setup a modem connection.

�
OK
Closes the dialogue and saves the settings.

�
Cancel
Closes the dialogue without saving.

Tab. 8-1: Description for Fig. 8-4

Choice Connection destination

Not specified

When a PLC is directly connected:
The PLC directly connected to the personal computer.

Via network:
The PLC at the station where the network module of the specified station No.
is installed in the network communication path.

Control system The PLC whose system type is the control system.

Standby system The PLC whose system type is the standby system.

System A The PLC connected to the A side connector of the tracking cable.

System B The PLC connected to the B side connector of the tracking cable.



Setup of the connection to the PLC

To setup the connection follow the different setup option in Fig.8-5.Therefore use the manuals
of the PLC CPU and the network type you are using.

GX IEC Developer provides the possibility to setup the PLC and network parameter by using
graphical images.

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.
The in Fig. 8-5 shown dialogue is opened.

� Click on the button Connection channel list. The following dialogue window is
opened.


 Graphical image of the in � selected network type.

� Listing of the possible network configurations for the selected PLC .

� Update
Click this button to confirm the selected network configuration without closing the
dialogue.

� OK
Confirm the set network configuration and close the dialogue.

� Cancel
Closes the dialogue without saving. When the button Update was clicked the dialogue is
closed but the network configuration is already saved.
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Fig. 8-5: Dialogue Connection channel list




�

� � �



� Use the scollingbar to scroll through the network configurations and select a network
configuration corresponding to your network type by clicking in the list. Click on the
button Update. Confirm the following security note with OK.

	 Test the selected network configuration by clicking on the button Connection test. If
the connection between the PC and the network is possible a positive note will be
shown on the screen. If no connection is possible an error message is shown. In this
case you have to check and correct the connection between the PC and the network.


 Close the dialogue by clicking on OK. The selected network configuration will be saved
and shown in the Transfer Setup.

� Now click on System image. An information window is opened in which an image of the
setup system is shown.
In comparison to the Connection channel list dialogue in this dialogue the system
parameter are also listed.
So you can change single settings and check the settings by the help of this dialogue.
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Fig. 8-6:
Security note

Fig. 8-7: Dialogue Transfer Setup



NOTES The COM and USB status is saved to the INI file every time you close the Transfer Setup
dialogue with the OK button. The saved values are then used as defaults when you create a
new project.

The USB status is only saved for Q PLCs. The selected COM port is only saved if USB is not
selected. For new projects, the USB status is used as default for Q PLCs, except the
Q00(J)/01 PLCs.

The following table shows the old Transfer Setup settings (Version 5.0 and before) and their
equivalents in the new Transfer Setup (Version 6.0 and later).

Example Example for reading the table: If you selected the CPU-Port interface with MELSECNET/10
network in the old Transfer Setup, you will have to do the following in the new Transfer Setup to
achieve the same result:

� Select the Serial / USB icon in the PC side I/F group.

� Double-click this icon to configure the settings such as port, baud rate, etc.

� Select the PLC module icon in the PLC side I/F group.

	 Double-click this icon to configure the PLC mode (if the PLC supports this).


 Select the Other station (Single network) icon in the Other Station group.

� Double-click this icon to configure timeout and retries settings.

� Select the NET/10(H) icon from the Network Route group.

" Double-click this icon to configure the Network and Station numbers.
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Fig. 8-8: Dialogue System image
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Old setting
New setting

Click to select… Double-click to configure…

CPU-Port
Host

PC side: Serial / USB
PLC side: PLC module
Other stat: No spec

COM port, Baud rate
PLC mode
Timeout, retries

CPU-Port
Net/NetII

PC side: Serial / USB
PLC side: PLC module
Other stat: Single network
Network: NET(II)

COM port, Baud rate
PLC mode
Timeout, retries
Station no.

CPU-Port
Net10

PC side: Serial / USB
PLC side: PLC module
Other stat: Single network
Network: NET/10(H)

COM port, Baud rate
PLC mode
Timeout, retries
Network no., station no.

CPU-Port
CC-Link

PC side: Serial / USB
PLC side: PLC module
Other stat: Single network
Network: CC-Link

COM port, Baud rate
PLC mode
Timeout, retries
Head I/O, station no.

Computer Link
Host

PC side: Serial / USB
PLC side: C24
Other stat: No spec

COM port, Baud rate
PLC type, Station no., parity
Timeout, retries

Computer Link
Net/NetII

PC side: Serial / USB
PLC side: C24
Other stat: Single network
Network: NET(II)

COM port, Baud rate
PLC type, Station no., parity
Timeout, retries
Station no.

Computer Link
Net10

PC side: Serial / USB
PLC side: C24
Other stat: Single network
Network: NET/10(H)

COM port, Baud rate
PLC type, Station no., parity
Timeout, retries
Network no., station no.

Computer Link
CC-Link

PC side: Serial / USB
PLC side: C24
Other stat: Single network
Network: CC-Link

COM port, Baud rate
PLC type, Station no., parity
Timeout, retries
Head I/O, station no.

Ethernet
Host

PC side: Ethernet board
PLC side: Ethernet module
Other stat: Single network
Network: Ethernet

Network no., station no., protocol
PLC type, IP address, host name
Timeout, retries
Network no., station no.

Ethernet
Net/NetII

PC side: Ethernet board
PLC side: Ethernet module
Other stat: Co-existence
Network: Ethernet
Co-existence: NET(II)

Network no., station no., protocol
PLC type, IP address, host name
Timeout, retries
—
Station no.

Ethernet
Net10

PC side: Ethernet board
PLC side: Ethernet module
Other stat: Single network
Network: Ethernet

Network no., station no., protocol
PLC type, IP address, host name
Timeout, retries
Network no., station no.

Ethernet
CC-Link

PC side: Ethernet board
PLC side: Ethernet module
Other stat: Co-existence
Network: Ethernet
Co-existence: CC-Link

Network no., station no., protocol
PLC type, IP address, host name
Timeout, retries
Network no., station no.
Head I/O, station no.

USB Port
Host

PC side: Serial / USB
PLC side: PLC module
Other stat: No spec

Select USB
PLC mode
Timeout, retries

USB Port
Net10

PC side: Serial / USB
PLC side: PLC module
Other stat: Single network
Network: NET/10(H)

Select USB
PLC mode
Timeout, retries
Network no., station no.

USB Port
CC-Link

PC side: Serial / USB
PLC side: PLC module
Other stat: Single network
Network: CC-Link

Select USB
PLC mode
Timeout, retries
Head I/O, station no.

Tab. 8-2: Comparison of old and new setting



8.4 Modem settings for analog Modems

When using an analog modem make the following settings.

� Set MAC transparent mode with CPU port or C24 in the menu Transfer Setup ->
Ports.

� Set the desired data transmission settings on the sending and receiving modems. You
can use any terminal program (e.g. Windows Hyperterminal) to configure the modem
settings.

� Click on the button Line connected in the menu Transfer Setup -> Ports.
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Fig. 8-9: Modem settings



Connection: Enter the telephone number here. Or select one out of the Call book by clicking
on the Browse button.

AT command: The modem settings are set here.Or select one out of the AT command regis-
tration by clicking on the Browse button.
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Fig. 8-10: Call book

Fig. 8-11: AT command registration



Data transmission procedure

� Set data transmission settings in GX IEC Developer and on MAC.

� Receiving modem: set “Auto Answer On”.

� Set data transmission settings on receiving and sending modems.

	 Start connection: dial receiving modem.


 Quit terminal software, though without hanging up.

� Take the necessary steps in GX IEC Developer.

Close communications

When the PLC and other devices (e.g. the MAC terminal in transparent mode) are connected
to the Personal Computer via the same communication port, the communications must be
closed to release the COM port when switching between the two software applications GX IEC
Developer and MAC Programmer.

� Click on the command Close communications in the Online menu.

NOTES The communications can not be closed when GX IEC Developer is running in monitor mode.

Follow the following precautions for access to the other station in the following Q, QnA, and A
CPU mixed system are as follows:

� Change the peripheral device to the PLC type of the request target. Communication
can not be performed, if the PLC type differs.

� The relay station used should be the Q CPU or QnA CPU.

� If GX IEC Developer is connected to the QnA CPU and the request target is the A CPU
GX IEC Developer can not communicate with the request target (A CPU).

	 If GX IEC Developer is connected to the Q CPU and the request target is the Q CPU,
GX IEC Developer can not communicate with the request target (Q CPU) via the relay
station (QnA/A CPU).
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Fig. 8-12: Hardware configuration for Q, QnA, and A CPU mixed systems.
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8.5 Modem settings for GSM Modems

8.5.1 FX-Series – Communication via Programming port

Environment: Analogue Modem -> GSM Modem -> Programming port

Analogue Modem settings:

AT E0
&S0

&D0

&K0

When the analogue modem is used at the PC side, the parity settings have to be modified:

Parity: Even

Data Bits: 7bits

Stop Bits: 1bit

AT +TFORMAT=”7E1”

GSM Modem settings:

AT E0
S0=2
&S0
&D0
+CICB=0
+IFC=0,0
+CMEE=1
+IPR=9600
+CPIN=____ (PIN No. of SIM card)
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FX-Series
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RS232

cable (1:1)

Programming
cable (SC09)

with “Blue Adapter”

Fig. 8-13: Environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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Fig. 8-14: Setting in the menu Transfer Setup

�

Fig. 8-15: Setting the communication details




 Select TEL (FXCPU), enter the Call number of the remote modem and click Connect.

� If the connection was successful, a message box shows:

– Connect completed

– Destination – 0123456789 ← Call number of your remote modem
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Fig. 8-16: Set up the connection



Environment: GSM Modem -> GSM Modem -> Programming port

GSM Modem settings:

AT E0
S0=2
&S0
&D0
+CICB=0
+IFC=0,0
+CMEE=1
+IPR=9600
&W
+CPIN=____ (PIN No. of SIM card)

The modem which is used at the PC side has to be modified regarding the parity settings:

Parity: Even

Data Bits: 7bits

Stop Bits: 1bit

AT +ICF=5,1
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MIM-G01 MIM-G01 PLC
FX-Series

Standard
RS232

cable (1:1)

Programming
cable (SC09)

with “Blue Adapter”

Fig. 8-17: Environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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Fig. 8-18: Setting in the menu Transfer Setup

�

Fig. 8-19: Setting the communication details




 Select TEL (FXCPU), enter the Call number of the remote modem and click Connect.

� If the connection was successful, a message box shows:

– Connect completed

– Destination – 0123456789 � Call number of your remote modem
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Fig. 8-20: Set up the connection



8.5.2 FX-Series – Communication with RS 232 BD

Environment: Analogue Modem -> GSM Modem -> RS 232 BD

NOTE A modification of the PLC settings for the RS 232 BD is not necessary.

Analogue Modem settings:

AT E0
&S0

&D0

&K0

When the analogue modem is used at the PC side, the parity settings have to be modified:

Parity: Even

Data Bits: 7bits

Stop Bits: 1bit

AT +TFORMAT=”7E1”

GSM Modem settings:

AT E0
S0=2

&S0

&D0

+CICB=0

+IFC=0,0

+CMEE=1

+IPR=9600

+CPIN=____ (PIN No. of SIM card)
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with “Red Adapter”

Fig. 8-21: Environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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Fig. 8-22: Setting in the menu Transfer Setup

�

Fig. 8-23: Setting the communication details




 Select TEL (FXCPU), enter the Call number of the remote modem and click Connect.

� If the connection was successful, a message box shows:

– Connect completed

– Destination – 0123456789 � Call number of your remote modem
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Fig. 8-24: Set up the connection



Environment: GSM Modem -> GSM Modem -> RS 232 BD

NOTE A modification of the PLC settings for the RS 232 BD is not necessary.

GSM Modem settings:

AT E0
S0=2
&S0
&D0
+CICB=0
+IFC=0,0
+CMEE=1
+IPR=9600
+CPIN=____ (PIN No. of SIM card)

The modem which is used at the PC side has to be modified regarding the parity settings:

Parity: Even

Data Bits: 7bits

Stop Bits: 1bit

AT +ICF=5,1
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with “Red Adapter”

Fig. 8-25: Environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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Fig. 8-26: Setting in the menu Transfer Setup

�

Fig. 8-27: Setting the communication details




 Select TEL (FXCPU), enter the Call number of the remote modem and click Connect.

� If the connection was successful, a message box shows:

– Connect completed

– Destination – 0123456789 � Call number of your remote modem
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Fig. 8-28: Set up the connection



8.5.3 FX-Series – Communication via MAC (Transparent Mode)

Settings for MAC Terminal:

8 – 28 MITSUBISHI ELECTRIC

Modem settings for GSM Modems Compiling and Downloading Programs

Fig. 8-29: Setting the peripheral configuration in the E-Designer



Environment: Analogue Modem -> GSM Modem -> MAC -> FX Programming Port

GSM Modem settings:

AT E0
S0=2

&S0

&D0

+CICB=0

+IFC=0,0

+CMEE=1

+IPR=9600

+CPIN=____ (PIN No. of SIM card)

Analogue Modem settings:

AT E0
&S0

&D0

&K0

When the analogue modem is used at the PC side, the parity settings have to be modified:

Parity: Even

Data Bits: 7bits

Stop Bits: 1bit

AT +TFORMAT=”7E1”
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7 --- 8
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Standard MAC
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Fig. 8-30: Environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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Fig. 8-31: Setting in the menu Transfer Setup

�

Fig. 8-32: Setting the communication details




 Double click on PLC side I/F - PLC Modul to open the dialogue box PLC side I/F
Detailed setting of PLC module and set the communication mode.

� Select TEL (FXCPU), enter the Call number of the remote modem and click Connect.

� If the connection was successful, a message box shows:

– Connect completed

– Destination – 0123456789 � Call number of your remote modem
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Fig. 8-33:
Setting the communication mode

Fig. 8-34: Set up the connection



Environment: GSM Modem -> GSM Modem -> MAC -> FX Progr. Port

GSM Modem settings:

AT E0
S0=2
&S0
&D0
+CICB=0
+IFC=0,0
+CMEE=1
+IPR=9600
&W
+CPIN=____ (PIN No. of SIM card)

The modem which is used at the PC side has to be modified regarding the parity settings:

Parity: Even

Data Bits: 7bits

Stop Bits: 1bit

AT +ICF=5,1
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7 --- 8
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Fig. 8-35: Environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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Fig. 8-36: Setting in the menu Transfer Setup

�

Fig. 8-37: Setting the communication details




 Double click on PLC side I/F - PLC Modul to open the dialogue box PLC side I/F
Detailed setting of PLC module and set the communication mode.

� Select TEL (FXCPU), enter the Call number of the remote modem and click Connect.

� If the connection was successful, a message box shows:

– Connect completed

– Destination – 0123456789 � Call number of your remote modem
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Fig. 8-38:
Setting the communication mode

Fig. 8-39: Set up the connection



Environment: GSM Modem -> GSM Alarm Modem -> FX Progr. Port

MIM-G01 settings:

AT E0

S0=2

&S0

&D0

+CICB=0

+IFC=0,0

+CMEE=1

+IPR=9600

%C0

\N0

&W

+CPIN=____ (PIN No. of SIM card)

MAM-GM6 settings:

For the MAM-GM6 settings refer to MX Mitsubishi Alarm Editor
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with “Red Adapter”

Fig. 8-40: Test environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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Fig. 8-41: Setting in the menu Transfer Setup

�

Fig. 8-42: Setting the communication details




 To connect the modems you have to use the MX Mitsubishi Alarm Editor.
The following screenshot shows the settings.

� To connect the modems click on the button Connect.
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Fig. 8-43: Settings in the MX Mitsubishi Alarm Editor



� After the connection has been established the following message is displayed.
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Fig. 8-44: Connection message



8.5.4 A-Series – Communication with C24

Settings for AJ71C24

Mode switch: 1 = Protocol 1

SW11 … SW24

SW11 OFF = RS232

SW12 ON = Data length = 8 bits

SW13 ON =

SW14 OFF = Baud rate = 9600

SW15 ON =

SW16 OFF = Parity check disabled

SW17 OFF = Not used

SW18 OFF = 1 Stop bit

SW21 ON = Sum check enabled

SW22 ON = Write during RUN enabled

SW23 OFF = Not used

SW24 OFF = Not used

Settings for A1SJ71C24-R2

Mode switch: 1 = Protocol 1

SW03 … SW12

SW03 OFF = Not used

SW04 ON = Write during RUN enabled

SW05 ON =

SW06 OFF = Baud rate = 9600

SW07 ON =

SW08 ON = Data length = 8 bits

SW09 OFF = Parity check disabled

SW10 OFF = Not used

SW11 OFF = 1 Stop bit

SW12 ON = Sum check enabled
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Environment: Analogue Modem -> GSM Modem -> A(1S)J71(U)C24

Analogue Modem settings:

AT E0
&S0

&D0

&K0

GSM Modem settings:

AT E0
S0=2
&S0
&D0
+CICB=0
+IFC=0,0
+CMEE=1
+IPR=9600
+CPIN=____ (PIN No. of SIM card)
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Fig. 8-45: Environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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Fig. 8-46: Setting in the menu Transfer Setup

�

Fig. 8-47: Setting the communication details




 Double click on PLC side I/F - C24 to open the dialogue box PLC side I/F Detailed
setting of C24 and set the details.

NOTE To connect the modems, the WINDOWS Hyperterminal has to be used.
The GX IEC Developer function Connect Line does not work in this case.
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Fig. 8-48:
Detailed setting for the C24



Environment: GSM Modem -> GSM Modem -> A(1S)J71(U)C24

GSM Modem settings:

AT E0
S0=2
&S0
&D0
+CICB=0
+IFC=0,0
+CMEE=1
+IPR=9600
+CPIN=____ (PIN No. of SIM card)
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Fig. 8-49: Environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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Fig. 8-50: Setting in the menu Transfer Setup

�

Fig: 8-51: Setting the communication details




 Double click on PLC side I/F - C24 to open the dialogue box PLC side I/F Detailed
setting of C24 and set the details.

NOTE To connect the modems, the WINDOWS Hyperterminal has to be used.
The GX IEC Developer function Connect Line does not work in this case.
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Fig. 8-52:
Detailed setting for the C24



8.5.5 A-Series – Communication via MAC (Transparent Mode)

Settings for MAC Terminal:
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Fig. 8-53:
Setting the peripheral configuration in
the E-Designer



Environment: Analogue Modem -> GSM Modem -> MAC -> A-Series Progr. Port

Analogue Modem settings:

AT E0
&S0

&D0

&K0

GSM Modem settings:

AT E0
S0=2

&S0

&D0

+CICB=0

+IFC=0,0

+CMEE=1

+IPR=9600

&W

+CPIN=____ (PIN No. of SIM card)
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7 --- 8
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Fig. 8-54: Environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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Fig. 8-55: Setting in the menu Transfer Setup

�

Fig. 8-56: Setting the communication details




 Double click on PLC side I/F - PLC Modul to open the dialogue box PLC side I/F
Detailed setting of PLC module and set the communication mode.

� Select Line Connected, enter the Call number of the remote modem and click
Connect.

� If the connection was successful, a message box shows:

– Connect completed

– Destination – 0123456789 � Call number of your remote modem
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Fig. 8-57:
Setting the communication mode

Fig. 8-58: Set up the connection



Environment: GSM Modem -> GSM Modem -> MAC -> A-Series Progr. Port

GSM Modem settings:

AT E0
S0=2

&S0

&D0

+CICB=0

+IFC=0,0

+CMEE=1

+IPR=9600

&W

+CPIN=____ (PIN No. of SIM card)
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Fig. 8-59: Environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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Fig. 8-60: Setting in the menu Transfer Setup

�

Fig. 8-61: Setting the communication details




 Double click on PLC side I/F - PLC Modul to open the dialogue box PLC side I/F
Detailed setting of PLC module and set the communication mode.

� Select Line Connected, enter the Call number of the remote modem and click
Connect.

� If the connection was successful, a message box shows:

– Connect completed

– Destination – 0123456789 � Call number of your remote modem
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Fig. 8-62:
Setting the communication mode

Fig. 8-63: Set up the connection



8.5.6 QnA-Series – Communication with C24

Settings for AJ71QC24N or A1SJ71QC24-R2

Mode switch: 5 = Binary mode Format 5

SW01 … SW12

SW01 OFF = always OFF

SW02 ON = Data length = 8 bits

SW03 OFF = Parity check disabled

SW04 OFF = Not used

SW05 OFF = 1 Stop bit

SW06 ON = Sum check enabled

SW07 ON = Write during RUN enabled

SW08 ON = Changes enabled (allow)

SW09 ON =

SW10 OFF =

SW11 ON =

SW12 OFF =
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} Baud rate = 9600



Environment: Analogue Modem -> GSM Modem -> A(1S)J71QC24

Analogue Modem settings:

AT E0
&S0
&D0
&K0

GSM Modem settings:

AT E0
S0=2
&S0
&D0
+CICB=0
+IFC=0,0
+CMEE=1
+IPR=9600
+CPIN=____ (PIN No. of SIM card)
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Fig. 8-64: Environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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Fig. 8-65: Setting in the menu Transfer Setup

�

Fig. 8-66: Setting the communication details




 Double click on PLC side I/F - C24 to open the dialogue box PLC side I/F Detailed
setting of C24 and set the details.

NOTE To connect the modems, the WINDOWS Hyperterminal has to be used.
The GX IEC Developer function Connect Line does not work in this case.
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Detailed setting for the C24



Environment: GSM Modem -> GSM Modem -> A(1S)J71QC24

GSM Modem settings:

AT E0
S0=2
&S0
&D0
+CICB=0
+IFC=0,0
+CMEE=1
+IPR=9600
+CPIN=____ (PIN No. of SIM card)
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Fig. 8-68: Environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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Fig. 8-69: Setting in the menu Transfer Setup

�

Fig. 8-70: Setting the communication details




 Double click on PLC side I/F - C24 to open the dialogue box PLC side I/F Detailed
setting of C24 and set the details.

NOTE To connect the modems, the WINDOWS Hyperterminal has to be used.
The GX IEC Developer function Connect Line does not work in this case.
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Fig. 8-71:
Detailed setting for the C24



8.5.7 QnA-Series – Communication via MAC (Transparent Mode)

Settings for MAC Terminal:
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Fig. 8-72:
Setting the peripheral configuration in
the E-Designer



Environment: Analogue Modem -> GSM Modem -> MAC -> QnA-Series Progr. Port

Analogue Modem settings:

AT E0

&S0

&D0

&K0

GSM Modem settings:

AT E0

S0=2

&S0

&D0

+CICB=0

+IFC=0,0

+CMEE=1

+IPR=9600

&W

+CPIN=____ (PIN No. of SIM card)
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Fig. 8-73: Environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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�

Fig. 8-75: Setting the communication details




 Double click on PLC side I/F - PLC Modul to open the dialogue box PLC side I/F
Detailed setting of PLC module and set the communication mode.

� Select Line Connected, enter the Call number of the remote modem and click
Connect.

� If the connection was successful, a message box shows:

– Connect completed

– Destination – 0123456789 � Call number of your remote modem
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Fig. 8-76:
Setting the communication mode

Fig. 8-77: Set up the connection



Environment: GSM -> GSM -> MAC -> QnA-Series Progr. Port

GSM Modem settings:

AT E0
S0=2
&S0
&D0
+CICB=0
+IFC=0,0
+CMEE=1
+IPR=9600
&W
+CPIN=____ (PIN No. of SIM card)
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Fig. 8-78: Environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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�

Fig. 8-80: Setting the communication details




 Double click on PLC side I/F - PLC Modul to open the dialogue box PLC side I/F
Detailed setting of PLC module and set the communication mode.

� Select Line Connected, enter the Call number of the remote modem and click
Connect.

� If the connection was successful, a message box shows:

– Connect completed

– Destination – 0123456789 � Call number of your remote modem
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Fig. 8-82: Set up the connection



8.5.8 Q-Series – Communication with C24

Settings for QJ71C24-R2

When using the QJ71C24-R2 you first have to do the following settings:

� Open the Parameter dialogue and select the tab I/O assignment.
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� Click on the button Switch setting to open the following dialogue.

� Set the following switches:

Switch 1: CH1 Communication and Transmission setting

Switch 2: CH1 Communication protocol setting

Switch 3: CH2 Communication and Transmission setting

Switch 4: CH2 Communication protocol setting

Switch 5: Station number setting

	 Click on the button End to save the settings.
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Environment: Analogue Modem -> GSM Modem -> QJ71C24-R2

Analogue Modem settings:

AT E0
&S0
&D0
&K0

GSM Modem settings:

AT E0
S0=2
&S0
&D0
+CICB=0
+IFC=0,0
+CMEE=1
+IPR=9600
+CPIN=____ (PIN No. of SIM card)
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Fig. 8-85: Environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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Fig. 8-86: Setting in the menu Transfer Setup

�

Fig. 8-87: Setting the communication details




 Double click on PLC side I/F - C24 to open the dialogue box PLC side I/F Detailed
setting of C24 and set the details.

� Select Line Connected, enter the Call number of the remote modem and click
Connect.

� If the connection was successful, a message box shows:

– Connect completed

– Destination – 0123456789 � Call number of your remote modem
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Fig. 8-88:
Detailed setting for the C24

Fig. 8-89: Set up the connection



Environment: GSM Modem -> GSM Modem -> QJ71C24-R2

GSM Modem settings:

AT E0
S0=2
&S0
&D0
+CICB=0
+IFC=0,0
+CMEE=1
+IPR=9600
+CPIN=____ (PIN No. of SIM card)
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Fig. 8-90: Environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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�

Fig. 8-92: Setting the communication details




 Double click on PLC side I/F - C24 to open the dialogue box PLC side I/F Detailed
setting of C24 and set the details.

� Select Line Connected, enter the Call number of the remote modem and click
Connect.

� If the connection was successful, a message box shows:

– Connect completed

– Destination – 0123456789 � Call number of your remote modem
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Detailed setting for the C24

Fig. 8-94: Set up the connection



8.5.9 Q-Series – Communication via MAC (Transparent Mode)

Settings for MAC Terminal:
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Fig. 8-95:
Setting the peripheral configuration in
the E-Designer



Environment: Analogue Modem -> GSM Modem -> MAC -> Q-Series Progr. Port

Analogue Modem settings:

AT E0
&S0
&D0
&K0

GSM Modem settings:

AT E0
S0=2
&S0
&D0
+CICB=0
+IFC=0,0
+CMEE=1
+IPR=9600
&W
+CPIN=____ (PIN No. of SIM card)
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Fig. 8-96: Environment



GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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�

Fig. 8-98: Setting the communication details




 Double click on PLC side I/F - PLC Modul to open the dialogue box PLC side I/F
Detailed setting of PLC module and set the communication mode.

� Select Line Connected, enter the Call number of the remote modem and click
Connect.

� If the connection was successful, a message box shows:

– Connect completed

– Destination – 0123456789 � Call number of your remote modem
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Fig. 8-100: Set up the connection



Environment: GSM Modem -> GSM Modem -> MAC -> Q-Series Progr. Port

GSM Modem settings:

AT E0
S0=2
&S0
&D0
+CICB=0
+IFC=0,0
+CMEE=1
+IPR=9600
&W
+CPIN=____ (PIN No. of SIM card)

GX IEC Developer Reference Manual 8 – 79

Compiling and Downloading Programs Modem settings for GSM Modems

MIM-G01 MIM-G01 MAC PLC
Q-Series

Standard
RS232

cable (1:1)

Crossed cable
1 --- 1
2 --- 3
3 --- 2
4 --- 6
5 --- 5
6 --- 4
7 --- 8
8 --- 7

Standard MAC
cable
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GX IEC Developer settings:

� Select Transfer Setup in the Online menu, then select Ports from the submenu
displayed.

� Set the value for the option Time out (� in the following dialogue window) to ≥ 15 sec.

� Double click on PC side I/F - Serial to open the dialogue box PC side I/F Serial setting
and set the connection details.

	 Select Setup to open the dialogue Transfer Setup: PC side I/F Serial Setting to set
up further communication details.
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�

Fig. 8-103: Setting the communication details




 Double click on PLC side I/F - PLC Modul to open the dialogue box PLC side I/F
Detailed setting of PLC module and set the communication mode.

� Select Line Connected, enter the Call number of the remote modem and click
Connect.

� If the connection was successful, a message box shows:

– Connect completed

– Destination – 0123456789 � Call number of your remote modem
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Fig. 8-104:
Setting the communication mode

Fig. 8-105: Set up the connection



8.5.10 Special Remarks on using GSM modems

GSM modem synchronisation

Some modems, mainly GSM modems, do not work with the standard communication settings.
In such cases the (GSM) modem often needs some time between retries while communi-
cating. This time to wait between retries we call modem synchronisation time, which can be
enabled and set in this functionality.

The menu item is available if a project is open and either MAC transparent mode with CPU port
or C24 is selected in the Transfer Setup -> Ports.

Use GSM modem synchronization: If checked, the synchronization is used. Enter a value in
the range of 1 to 60000 ms for synchronization.

Timeout setting for communication initialization

When initializing the connection with the PLC, the timeout setting entered in the Transfer
Setup does not apply to the communication. The timeout value set in the Transfer Setup is
used only after the communication has been initialized.

The pre-defined timeout setting is not suitable for GSM communication under specific circum-
stances, which causes communication failures.

To avoid communication failures when using GSM or other connection types with occasional
high delays, it is possible to increase the timeout value used at communication initialization.
When you set a timeout value of 15 seconds or more in the Transfer Setup, this value will be
used also when initializing the communication with the PLC. If the timeout value is lower than
15 seconds, the original pre-defined value will be used for communication initialization.

� If the timeout setting is less than 15 seconds, then the performance is not affected.

� If the timeout setting is 15 seconds or greater, then:

– If the connected PLC can be accessed, the performance of the communication
initialization is not affected.

– If there is no connected PLC, or the connected PLC cannot be accessed, then at
least the time set for timeout must elapse until the communication initialization
attempt can finish.
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Dialogue



8.6 Transfer Setup - Project

You can specify precisely which objects and source information in your project you want to
download.

NOTES The option Init System Addresses is set as default when creating a new project.As this is a
project specific option, it does not affect the setting in other projects opened, who were
created without this option set.

Since the Q Remote I/O module has a Flash ROM drive only, the download function
transfers only the parameter and (if selected) the intelligent parameter to drive 4 of the PLC.

How to set the transfer settings

� In the Online menu select Transfer Setup, then select Project.

� Select the desired options in the Download Object and Source Information fields of
the dialogue box.

PLC Parameter : Downloads only the PLC configuration data to the PLC CPU.

Program: Downloads only the compiled program code to the PLC.
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Fig. 8-108:
Project transfer setup

Fig. 8-109:
Project transfer setup for a Q Remote I/O module



PLC Parameter and Program: Downloads both the configuration data and the compiled
program code to the PLC.

Download Intelligent Parameter File (only Q Remote I/O): Downloads the intelligent
parameter file to the Remote I/O module.

Drive: Select the PLC CPU drive for the transfer.

Init System Addresses: Initialises all system variables during download. This is done by a
direct memory write.

Download Boot (Autoexec) File: Controls the download of the boot file to the PLC. However,
if this check box is unchecked, the boot file (if it already exists on the PLC) will be deleted from
the PLC during download. For Q00(J)/Q01 PLCs this check box is disabled. To download the
boot file to these PLCs, the corresponding check box Do boot from standard ROM in the PLC
Parameters option Boot File has to be checked.

Download Intelligent Parameter File: By checking this option the Intelligent Parameter File
(IPARAM) for Q projects will be downloaded to the PLC.

Symbolic: Downloads the project together with all information, including the POUs not
defined in tasks. If a project, which includes the setting structure (used in lower MM+ versions),
is downloaded the setting will be converted automatically to symbolic. This means that the
information in the project database will not be changed, but when the information is queried,
structure will be handled as symbolic.
The symbolic download may be encrypted with a password. In the password only alphanu-
meric characters (a..z, A..Z, 0..9) are accepted.

No Information: Downloads only the binary program code to the CPU.

Drive: Select the PLC CPU drive for the transfer.

MELSEC IL (always drive 0): Reads the binary code from the PLC CPU and creates a POU in
MELSEC IL language with the standard name PRG_MAIN and a task with the standard name
MELSEC_MAIN.

Source information: Reads all the graphical and structural information from the PLC CPU in
addition to the binary code.

Drive: Select the PLC CPU drive for the transfer.

Upload Intelligent Parameter File: By checking this option the Intelligent Parameter File
(IPARAM) for Q projects will be uploaded from the PLC.

� Confirm your selections with OK.

E
WARNING:
The first time you download a new project it is important to ensure that the option PLC
Parameter and Program is selected.
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Available drives

The following table lists all drives and their respective availability for the following functions in
the menu Project - Transfer:
Upload from PLC, Download to PLC, Copy Program Memory to Flash ROM.

# Supported

— Not supported
� Direct download of the project to a flash ROM is not supported for the Q00(J)/Q01 CPUs. A

project can be transferred to drive 4 by downloading it to the program memory and then
copying the program memory to the flash ROM.
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Drive Q Q00(J)/Q01 QnA Q Remote I/O

0 Type Program memory Program memory Internal RAM —

Upload # # # —

Download # # # —

1 Type Memory card RAM not available IC card A RAM —

Upload # # —

Download # # —

Copy destination — — —

2 Type Memory card ROM not available IC card A ROM —

Upload # # —

Download # # —

Copy destination #
(flash ROM card
only)

— —

3 Type Standard RAM Standard RAM
(used for auto-
matically defined
file registers)

IC card B RAM —

Upload — — # —

Download — — # —

Copy destination — — — —

4 Type Standard ROM Standard ROM IC card B ROM Flash ROM

Upload # # # �

Download # — � # �

Copy destination # # — �

Tab. 8-3: Available PLC CPU drives



8.6.1 Downloading the Intelligent Parameter file for Q projects

The download of the Intelligent Parameter (IPARAM) file for a Q project is handled by the
dialogues PLC Parameter Boot Settings and Project Transfer Setup. The file IPARAM is
part of the GX IEC Developer project. It is located in the subfolder Resource of the project
folder.

PLC Parameter

The Intelligent Parameter file is added to the Boot file setting list automatically. Additionally,
editing the “Boot file setting” list is enabled. This causes the following behaviour:

� The column Transfer from is editable for all entries, allowing you to select the drive where
the PLC files are transferred from.

� The buttons Insert and Delete are used to insert or delete an entry in the Boot file setting
list.

NOTE However, in order to preserve consistency in the project, if CONSIST.MMP is removed from
the Boot file setting list, it will be re-added automatically as soon as the dialogue is closed.
The Transfer from drive of CONSIST.MMP will be set to the same drive as for the MAIN
program.

� An entry for a SFC program will be added or removed automatically during compile,
depending on the existence of a SFC program in the project. The Transfer from drive of
the SFC program will be set to the same drive as for the MAIN program.
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Checking the Boot File before download

If the Boot File is selected for download, its entries will be checked during the initialization of
the Download process. The following warning will be displayed if either the Parameter, the
MAIN or (if it exists in the project) the SFC program is missing from the boot File:

The following warning will be displayed if the Transfer from drive of all entries is not set to the
same drive:

When the PLC Parameter dialogue is opened, it is automatically checked if the Intelligent
Parameter File exists in the project. If it does, the display of the Boot File setting is modified,
so it includes an entry for the Intelligent Parameter File. The Transfer from drive of the Intelli-
gent Parameter File is set to the same drive as for the PLC Parameter.

At the beginning of the Download process, it is checked if the Boot File and the Intelligent
Parameter File are selected to be transferred. If both files were selected, the Boot File will be
modified before download to include an entry for the Intelligent Parameter File (if this entry
does not exist already).
The Transfer from drive of the Intelligent Parameter File is set to the same drive as for the PLC
Parameter. The existence of the IPARAM file in the project will be checked before download.
If no IPARAM file exists in the project, no entry will be added to the Boot File of the Intelligent
Parameter File. If the entry already exists, it will be removed.

The message Download success will be shown, in order to inform you:
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Fig. 8-111:
Message

Fig. 8-112:
Warning

Fig. 8-113:
Download success



Download and Upload of the Intelligent Parameter

The dialogue showing the Download results also includes the status of the Intelligent Param-
eter. If the download of IPARAM was successful, but the download process fails or is aborted
later, the following dialogue will be displayed:

NOTE When downloading to both systems of a QnPRH PLC, the redundant version of this dialogue
will be used. In this case, the same file is downloaded to both systems (as with all other files
during a redundant download).

If the download of the Intelligent Parameter fails because the project does not contain the Intel-
ligent Parameter (IPARAM.WPA) file, the download process will not be interrupted. In this
case, the following dialogue will be shown:

If the download of the Intelligent Parameter fails because of any other reason, the download
process will be aborted and the dialogue showing the Download Results will be displayed:

8 – 88 MITSUBISHI ELECTRIC

Transfer Setup - Project Compiling and Downloading Programs

Fig. 8-114:
Download results

Fig. 8-115:
Message

Fig. 8-116:
Download results



If the upload of the Intelligent Parameter fails because the PLC drive does not contain the Intel-
ligent Parameter (IPARAM.QPA) file, the upload process will not be interrupted. In this case,
the following dialogue will be displayed:

If the upload of the Intelligent Parameter fails because of any other reason, the upload process
will be aborted and the same dialogue will be displayed as for any other error occurring during
the upload:

8.6.2 Download symbolic information by menu command

The menu Project - Transfer includes a menu command to download symbolic information of
the current project to the PLC. This is independent of the current settings concerning source
information in the transfer setup.

This menu command will be shown only when the current PLC type is A/QnA/Q.

In a redundant PLC system in backup mode, the user will be asked (via a confirmation
dialogue) if he wants to download symbolic information of the current project to both PLCs.
(Please refer to section 3.7.2 for details of the confirmation dialogue.)
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Fig. 8-117:
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Fig. 8-118:
Warning



8.6.3 Ignore checks

If the project currently open in GX IEC Developer and the project on the connected PLC have
different time stamps, there is the possibility to continue the current action, although the
projects are not equal.

This dialogue is used for the following actions:

� Project online program change

� Online change mode

� Download symbolic information

During monitoring the button Ignore Checks is enabled. In this non-critical case the user is
allowed to monitor the projects although the projects are not equal. In all other cases the button
Ignore Checks is disabled.

It is not possible to ignore checks when starting a project online program change or entering
the online change mode.
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8.6.4 The Q/QnA’s File Structure

How to format and defragment the Q/QnA series drive

Before you can use the memory in the MELSEC Q/QnA series CPUs you must first format the
corresponding drive. This applies both for the internal RAM and the external memory cards.

For details on the available drives refer to the table on page 8-85.

� Select Format Drive in the Online menu. The Format / Defragment dialogue box is
displayed.

In a redundant PLC system in backup mode, the user will be asked (via a confirmation
dialogue) if he wants to format the specified drive of both PLCs. (Please refer to section
3.7.2 for details of the confirmation dialogue.)

Similarly, before defragmenting any of the drives in Backup mode, the user will be
asked (via a confirmation dialogue) if he wants to defragment the specified drive of
both systems. (Please refer to section 3.7.2 for details of the confirmation dialogue.)

0 … 4: Drive to be formatted or defragmented.

Create system area to speed up monitoring...: If a Q/QnA is connected to GX IEC
Developer and a remote Q/QnA is to be monitored, both PLCs (host and remote) have to be
formatted with at least 1-K steps system area available in the dialogue Format / Defragment.
If one of both PLCs is not formatted with this system area, the remote Q/QnA cannot be
monitored.

Create system area to enable Multi Block Online Changes… : In the CPUs supporting the
MBOC function the number of steps which can be exchanged in the online mode has been
expanded to 1024 steps. These 1024 steps do not have to be within one block. It is also
possible to make changes in several small blocks. The maximum number of blocks is fixed to
64. However, the number of 1024 steps must not be exceeded (Q series only except Q00(J),
Q01, and QnU CPUs).

Format: Selecting this button starts the format procedure.

Defragment: Because of the file structure used in the Q/QnA series CPUs it is possible for the
drives to become fragmented after data have been written to the CPU, just as with a normal
hard drive. Selecting the Defragment button executes a procedure that defragments the
contents of the drive for better performance.
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How to get File Information

� Select File Info in the Online menu. The File Info dialogue box displays information on
the memory and the files in the CPU.
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For details on the available drives refer to the table on page 8-85.

Memory usage - drive

Used memory: Amount of downloaded data (unit: bytes)

Available memory: Amount of memory available for use (unit: bytes)

Largest free block: Largest free memory block available (unit: bytes)
In case this block is not large enough, use the Defrag option.

Execute operations on System ...: If one of the Execute operations check boxes of the
extended dialog for the redundant system is unchecked, the corresponding file list will be
disabled and any selections removed.
If both of the Execute operations check boxes are unchecked, the Delete, Read and Write
buttons will become disabled.
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MAIN program - drive

Generated with version: Displays the version of GID that was used to generate the program

– Version string extracted from MAIN.QPG

– “n/a” if there’s no program, or it was not generated with GX IEC Developer

Generation time: Displays the generation time of the program

– Generation time extracted from the consistency information (CONSIST.MMP) (*)

– “n/a” if there’s no program or no consistency information

Files

0 … 4: Files stored in the program memory (Drive 0), in the RAM or ROM of the memory card
(Drives 1 and 2), and in the standard RAM or standard ROM (Drives 3 and 4).

NOTES Full details on the file structure used by the MELSEC Q/QnA series CPUs can be found in
the CPU manuals.

The extended dialog for the redundant system is used in Backup and Separate mode if both
systems are accessible. In Debug mode, or if the other system is not accessible, the
standard version of this dialog is used.

Transfer files between personal computer and PLC

From the File Info dialogue selected PLC files can be transferred from the PLC drives to the
hard disk of your personal computer and vice versa. They can also be deleted. Multiple files
can be selected via mouse-click in combination with the [CTRL] or [SHIFT] key.

This function is for example useful for storing the documentation of the currently running
process on a PLC drive to make it always available.

Delete file(s)

Deletes the selected files from the PLC.Multiple files can only be deleted from one single drive.
Only files can be deleted (not drives etc.).

Read from PLC

Reads the selected files from the PLC. A standard file dialogue is opened where you specify
the destination folder for the selected PLC file(s) on your hard disk. Multiple files can only be
read from one single drive.

Write to PLC

Writes the selected files to the selected PLC drive. A standard file dialogue is opened where
you specify the source file(s) on your hard disk. Multiple files can only be written from one
single directory. Writing to flash ROM drives is not supported.
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Remarks on stopping and restarting the PLC during the "Write to PLC" operation

Some files (e.g. Program and Parameter files) cannot be written to Q and QnA PLCs via the
File Info dialogue when the PLC is in RUN mode. In previous versions of GX IEC Developer,
attempting to write such files during RUN failed with an EasySocket error message.

The dialogues Stop PLC and Restart PLC (normaly used to stop and restart the PLC e.g.
during a Delete file operation) can also be used to stop and restart the PLC during a Write to
PLC operation if any system files (i.e. files used by the GX IEC Developer project) are selected.

The following files will be considered to be system files:

When the first such file is encountered during Write to PLC, the following dialogue will be
displayed if the PLC is in RUN mode:

When the Write to PLC operation is finished, the following dialogue will be displayed:

For QnPRH PLCs in Backup mode, or if both systems are selected in Separate mode, the
redundant version of these dialogues will be used:
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Fig. 8-123:
Warning that PLC will be stopped

� MAIN.QPG � CONSIST.MMP

� SFC.QPG or MAIN-SFC.QPG � SYMBOLIC.MMP

� PARAM.QPA � LIBRARY.MMP

� IPARAM.QPA � AUTOEXEC.QBT

� SYMPARAM.MMP � MBOC.QMB

Fig. 8-124:
Message about copying result

Fig. 8-125:
Warning that both PLCs of a redundant
system will be stopped

Fig. 8-126:
Message about copying result for
a redundant system



8.6.5 Copy program memory to flash ROM (MELSEC Q only)

The complete PLC program memory content can be copied to the selected flash ROM drive.
The flash ROM drive can even be unformatted. All files stored on the flash ROM drive are
overwritten.

Select the menu item Project - Transfer - Copy Program Memory to Flash ROM to open the
following dialogue.

Select the desired flash ROM drive and confirm with OK.

In a redundant PLC system in backup mode, the user will be asked (via a confirmation
dialogue) if he wants to copy the program memory to the Flash ROMs of both PLCs. (Please
refer to section 3.7.2 for details of the confirmation dialogue.)

Supported flash ROM drives

Only the following drives are supported as copy destinations.

NOTE In case of QnU(D)(E)(H)-series PLCs copying the whole content of Drive 0 (program
memory) will be possible only to Drive 2 (memory card ROM), not to Drive 4 (standard
ROM).

8.6.6 Copy Program Cache to Program Memory

This function is only available for the series QnU(D)(E)(H) and is enabled when a project is
open.

The QnU(D)(E)(H)-series has a different memory model compared to the Qn(H)-series.
Instead of a single program memory, a QnU(D)(E)(H) CPU has a program memory and a
program cache memory.

� The program memory is of Flash-ROM type to store its contents permanently without the
need for battery backup.

� The program cache memory is an SRAM that loses its contents when the power is cut.

The only purpose of the program memory is to store the data. When the PLC is switched on or
reset, the contents of the program memory is copied to the program cache memory. All files
(parameter, program, symbolic information, etc.) are transferred. Afterwards the
QnU(D)(E)(H) PLC uses the program cache memory in the same sense as a Qn(H)-series
PLC uses the program memory. When switched to RUN mode, it executes the program in the
program cache memory.
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Fig. 8-127:
Copy Program Memory to Flash ROM dialogue

Drive Q Q00(J), Q01

2 Memory card ROM (only flash type supported) not available

4 Standard ROM Standard ROM

Tab. 8-4: Available copy destination drives



When changing the contents of the program cache memory, it is necessary to keep the
program cache memory synchronised with the program memory, otherwise the changes
would get lost if the power is cut from the CPU. Most of the time the changes in the program
cache memory are automatically mirrored to the program memory. For example, when
executing the download to PLC operation, data are first written into the program cache
memory of the CPU module, and then transferred to the program memory automatically.

However, in case of online program change operations it is possible to disable the automatic
mirroring in the Options (see section 2.9.3). The reason for this possibility is that since the
program memory is of flash ROM type, its lifecycle is limited to about 100000 writing opera-
tions. When online program change is executed frequently, turning off automatic transfer will
extend the lifetime of the flash ROM.

In order to give the chance to keep data up to date, the function Project Transfer Copy
Program Cache to Program Memory… is available to start the transfer from the program
cache memory to the program memory manually from GX IEC Developer. For example, it can
be used if the last online program change operation was performed without mirroring.

8.6.7 Latch Data Backup

To prolong the life of the battery for the series QnU(D)(E)(H) when the system is stopped for a
long period of time it is possible to keep latch data (such as device data or error history) in the
standard ROM, which does not need the battery to hold them, as it is a flash memory.
Once the data is backed up, the power of the PLC can be switched off and the data will be held
until the power is switched back on, when the data will be restored.

Backup

Calling Online Latch Data Backup Backup enables to copy (back up) latch data in the
memory.

After confirmation the status of the PLC will be checked. If it is in RUN mode, it has to be
switched to STOP. This will be confirmed by the following dialog.

NOTES Choosing not to stop the PLC will result in terminating the process, and data will not be
backed up!

To avoid losing data on the PLC when turning off the PLC after the latch data backup
operation, you will be warned if online program change was used while the project was open,
and the program memory was not updated with the data in the program cache since then.
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Fig. 8-128:
Confirmation for
backing up data

Fig. 8-129:
Confirmation for
stopping the PLC



If the action is performed successfully, a dialog will inform you about finishing.
The BATTERY LED of the CPU will flash in green, signaling that the PLC can be turned off.

NOTES If the backup cannot be performed, a message box with the cause or the list of possible
causes will be displayed.

If backup data from a former backup operation already exists in the Standard ROM, it will be
automatically overwritten.

Delete

The backup data can be deleted by calling Online Latch Data Backup Delete Backup
Data. The function can be used if the data will no longer be needed to be stored in the flash
memory after restoring.

If the Standard ROM contains data to be deleted, the following confirmation message will be
displayed.

After confirmation the status of the PLC will be checked. If it is in RUN mode, it has to be
switched to STOP. This will be confirmed by the following dialog.

NOTES If the deletion cannot be performed, a message box with the cause or the list of possible
causes will be displayed.

If the action is performed successfully, a dialog will inform you about the completion.
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Fig. 8-130:
Confirmation
message

Fig. 8-131:
Confirmation
message

Fig. 8-132:
Confirmation for
stopping the PLC



8.6.8 Downloading the Project

When you have checked the port settings and project parameters you can download your
project to the controller.

How to download the project to the PLC

� Select Transfer in the Project menu, then select Download to PLC.

NOTES In a redundant PLC system in backup mode, the user will be asked (via a confirmation
dialogue) if he wants to download the project to both PLCs. (Please refer to section 3.7.2 for
details of the confirmation dialogue.)

In case of a Q Remote I/O module the download function transfers only the parameter and (if
selected) the intelligent parameter to drive 4 of the PLC.

The progress of the download process will be documented in a status window.

The successful transfer to the PLC is confirmed by a message box.

Check list before downloading

� Has the project been compiled without errors?

� Are the port parameters set properly for the transfer?

� Are the project parameters set correctly?
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8.7 Comparison and Online Change of Project Data

8.7.1 Consistency

To verify the consistency between the data in the project and on the PLC, the necessary data
must be uploaded from the PLC, which can take a long time with large projects.
To provide a quick way to check if the parameter and program data in the project and on the
PLC are identical, consistency information is maintained on the PLC for projects downloaded
by GX IEC Developer. The project consistency check is based on the timestamp stored in the
consistency information, which represents the time when the program codes were generated.
If there is no consistency information on the PLC, or if it is incorrect (not downloaded by GX IEC
Developer), consistency cannot be determined by this quick method.

Hereafter the exact verification of consistency will be referred to as verification of consistency
by the long method.The quick consistency check, based on the consistency information down-
loaded to the PLC, will be referred to as checking consistency by the quick method or quick
consistency check.

Parameter and program data on the PLC are considered to be consistent with that in the
project, if the following conditions are met:

For all PLC types:

� The project is compiled without any error.

� Code generation options and PLC parameter have not been changed in the project since
last compilation.

Additionally for Q/QnA series PLC types:

� The parameter in the project and the parameter on the PLC are identical, excluding the
parts of the parameter which are modified by the PLC after switching it to RUN mode.

� The main program in the project and the main program on the PLC are identical.

� The SFC program in the project and the SFC program on the PLC are identical (if SFC
program exists in the project), considering SFC program file headers as well.

NOTE When online verification is called to confirm consistency, the boot settings will not be
compared.The reason is that differences in the boot settings do not affect the functionalities
that require consistency.

Additionally for A series PLC types:

� The parameter in the project and the parameter on the PLC are identical, excluding the
parts of the parameter which are modified by the PLC after switching it to RUN mode.

� The main program in the project and the main program on the PLC are identical.

� The timer initial values of the main program are identical in the project and on the PLC.

� The counter initial values of the main program are identical in the project and on the PLC.

� The sub program in the project and the sub program on the PLC are identical (if sub
program exists in the project).

� The timer initial values of the sub program are identical in the project and on the PLC (if sub
program exists in the project).

� The counter initial values of the sub program are identical in the project and on the PLC (if
sub program exists in the project).

� The SFC program in the project and the SFC program on the PLC are identical (if SFC
program exists in the project).
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Additionally for FX series PLC types:

� The parameter in the project and the parameter on the PLC are identical, excluding the
parts of the parameter which are modified by the PLC after switching it to RUN mode.

� The program in the project and the program on the PLC are identical.

There are situations when the consistency information is wrong, i.e. inconsistency is indicated
although the parameter and the program codes are identical, or consistency is indicated
although the parameter and/or the program codes are different.
The first case is inconvenient for the user, because he must then verify the consistency by the
long method, which can take much longer than the quick consistency check.
The second case is dangerous, because functionalities assuming consistency from the quick
check can cause erroneous operations when the data in the project and on the PLC are
actually inconsistent.
Solutions for both of these issues are available.

False indication of inconsistency – due to missing or invalid consistency information

It is possible that the consistency information in the PLC’s memory is invalid, or there is no
consistency information at all on the PLC. Invalid consistency information means that the data
existing in the location of supposed GX IEC Developer consistency information is actually not
GX IEC Developer consistency information.

This can happen, because...

� the project was not downloaded by GX IEC Developer.

� the consistency information on the PLC has been (accidentally) overwritten or deleted by
the user.

� the data on the PLC has been changed in an unsupported way (i.e. not by GX IEC
Developer).

� for FX and A PLCs: the PLC has not been switched to RUN mode since last download.

In this case, when a functionality that requires consistency is performed, the user will be
presented a dialogue where he is noticed about inconsistency – based on the validity of the
consistency information –, and he is offered to verify consistency by the long method.Verifying
consistency can take long, so it is desirable to perform it as infrequently as possible.

The Online Verify functionality is extended, so that when Project Transfer Verify is
called, it will determine if the consistency information on the PLC is valid. If the verification finds
that all required data in the project is identical with that of the PLC, and there is no valid consis-
tency information on the PLC, the user will be asked whether he wants to download valid
consistency information to the PLC.The question will be shown after displaying all the verifica-
tion results in the Verify Result Messages window (please see Tab. 4-6 and Tab. 4-7 for
details on the messages).
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Fig. 8-134:
Message box



(“Drive 0” in the question will be replaced by the drive set in the project transfer setup for Q- and
QnA series PLCs. It will be replaced by “the PLC” for FX- and A series PLCs.)

If the user clicks on Yes, consistency information will be generated and downloaded to the
PLC. As a result, next time when an operation requiring consistency is called, it will be able to
detect consistency by the quick method.

NOTE This feature is not available when the drive selected for download in the project transfer
setup (Online Transfer Setup Project) of a Q or QnA series PLC is Flash ROM type.

False indication of inconsistency – due to different program code generation times

When there is valid consistency information on the PLC, it is possible that the program code
generation times differ even with identical parameters and program codes. For example if the
project is changed and compiled, then changed back and compiled again. In this case, when a
functionality that requires consistency is performed, the user will be presented a dialogue
where he is noticed about inconsistency – based on code generation times –, and he is offered
to verify consistency by the long method. Verifying consistency can take long, so it is desirable
to perform it as infrequently as possible.

In the current version, when consistency verification is invoked from this dialogue, and it is
proved that the parameters and the program codes are identical, the generation times in the
consistency information of the project and the PLC will be synchronized, so that next time the
quick consistency check will find consistency.

On the other hand, when Project Transfer Verify was called, it did not synchronize
generation times in the same situation. So the user will be asked whether the consistency
information should be updated. The question will be shown after displaying all the verification
results in the Verify Result Messages window.
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Fig. 8-136:
Message box



If the user clicks on Yes, the generation time of the project will be updated to be the same as the
generation time on the PLC. The project has to be saved to keep this change.

False indication of consistency

It is possible that the program code generation times are equal even with different parameters
and/or program codes.

It is a rather rare situation, but it can happen if...

� a software other than GX IEC Developer was used to download or change data on the PLC,
when the PLC has project data downloaded by GX IEC Developer.

� system files were directly manipulated on the PLC with GX IEC Developer or another
software.

It is dangerous to have incorrect consistency information on the PLC, when the parameters
and/or the program codes in the project and on the PLC are different. It can easily result in
malfunction when an operation – e.g. online program change – falsely assumes consistency
by the quick method.

The Online Verify functionality is extended, so that when the user calls Project Transfer
Verify, such a false indication of consistency will be detected and the user will be asked if the
incorrect consistency information should be deleted.

(“Drive 0” in the question will be replaced by the drive set in the project transfer setup for Q- and
QnA series PLCs. It will be replaced by “the PLC” for FX- and A series PLCs.)

If the user clicks on Yes, the consistency information will be removed from the PLC.

NOTES This feature is not available when the drive selected for download in the project transfer
setup (Online Transfer Setup Project) of a Q or QnA series PLC is Flash ROM type.

The FX0 and FX0S PLCs have no consistency information, therefore this functionality is not
applicable to FX0 and FX0S PLCs.

Downloading or deleting consistency information in Flash ROM type memories is not
supported. This feature is not available when the drive selected for download in the project
transfer setup (Online Transfer Setup Project) of a Q or QnA series PLC is Flash
ROM type.
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8.7.2 Comparing the programs in the PLC CPU and GX IEC Developer

The function Online verify in the menu Project - Transfer compares the program code stored
in the PLC CPU with the code of the current project compiled by GX IEC Developer.

NOTE In a redundant PLC system in backup mode, the user will be asked (via a confirmation
dialogue) if he wants to verify both PLCs. (Please refer to section 3.7.2 for details of the
confirmation dialogue.)

Only sequence code differences are shown. Differences for SFC programs of A series CPUs
which will be transferred to the main micro computer area will not be shown.

For a redundant PLC system in backup mode the verify process will display items for both
PLCs in the Verify Result Messages window.

NOTES Please see Tab. 4-6 and Tab. 4-7 for details on these messages.

For Online Verify the message Boot file not found is displayed, if there is no boot file in the
project on the PLC compared with.

Detected differences in the program code can be shown in a Main or Sub Program Differ-
ence window via the Show button. The verify results are listed as recompiled MELSEC IL, the
differences are highlighted in the error color. The left part of the window lists the project code,
the right part of the window lists the uploaded PLC code.
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Verify Result Messages



When the Main or Sub Program Difference window is opened the following menu items are
available in the Tools menu:

Next Difference: Next Difference or the tabulator key will position the text in the window so
that the first line of the next difference is the top most line. The top most line will be selected.
The according calltree, number of network and for IL and ST the line in the network of the
selected line are shown in the status bar. If no next difference exists, the menu item is greyed.

Previous Difference:Previous Difference or the shift tabulator key will position the text in the
window so that the first line of the previous difference is the top most line. The top most line will
be selected. The according calltree, number of network and for IL and ST the line in the
network of the selected line are shown in the status bar. If no previous difference exists, the
menu item is greyed.

Goto Editor: Goto Editor or a double click on a selected line will open the according POU
body. In IL/ ST the according line and in LD/ FBD the according network is positioned to the
visible area and marked with the browser colour in the network column.
If no POU body relates to the selected line a message window is opened to inform you of this
circumstance. The message text will be “The selected line belongs to code generated for task
or program handling. No editor could be opened.”

Show Step Number: This menu item is checked as default. If it is checked, the step number for
each instruction for the code of the project and of the PLC are displayed.
If it is not checked, the step number are not displayed. If a line is selected and the step number
are not displayed, the line is marked with a small box in front of the instruction.
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8.7.3 Online Changes

There are three different ways to make changes to programs when the controller is in RUN
mode:

Project – Online Program Change and Online Program Exchange respectively:
These options compile the whole modified program and transfer it to the PLC.

Online – Online Change Mode:
Selecting this option compiles changes made in a program network and directly transfers them
to the PLC.

Tool for the menu command Online - Online Change Mode

In general Online Change only works if the compiled program codes in the project and the PLC
are identical. After the project is changed and compiled, online change cannot be performed,
because the compiled program codes are different in the actual project and on the PLC. In this
case the projects in GX IEC Developer and on the PLC are called inconsistent (� 8.7.1). You
will be shown the following dialogue when an online change is attempted:

This result is based on the comparison of the generation times of the program codes in the
project and on the PLC (� 8.7.1).
The generation times can differ even if the program codes are identical (e.g.when the project is
changed, compiled and then changed back to its original state and compiled again). The
Verify button can be used to check if the program codes and the parameter are really different.
If the parameter and the program codes turn out to be identical, online change will be
performed.

Online program change needs to compare the differences between the old and the new
program codes. If the two projects are inconsistent, the old program code exists only on the
PLC, not in the project, so the new program code cannot be compared with the old one.

When the parameters in the actual project and on the PLC don’t differ, the program code on the
PLC can be uploaded and used as “old code” to be compared with the new code when online
program change is prepared. This way it will be possible to perform an online change even if
(an accidental) Rebuild was called before.
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After pressing the Verify button in the consistency dialogue shown above, if the inconsistency
is confirmed, you will be warned and asked whether you still want to perform online program
change.

If you click on Yes, online change will be performed by comparing the newly compiled code
with the old code that is uploaded from the PLC before – provided that the other usual checks
preceding an online change are passed (see below). Depending on the circumstances (e.g.
too big code parts to be changed), it is possible that online exchange will be applied – just like
in the case of a consistent project. And in specific cases (e.g. when changing both SFC and
Main programs with step deletion in the SFC program or when the connected PLC does not
support online exchange), it will be possible that online change will be denied – just like in the
case of a consistent project.

In the case that online change (or online exchange) is executed, the actual project and the
project on the PLC will be consistent after that.Consecutive online changes can be completed
normally, without the above described handling.

You can set if online change should be available when inconsistency is found. Please see
section 2.9.3 for the related Options setting.

NOTES In Backup mode only the control system has to be in RUN mode for Online Change. The
standby system may be in either RUN or STOP mode. However, if the standby system is in
FILE VERIFY ERROR (6000 or 6001), an error message will be displayed and Online
Change will be aborted.

In backup mode Online Program Change will only be executed if the registered keyword (if
any) is the same on both PLCs. If there’s a mismatch, an error message will be displayed,
and Online Change will be aborted.

In Backup mode Online Program Change will only be executed if the size of the additional
program size area is the same on both PLCs. (For details on setting the additional program
size please refer to section 2.9.3.) If there’s a mismatch, an error message will be displayed,
and Online Change will be aborted.

If in a redundant system the current additional program size area is exceeded during online
program change, the number of necessary additional steps will be calculated. If either of the
PLCs has not enough free space in Program Memory for the necessary additional steps, an
error message will be displayed, and Online Change will be aborted.
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Project – Online Program Change/Online Program Exchange

This function enables you to make changes to the program while the system is in RUN mode.
The edited program is recompiled automatically and compared with the code in the PLC CPU.
Only the altered part of the program code is downloaded to the CPU.

NOTE Online changes are possible using the Single Block Online Change (SBOC) function or
the Multiple Block Online Change (MBOC) function which is available for MELSEC Q/QnA
series’ CPUs (from release date 03.1999 on). The MBOC function is not available in the
Q4ARCPU.

Limitations for FX CPUs

For the FX family, there are the following restrictions regarding the kind of changes you can
apply on the program with Online Program Change:

� No newly added, deleted or changed (replaced) pointer or interrupt labels (P and I) are
allowed.

� No used pointer or interrupt label (P and I) may be shifted up or down due to a change in the
size of the program code.

� No pointer or interrupt label (P and I) may be included in the changed part of a program.

� No newly added or deleted start or reset of high speed counters is allowed.

� No newly added start of 1 ms timers is allowed.

� No newly added or deleted instructions MNET(P), ANRD(P), ANWR(P), RMST,
(D)RMWR(P), (D)RMRD(P), RMMN(P), BLK(P) or MCDE(P) are allowed.

Limitations for FX3U CPUs

For the FX3U there are fewer limitations than for other FX PLCs.The restrictions for FX3U are:

� No newly added, deleted or changed (replaced) pointer or interrupt labels (P and I) are
allowed.

� No newly added or deleted start or reset of high speed counters is allowed.

� No newly added start of 1 ms timers is allowed.

� No newly added or deleted instructions DTBL, WBFM, RBFM or (D)SORT2 are allowed.

When online program change is not possible because one or more restricted changes have
been made to the program, the reason(s) will be displayed in the following dialogue and online
program change will be aborted.

8 – 108 MITSUBISHI ELECTRIC

Comparison and Online Change of Project Data Compiling and Downloading Programs

Fig. 8-142:
Message window in case of
a FX3U CPU



Online Program Exchange is an extension to Online Program Change and Online Change
Mode. If the difference between the old and the new main/SFC program exceeds the step-limit
of normal online change (both SBOC and MBOC if available), you will be offered to use Online
Program Exchange to perform the change on the respective program type.
If you then chooses not to do so, online change will recover, as it does when the step-limit is
exceeded. The Online Program Change will not be executed then.
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Fig. 8-143: Dialogue box to inform about program exchange
(for a QnH CPU other than Q02H)

Fig. 8-144: Dialogue box to inform about program exchange
(for a Q02H CPU)



Pressing the Details button shows the following dialogue box:
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Fig. 8-145: Dialogue box to inform about program exchange
(for a Q25SS CPU)

Fig. 8-146: Dialogue box to inform about program exchange
(if the SFC structure has been changed)

Fig. 8-147: Dialogue box Warning Details



PLCs of the MELSEC Q series support Online Program Exchange.This means that while the
PLC is in RUN mode, the main program on drive 0 (program memory) of the PLC will
completely be replaced with the one you are working on. The advantage of this functionality
compared to the normal Online Program Change is that it allows a significantly larger number
of steps to be changed at once than using the Online Program Change.
The advantage of the project download is that there is no need to stop the PLC.

Nevertheless it is recommended to use Online Program Change instead of Online Program
Exchange if the applicable differences can be handled by Online Program Change, as it
needs less free memory and time.

NOTE Qn(H) CPUs from version B4 onward support Online Program Change of the SFC
program. Online Program Exchange is supported as well. SFC online change with older
CPU versions will work just like before: if normal Online Program Change cannot be
performed, the online change process will be aborted.

The following table shows the availability of main program and SFC program online exchange
on specific CPUs of the Q-series:

So in the case of a SFC program when online change fails, online exchange can be performed.
If the structure of at least one SFC POU was modified, online exchange will be offered –
provided that the version of the CPU is detected to be at least B4.

When executing Online Program Exchange first the compiled main/SFC program is down-
loaded to the PLC’s memory, then MAIN.QPG/SFC.QPG in the program memory is over-
written with the downloaded file. For this program exchange there must be enough free space
for the new program code while the old MAIN.QPG/SFC.QPG is still in memory. This free
space can be either in the program memory or in a SRAM or ATA memory card (provided that
the size of the downloaded file is not greater than the size of the exchanged file and the free
memory space in the program memory altogether).

If there is not enough free space on drive 0, an installed memory card is automatically used
instead.

If both programs have to be exchanged, the main and the SFC program are exchanged sepa-
rately, so there must be enough free space for the bigger program for a successful online
exchange.

After Online Program Exchange a SFC program is not automatically restarted by the PLC
(except for block 0, if the “Autostart block 0” option is set in the SFC Parameters).
Therefore, for Q Series PLCs, the code generated when SFC POUs are used in a project, the
last SFC block (BL319) is generated as an SFC control block, which is used to restart all SFC
blocks after an Online Exchange.
If this control block could not be generated (because the project already used SFC block 319),
a warning will be displayed during SFC Online Exchange.
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CPU Support of
main program exchange

Support of
SFC program exchange

Q02(H), Q06H, Q12H, Q25H ✔ from version B4 on

Q12PH, Q25PH ✔ —

Q25SS ✔ —

Q00(J), Q01 — —

Tab. 8-5: Support of Online Program Exchange



E
CAUTION
- Performing an Online Program Exchange affects the behaviour of the PLC.
- Controls are stopped during the program exchange interval and outputs are not

changed, which may be dangerous in some situations.

NOTES The scan time of the first cycle after finishing the program exchange will be increased by
approximately
- 1.2 ms/kSteps on QnH CPU and
- 2.9 ms/kSteps on Qn CPU
if there is enough space in the program memory to perform the exchange.

If a SRAM card is needed for the operation, the scan time will be increased by approximately
- 2.3 ms/kSteps on QnH CPU and
- 4.8 ms/kSteps on Qn CPU.

If an ATA card is needed for the operation, the scan time will be increased by approximately
50 ms/kSteps.

While Online Program Exchange is in progress, an instruction to make access to a file is
not executed.

The following conditions have to be fulfilled to start the Online Program Exchange:

� Online Program Change must fail because of exceeding the step-limit of both SBOC and
MBOC (if available), or because of the SFC structure change.

� There must be enough space on drive 0 for the new program(s) (with the old program(s)
considered as free space, since they will be replaced)

� There must be enough space on drive 0 or a memory card for the new program file (with the
old program file still in memory). If both main and SFC programs get exchanged, there
must be enough space for the bigger one of them.

Online Program Exchange is not available in the following situations:

� Too many changed labels and/or interrupt labels

� The CHK CHKST, CHKCIR or CHKEND instruction could not be changed, added or
deleted.

Changes between the CHKST and CHK, or between the CHKCIR and CHKEND instructions
are not allowed.
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Online – Online Change Mode

Online Change Mode is different to the options for compiling the project or Online Program
Change. In this mode, as soon as you make a change to a network a program verify is
performed and the change is then written directly to the PLC. This ensures maximum program
consistency and security.

After an online change has been made GX IEC Developer checks whether symbolic source
information is selected in the transfer setup. If this is the case, you will be asked whether you
want to download symbolic information. This dialogue can be disabled for the current GX IEC
Developer session.

If you do not want to download any symbolic information or the option no information is
selected in the transfer setup, symbolic information is deleted on the PLC.

NOTES You should only ever make changes to one contiguous program range in the PLC at a time,
and the range should not be too large. If you want to be absolutely sure that you are not
modifying excessively large sections it is advisable to use Online Change Mode, as this
mode only permits you to make changes to one network at a time. After every change made
to a network the system automatically performs a program compare and transfers the
modification directly to the PLC.This approach ensures maximum program consistency and
security.

In FX0 CPUs you can only change counters and timers when the PLC is in RUN mode.

Add new network

In the Online Change Mode new networks can be added to programs of the type IL, LD, FBD,
and MIL in the editors. To add a new network, in the Edit menu select New Network. From the
opening submenu select where to insert the new network: Top, Before, After, Bottom.

In the ST editor (Structured Text) online changes can be performed in the network.

Creation or Update of a Variable

In Online Change Mode the Variable Selection Dialog can be opened and a new variable can
be created or an existing one can be changed. The according POU or a GVL is saved in the
database immediately.

But these changes can not be undone when the Online Change Mode is left. Because of this a
confirmation message is displayed when you create a new variable or update an existing
variable in the POU header or a GVL in Online Change Mode.
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Recover Online Changes

If the online change fails or it is cancelled by the user, a message box appears giving three
options. In case a variable was created or changed an Undo is not possible.The Undo button is
grayed then.

Undo

The changes recently made are rejected and the unmodified network saved at the beginning is
recovered. GX IEC Developer remains in online change mode. Additional Undo/Redo in the
menu Edit is not possible.

Continue

The changes recently made are kept and you have the possibility to correct the faulty network
manually. Recent changes can be restored by means of the functions Edit - Undo and Edit -
Redo.

GX IEC Developer remains in online change mode.

Abort

The changes recently made are kept and the online change mode will be left. Recent changes
can be restored by means of the functions Edit - Undo and Edit - Redo.

Via mouse clicks to the navigator area the online change mode will be left.

If you have made changes, you are asked whether you want to remain in the online change
mode. Additionally you have the option to undo the changes which have already been done.
In case a variable was created or changed an Undo is not possible. The Undo button is grayed
then.
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Code Generation Options

In the Extras - Options menu the Code Generation command is available (refer to 2.9.1).

The file structure used in the CPUs of the MELSEC Q series makes it necessary to define an
additional program range (in units of steps) for online changes when you are using these
controllers.

8.7.4 Transfer from Program Cache to Program Memory after Online
Program (Ex)Change

Normally the functionalities Online Program Change and Online Program Exchange apply
the modifications to the program cache, then the changes are automatically transferred to the
program memory. In case of the Series QnU(D)(E)(H) the program memory is of flash ROM
type, so its lifecycle is limited to about 100000 writing operations.
When Online Program (Ex)Change is executed frequently, the automatic transfer to the
program memory can be turned off in the Options (see Section 2.9.3), to extend the lifetime of
the flash ROM.

When the automatic transfer to program memory is turned off, you will be asked after each
online (ex)change operation whether the changes should be transferred.

NOTE It is important that the Program Memory is updated when all changes are applied to the PLC.
Even if you forget to transfer the Program Cache to the Program Memory after the last online
program (ex)change operation, it is possible to initiate the transfer explicitly via the menu
item Project Transfer Copy Program Cache to Program Memory… (see Section
8.6.6).
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8.8 Exporting

When you perform an import/export both the PLC program data and all the parameter settings
are now imported and exported.

8.8.1 Exporting an GX IEC Developer project into an ASCII file

You can export and save the contents of your projects in ASCII format for archiving or to
provide the information to others.The ASCII file contains all the project data and has the added
advantage that it takes up significantly less storage space than the contents of a complete
project directory.

How to export the entire project

� Select the command Other in the Project menu, then select Export.

A dialogue box is displayed.

� Enter the name for the ASCII file.

� Click on the OK button.

The progress of the export process is documented in a status window.

How to export individual objects

� Select the objects in Project Navigator you wish to export.

� Select the command Export in the Object menu.

A dialogue box is displayed.

� Enter the name for the ASCII file.

	 Click on the OK button.

The progress of the export process is documented in a status window.

8.8.2 Export to EPROM

This function stores an ASCII file in Motorola format which can then be used to program PLC
EPROMS with a standard EPROM programmer. Every line in the ASCII file contains the
corresponding hardware address and values. The Export to EPROM command is in the
Other submenu of the Project menu.
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8.8.3 CSV variable export

The menu item Extras - Export Variables exports all variables defined in the GVL and the
POU header of a project in the CSV (Comma Separated Variables) format into a text file. This
file can be opened in external tools, e.g. process visualisation or Microsoft Excel.

Before the function is available, the project must be compiled. Besides the variable
declarations (including class, identifier, address, type, initial value, comment), the exported
file contains general project information (e.g. project name and GX IEC Developer version
number).

The options for the CSV variable export can be set under Extras - Options - CSV-Export
(refer to section 2.8.2).
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8.9 Importing

When you perform an import/export both the PLC program data and all the parameter settings
are now imported and exported.

GX IEC Developer provides a number of data import functions, which are listed briefly below.

Importing Programs from Files

� Import a GX IEC Developer ASCII file
(Project - Other - Import) (Object - Import)

� Import a GX IEC Developer ASCII file
(Tools - Import - GX Developer Network)

� Import a MELSEC print file
(Tools - Import MEDOC Network)

Importing Programs from the PLC CPU

� Symbolic Upload: Upload the project from the PLC CPU, together with all graphical
information (Project - Transfer - PLC to MEDOC (Symbolic))

� MELSEC Upload: Upload the project from the PLC CPU in a MELSEC network
(Project - Transfer - PLC to MEDOC (MELSEC))

8.9.1 Importing GX IEC Developer ASCII files

A project saved as an ASCII file can be imported selectively. If you do not create a new project
before performing the import the selected objects are added to those in the current project.
This applies for all POUs, the tasks, DUTs and the global variables. The import function only
works on ASCII files saved with the GX IEC Developer Export function!

NOTES You must first create an export file before you can perform an import.
Importing a large ASCII file may take a while without any indication.

The ASCII import functionality is restricted for the Q Remote I/O modules. Files exported
from a non-Q Remote I/O project are not allowed to be imported into a Q Remote I/O project.
And files exported from a Q Remote I/O project are not allowed to be imported into a non-Q
Remote I/O project.

How to import the entire project

� Select the command Other in the Project menu, then select Import.

A dialogue box is displayed.

� Select the desired ASCII file.

� Click on the OK button.

The progress of the import process is documented in a status window.
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How to import individual objects

� Select the command Import in the Object menu.
A dialogue box is displayed in which you can select the objects that you wish to import
into the new or existing project.

NOTE In case of a Q Remote I/O module the Import functionality will import only the PLC
Parameter, since Q Remote I/O projects have no other objects. Therefore in the object
selection dialogue of the Import functionality all objects except the PLC Parameter will be
disabled.

� Mark the check boxes of the objects you wish to import.

– Data Unit Types (DUTs)

– Data Units Variables

– POUs

– Global Variables

– Tasks

– PLC Parameter

– User Objects

– User Libraries
� Click on the OK button..

A dialogue box is displayed.

	 Select the desired ASCII file.


 Click on the OK button.

The progress of the import process is documented in a status window.

NOTES When importing data from an ASCII export file that includes the Global Variable List (e.g. a
complete project export), external variables will be automatically removed from POU
headers (including POUs in user libraries).

When importing data from an ASCII export file that has no Global Variable List in it, each
imported POU header will be checked for external variables. If one or more variables with the
class VAR_EXTERNAL or VAR_EXTERNAL_CONSTANT are found, you will be warned
that these variables will be skipped.
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8.9.2 Importing GX Developer ASCII files

GX Developer (former GPP/WIN) ASCII files can be imported. The ASCII file must have been
exported from GX Developer by the separate software package GX Converter.

Open any editor of the type IL or MELSEC IL and select a network. In the Tools menu select the
item Import GX Developer Network.Select the required file from GX Developer (text or CSV)
to be imported into the selected network.

NOTE Functions not supported by GX IEC Developer are ignored during the import (e. g. device
comments, initial values, program execution types).
SFC programs can not be imported.

The data to be imported must comply with the following requirements:

Common

The maximum length of an import line is limited to 512 characters.

The width of the different data fields is limited to the following values:

� Step number: 7

� Line statement: 64

� Instruction: 15

� P/I-Statement: 64

� Note: 32

� Device: 15

Text files:

� Text files have to start with a step number followed by a blank (‘ ‘); otherwise the text file is
not recognized as a text file

� Line statements have to start with a step number, followed by one or more blanks, followed
by a ‘;’ and followed directly with the line statement.
Sample:
7 ;I am a line statement

� Notes may not start with a step number and can be located wherever in the import line; they
have to be enclosed by ‘<’ and ‘>’
Sample:
<I am a Note>

� P/I-statements may not start with a step number and can be located wherever in the import
line; they have to be enclosed by ‘[’ and ‘]’. Separate Statements must start with a ‘*’ before
the ‘[‘.
Sample:
*[I am a separate Statement]
[I am an embedded Statement]

� If a line only contains device data and no statement, the device information must start in
column 25, columns 9 to 24 must be blank (‘ ‘)
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CSV-Files:

� CSV-files have to start with a step number followed by a comma (‘,’), otherwise CSV-Files
are not recognised as CSV-Files

� Step numbers must be located in column 1

� Line statements must be located in column 2

� Instructions must be located in column 3

� Devices must be located in column 4

� Column 5 must be empty

� P/I statements must be located in column 6

� Notes must be located in column 7

� Columns 8 and 9 must be empty

� Each line must contain exactly 8 separators

� Notes, line statements and P/I statements, which contain one or more ‘,’ must be enclosed
with quotes ‘”’

� Quotes within notes, line statements and P/I statements must be masked with another
quote; the whole statements must be enclosed with quotes

� Separate P/I-statements must start with ‘*’
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8.9.3 Importing MELSEC MEDOC print files

Print files generated by MELSEC MEDOC (DOS version) can be loaded into IEC or MELSEC
Instruction Lists as MELSEC networks. The POU into which you wish to load the file must be
open and the network must be selected. Please note that performing this import procedure
automatically overwrites the contents of the selected network in the body!

How to import MELSEC MEDOC print files

In MELSEC MEDOC (DOS version):

� Select a file name as the printer port. The extension TMP is added to the file name
automatically.

� Select only the Instruction List and Name List in the program listing. Make sure that the
header is switched off!

� Start the print procedure.

In GX IEC Developer:

	 Open the body of a MELSEC Instruction List or create a new MELSEC Instruction List
POU. This new POU must be a Program (PRG).


 Select New Network in the Edit menu, then select MELSEC Before from the submenu
displayed.

� Select Import MELSEC Network in the Tools menu.

� In the dialogue box displayed specify the drive and directory where the import file is
stored and select the import file (TMP). Confirm your selection with OK. An option box is
opened.
GX IEC Developer checks whether the specified file is a valid import file, and whether it
contains program code and symbolic names. The default settings displayed in the option
box depend on the results of this check. For example, if no symbolic names are found
this option will be displayed in light grey and is not selectable.

" Confirm the selections with OK.

The progress of the import process is documented in a status window.

MELSEC Program: Import only the program code lines of the Instruction List.

MELSEC Symbolic Names: Import only the Name List. The entries from the list are inserted
both in the global variables declaration table and in the header of the POU. Comments after
relays and data registers are converted into symbolic names and imported as comments.
When this conversion is performed spaces, quotes and periods are either deleted or replaced
with underline characters in accordance with the IEC standard.
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The translation of the symbolic names can result in duplicate names for some variables. If this
happens the following dialogue box is displayed:

The first two entries show the name of the existing variable and the name that the program
proposes to use to overwrite this variable.

Replace: Replace the old variable name with the new one.

Repl. all: Replace all existing variable names with new names. If you select this button the
program will replace all subsequent variables without prompting.

Skip: Skip this variable name without replacing it. The name is also not added to the Variable
List.

Skip all: Skip all variables with duplicate names and do not add any of them to the Variable
List. If you select this button the program will skip all subsequent duplicate variables without
prompting.

8.9.4 Upload PLC to MEDOC

The upload function reads the binary code from the PLC CPU and creates a POU in MELSEC
IL language with the standard name PRG_MAIN and a task with the standard name
MELSEC_MAIN. In addition to the binary code all the graphical and structural information from
the PLC CPU can be uploaded.

How to upload project code from the CPU

� In the Project menu select Transfer. Then select Upload from PLC.

� Select the PLC type and confirm with OK.

� The upload must be stored in a new project. Enter the name of the new project to be
created in the dialogue box displayed.

	 Confirm your entry with OK.


 A dialogue box is displayed showing a selection of ports for the transfer procedure:

– CPU Port

– Computer Link

– Ethernet
� Select the appropriate port for your configuration and confirm with OK.
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� A dialogue box is displayed showing a selection of UPLOAD modes:

– MELSEC IL

– Source Information
" Select the required UPLOAD mode and confirm with OK.

When you select symbolic source information to be uploaded from the PLC, GX IEC
Developer  will check whether symbolic information is available on the PLC.

The progress of the import procedure is documented in a status window.

Absolute Label

Absolute labels are used as jump destinations when PLC programs are uploaded in GX IEC
Developer. Absolute labels are specific pointer addresses (e.g. P20). Every program section
identified with a pointer in the original PLC program is loaded to a separate MELSEC network.

Absolute labels can also be assigned by the user, but you must be very careful to use the
correct syntax. Only addresses with the format P – underline – address are interpreted as
absolute labels.

P_20 Reference to pointer P20 (absolute label)

P20 Reference to a free pointer P** (not an absolute label)

NOTE The labels with the format LAB_20 generated when you import MELSEC MEDOC print files
are not absolute labels!
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9 Diagnostics Functions and Online
Operation

9.1 Debugging

The following sections describe the functions in the Debug menu, which allow to perform
precise troubleshooting and error analysis on your progress.
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9.2 PLC diagnostics

9.2.1 A CPU diagnostics

The status and the error codes of the CPU can be displayed. In the Debug menu select PLC
Diagnostics. The PLC will be checked and the dialogue below is opened.
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Item Description

� PLC Panel

Shows the operation status of the target PLC.

� Monitor

The Start monitor button starts the communications with the PLC and the error display is updated.
The Stop monitor button stops the communication with the PLC and the error display.
Clicking on Error log or Clear Log automatically stops monitoring.

� Error display (Present Error)

This section displays errors currently occurring in the connected CPU.

� Error display (Error message)

This section lists the detected errors.
Click on the Error log button to display recent error messages from an error log.
The Clear Log button clears this error log.

Tab. 9-1: A CPU diagnostics items

Fig. 9-1: A CPU diagnostics

�

�

�

�



9.2.2 QnA CPU diagnostics

The status and the error codes of the CPU can be displayed. In the Debug menu select PLC
Diagnostics. The PLC will be checked and the dialogue below is opened.
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Item Description

� PLC panel
Shows the PLC panel status of the target PLC.

� PLC operation status
Shows the PLC operation status of the target PLC.

� Monitor
The Start monitor button starts the communications with the PLC and the error display is updated.
The Stop monitor button stops the communication with the PLC and the error display. Clicking on
Error log or Clear Log automatically stops monitoring.

� Swap module during run
Select the base number and the slot number for the module to be swapped and click on Detach
target.

� Error display
Click on the Present Error button to display errors currently occurring in the connected CPU.
Click on the Error log button to display recent error messages from an error log. The Clear Log
button clears this error log.

Tab. 9-2: QnA CPU diagnostics items

Fig. 9-2: QnA CPU diagnostics
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NOTE Double-click on a present/current error shown in the list to open the Error details dialogue.
The Error details dialogue shows the content of SD5 – SD15 (common error information)
and SD16 – SD26 (individual error information).
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9.2.3 Q CPU/Q Remote I/O Module diagnostics

The status and the error codes of the CPU can be displayed. In the Debug menu select PLC
Diagnostics. The PLC will be checked and the dialogue below is opened.

GX IEC Developer Reference Manual 9 – 5

Diagnostics Functions and Online Operation PLC diagnostics
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Item Description

� PLC operation status
Shows the PLC operation status of the target PLC.

� Monitor run/stop
The Start monitor button starts the communications with the PLC and the error display is
updated.
The Stop monitor button stops the communication with the PLC and the error display. Clicking on
Error log or Clear Log automatically stops monitoring.

� Error log
This section lists the detected errors.

� Error status
This section shows whether the displayed error is a present error or an error from the error log.
Click on the Present Error button to display errors currently occurring in the connected CPU.
Click on the Error log button to display recent error messages from an error log. The Clear Log
button clears this error log.

Tab. 9-3: Q CPU diagnostics items



9.2.4 FX diagnostics
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Item Description

� PLC panel
Shows the PLC panel status of the target PLC.

� Error indication
Click on the Current Error button to display errors currently occurring in the connected CPU. The
date and time values refer to the moment when the Current Error button was activated but not
when the error occurred.
The currently occurring errors are listed including the error code and error message.

� Monitor start/stop
The Start monitor button starts the communications with the PLC and the error display is
updated.
The Stop monitor button stops the communication with the PLC and the error display.

Tab. 9-4: FX diagnostics items



9.3 MELSECNET Diagnostics

From a selectable target host station the status of a MELSECNET (II) or MELSECNET/10
network can be checked.
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Item Description

� Tabs for link modules
Select the tab for the link module for displaying the diagnostics results (AnN or AnA CPUs only
support 2 modules).

� Network information
Shows information on the network the selected target host station belongs to (for MELSECNET (II)
the network number and group address are not displayed).

� Link information
Shows the network status.

� Monitoring
The Start monitor button starts monitoring. In RUN mode the display will be updated.
The Stop monitor button stops monitoring.

� Communication information
Shows the communications status of the selected network (for MELSECNET/10 only the
communications status is displayed).

� Error History Monitor (see below)
Network Monitor Details (see below)
Other station information (see below)

� Network diagnostics (see below)
Network test
Setup confirmation test
Station order check test
Communication test

Tab. 9-5: Network diagnostics items



NOTES In a MELSECNET (II) network at maximum 2 link modules can be installed.
In a MELSECNET/10 network at maximum 4 link modules can be installed.

The network diagnostics check the network the connected host station belongs to. To
change the network simply change the connection to the host station and select the
connection to another host station.

For the connection to remote I/O modules the network diagnostics are not supported.

If the connection is established via a E71 unit the monitoring of an AnU CPU is performed
like for an AnA CPU. MELSECNET (II) information can be monitored but no
MELSECNET/10 information.

Error history Monitor

This button in the Network diagnostics dialogue opens a dialogue that monitors and lists
communication errors in an error history. Communication errors are listed separately for
the forward and the reverse loop. Error history details can be monitored and the error history
can be cleared.
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Network Monitor Details

This button in the Network diagnostics dialogue opens a dialogue that displays network monitor
details.
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Other station information

This button in the Network diagnostics dialogue opens a dialogue that monitors other
stations connected to the MELSECNET (II) or 10.

� Network information: Shows information on the network of the selected target host
station.

� Other station information/Error information: If an error in a station, a stopped station, a
reserved station, or a station with external power supply the error information field reads
ERR. Click on the respective button to select an object for the error information to show
detailed error information.

� Display field for detailed error information: Shows the status of the relevant station for
the selected item.

� Start monitor: Starts monitoring.

� Stop monitor: Stops monitoring.
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The following information on other stations is available for the A series:

# = available, – = not available

The following information on other stations is available for the Q/QnA:

# = available, – = not available
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Information on each Station

MELSECNET /10 MELSECNET (II)

MELSECNET /10 MELSECNET (II) —

Control Station Normal Station Master Station Master Local

Loop Branch Loop Branch Loop Branch — —

1 Communications Status # # # # # # # —

2 Data Link Status # # # # # # — —

3 Parameter Status # # (—) (—) # # # —

4 CPU Operation Status # # # # — — — —

5 CPU RUN Status # # # # — — # #

6 Loop Status # — # — # — # —

7 Res. Station Designation # # # # # # — —

8 External Power Supply — — — — — — — —

9 Error Search Status — — — — — — # —

Tab. 9-6: Information on other stations, A series

Information on each Station

MELSECNET /10 MELSECNET (II)

MELSECNET /10 MELSECNET (II) —

Control Station Normal Station Master Station Master Local

Loop Branch Loop Branch Loop Branch — —

1 Communications Status # # # # # # # —

2 Data Link Status # # # # # # — —

3 Parameter Status # # (—) (—) # # # —

4 CPU Operation Status # # # # — — — —

5 CPU RUN Status # # # # — — # #

6 Loop Status # — # — # — # —

7 Res, Station Designation # # # # # # — —

8 External Power Supply # (—) # (—) # (—) — —

9 Error Search Status — — — — — — # —

Tab. 9-7: Information on other stations, Q/QnA



Network diagnostics/Network test

This button in the Network diagnostics dialogue opens a dialogue where you can start or
stop the link operation for the MELSECNET/10 host station, selected stations, or all stations.

The following items are available:

� Network information: Shows information on the network of the selected target host
station.

� All stations operating status: Displays the operating status of the tested modules.

� Link start/stop:
Link start: Stations that were stopped by the host station can be started. Stations that
were stopped by another station can not be started.

Link stop: Stations can be stopped by the host station or another station.

Force link start: Stations can be started regardless of whether they have been
stopped by a host station or another station.

However, the start can not be forced, if all stations were stopped. A start can not be
forced neither, if for the link target another station is the target.

By monitoring SB and SW can be determined whether a forced start of a peripheral
device can be performed. By monitoring SW0000 – SW0004 can be determined
whether the execution was started or stopped by a host station.

A start can be forced, if the connection is established via C24, UC24, or QC24.

Via a MELSECNET (II) or 10 interface board the start can not be forced.

Via E71/QE71 the start can not be forced.
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Network diagnostics/Setup confirmation test

This button in the Network diagnostics dialogue opens a dialogue where you can check the
status of the station number, network address, and group address.

The following items are available:

� Network information: Shows information on the network of the selected target host
station.

� Setting check test:

Parameter settings: All stations that are setup in the parameters except the reserved
station are tested (If no network settings are setup, all stations are tested).

All stations: All stations are tested. No specified station is addressed.

Target module: The module by default selected for the for the line monitor is specified.
If no MELSECNET/10 module is connected, an error message is returned.

� Execution results:

Station number: Shows the station number up to the specified station
(64 station numbers max.).

Loopback station: If the same loopback station was assigned to more than one
station a “*” is displayed.

Network number: If the same network number was assigned to more than one station,
“*” is displayed.

Group number: Shows the group addresses of the stations for which the setup
confirmation test is performed. For a remote I/O network faulty stations are indicated by
a blank.

Reserved station: For stations specified as reserved stations “*” is displayed (if
parameter confirmation was selected as test object).

Error: If a station is reserved in the parameter settings or if a module in all selected
stations is faulty “*” is displayed.

Error network type (Q series only): Stations for which the parameter settings and
current link do not match are indicated as “*”.

Double multiplex remote master station (Q series only): Stations with more than one
sub master station within the same network are indicated by “*”.

Double parallel remote master stationXXX (Q series only): Stations with more than
one sub master station within the same network are indicated by “*”.

NOTE The tests can not be performed for more than one station at one time.
During the test execution the scan execution is stopped.
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Network diagnostics/Station order check test

This button in the Network diagnostics dialogue opens a dialogue where you can check the
station order in the forward and reverse loops of a MELSECNET/10.

� Network information: Shows the information on the network of the selected target host
station.
The loop status is displayed for forward loops, reverse loops, forward/reverse loops, or
loopback. The displayed total number of stations includes also the reserved-by station.

� Loop test: All stations specified in the parameter settings except the reserved stations are
tested (If no network settings were specified, all stations are tested).

All stations: All stations are tested. No specific station is addressed.

Target module: The module by default selected for the for the connection monitor is
specified. If no MELSECNET/10 module is connected, an error message is returned.

� Execution results: The station order is displayed in forward loop and reverse loop
direction beginning from the host station.
For loopback only the station order in forward loop direction is displayed.

NOTE The tests can not be performed for more than one station at one time.
During the test execution the scan execution is stopped.

Network diagnostics/Communication test

This button in the Network diagnostics dialogue opens a dialogue that displays general
communication test results.
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9.4 Ethernet Diagnostics

The Ethernet diagnostics test several settings of the connected Ethernet modules.

For details on error messages and the buffer memory refer to the manuals of the corre-
sponding modules:

� Ethernet modules for the Q series (User's manual)

� Ethernet modules for the QnA series (User's manual)

� Ethernet modules AJ71E71-S3, A1SJ71E71-B2-S3, and A1SJ71E71-B5-S3
(User's Manual)

You can check the status of the following items:

� Parameters

� Errors

� Individual connections

� Individual protocols

� LEDs

� Received and sent e-mail information
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Fig. 9-11: Ethernet diagnostics
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Item Description

� Target module setting
Here you select the Ethernet module to be checked. The Q series modules No. 1 – 4 can be
selected.
A or QnA series modules are selected by their I/O address.

� Change IP address display
Here the display of the IP address can be toggled between decimal or hexadecimal format.

� Tabs for Ethernet information
Here different information types for the Ethernet modules are displayed.

� PING test
Tests an Ethernet module that has completed its initialization or checks for any existing IP
address.
The PING test can either be executed via an Ethernet board or via a direct connection to the PLC CPU.

� Loop test
This function is intended for Ethernet modules that are compatible with the Q series function
version B or higher. A loop instruction tests whether all modules under a specified network number
or station number have completed their initialization.
If this test is executed for Ethernet modules that are compatible with the Q series function version
A the response can not be evaluated and is processed as not responding.
The loop test can either be executed via an Ethernet board or via a direct connection to the PLC
CPU.

� COM. ERR. off
Turns off the communications error LED.

� Start monitor
Starts the Ethernet diagnostics.

Tab. 9-8: Ethernet diagnostics items



9.5 CC-Link(-LT) Diagnostics

The CC-Link(-LT) diagnostics monitor the network information of each station and test the network
status.

The CC-Link(-LT) diagnostics can be started via the PLC CPU independently from the
CC-Link station running as master, stand-by master, or local station.

NOTE For the diagnostics via a Q CPU in Q mode the module QJ61BT11 is required.
For the diagnostics via a Q CPU in A mode the module AJ61BT11 or A1SJ61BT11 is
required. If a program for the A series includes refresh parameters, the network test is
disabled.

Monitoring a CC-Link line (host station)

The CC-Link(-LT) diagnostics monitor the CC-Link line connected to the PLC CPU via the host
station.

GX IEC Developer Reference Manual 9 – 17

Diagnostics Functions and Online Operation CC-Link(-LT) Diagnostics

Fig. 9-12: CC-Link(-LT) Diagnostics

�

�

�

�

���



9 – 18 MITSUBISHI ELECTRIC

CC-Link(-LT) Diagnostics Diagnostics Functions and Online Operation

Item Description

� Line Monitor (Host station)
Lists all connection relevant CC-Link information.
For details on the indication of special relays (SB) and special registers (SW) refer to:
Loop test: See section below
Monitoring other station: See section below

� Module setting (Q series only):
Specify the module the CC-Link diagnostics have to be executed for. Before executing make sure
that your Q CPU and QJ61BT11 are of function version B or higher.

� Network test
The data link is started or stopped for the specified CC-Link module.

� Monitor start/stop
The monitoring of the host station is started or stopped.

� Acquire the setting information
The setting information of the CC-Link module is acquired for the CC-Link status.
After execution the acquired setting information can be set as EEPROM parameters by turning ON the
device YnA via the Device Test.

� Loop test: See section below

� Monitoring other station: See section below

Tab. 9-9: CC-Link(-LT) Diagnostics items



Monitoring other station

The CC-Link(-LT) diagnostics monitor the CC-Link line connected to the PLC CPU via other
stations.

Maker Code
Displays the manufacturer's name and identification of the modules connected via CC-Link.
The manufacturer identification is also displayed, in case the manufacturer name has not been
entered.
The remote I/O modules are represented as blank entry because they do not provide a manu-
facturer name or identification.
The list of manufacturers is saved as file (PARTNER.DAT) in the GX IEC Developer installation
directory. It can be edited with a text (ASCII) editor.
When editing the list the following formatting must be kept:

� The maker's name should be completely entered in " ". Example: "##### Co., Ltd."
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Fig. 9-13: Line monitor (Other station)
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Item Description

� Information on other station
Acquires and displays information on reserve stations, settings for invalid errors, station types, and
occupied station numbers from the Q CPU.

� Invalid station if temporary error
Modules that have been replaced without corresponding remote station are detected in online
operation mode.

Tab. 9-10: Line monitor (Other station) items

Description Maker Code Company name

Maximum number of characters 5 255

Allowed characters � 0 – 9 Alphanumeric, symbols

Remarks Manufacturer identification not
consisting of 5 digits is ignored.

Display varies depending on
screen size.
More than 75 characters can not
be displayed in one window.

Tab. 9-11: PARTNER.DAT formatting



Loop test

The loop test tests all stations or a selected station.
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Fig. 9-14:
Loop test
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Item Description

� Monitor all stations
Monitors all CC-Link stations
Illegal stations are indicated in red.

� Loop test
Specify whether to test All stations or a Selected station.  Click Execute Test to execute the
loop test.

Tab. 9-12: Loop test items



9.6 System Monitor

The System Monitor displays comprehensive information on the entire connected PLC
system. The System Monitor supports Q series PLCs only.

In the Debug menu select System Monitor to open the following dialogue:

Installed status

This section illustrates the selected base and shows the installed modules and vacant slots
(”not mounted”).

Base

This section lists the connected bases and displays the error status coded by colors (see section
“Status”). If several bases are connected, the base to be displayed can be selected via radio
buttons.

Parameter status

This section gives additional information on the installed modules and their addresses.

Status

Indicates the color codes for the status displayed in the “Base” section.

GX IEC Developer Reference Manual 9 – 21

Diagnostics Functions and Online Operation System Monitor

Fig. 9-15: Mode: System Monitor



Start monitor/Stop monitor

Starts or stops monitoring.

Diagnostics

Also available in the context menu as Diagnosis feature execution.

Opens appropriate diagnostics functions for the selected module:

� For a CPU module the PLC diagnostics dialogue (see section 9.2) is opened.

� For an Intelligent Function Module the Intelligent Function Module Utility (see section
9.16) is opened.

� For network modules the Networks Diagnostics dialogue (see section 9.3) is opened.

Module’s Detailed Information

Also available in the context menu as module’s detailed information or via double-click on a
module.

Opens the following dialogue that displays detailed information on the selected module.

NOTE It may take a few seconds until all details are displayed, especially those for the error display.

Error History: Displays the stored error history.

H/W Information: Opens a dialogue that displays more details on the LED and SW status.

Start monitor: Starts monitoring.

Stop monitor: Stops monitoring
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Fig. 9-16:
Module’s Detailed
Information



Base Information

Opens the following dialogue that displays information on the selected base.

Product Inf. List

Opens the Product Information List that gives an overview of the connected PLC system.
The Product Information List can be exported into a CSV file (comma separated value) via
the CSV file creating button. The CSV format can be imported by many other applications.
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Fig. 9-17:
Base Information

Fig. 9-18: Product Information List



9.7 CC-Link IE Controller Network Diagnostics

NOTE The CC-Link IE Controller Network is suppor ted only by Qn(H)-ser ies and
QnU(D)(E)(H)-series PLCs.

The CC-Link IE Controller Network diagnostics monitor the network status and the operating
status of each station can be checked.

� Select the menu Diagnostics - CC IE Control diagnostics.

� When two or more CC-Link IE controller network modules are mounted, the dialog box
Select diagnostics destination appears. Select a network to be diagnosed and click
OK.

� The dialog box CC IE Control Network Diagnostics is displayed. For its operation, refer
to the following explanation.
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Fig. 9-19: Select diagnostics destination

Fig. 9-20: CC IE Control Network Diagnostics



Change Module: When two or more CC-Link IE controller network modules are mounted,
Select diagnostics destination is displayed by clicking the button Change Module.

Select station: Specifies station No. of selected station.

Change select station:Enter a station No. to Select station and click Change select station
to change the selected station.

Network information display: See section 9.7.1

Select station network device status display: See section 9.7.2

Button Communication test �, �: This button in the CC IE Control Network Diagnostics
dialogue opens a dialogue that displays general communication test results.

Button Link start/stop �, �: Receiving data from other stations and sending data of its own
station can be disabled in a case such as debugging. (Transient transmission is not stopped.)
Each station's cyclic transmission can be stopped or restarted from GX IEC Developer.
Note that this function is not available in circuit test mode.

Button Logging �, �: See section 9.7.3

Button System monitor: See section 9.7.4

Button Remote operation: See section 9.7.5
� Selectable when the selected station is connected to GX IEC Developer (the own station).

Not selectable when it is any other station.
� Not selectable in circuit test mode.
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9.7.1 Network information display

The result of checking the line status and parameter setting status is displayed.

Module�: Displays the module No. of network which is being diagnosed.

Network No.: Displays the network No. of network which is being diagnosed.

Total No. of stations: Displays the total number of stations in a network.

I/O master station: Displays the station No. of I/O master station.

Link scan time: Displays the current link scan time.

Icon: Displays the status of each station and status between stations.

Button Prev: When the total number of stations is 61 or more, the screen prior to network infor-
mation display is displayed by clicking Prev.

Button Next: When the total number of stations is 61 or more, the screen next to network infor-
mation display is displayed by clicking Next.
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Fig. 9-21: Network information display



Description of icons

The status of each station and status between stations are displayed.


 Station No.
1 to 120: Displays the station No. of the CC-Link IE controller network module.
Undef.: Displayed for the station for which parameters have not been set� or station No. is
not assigned.
� For display of the station for which parameters have not been set, there are restrictions

on the CC-Link IE controller network module versions.Check the serial No.and software
version for applicability.

� Connected
This is displayed for the station connected to GX IEC Developer (own station).

� Icon
When double-clicking the station icon, System Monitor is displayed, see section 9.1.5.
The icons that may be displayed are listed below.
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Fig. 9-22: Different icons
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� Present Control and Assign Control
Present Control: Displayed to the station actually operating as control station.
Assign Control: Displayed to the station set by network parameters.

NOTE When multiple stations on the same system (in a multiple CPU system configuration) have
the same network No. If a station other than those on the system is selected while a station of
the lowest start I/O No. has a baton pass error, a transient execution error (no baton passing
on the own station) (E504H) will occur. Resolve the baton pass error, and then redo the
operation.
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Icon Description

Normally operating station

Faulty station (a fault has occurred on a module, board, display, or cable while cyclic
transmission is performed.)

Faulty station (Cyclic transmission is stopped.)

Station in a different shared group (no cyclic data are received.)

Disconnected station (black)

Reserved station (gray)

Selected station (station icon edged with green)

� This can be selected by clicking a station icon or moving a focus and holding down a
space bar.

� The detailed information is displayed at [Select station network device status display].

� In addition, disconnected station and reserved station cannot be selected.

Focusing (station icon edged with dotted line)

� Holding down a space bar makes a station to be selected station.

� In addition, disconnected station and reserved station cannot be selected.

Communication error

� When selecting the station next to the one where communication error is occurring, the
detailed information is displayed at Select station network device status display.

Tab. 9-13: Description of icons



Display position of a disconnected station

There are two cases for positioning a disconnected station on the screen.

� When normal connection information has been obtained �, �

The disconnected station (station No.4) is displayed in the position where it was
connected when normal.

� When normal connection information has not been obtained
The disconnected station (station No.4) is displayed on the IN side of the GX IEC
Developer connected station.

� The normal connection information is network configuration data that the CC-Link IE con-
troller network module on the GX IEC Developer connected station stores in its memory
when all stations are normal. When all of the following conditions are met, the normal con-
nection information can be obtained. Also, after any of the conditions became unsatisfied, if
all of them are met again, the normal connection information will be updated.
- All stations are in data link status (Cyclic transmission status of each station (SB00B0) is OFF.)
- No loopback station (Loopback status (SB0065) is OFF.)
- No station has a parameter error. (Parameter status of each station (SB00E0) is OFF.)
- The number of actually connected stations is the same as the total of stations that is set for

the control station (except reserved stations).
� For obtaining the normal connection information, there are restrictions on the version of the

CC-Link IE controller network module on the GX IEC Developer connected station. Check
the serial No. and software version for applicability.

NOTES If the system was rewired after system activation, set Normal connection information refresh
instruction (SB000C) to ON to update the normal connection information.

If station No. of a disconnected station (No.4) is set to an invalid value (station No.9) by
mistake after acquisition of the normal connection information, the icon of the station will be
displayed on the IN side of the GX IEC Developer connected station.
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Fig. 9-23: When normal connection information has been obtained

Fig. 9-24: When normal connection information has not been obtained

Fig. 9-25: Display example



9.7.2 Select station network device status display

The detailed information of the selected station is displayed. A module is selected here. For
selection of a board or terminal display, refer to the relevant manual.

Description of select station network device status display:
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Fig. 9-26: Select station network device status display

Item Description Display content

Group No.
Displays a group number of the
selected station.

0 to 32

Shared group No.
Displays a shared group number of
the selected station.

0 to 120

Mode
Displays the mode of the selected
station.

Online
Offline

H/W test
Self-loopback test

Circuit test
Test between station

Operating status

Normal operation

Operation error (data link
continued) (yellow)

Operation error (data link
discontinued) (red)

Select station network device status
display

See section Indicator LEDs in the
Hardware Manual of the relevant
CPU modul.

Communication status

Data linking

Cable disconnection

Communication error (other than
cable disconnection)

Module error (CC-Link IE controller
network parameter setting error or
transient transmission error)

Error details button
Displayed at faulty parts.
See section "Error details".

Tab. 9-14: Description of select station network device status display



NOTES When a transient transmission error occurs, check the error description in error code and
take corrective action.
When a transient transmission error log is cleared after taking a corrective action toward the
error, the communication error display is cleared.
See section 9.7.3.

When multiple stations on the same system (in a multiple CPU system configuration) have
the same network No.
If a station other than those on the system is selected while a station of the lowest start I/O
No.has a baton pass error, a transient execution error (no baton passing on the own station)
(E504H) will occur.
Resolve the baton pass error, and then redo the operation.

Error details

When clicking on the error showing button the dialog box Error details is displayed.
Take corrective action according to troubleshooting.
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Fig. 9-27:
Error details



9.7.3 Logging

The history for the communication path switching and transient transmission error can be
monitored and the error information can be cleared.
Note that these operations are not available in circuit test mode.

� The dialog box Logging is displayed by clicking on the button Logging in the dialogue
box CC IE Control Network Diagnostics. For its operation, refer to the following
explanation.
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Fig. 9-28: Tab Monitor detail

Fig. 9-29: Tab Error clear



Display Station: Displays the network No., group No., and station No. of the connected
station.

Tab Monitor detail: The history for the communication path switching and transient transmis-
sion error is displayed.

Switch transmission path �

Loop Status: Displays the status of a loop.
Loopback station: Displays a station where loopback occurs at IN-side and OUT-side at
loopback.
Date: Displays a time when a communication path is switched.

Transient transmission error �

Error Code: Displays error codes. For details concerning the error codes please see the
CC-Link IE Controller Network Reference Manual, section 10.2 Error Code List.
Target Net: Displays network No. of the station where an error was detected.
Target Station: Displays station No. of the station where an error was detected.
Date �: Displays a time when a transient transmission error is detected.

Button Save error log: Saves the description of monitor detail in CSV file. You have to specify
the drive/path and the file name for saving the CSV file.

Tab Error clear: The error information is cleared.
To clear error information select an item at Clear type. The error information then can be
cleared by clicking the button Clear Error info.
� Up to 100 logs are displayed, and when the maximum is reached, they will be erased in

sequence from the oldest one.
Note that when the screen is closed, logs numbered 17 or higher are deleted.To retain them,
click on the Save error log.

� If a transient transmission error is detected during start-up of the CC-Link IE controller net-
work module, the time of the error may be displayed as blank.
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9.7.4 System monitor

The module status of the CC-Link IE controller network module can be checked.

� Perform any one of the following operations.

– Click in the CC IE Control Network Diagnostics dialog box.

– Double-click in the CC IE Control Network Diagnostics dialog box.

– Select Diagnostics - System Monitor menu.

� The System Monitor dialog box is displayed.

� Perform any one of the following operations.

– Click in the System Monitor dialog box.

– Double-click Installed status of the CC-Link IE controller network module in the
System Monitor dialog box.

	 The Module's Detailed Information dialog box is displayed.
For its operation, refer to the following explanation.
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Fig. 9-30: Module's Detailed Information



Module

Module Name: Displays the name of a module.
I/O Address: Displays the start I/O number of a module.
Implementation Position: Displays the slot position where a module is mounted.
Product information: Displays product information.
- The end of the product information indicates function version of the module.
- When the end is "B", it indicates the module of function version B.

Module Information

Module access: Displays Possible when no watchdog timer error occurs.
Status of I/O Address Verify:The parameter setting and the verification result of the mounted
module are displayed.

Error Display

Present Error: Displays the latest error code. For details concerning the error codes please
see the CC-Link IE Controller Network Reference Manual, section 10.2 Error Code List.
Button Error History: The history of error codes is displayed by clicking the button Error
History. For details concerning the error codes please see the CC-Link IE Controller Network
Reference Manual, section 10.2 Error Code List.
Error contents - Disposal: The description and corrective action of an error code selected by
Error Display.

Button H/W Information: The LED information and switch information of the module can be
checked.
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Fig. 9-31: H/W Information
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Item Description

RUN
Displays the operating status of a module.
0001: Operating normally
0000: Hardware fault or watchdog timer error

PLC Displays the network type.
0001: Controller network

ONLINE
Displays the operation mode of the CC-Link IE controller network module.
0001: Online mode
0000: Other than online mode

TEST
Displays the operation mode of the CC-Link IE controller network module.
0001: Test mode
0000: Other than test mode

OFFLINE
Displays the operation mode of the CC-Link IE controller network module.
0001: Offline mode
0000: Other than offline mode

M/S. ERR.

Displays the detection status of duplicated control station or station No.
Check the network status by CC IE Control Network Diagnostics.
0001: Duplicated control station or station No. detected
0000: Undetected

PARAM.ERR.

Displays the parameter error detection status.
Check the network status by CC IE Control Network Diagnostics.
0001: Parameter error detected
0000: Undetected

F LOOP ERR.

Displays the IN-side error detection of the CC-Link IE controller network module.
Check the network status by CC IE Control Network Diagnostics.
0001: IN-side error detected
0000: Undetected

MANAGER
Displays the station type of the CC-Link IE controller network module.
0001: Control station is operating
0000: Other than control station is operating

SUB MANAGER
Displays the station type of the CC-Link IE controller network module.
0001: Sub-control station is operating
0000: Other than sub-control station is operating

NORMAL
Displays the station type of the CC-Link IE controller network module.
0001: Normal station is operating
0000: Other than normal station is operating

TOKEN PASS
Displays the baton pass status of the CC-Link IE controller network module.
0001: Baton pass being executed
0000: Baton pass unexecuted

DATA LINK
Displays the data link status of the CC-Link IE controller network module.
0001: Data link being executed
0000: Data link not executed

R LOOP ERR.

Displays the OUT-side error detection of the CC-Link IE controller network module.
Check the network status by CC IE Control Network Diagnostics.
0001: OUT-side error detected
0000: Undetected

EXT. POWER

Displays the external power supply status, of the CC-Link IE controller network
module with external power supply function.
0001: External power supplied
0000: No external power supplied

Tab. 9-15: H/W LED Information
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Item Description

NET WORK NO.
Displays the network No. of the CC-Link IE controller network module.
(Range: 1 to 239)

GROUP NO.
Displays the group No. of the CC-Link IE controller network module.
(Range: 1 to 32)

STATION NO.
Displays the station No. of the CC-Link IE controller network module.
(Range: 1 to 120)

MODE

Displays the operation mode of the CC-Link IE controller network module.
0: Online
2: Offline
5: Station-to-station test
6: Circuit test
7: Self-loopback test
9: Hardware test

CONFIG.

Displays the configuration of the CC-Link IE controller network module.

Tab. 9-16: H/W SW Information



9.7.5 Remote Operation

The operating status of the CPU module that is connected to a network can be changed.

� Perform any one of the following operations.

– Click the button Remote operation in the CC IE Control Network Diagnostics
dialog box.

– Select On line - Remote operation menu.

� The Remote operation dialog box is displayed.

� Set the following item and click the button Execute.

Connection target information: The connection target information is displayed.

Operation: Select the radio button PLC to select the operating status to be changed.

Operation during RUN, STEP-RUN: Select the operation of the device memory and signal
flow at RUN or STEP-RUN.

Specify execution destination: Set the target of executing Remote operation.

– Currently specified station: Remote operation is executed to the station which is
specified as connection target.

– All stations: Remote operation is executed to all stations in the network specified
by Specify execution unit.

– Specific group: Remote operation is executed to the specified group No. in the
network specified by Specify execution unit.
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Fig. 9-32: Remote operation



9.8 Online Module Change

The System Monitor display also provides the option of online module change (hot swapping)
with the QnPH, QnPRH and Q Remote I/O PLCs.

In the Debug menu select Online Module Change to open the following dialogue or select the
different mode, if it was opened via System Monitor already:
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Fig. 9-33: Mode: Online module change



The following explains a sequence of operations for making online module change from
System monitor.

� Choose the module you want to change from Mounting status on the System monitor
screen. (Module selection waiting status)

� After the Online module change dialogue box has appeared, click the Execution
button. (Online module change execution confirmation)

NOTE Depending on the faulty condition of the module to be changed, the type of the module may
not be acquired. In that case, "Unknown" appears in the Target module name display field.

� The dialogue box indicating that online module change can be made appears. (Online
module change completion confirmation)
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Fig. 9-34:
Online module change –
execution confirmation

Fig. 9-35:
Online module change –
completion confirmation



	 After changing the module, click the Execution button.


 If online module change is completed properly, the following dialogue box appears.
(Module control resumption confirmation)

If it is not completed properly, the following dialogue box appears.

Click the OK button. As clicking that button the Online module change dialogue box is
displayed again, and you can restart the procedure from step �.
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Fig. 9-36:
Online module change –
resumption confirmation

Fig. 9-37:
Online module
change – error



NOTES GX IEC Developer cannot perform the online module change of multiple modules
simultaneously.

Note that if the Process CPU/redundant CPU is in either of the following statuses, online
module change cannot be performed.
� PLC CPU's RESET/L.CLR is reset.
� PLC CPU is stopped due to stop error.

If online module change is performed from two personal computers to one PLC CPU, an
error message appears on the personal computer where online module change was
performed later.

If the PLC CPU is reset or powered off while the Online module change execution dialogue
box is being displayed, online module change cannot be continued and an error message
appears.
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9.9 PLC System Error Check

9.9.1 System errors

If a system error occurs, GX IEC Developer automatically outputs the corresponding error
code in the System Errors dialogue.

The System Errors dialogue can be opened by Debug System errors.

The button Show opens the editor window containing the error location of the selected error if
it is possible to show it.You can obtain additional information on the error message by selecting
the Help button.

A system error can be cleared by selecting the button Clear.

NOTES Clearing the system error is only possible for errors that allow the PLC to continue operation.
If the cause of the error is still present, it will be re-registered in the failure history.

The Clear error functionality is available for all Q and QnA series PLCs only.
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Fig. 9-38:
System Errors dialogue

Fig. 9-39: System Errors dialogue for QnPRH



9.9.2 User-defined errors

These functions are not available for the FX series.

Error flags combined with an error location program make it possible to display errors that
occur in the course of the process. If an error is encountered, an error flag (F) is set, together
with a special relay (M/SM) to indicate the presence of an error condition. The error flags F0 –

F127 can be programmed for example in the MELSEC network with the OUT function.

The text for the error messages must be stored in the error file USER_ERR.TXT in the current
project’s directory.

How to create an error messages file

� Open the Windows Notepad editor (you can also use any other editor that saves files in
ASCII format without formatting codes).

� Create a new file.

� Enter the error messages, one message per line.
Syntax:
0, Text1
1, Text2
…

You must enter a space between the comma and the text of the error message.

Meaning:

In the example above Text1 will be displayed, if F0is set and Text2 is displayed, if F1 is
set.

	 Store the file as USER_ERR.TXT in the current project’s directory.
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9.9.3 Hardware Diagnostics

Selecting HW Diagnosis in the Debug menu shows all hardware errors registered
(not available for FX series).

M9000 (A) / SM60 (Q/QnA): Fuse blown.This relay is set as soon as a blown fuse is registered
in one or more modules in the system. The relay will remain set even after you switch back to
normal status. (Does not apply for A2C CPUs.)

M9002 (A) / SM61 (Q/QnA): I/O module verify error.

M9005 (A) / SM53 (Q/QnA): Mains power drop. The relay is set after a power drop of no more
than 20 ms. You can reset the relay after switching the power supply off and on again.

M9006 (A) / SM52 (Q/QnA): Battery low. The voltage of the retentive memory battery has
dropped below the minimum level. This flag is reset when the battery is replaced.

M9007 (A) / SM51 (Q/QnA): Battery low (latch relay). The voltage of the retentive memory
battery has dropped below the minimum level.This flag is reset when the battery is replaced.

M9026 (A) / SM211 (Q/QnA): Clock data error. Set in the event of incorrect clock data (regis-
ters D9025 – D9028). (Only for AnN/AnS CPUs.)

Hardware errors are indicated by cross symbols instead of minus signs on the corresponding
buttons. Clicking on a button with a cross displays context-sensitive help for that error.

NOTE You will find detailed descriptions and information on special relays and special registers in
the controller manuals.

9.9.4 Scan

The Scan command in the Debug menu provides a statistical display of the scan time perfor-
mance of the program in the PLC CPU.

The program execution cycle periods can vary depending on status conditions, e.g. whether
inputs are polled during the cycle or not. The PLC CPU logs the following scan times:

Actual Scan Time: The current program cycle time (special register D9018 in the A series;
D8010 in the FX series)

Minimal Scan Time: The last minimum scan time saved (special register D9017 in the A
series; D8011 in the FX series)

Maximal Scan Time: The last maximum scan time saved (special register D9019 in the A
series; D8012 in the FX series)
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9.9.5 Show Step

To show the location of a given PLC Main program step in the source code you use the Show
Step command in the Debug menu.

When you call the menu command Debug Show Step, a dialog will be displayed to enter
the step number. The maximum number of characters in the Step number edit box of the
Show Step dialogue is limited to the number of characters in the highest step number of the
current main program. E.g. if the main program has 7490 steps, then the edit box is limited to a
maximum of 4 characters.

After pressing Show, the body where the selected step is located will be opened, and the line
or object corresponding to that step will be marked.

If the selected step number is valid, the location of the step will be marked:

If the selected step number is invalid, the following error message is shown:

In the message the actual step range of the program is shown.
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Fig. 9-40: Menu command Debug Show Step

Fig. 9-41:
The desired step is marked and displayed

Fig. 9-42:
Error message



If the selected step number is valid, but the code does not belong to any of the editors, the
following message is displayed:

NOTES This command is available, if a compiled project is open. It is disabled for Remote I/O
projects.

This functionality can only show steps of the Main program. Showing step locations in the
Sub and SFC programs is not supported.
Since the SFC POUs of FX series projects are compiled into the Main program, it is possible
that a step of a FX-series Main program is located in a SFC body. If you specify a step that
originates from a SFC POU, the appropriate body will be opened, but no source code
position will be marked.
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Fig. 9-43: Message



9.10 The Device Editor

The device editor is a tool for displaying and editing the contents of the PLC CPU’s word and bit
devices.The main element of the device editor is a table that is very similar to a Microsoft Excel
worksheet, both in its appearance and in the way it is used.

You can read the values from the CPU to the table, and after editing them you can then write the
new values back to the CPU. Additionally, you can also write the table contents to an external
file and load external files for editing. These files are stored in Excel 4.0 format, which makes it
possible to edit them with Microsoft’s Excel spreadsheet program as well.

Maximum table size is 16,383 lines and 255 columns, which means it can handle a total of
4,177,665 cells.Effectively, the number of bit and word devices you can load to the table is only
restricted by the amount of available memory on your computer.

Warning prompts are displayed before all operations that alter table ranges, before critical
operations (e.g. writing to CPU inputs) and before you close the device editor.
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9.10.1 The worksheet

The Device Editor option in the Debug menu opens the Device Edit window, which contains
the worksheet table in which all editing actions are performed.
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Fig. 9-44: Device editor


�

�

�

�

�

Item Description

� The numbers of the devices following the first device are obtained by adding the values shown at
the heads of the column.

� The leftmost column of the table contains the first of a consecutive sequence of devices.

� Each series of devices is displayed across a table line.

� The values of the devices are contained in the individual table cells.

� The current display mode of the selected cell is shown underlined. The display mode is set in the
pop-up menu (see below).

� Commands can be accessed by clicking on the buttons (see below)or with the pop-up menu (see
below).

Tab. 9-17: Device editor items



9.10.2 Buttons

Read from PLC: Reads the values of word and bit devices (registers) from the PLC. You can
choose to read either the entire table or a selected table range.

Write to PLC: Writes the table values to the PLC’s word and bit devices (registers). You can
write either the entire table or a selected table range.

Read from File: Loads an external file stored in Excel 4.0 format.

Write to File: Writes the GX IEC Developer device table data to an external file in Excel 4.0
format.

E
WARNING:
The device table settings are not stored with the GX IEC Developer project. They are lost
irrevocably when you close the Device Edit window. If you want to access the data again
later you should always save the table to a file before closing the edit window.

9.10.3 The pop-up menu

To display the pop-up menu click with the right mouse button or press��.

Cut: Copies the contents of selected cells to the clipboard and deletes them from the table (�')

Copy: Copies the contents of selected cells to the clipboard (��)

Paste: Pastes the content of the clipboard to the table (��)
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Fig. 9-45:
Selected Devices: Read/write only the devices selected in
the table.
All Devices: Read/write all the registers in the table.

Fig. 9-46:
For QnPRH:
Selected Devices: Read/write only the devices selected in
the table.
All Devices: Read/write all the registers in the table.

Fig. 9-47:
Device editor pop-up menu



Paste Text: Opens a dialogue box in which you can enter ASCII text to paste to the table.
ASCII characters are only displayed in the table in the ASC display mode. You cannot enter
more characters than the selected device can store. A data register can only store two ASCII
characters, for example. You can enter more characters by selecting several cells (i.e. a series
of registers) and entering ASCII text.

Insert Devices: Displays this dialogue box:

Delete Devices: Deletes the selected device or device range.A prompt is displayed asking for
confirmation before the delete operation is executed.

Find Device: Searches for specific devices. You can select the search direction.

Find Value: You can also search for a specific value in a device register. Again, you can
specify the search direction.

Replace Value: Search and replace function for replacing device register values.

Display Mode: Displays this dialogue box:

Options: Displays the following dialogue box in which you can set the basic options for the
table structure:

Number of Columns
Automatic: 8 rows for octal registers, 10 rows for decimal registers, 16 rows for hex registers
Input Number: You can enter a value between 1 an 255.
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Fig. 9-48:
Device: List of the available devices for
selection.
All: Selects the entire range of devices for
insertion in the table.
Addresses: Allows specification of a specific
address range.
Display Mode: Specifies the display mode
for the new registers

Fig. 9-49:
Display Mode: Mode for displaying the selected devices
Register: Selects 16 or 32 bit register display.

Fig. 9-50:
Device editor options



Number of Rows
Maximum Number (16383): Sets the rows to the maximum of 16,383 rows.
Input Number: You can enter a value between 1 and 16,383.

Use Colors: When this check box is selected the table is displayed using different colors.

Additional Safety Inquiry: When this check box is selected the system displays an additional
prompt asking for confirmation for some critical operations.

Inserting devices with the Insert Devices dialogue box

Open the Device Edit window and select the top left cell of the table.

� Click with the right mouse button to open the pop-up menu.

� Click on Insert Devices with the left mouse button to display the Insert Devices dialogue
box.

� Select the device type, address range and display mode, then click on OK.

The devices are inserted in the table. Initially, all the devices are given a default value of 0.

Inserting devices directly

Open the Device Edit window.

� Click in any cell in a free line. All the cells in the line must be empty!

� Enter the device. The system automatically switches to editing mode when you make
an entry. GX IEC Developer only accepts valid entries. If you make an incorrect entry
editing mode will remain active.

The inserted device is then displayed in the leftmost table column.

NOTE When you enter registers directly you can only store one register in a line; the remaining
cells in the line are disabled and cannot be selected.
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Fig. 9-51:
Data registers D

Address range: D12 – D16

Display mode: Decimal

Fig. 9-52:
Devices D12 – D16 have
been inserted in the table.

D12 D13 D14 D15 D16



Entering device values

� Select the cell where you want to enter the value.

� Enter the new value. The system switches to editing mode automatically when you
make an entry. GX IEC Developer only accepts valid entries. If you make an incorrect
entry editing mode will remain active.

NOTE Double-clicking on a bit device (or pressing �) toggles the value of the device between 0
and 1. Double-clicking on a word device activates editing mode.

Entering 32-bit values

A 32-bit value is stored in two 16-bit registers.

� Select the first of the two table cells.

� Hold down the � key and extend the selection to include the second cell using the
mouse or cursor key. Both cells now have a bold outline and the second cell is shaded.

� Press�* to select the Display Mode dialogue box from the pop-up menu.

	 Select the 32-bit option in the Registers field.


 Click on OK to link the two selected cells.

� Enter a 32-bit value in the cell. GX IEC Developer will only accept valid entries.

NOTE You can use the standard Windows mouse actions and key combinations in the device table.
Special key combinations are listed in the Appendix B of this manual.
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9.10.4 Editing tables in Microsoft Excel

Changing device designations

� Overwrite the entry in D12 in leftmost column, e.g. by entering D24.

The line now contains the five data registers D24 – D28.

Adding devices to a line

� Select the cell in column +5 and enter the value to be contained by the new register
D17.

� Click with the right mouse button to open the pop-up menu and select the Number
Format option.

� Select the appropriate number format from the list in the dialogue box.

The number formats in Excel correspond to the display mode in GX IEC Developer.
These formats are represented by a fixed number of spaces and the @ character:

NOTE Setting the correct number format (i.e. the right display mode) is absolutely essential when
you add new devices in an Excel table that you plan to reload in GX IEC Developer later!
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Fig. 9-53:
Entries in Excel

D12 – D16

X5 – X9

Fig. 9-54:

BIN: 1 space
HEX: 2 spaces
ASC: 3 spaces
DEC: No spaces
OCT: 4 spaces



9.11 Forced Settings

9.11.1 Forced Input/Output

By using the function Forced Input Output Registration/Cancellation it is possible to force-
fully set or reset an input (X device) and output (Y device) of a PLC. The user can easily debug
a program that is under execution in the PLC by intentionally setting or resetting the X/Y
devices. The function facilitates a detailed study of input and output changes.

NOTES Once a device X/Y is forced to turn ON/OFF, its status is not affected by the input (X) from an
external device and the output (Y) of the program. The forced input/output status can be
cancelled only through the Forced Input Output Registration/Cancellation function.

Since the exclusive control is not exercised on the PLC CPU side, forcefully setting or
resetting a device may cause the registration to be changed from multiple GX IEC Developer
programs or from the equipment which can register/cancel forced devices.

The Forced input/output function is available only in Q series PLCs (except Q00(J)/01)
and Q Remote I/O modules, but is not supported by the A, QnA and FX series.

The Forced input/output function is not supported by a standby system of a QnPRH PLC.
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Fig. 9-55:
Menu Debug



Select Forced Input Output Registration/Cancellation in the menu Debug to open the
following dialogue box.

The forced input output registration and cancellation can be executed from the Forced input
output registration/cancellation dialogue. The device name entered in the dialogue can be
forced to turn ON/OFF using the respective command button.
Most recently used devices can be automatically added by using the selection list Device.The
maximum number of devices that can be stored in the Device list is 5. When the 6th device is
entered in the device name list, the least recently used or the very first entry in the list is deleted
from it.

By pressing the button Set forced ON, the X/Y device entered/selected in the Devices list is
set to ON regardless of the current device status.
When the Set forced OFF button is pressed, the X/Y device entered/selected in the Devices
list is set to OFF regardless of the current device status.

The devices that are currently under forced input/output are displayed in a list in the dialogue
so that the status of forced registration/cancellation can easily be checked.

NOTE Up to 32 devices can be set to forced ON/OFF.

When the Cancel it button is pressed, the forced ON/OFF status of the X/Y device
entered/selected from the devices list Device is cancelled and the device name is also
removed from the forced I/O devices display list.
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Fig. 9-56:
Dialogue box Forced Input
Output…



To export the listed devices under forced ON/OFF press the Export forced device list button.
This opens a file save dialogue to select the path for saving the file. The default path is the
project path.The default file name is “ForcedDeviceList.xls”.The file format is the Excel format.

For importing a saved device list press the Import forced device list button. A file open
dialogue is opened to select the list file to be loaded. The default path is the project path. The
default file name is “ForcedDeviceList.xls”.

By clicking on the button Update status it is possible to update the current status of the forced
input/output devices in the list. All forced I/Os registered to the PLC CPU can be cancelled by
clicking on the button Clear all .

NOTE The status of forced input or output devices is not modified until it is modified through this
dialogue by the user.

9.11.2 Starting/Stopping a PLC

This function toggles the PLC CPU's RUN/STOP mode.To control SFCs in a project from other
program parts, GX IEC Developer provides the following functions for the System Q/QnA
CPUs: Start, stop, and initialise.

Status of redundant PLC system: Shows the status of the redundant PLC system.

System A: Shows the status information of System A.

System B: Shows the status information of System B.

Set Remote Mode

� Select to set the operating state of the PLC:
Run, Stop, Pause, Reset

� Select to choose the target PLC for the remote mode change:
Control, Standby, System A, System B, Both

Execute: Sets the operating state of the PLC

Refresh: Re-reads the operating state information from the PLCs.

Close: Closes the dialogue box.
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Fig. 9-57: PLC status display options in case of a redundant PLC system



How to start/stop a PLC

� Select the Start/Stop PLC command in the Online menu.

� Click on the desired mode in the right hand section of the dialogue window displayed.

� In a redundant system click on the desired target PLC in the right hand section of the
dialogue window displayed.

	 Confirm your selection with Execute.
You will be prompted for a confirmation when you attempt to switch from RUN to STOP
mode. The current status of the PLC is shown in the left hand section of the dialogue
box.

Stop PLC and Restart PLC during RUN mode

A Stop PLC dialogue is displayed when you attempt an operation in RUN mode that is only
possible in STOP mode (e.g. Download to PLC). For the QnPRH PLCs in Backup mode, when
both PLCs are involved in the operation, a dialogue is shown to inform you that both PLC need
to be stopped.

A Restart PLC dialogue is displayed after the PLC was stopped because of an operation that
was only possible in STOP mode (e.g. Download to PLC). For the QnPRH PLCs in Backup
mode, when both PLCs were involved in the operation, a dialogue is shown to inform you that
both PLC will be restarted.
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Fig. 9-58:
STOP PLC dialogue when
downloading to PLC

Fig. 9-59:
STOP PLC dialogue for all other
functions

Fig. 9-60:
Restart PLC dialogue after Download
to PLC

Fig. 9-61:
Restart PLC dialogue after other
function



9.11.3 Setting the PLC Time

This function sets the time on the connected PLC or on all PLCs in a network.

Connection target information: Shows the actual connection.

Clock setup: Set date, time, and day.

Specify execution target: You can select between Currently specified station, Specify all
stations, and Specify group in connection with the Group no. as the target for setting the
internal clocks.

Specify execution unit: Set the board no.

Setup: Sets up the set time information.

Close: Closes the dialogue box.
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Fig. 9-62: Set time dialogue



9.12 The Monitor Function

The monitor function enables you to follow program execution and to check the status of
operands/devices in runtime. The data for monitor mode is read from the PLC itself.

GX IEC Developer supports different monitoring modes:

� Program Monitor

� Entry Data Monitor

� Header Monitor

� Link Monitor (see page 5-11)

NOTE When the monitoring mode is activated all GX IEC Developer editing functions are disabled.

9.12.1 Inheritance

The monitor mode is inherited to objects that are opened by other objects they depend on.
Therefore, the monitor mode does not need to be enabled for depending objects manually.

For the following actions the monitor mode will be inherited:
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Action Monitor mode inherited to

Change instance of a function block New instance

Zoom function block Body of function block

Zoom function Body of function

Open transition from SFC body Transition

� Transition elements of the body, if the transition is a
variable or address

� Transition condition editor

Open action from SFC body Action

� Action association list editor

Open new windows during tracking New window

Tab. 9-18: Inheritance of monitor mode



9.12.2 Monitor Mode Options

In the Extras - Options menu you can specify options for the monitor mode.

Displayed String Length: Displaying long strings significantly reduces performance in moni-
toring mode. It is thus advisable to limit the number of characters to be displayed.

Pollrate: Interval at which the monitor polls the CPU, expressed in ms.

NOTE While monitoring at a low poll rate and rapidly changing activation of actions/transitions the
system may be slowed down.

9.12.3 System Switching during Monitoring a Redundant System

If the control and standby systems are switched during monitoring, the monitoring continues
automatically with the system selected in Transfer Setup Ports (see section 8.3.1).
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Fig. 9-63: Monitor mode options

Transfer Setup setting Physically connected Monitoring before switch Monitoring after switch

Not specified

System A (Control) System A (Control) System A (Standby)

System B (Control) System B (Control) System B (Standby)

System A (Standby) System A (Standby) System A (Control)

System B (Standby) System B (Standby) System B (Control)

Control system not relevant
System A (Control) System B (Control)

System B (Control) System A (Control)

Standby system not relevant
System A (Standby) System B (Standby)

System B (Standby) System A (Standby)

System A not relevant
System A (Control) System A (Standby)

System A (Standby) System A (Control)

System B not relevant
System B (Control) System B (Standby)

System B (Standby) System B (Control)

Tab. 9-19: Switching between control and standby system



If the switch was caused by a transmission error in the tracking cable, the following message
will be displayed:

If the switch was caused by a request from a network module, the following message will be
displayed:

9.12.4 The Program Monitor

In the text and graphical editors the values of all visible variables are displayed in the editing
window, and they are updated after every program scan. The variables shown are always
those lying within the current editing window pane. If you scroll the contents of the window or
change its size the system automatically shows the values of all new variables that come into
the window, and stops displaying the values of all variables that move out of the window.

Inputs and outputs that are set are displayed in the colours corresponding to the colour param-
eter settings.

When you start monitoring in the Sequential Function Chart editor the active Steps in the
current window are shown in the colours set in the parameters. This enables you to follow
which Step is currently active.

How to open the Program Monitor window

� Switch to Online mode by activating Monitor Mode in the Online menu or clicking on
the monitor mode icon:

Tool for activating the monitor mode

� Open and select the body of the POU that you wish to switch to monitoring mode.

� Select Start Monitoring in the Online menu.

9 – 62 MITSUBISHI ELECTRIC

The Monitor Function Diagnostics Functions and Online Operation

Fig. 9-64: Switching notification

Fig. 9-65: Switching notification

Fig. 9-66:
Active inputs and outputs are identified in
colour.

Register D100 takes the value 255 of the
base-8 literal.



In addition to Program POUs you can also use the Program Monitor for function blocks and
functions. When you activate monitoring for the operand status of function blocks GX IEC
Developer first prompts you to specify the Instance of the function block for which you wish to
activate the Program Monitor.

How to start monitoring of an IL editor in a normal window

� Activate the command Start Monitoring Body in the Online menu.

When Body Window monitoring is started, Boolean and all other types of variables will
be monitored in the un-split body window. If more than one variable or device is used in
one line, monitored values will be displayed at subsequent tab stops.
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Fig. 9-67:
In the body of the program there is a
signal on the inputs and outputs of
Log_Add_1, which is an instance of
function block FB_1.

Log_Add_2 (an instance of function
block FB_1) has no signals on its
I/Os …

... as a result, no signals are
displayed for the devices of function
block FB_1 in Monitor mode.
In Monitor mode, there would be
signals in the devices In_1, In_2 and
Out_1 of FB_1.

Fig. 9-68: Monitoring in an unsplit window



How to start monitoring of an IL editor in a split window

� Activate the command Start Monitoring Split Window in the Online menu.

When Split Window monitoring is started, the editor will be split into two vertical
columns. Boolean values will be monitored as usual in the left split window. All other
devices and variable types will be monitored in the right split window, as in the ST
editor Split Window monitoring.

NOTE When the monitoring of an IL body is not started by one of the above mentioned menu items
(but e.g. with Online Monitoring Mode, or via zooming into a FB body), Split Window
Monitoring will be used.
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Fig. 9-69: Monitoring in a split window



How to stop the Program Monitor window

� Activate the command Stop Monitoring in the Online menu.

NOTE If you experience difficulties in distinguishing symbols that are closely spaced e. g. the “-”
and the “#” symbols in the example below in the default Arial font setting, switch to another
font such as Courier New or Fixedsys for better viewing.

Display in Arial font

Display in Courier New font

Refer to section for details on the font selection.
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Fig. 9-70:
Display in Arial font

Fig. 9-71:
Display in Courier New font



9.12.5 The Entry Data Monitor (EDM) and the Header Monitor

The Entry Data Monitor can be used to group objects from the open project in order to obtain a
display of their current status. Several windows can be opened at once. The Header Monitor
essentially offers all the functions available in the Entry Data Monitor. The only difference,
although an important one, is that calling up the Header Monitor automatically displays the
objects of the active POU.

The status of the following objects can be monitored in the Entry Data Monitor: Global and
Local Variables, POUs and Tasks.

The central element of the Data Entry Monitor is a table which the user can configure himself.

The values in the table can be read from the CPU and also written back to the CPU after
editing.There is also the possibility of writing the table, i.e. the grouped objects, and the config-
uration of the table into an external file, or of reading the data from an external file.

The table is restricted to a maximum of 16,383 rows and 255 columns. This means that a total
of 4,177,655 cells can be managed. The number of objects in the table is limited only by the
available memory on your computer.

A security function is available to prevent data being written into the CPU.

The worksheet

In the Online menu, the Entry Data Monitor command calls up the EDM window.

If a direct address (in the IEC and Mitsubishi Editor) was entered in lower-case letters, these
characters will automatically be converted into upper-case letters.

Rows including Boolean objects are highlighted if the respective object is active. The colour is
defined in the project settings.

By means of this option it is possible to monitor an object in the Mitsubishi Kn notation.

9 – 66 MITSUBISHI ELECTRIC

The Monitor Function Diagnostics Functions and Online Operation

Fig. 9-72: Entry Data Monitor worksheet



Example K1M10 will monitor the relays M10 to M13.

The result is displayed in the result columns offering a suitable style, e.g. Value (bin), Value
(dec), Value (hex). The objects will be displayed in their respective representations.

�

Example Bit pattern of M0 to M7 is displayed as 1000 1101.

In the column Value (bin) it will be displayed as 1000 1101.
In the column Value (dec) it will be displayed as 141.
In the column Value (hex) it will be displayed as 8D.

In the Mitsubishi Kn notation object values cannot be changed.

�

NOTE The commands in the Edit and Tools menus can also be called up via the pop-up menu.The
pop-up menu appears if you press the right-hand mouse button or press the key
combination��.

The Edit menu

The following commands are available in the Edit menu when the window of the Data Entry
Monitor is active:

Insert Object: The Object List window appears containing all the objects available in the
current project. The objects can be selected via a group filter and a type ahead input field.

Next Object: The object following the currently selected object is inserted. If the selection
marker is positioned on an Array entry, the next element of this Array is inserted. If the selection
marker is positioned on a numbered entry, the element with the next number is inserted. In all
other cases, the object with the next consecutive address is inserted. This command is only
available if the selected row contains an elementary object and the selected object is not a
sub-object.

Insert Forced Inputs (not for FX family and Q00(J),Q01 CPUs): Inserts all user-forced input
devices into the EDM. The “Status” column indicates that they are “Forced” (see below).
Forced inputs can be cleared via Online - PLC Clear - Forced Inputs.

Insert Set Inputs (FX family and Q00(J), Q01 CPUs only): Inserts all user-set input devices
into the EDM. The “Status” column indicates that they are “Set” (see below).
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Insert Set Outputs: Inserts all user-set outputs into the EDM. The “Status” column indicates
that they are “Set” (see below).

Clear Device File: All forced or set inputs and outputs are stored in the DeviceFile.MON in the
project path. This file is cleared.

Insert Row: A new row is inserted in front of the selected row. As the EDM does not offer copy
and paste operations, you cannot insert several rows at once.

Delete Rows: The selected row is deleted. You can also delete several rows at once. This
command is only available if the first object selected and the object after the last object
selected are not sub-objects.

Delete All: All entries in the table and the table configuration are deleted. You are asked to
confirm the command before it is executed.

Close: The EDM window is closed. All information is automatically saved. The information
concerning the current settings is stored in the MMP703.INI file and is loaded as the default
when the EDM is next called up.

The Tools menu

The following commands are available in the Tools menu when the window of the Entry Data
Monitor is active:

Read from PLC: The data are read from the PLC and displayed in the EDM table. This
command is only available in Offline mode.

Write to PLC: The data from the EDM table are written to the PLC.A dialogue window appears
which allows you to choose whether only the selected objects or all objects are to be trans-
mitted. This command is only available in Offline mode.

Read from File: The file previously created with the Write to File command is called up. This
command is only available in Offline mode.

Write to File: Both the grouped objects and the configuration of the table can be saved in an
external file.This file has the file extension EDM.This command is only available in Offline mode.
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Setup: The Setup dialogue window is opened, in which the EDM table can be configured and
the security function activated.

Disable automatic search

If you enter a direct address into the Entry Data Monitor, the system searches automatically for
a corresponding variable in the GVL of the project. If a variable has been found, the variable
name is added to the Entry Data Monitor.

This feature can cause long delays if the projects include many global variables. To increase
the performance of GX IEC Developer, disable the automatic search in the setup of the Entry
Data Monitor.

Monitor only visible objects in window

In the monitor mode all objects entered in the Entry Data Monitor are monitored, even if they
are not visible.This feature can cause long delays if the window contains many EDM elements.
To increase the performance of GX IEC Developer, it is possible to monitor only visible objects
in the Entry Data Monitor. This option is realised in the setup of the Entry Data Monitor:

The disadvantage of this option is that short delays may be caused during scrolling in the Entry
Data Monitor. These delays are caused by the registration, which is changed every time when
the visible part of the window has been changed.

Always on top: Keeps the Entry Data Monitor always on top of other windows. This option
can be enabled or disabled in the menu Tools or Context. If this option is active, a check mark
is placed next to the menu item. Only one Entry Data Monitor can be on top.

List global variables used in POU

This function in the EDM Setup is used to switch the listing of global variables used in a POU on
and off. When the setting is off, only local variables (those declared in the POU header) will be
listed under the POU. When the setting is on, the list will also contain all global variables used
in the POU’s body, actions and transitions.
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The pop-up menu for configuring the table

The Shortcut menu appears if you select the desired row and click on the right-hand mouse
button or press the key combination��.

Field list: The Field List contains the possible column entries for the EDM table.

Insert row: A new row is inserted in front of the selected row.

Delete row: The selected row is deleted.

Delete All: All entries are deleted. You are asked to confirm your choice before the command
is executed.

The buttons for configuring the table

Close: The dialogue window is closed. The settings are saved.

Cancel: The operation is aborted. The settings are not saved.

Read Setup: The file previously created with the Write Setup is called up.

Write Setup: The table configuration can be stored in an external file. This file is given the
extension SED.

Password: The password for the security function is defined here.

Security on/off: A security function is available to prevent data being written into the CPU.
The security function can be switched on or off. You are prompted for the password.
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How to open the Entry Data Monitor or the Header Monitor

� Activate the Monitor Mode command in the Online menu.

� Select the POU to be switched to Monitor Mode.

� Select the Entry Data Monitor or Header Monitor command in the Online menu. The
dialogue window containing the EDM table appears.

How to insert an object

� Select any cell in the desired row. A selected cell is indicated by the double border. (If
the Name or Address column is selected, you can now enter the name or address
directly.)

� Select the Insert Object command from the Edit menu or from the pop-up menu.

� Select the desired object and click on OK. You can also select several objects in the list -
consecutively or selectively. You also have the possibility of transferring the entire list of
Global Variables, as well as the entire POU and Task pool.

or

� Copy global declarations from a GVL into an EDM window (Cut, Copy and Paste or Ctrl+X,
Ctrl+C and Ctrl+V).

� Copy entries within an EDM window (Cut, Copy and Paste or Ctrl+X, Ctrl+C and Ctrl+V).

� Copy entries between two EDM windows (Cut, Copy and Paste or Ctrl+X, Ctrl+C and
Ctrl+V).

How to insert a 32-bit register

� As an IEC address: Enter the corresponding address in the Address (IEC) column, e.g.
%MD0.0.

As a MITSUBISHI address: Enter the two contiguous MITSUBISHI addresses in the
Name column, e.g. D3+D4.

How to change the values of the objects

� Select the desired values column.

� In the case of bit operands: You can switch between the two possible entries (0 and 1)
by double-clicking or pressing the SPACE key.

In the case of word operands: Activate the Edit Mode (mouse click or m). Enter the
desired value. GX IEC Developer only accepts valid entries. Pay attention to the correct
format (decimal, octal, etc.). The Edit Mode remains active in the event of an incorrect
entry.
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How to open and close a structure

The word Structure in the Type column indicates a tree structure. If a tree structure is open, all
the associated variables of the POU are displayed.

� Select the Name cell in the row containing a structure.

� Closing an open structure: The open structure is indicated by a minus sign in front of
the name. Double-click on the Name cell or press the �+ key combination. This
closes the tree structure.

Opening a closed structure: The closed structure is indicated by a plus sign in front of
the name. Double-click on the Name cell or press the�, key combination. This
opens the tree structure.

Arrays in the Entry Data Monitor

You can enter arrays in the Entry Data Monitor. All elements of the array can be read, written
and set.

If the array is large it may not be possible to display all its elements on the screen at the same
time. You can set the default number of elements to display to a maximum of 50 with the option
Extras - Options - General - Array Elements To Show.

You can also change this value in the prompt dialogue that is displayed when you open an
array in the Entry Data Monitor.

The entry in the Lower Bound field specifies the first array element to be displayed.
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9.12.6 Changing variable values

The value of a variable can be changed in the Entry Data Monitor (EDM). Additionally the
variable value can be changed directly in an editor (IL, MELSEC IL, Ladder, FBD, and SFC).
This is realised by means of new dialogues for simple data types, which can be opened in the
monitor mode. The restriction to simple data types means that it is not possible to change the
values of structured data types (e.g. DUTs).

Dialogue layouts

Three different dialogue layouts are available for changing a variable value in an editor:

a) Dialogue to toggle Boolean variables or devices

This dialogue appears, if you want to change a Boolean variable or device. This dialogue can
be switched off by selecting the correspondent option in the dialogue. This setting is valid until
you leave the monitor mode.

b) Dialogue to change numerical variables or devices

This dialogue appears, if you want to change a numerical variable or device. It contains the
type and the current value of the variable or device. The new value can be entered either as a
decimal or as a hexadecimal value.
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For a Q Remote I/O module the Modify variable value functionality can only be used to modify
device values, since a Q Remote I/O project does not have symbolic names (there are neither
GVLs nor POU headers). Because of this, the dialogue is different for the Q Remote I/O
module.

By clicking on Ranges you get shown a list of valid device ranges for the current PLC.

NOTE The devices LB, LW, LX, LY cannot be monitored in GX IEC Developer, therefore they will not
be displayed in the Available device ranges list of the Modify Variable Value dialogue.
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Dialogue operations

There are the following dialogue operations:

� Changing the value of a variable or device

After you have entered the new value in the edit control, press Enter or OK to leave
the dialogue. A message will appear asking whether the value should be written to the
PLC. If the new value has a wrong format, a message in the dialogue appears and the
value in the edit control is selected. In this case the value is not written to the PLC. For
numerical data types (INT, WORD, DWORD, DINT), the value can be entered in the
hexadecimal format.

� Changing the name of a variable or device

After you have entered a new variable or device and left the corresponding edit control,
the dialogue will be updated. If the variable can be monitored, the new name and the
current value are displayed. The cursor is set to the edit control New Value.

The following objects are valid:

– global variables

– local variables which are declared in the POU of the active body

– direct addresses

� Changing the display type

For numerical data types it is possible to switch the display format of the current value and
the new value between decimal or hexadecimal. This option is disabled for Boolean
variables or devices.

� Updating the current value

The current value of the variable or device will be updated according to the poll rate of
the monitor mode.

c) Dialogue to change string variables

This dialogue appears, if you want to change a string variable. It contains the type and the
current value (character string) of the variable or device. The new value (character string) can
be entered in the field New Value.
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Opening the dialogues

The dialogues to change the variable or device values can be opened in the monitor mode in
the following ways for the corresponding windows:

a) SFC Body

� Choose Modify variable in the menu Online or use the shortcut [CTRL] + [F9].
If a transition with a variable or device is selected in the POU body, the corresponding
dialogue with this variable or device is opened. If no transition with a variable or device
is selected, the dialogue is empty and you can enter a variable or device.

� Double-click with the left mouse button on a transition with a variable or device. The
corresponding dialogue with this variable or device is opened.

Example For a selected transition with the variable OperationDone:

�
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b) MELSEC IL / IL Body

� Choose Modify variable in the menu Online or use the shortcut [CTRL] + [F9].
If a variable or device is selected in the POU body, the corresponding dialogue with this
variable or device is opened. If no variable or device is selected, the dialogue is empty
and you can enter a variable or device.

� Double-click with the left mouse button on a variable or device. The corresponding
dialogue with this variable or device is opened.

Example In IL for the selected variable MotorVal:

�

c) Ladder / FBD Body

� Choose Modify variable in the menu Online or use the shortcut [CTRL] + [F9].
If a variable or device is selected in the body of the POU, the corresponding dialogue
with this variable or device is opened. If no variable or device is selected, the dialogue
is empty and you can enter a variable or device.

� Double-click with the left mouse button on a variable or device. The corresponding
dialogue is opened with this variable or device.

Example Example in Ladder for the selected variable MotorVal:

�

d) Navigator

� To open the dialogue select Modify variable in the menu Online or press the shortcut
[CTRL] + [F9]. The dialogue is empty and you can enter a variable or device.
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9.12.7 Display direct address of a variable

In the monitor mode the direct address instead of the symbolic name of global variables can be
displayed. This is possible for global variables of simple data types in Ladder and FBD.

Toggle direct address and symbolic name

In the monitor mode direct address and symbolic name of a variable can be toggled.

� Select the symbolic name or direct address of a global variable and choose Toggle
variable in the menu Online or press the shortcut [ALT] + [F9].

� Press [CTRL] and double-click with the left mouse button on the symbolic name or
direct address of the global variable.

Example Example in Ladder

A) Global variable MotorVal before calling the toggle functionality:

B) Global variable MotorVal after the toggle functionality has been called:

If the monitoring is stopped for a window, the direct addresses of the toggled global variables
are still available. If the monitor mode is finished, the symbolic names of the toggled global vari-
ables are restored.

�

9 – 78 MITSUBISHI ELECTRIC

The Monitor Function Diagnostics Functions and Online Operation

Fig. 9-87:
Symbolic name is indicated

Fig. 9-88:
After toggling direct
address is indicated



9.12.8 Tracking variables

The write access to variables can be tracked during monitoring. The tracking of variables is
available within the IL, MELSEC IL, ST, LD, and FBD editors for the following objects:

� POU bodies

� SFC transitions

� SFC actions

The tracking functions are available from

� the menu Tools - Tracking.

� the declaration and language editors context menu in edit mode and non-edit mode
(right-click on variable or keys [SHIFT]+[F12]).

� the declaration editor context menu by [CTRL] + Double-click, to directly go to the
location, where the identifier of a given row is first referenced.
(The jump to the first reference is initiated by double-clicking on a row while pressing the
[CTRL] key.)

NOTE Edit mode refers to the state of a language editor, when the source code is being edited (i.e.
there is a text edit cursor) and in the case of a declaration editor, when one of the fields is
being edited. Non-edit mode on the contrary is the state of an editor, when its content is not
edited.

If the tracking function is started, a dialogue to enter the variable name and the access type (to
search only for variables with write access or for all variables) appears.The tracking function is
started, when the dialogue is closed with the OK button.

The tracking function can be started in the menu bar, if the monitor functionality is switched off
or switched on (not context sensitive).
If the monitor mode is switched on, the tracking functionality is also available in the context
menu. The name of the variable, where the right mouse click was done, is used as the default
variable name in the appearing dialogue.

The Start Tracking function creates an internal list (from the browser information). This
internal list indicates where the selected variable name is used for write access. If this list
already exists, it will be overwritten.A window will be opened showing where the variable name
is used for the first time. In this window the corresponding variable is highlighted. If the corre-
sponding variable name can not be found or if the browser information is not available, an
appropriate message box will appear.
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If the variable name could be found, the next, previous, first, and last occurrence of the
variable can be tracked via menu commands. Each occurrence is shown in a window where
the variable is highlighted. If the corresponding variable name can not be found or if the
browser information is not available, an appropriate message box will appear.

Tracking menu items and functions

Start Tracking:

� Open the browser.

� The code location selected is the first entry in the browser list box.

� Open the code location of the occurrence.

� Mark the code location of the variable occurrence.

� Start monitoring of the newly opened editor.

� If no ‚First‘ is found, the following message box is displayed: ‘Start Tracking:
No reference found’.

Next:

� According to the browser information the selection is set to the next occurrence.

� Open the code location of the occurrence.

� Mark the code location of the variable occurrence.

� Start monitoring of the newly opened editor.

� If no Next is found, the following message box is displayed: “No reference found”.

Previous:

� According to the browser information the selection is set to the previous occurrence.

� Open the code location of the occurrence.

� Mark the code location of the variable occurrence.

� Start monitoring of the newly opened editor.

� If no ‚Previous‘ is found, the following message box is displayed: “Previous:
No reference found”.

First:

� According to the browser information the selection is set to the first occurrence within the
browser.

� Open the code location of the occurrence.

� Mark the code location of the variable occurrence.

� Start monitoring of the newly opened editor.

� If no First is found, the following message box is displayed: “Already placed on desired
location”.
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Last:

� According to the browser information the selection is set to the last occurrence within the
browser.

� Open the code location of the occurrence.

� Mark the code location of the variable occurrence.

� Start monitoring of the newly opened editor.

� If no Last is found, the following message box is displayed: “Already placed on desired
location”.

NOTES If the .scx file is not available and the .sct files are also not available, a dialogue will appear
with the information, that the project must be checked or compiled with activated cross
reference options. A button to call the corresponding options dialogue is also available.

If the .sct files are not available, a dialogue will appear with the information, that the project
must be checked or compiled with activated cross reference options. A button to call the
corresponding options dialogue is also available.

If the .scx file is not available and the .sct files are available, a dialogue will appear with the
information, that the cross reference must be generated.

Limitations

If a variable is used in the MELSEC IL, the variable can not be displayed by the tracking
function.
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9.12.9 Tracking Variables in a Redundant System

If default tracking settings are used, most system variables will automatically be tracked.There
is, however, a problem if the device R is selected as the Word range of system variables
because File Registers are not automatically tracked.

It is possible to set tracking ranges manually in the Redundant PLC Parameter dialogue (also
see sec. 5.2). In this case only the devices set by the user are tracked. Therefore the system
variables will not be tracked if the user does not specifically set all system variable ranges to be
tracked.

The following table describes the default tracking ranges and the possible tracking ranges that
may be set in the Redundant PLC Parameter.

 : Can be used as a System Variable

!: Can not be used as a System Variable
� If the number of devices is modified in PLC Parameter Devices, both the default and the

possible tracking ranges change accordingly.
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Device Default tracking range Possible tracking range Can be used as system
variable

Input X0 to X1FFF !

Output Y0 to Y1FFF !

Internal Relay M0 to M8191 �  

Latch Relay L0 to L8191 � !

Step Relay S0 to S8191  

Annunciator —

F0 to F2047
or the range set in
PLC Parameter

Devices

!

Edge Relay V0 to V2047 � !

Link Relay B0 to B1FFF � !

Link Special Relay — SB0 to SB7FF !

Timer T0 to T2047 �  

Retentive Timer —  

Counter C0 to C1023 �  

Data Register D0 to D12287 �  

Link Register W0 to W1FFF �  

Link Special Register — SW0 to SW7FF !

Index Register Z0 to Z15 !

Special Relay See QnPRH user manual
chapter 5.5.3 (2) (c)

Not necessary; default
range is always tracked in

backup mode
!

Special Register See QnPRH user manual
chapter 5.5.3 (2) (d)

Not necessary; default
range is always tracked in

backup mode
!

File Register —
The range set in

PLC Parameter
PLC File, if any

 

Tab. 9-20: Default tracking ranges



The following checks will be carried out, depending on the settings of the Redundant Param-
eter and the System Variables options:

If default tracking settings are used, the whole range of the following devices that may be used
in system variables are tracked by default: D, W, T, ST, C, M, S.
It is not necessary to track P devices.

� A warning dialogue is displayed if R devices are used as system variables.

If tracking ranges are set manually, then it is necessary to check all used system variable
ranges against the set tracking ranges.

� A warning dialogue is displayed if not all devices used as system variables are tracked.

� A warning dialogue is displayed if all devices used as system variables are tracked, but in
several different tracking blocks.

� A warning dialogue is displayed if all devices used as system variables are tracked in one
tracking block, to inform the user how to make sure that the block is actually tracked.

These checks will be executed during project check. If a problem is found, a warning will be
displayed in the Compile/Check Messages window. Please refer to section 8.2 for details.

If the situation is not corrected, a warning dialogue will be displayed when attempting to
download the project.
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9.12.10 Monitoring Boolean I/Os of function blocks

Boolean inputs and outputs of function blocks are monitored even if they are connected to a
network. The function block itself does not need to be opened and monitored individually.

All Boolean inputs and outputs of a function block are monitored in the function block box, if the
monitor mode is active. The Boolean variables of the value FALSE are indicated by a high-
lighted frame and the Boolean variables of the value TRUE are indicated by a completely high-
lighted rectangle.
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9.13 In Cycle Monitor

In GX IEC Developer monitoring can be done at any valid step of the sequence program.

When doing „normal“ monitoring, the monitor values reflect the status of the monitored
devices at the end of the scan cycle.When doing in cycle monitoring, the monitor values reflect
the status of the monitored devices previous of executing the designated step.

9.13.1 Running the In Cycle Monitor

Two entries in the Online-menu allow starting and stopping of the In Cycle Monitor.

The following conditions must be fulfilled to start the In Cycle Monitor:

� A project must be open

� The project’s PLC type is Q or QnA series

� The PLC must be in RUN mode

� Transfer Setup designates PLC Module or Net/10(H) Module as the PLC side I/F, and in the
Network route there is no specification or Net/10(H) selected

� The monitor mode is off

� The online change mode is off

� The GX Simulator is not running

NOTES In Cycle Monitor is not available for SFC POUs (only the main program file MAIN.QPG is
supported).

In Cycle Monitor is not available for the standby system of a redundant system in Backup
mode. A corresponding message will be shown if an attempt for monitoring is made.

The In Cycle Monitor is not available for the A and FX series.

It is not possible to use “normal” monitoring for one window and in cycle monitoring for
another. Once monitoring is started in In Cycle Monitor mode all monitoring is done at the
designated step and vice versa.
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The „Stop In Cycle Monitor“ menu command will also stop monitor mode and vice-versa, if the
command „Stop Monitoring“ mode is issued during In Cycle Monitoring, In Cycle Monitoring is
stopped automatically.

If you are in In Cycle Monitor mode, but would like to monitor at another step, then first you will
have to stop monitoring and start In Cycle Monitor again.

After starting the In Cycle Monitor, a dialogue box for input of the step number will be displayed:

The step number is pre-initialised, if the In Cycle Monitor is started from one of the IL, MELSEC
IL or ST body editors and from the current editor position a step can be calculated. If for the
current line no step number can be calculated, the previous lines are tried, until a step number
can be calculated or the beginning of the network is reached.

The step number is also pre-initialised, if the In Cycle Monitor is started from one of the IL,
MELSEC IL, LD or FBD body editors and a network is selected. In this case the first step after
the network is used for pre-initialisation. This means that the status after the network is
executed is monitored.

If a step number cannot be calculated the dialogue is opened with the Step No. field empty.

The Step No. field cannot be initialised if

� the actual window is not an IL, MELSEC IL, LD, FBD or ST body editor

� the body is not compiled

� an empty network is selected

� more than one network is selected

NOTE If the designated step is not executed (e.g. the step is jumped or the PLC is in STOP mode),
no monitoring values can be read and a communication error will occur.
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How to calculate the step number to input?

With In Cycle Monitoring, the monitor values shows the status of the monitored devices
previous of executing the designated step.This means, that the actions of the step set as the In
Cycle Monitoring step, do not effect the monitor values.

If you would like to monitor the results of a step, for In Cycle Monitoring you must set the result
of the addition
„starting step number of the desired instruction“ + „length of the desired instruction“.

For convenience, the Tools -> Show MELSEC Code Of Networks functionality can be used,
where the start step of each instruction is displayed (in brackets at the end of each line).

Example The following example shows 12 steps of code, generated for a Q06H PLC. The code snippet
occupies step 14 through 26. After the code lines the start step number is written in brackets.

Every LD instruction for the Q06H PLC occupies 1 step each, whereas a MOV instruction
occupies 2 steps.

In these 12 steps of PLC program the value of the device D1 is changed four times, by four
different MOV instructions.

The value of the device D1 is not changed elsewhere in the PLC program.

If you would monitor the device D1 in „normal“ monitor mode, the value would be 4444, as this
is the last setting.

As an example, if you would like to monitor the result of the MOV instruction at step 22, you
must add 2 (length of MOV instructions) to the start step (22).The result is 24, which is also the
start step of the following instruction, of course.
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Fig. 9-94:
Program sequence for the exampleLD SM400 (* 15 *)

MOV K1111 (* 16 *)

D1

LD SM400 (* 18 *)

MOV K2222 (* 19 *)

D1

LD SM400 (* 21 *)

MOV K3333 (* 22 *)

D1

LD SM400 (* 24 *)

MOV K4444 (* 25 *)

D1



For the in cycle monitoring mode the following table shows the monitored values corre-
sponding to the set in cycle monitor step:

�

Before in cycle monitoring is started the validity of the step is checked both in the project and
on the PLC. If the step is found invalid or the program on the PLC does not have the same
instruction at the same step, in cycle monitoring is aborted. A step is considered valid for in
cycle monitoring, if it is in the range of the program and it is the start step of any instruction. In
the above example, steps 17, 20, 23 and 26 would not be accepted.

During the operation of the In Cycle Monitor a dialogue box informs you about the selected
step number:

If the step selected for In Cycle Monitoring is invalid or not executed by the PLC, it can take
longer than the communication time-out setting for the PLC to return an error, and afterwards
to terminate In Cycle Monitoring.

A status dialogue is displayed when In Cycle Monitoring is started or terminated, until the
process is finished. The estimated time depends on the communication time-out setting.
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Step No. Monitored value of D1

… 14 4444

15 or 16 4444

18 or 19 1111

21 or 22 2222

24 or 25 3333

27 … 4444

Tab. 9-21:
Monitored value for the example

Fig. 9-95:
Display of the monitored step no.

Fig. 9-96:
Status dialogue



9.14 Buffer Memory Monitoring

Using the function of Buffer Memory Batch in the menu Debug you can monitor the current
values of the buffer memory of a special function module attached with the active PLC. The
monitoring can be started and stopped from the buffer memory monitor window.For displaying
the monitored values you can select different user defined monitor, display and value formats.
The formats can be changed by clicking the radio buttons in the function dialogue box.

NOTES The function of Buffer Memory Batch is not supported by the PLCs of the FX series.

GX Simulator (section 9.15) does not support buffer memory monitoring.

When using the function Buffer Memory Batch some menu items like Object, Edit and
Tools are not available.

When selecting Buffer Memory Batch in the Debug menu the following dialogue box will be
displayed.

Module start address: Enter here the I/O address (lowest digit not required) of the special
function module whose buffer memory you want to be monitored. The module start address
should be input in hexadecimal format.

Buffer memory address: Here the start address of the buffer memory block that is to be moni-
tored has to be set. The address can be in either decimal or hexadecimal format according to
the value format option selected (see section 9.14.3).

Monitor format: Please see sections 9.14.1 to 9.14.3.

Start monitor: Click here to start the buffer monitor function.

Stop monitor: Click here to stop the buffer monitor function.

Option setup: Clicking on this button opens a dialogue box to select the bit order for displaying
the buffer memory monitor values.
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Fig. 9-97:
Dialogue box Buffer
memory batch monitor

Fig. 9-98:
Dialogue box Option setup



Device test: Clicking on this button opens a dialogue box for device test.

Module start I/O: In this pull-down list select the start I/O address of the module in which the
buffer memory device for testing is available.

Address: Select a buffer memory address for testing from this pull-down list.

Close: Clicking on this button closes the dialogue.

Setting value: Here you can input the value to be set in the selected buffer memory address.
By clicking on the Set button the input value is set to the selected buffer memory address.

Hide history: Clicking on this button shows/hides the device test history panel in the Device
test dialogue.

Execution history: This history list shows the device tests made using the Device test
dialogue. Here the devices and their setting values are displayed.

Re-setting: Sets the selected device and its associated value from the history panel to the
Setting value box.To finally set the value in buffer memory you have to click on the Set button.

Clear: This button deletes all data of the history.
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Fig. 9-99: Dialogue box Device test



9.14.1 Monitor Formats

You can select one of the following formats for buffer memory monitoring.

� Bit & Word

The buffer memory can be monitored by having displayed both Bits and Words as
shown below.

� Bit only

The buffer memory can be monitored by having displayed only Bits as shown below.

� Word only

The buffer memory can be monitored by having displayed only Words as shown below.
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Fig. 9-100: Monitoring option Bit & Word

Fig. 9-101: Monitoring option Bit only

Fig. 9-102: Monitoring option Word only



9.14.2 Monitor Display

When you have chosen one of the monitor format options Bit & Word or Word only you can
additionally select one of the following display options for the buffer memory monitoring value.
This option only applies to the monitoring values in Word format.

� 16-Bit-Integer

The monitoring values will be displayed in 16-Bit-Integer.

� 32-Bit-Integer

The monitoring values will be displayed in 32-Bit-Integer.

� Real number

The monitoring values will be displayed as Real numbers.

� ASCII character

The monitoring values will be displayed as ASCII characters.
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Fig. 9-103: Monitoring option 16bit integer

Fig. 9-104: Monitoring option 32bit integer

Fig. 9-105: Monitoring option Real number

Fig. 9-106: Monitoring option ASCII character



9.14.3 Monitor Value

When you have chosen one of the monitor format options Bit & Word or Word only you can
additionally select one of the following value options for the buffer memory monitoring value.
This option only applies to the monitoring values in Word format.

� Decimal

The monitoring values will be displayed in decimal format.

� Hexadecimal

The monitoring values will be displayed in hexadecimal format.
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Fig. 9-107: Monitoring option DEC (10)

Fig. 9-108: Monitoring option HEX (16)



9.15 GX Simulator

The GX Simulator is a utility for offline simulation and debugging of PLC programs. It provides
the simulation of external devices, load and save buffer memory contents, timing charts and
much more.

NOTE Step execution is also supported even for an FX CPU.

GX Simulator can only be started, if the tool is installed, the project is compiled, and GX IEC
Developer is not in online-mode.

In the Online menu select GX Simulator. The PLC parameters are transferred to GX Simu-
lator and the main GX Simulator window appears. It shows the PLC CPU condition and allows
to start different tools.

The device memory monitor of the GX Simulator shows the values of the selected devices and
allows to change them.
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Fig. 9-109:
GX Simulator main window

Fig. 9-110: Device Memory Monitor



The timing chart shows the condition of the selected devices within a selected timing range.

It is not possible to perform online changes. Rounding errors may occur in the results of
instructions using the floating decimal point.

NOTE After the error correction by the GX Simulator program module the program must be
transferred to the specified PLC and checked again before it is executed.

The following functions are not supported:

� Physical special function modules

� Physical I/O modules

� Networks

� Interrupt programs

� Read from PLC, Compare with PLC

� Comments

� SFC programs

There are other CPU related restrictions in device ranges, PLC memory format, etc. For more
details refer to the manual for the GX Simulator.
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Fig. 9-111: Timing Monitor



9.16 Intelligent Function Module Utility

The included intelligent function module utility has to be installed separately. It supports an
easy configuration of intelligent function modules by dialogue based input instead of PLC
program code needed to access the module buffer memory setup area.

The utility is available only if a Q series project is active and the utility is installed. The utility
supports the Q series only. For details refer to the documentation of the utility.

GX IEC Developer supports the call of the intelligent function module utility and a check for
address collisions between refresh parameters for the modules and GX IEC Developer system
addresses.The configuration file has to be written by the intelligent function utility to the PLC and
to the hard disk. A corresponding message is displayed by GX IEC Developer if the utility is
started.

If initial setting and automatic refresh setting are performed, the intelligent function module
parameters require a maximum of 76 bytes per module.

If the project is saved with a different name, GX IEC Developer informs the utility about a
closed project because the iparam.wpa file of the old project path is not saved with the new
project! The iparam.wpa file is the configuration file, created by the utility. It can be found in the
subdirectory Resource of the current project. You have to close the utility, and copy the
iparam.wpa file from the old project to the new one.

NOTES After configuration of the intelligent function module, please save the parameters to hard
disk!

The intelligent function module utility will be closed, if the current project is closed or
changed. Please remember to save the configuration BEFORE closing or changing the
project.
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9.16.1 Starting the utility

From the Extras menu select Intelligent Function Utility - Start to start the external utilities
and navigate via the utility’s menus.

From the Extras menu select Intelligent Function Utility - Verify System Variables to start
the external utilities and directly verify the system variables.

Address collisions between refresh addresses and GX IEC Developer system
addresses.

Intelligent function module utility with configuration for three different modules.
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Fig. 9-112:
Notified address collisions

Fig. 9-113:
Intelligent function module utility



Example Example for the auto refresh configuration of the A/D conversion Module Q64AD.

�

9.16.2 Troubleshooting

In very rare cases problems might occur which will be solved in future software versions.

� Problem: If GX IEC Developer 7.03 is already installed before installing GX Developer
(Version < 8.00), the Intelligent Function Utility can not be started anymore from
GX IEC Developer 7.03.
Solution: Install GX IEC Developer 7.03 again.

� Problem: If GX Developer (Version < 8.00) is already installed before installing
GX IEC Developer 7.03, GX Developer can not be started anymore.
Solution: Install GX Developer again in a newer version (Version > 8.00).

� Problem: If GX Developer as well as GX IEC Developer 7.03 are installed and
GX Developer will be uninstalled afterwards, the Intelligent Function Utility can not be
started anymore from GX IEC Developer 7.03.
Solution: Install GX IEC Developer 7.03 again.
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Fig. 9-114: Sample auto refresh settings



10 Working with Projects of Version 6.11
and before

This chapter describes major changes in the new version of the GX IEC Developer compared
to earlier versions. So reading this chapter is important for users who want to use projects with
the GX IEC Developer 7.03 that have been created by using the GX IEC Developer 6.11 or an
earlier version. Please also see section 10.4.

10.1 External Variables are no longer used

Instead of using external variables, every global variable can be directly accessed from any
POU since version 7.00 of GX IEC Developer.
This means that in a POU body, action or transition every variable will be accessible that is
declared either global or local in the respective scope. A global variable declaration can either
take place in the Global Variable List of the project or in any user library.

10.1.1 Using Global Variables in Bodies

Every global variable is now accessible from any POU body, action or transition, without
declaring it as an external variable in the POU scope. Global variables will be usable the same
way as any local variable.

When there is a local variable declared in a POU with the same name as a global variable, the
global variable is hidden, i.e. it is not possible to read or write the value of that global variable –
always the local variable is referenced instead.
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In the example below there are both global and local variables used in a POU body.

Example There are three variables in the POU’s header whose names are identical with global variable
names: Count, MotorOff and Frequency. These local variables hide the corresponding global
variables, so when e.g. Count is used in the POU’s body, it means the local variable Count, not
the global variable Count.

�
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Fig. 10-1: Global and local variables with the same name

hidden
global

variables



10.1.2 Compiler Options

Two new options are introduced on the Compiler page of the Options. One is to allow you to
choose if global variable hiding should be considered as a programming error or not, the other
one is to allow you to choose if using lower case device/constant names used as variable
names should be considered as a programming error or not.

Please refer to section 2.9.2 for additional information.

Hiding global variables

By default, if a local variable of a POU has the same name as a global variable, an error will be
shown when the POU is checked. If you turn this option on, hiding of global variables will be
allowed and the POU will be compiled.

POUs that have been already compiled without error and have not been changed since the
compilation are not checked or built again when the corresponding menu command Object
Check or Project Build is called.
Consequently, for already compiled POUs changing the option “Allow local variable with the
same name as a global variable” from checked to unchecked has no effect, unless the whole
project is recompiled by calling the menu item Project Rebuild All.
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Fig. 10-2:
Options - Compiler



Using lower case device/constant names

The following programming is possible in GX IEC Developer:

� Using X1 and X2 variables in a body (either typed with caps, or automatically converted by
the editor) with no declarations in the header or GVL.
Result: Devices are used in the generated code.

� Using X1 and X2 variables in a body (either typed with caps, or automatically converted by
the editor) with x1 and x2 declarations in the header or GVL.
Result: Variables are used in the generated code.
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Fig. 10-3: Using X1 and X2 variables in a body with no declarations

Fig. 10-4: Using X1 and X2 variables in a body with declarations



To give the user a hint, that a Mitsubishi device or constant could be hidden by a variable decla-
ration with lower case letters the new option is added to the General Options\Compiler
option.

If the option is checked, the following warning is shown when a Mitsubishi device/ constant
name is used as variable name in a lower case format:

Warning: C9173 The variable ‘%s’ could hide a Mitsubishi device/ constant. Make sure
you want to use the variable instead.

If the option is unchecked, the following error is shown when a Mitsubishi device/ constant
name is used in a lower case format as variable name:

Error: C9172 The variable ‘%s’ has the same name in lower case format as a
Mitsubishi device/ constant. This error can be converted to a warning in General
Options\ Compiler.

In the LD/FBD and ST editor Mitsubishi devices are already converted to upper case when
they are entered in lower case format.Since GX IEC Developer 7.00 this is extended to convert
Mitsubishi constants, too.

10.1.3 Variable Declaration

Variable Declaration in the Declaration Editors

The global variable list and POU header editors were modified to comply with the new conven-
tion. In the GVL editor the Autoextern checkbox column was removed, because every global
variable now is accessible from any POU.

In the POU header editor VAR_EXTERNAL and VAR_EXTERNAL_CONSTANT were
removed from the list of available classes.Moreover, the button column on the right of the Iden-
tifier column also is removed, because it was used to access the dialogue to select the name of
an external variable from the list of global variable names.

Example Example of the changed Global Variable List editor:

Example to the changed POU header editor:
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Fig. 10-5: Sample of GVL

Fig. 10-6: Sample of POU Header



Variable Declaration in the Variable Selection Dialogue

The variable declaration part of the Variable Selection dialogue has also been modified to
comply with the changed variable scope convention.
The Autoextern checkbox was removed from the dialogue, and the external variable classes
(VAR_EXTERNAL and VAR_EXTERNAL_CONSTANT) are no longer available in the Class
list when the scope of the Variable Selection dialogue is set to <Header>.

Declaration of a SFC Reset Variable

In each SFC POU of an FX project a Boolean variable can be specified to be used to trigger the
reset of all steps and the set of the initial step. This variable can be either local or global
(external in previous versions).
Formerly a variable was specified to be such a SFC reset variable by setting its comment field
in the POU header to “!RESET!” (the first variable in the POU header with the comment
“!RESET!” was used as SFC reset variable).
With the removal of external variables, this is not possible anymore, because a global variable
can not be specified to be the reset variable for a POU, as it is not in the header of the POU.

The assignment of a SFC reset variable to a SFC POU of an FX project is introduced in the
POU information dialogue. When calling Object Information for a SFC POU in an FX
project, the dialogue will provide the setting for the SFC reset variable.
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Fig. 10-7:
Variable Selection Dialogue

Fig. 10-8:
Function Information
Dialogue



NOTES The SFC reset variable can be a local or global variable with the type BOOL or ARRAY OF
BOOL. When an ARRAY OF BOOL variable is given, its first element will be used as the
reset variable.

By pressing the function key F2 the dialogue Variable Selection can be called to select and
apply a variable for SFC reset.

When pressing OK in the dialogue, the syntax of the entered name will be checked, but it will
not be verified whether the entered name specifies an existing variable. When the POU or the
project is checked (or built), and the SFC reset setting does not specify a valid variable, an
error will be added to the list of errors and warnings in the Compile/Check Messages
dialogue. See section 8.1 for details.

10.1.4 Update Variables

The function of updating variables is enabled when at least one declaration is selected in an
active GVL or POU header editor; is disabled in Monitoring mode. It is disabled in POU header
editors if the POU does not have a write-accessible body and in GVL editors if the GVL is in the
Standard or the Manufacturer library, or if it is in a read-only user library.

Formerly when the functionality Extras Update Variables was called in a GVL, every refer-
ence in the project to the selected variable(s) – including all user libraries – was updated.
Variable update meant that in all POU headers the external variable(s) referring the selected
global variable(s) were synchronized with the global variables, so that their type, address and
other properties matched.
Furthermore, if the name of a global variable was changed, not only the corresponding
external variables were updated in the POU headers, but also all occurrences of those
external variables in the POU bodies.

With the removal of external variables, POU headers do not have to be updated when a global
variable is updated. If the name of a global variable is changed, Update Variables will change
all occurrences of that global variable in each POU.

When the Auto Update feature is switched on in the Editing page of the Options (� 2.8.3), the
update of changed variables will be performed automatically each time the GVL is saved.

The behaviour of Extras Update Variables remains the same as in former versions when
called in a POU header: all occurrences of selected local variables whose name has been
changed will be updated in the POU.
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10.1.5 Import from Excel

When importing a Microsoft Excel file into a POU header, the file is checked for external vari-
ables in it.
If one or more variables with the class VAR_EXTERNAL or VAR_EXTERNAL_CONSTANT
are found, you will be warned that these variables will be skipped.

Example

�
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Fig. 10-9:
Warning message

Fig. 10-10: External variables are skipped



10.1.6 ASCII Import and Export

ASCII Import

When you import data from an ASCII export file that includes the Global Variable List (e.g. a
complete project exported), the external variables will be automatically removed from the POU
headers (including the POUs in user libraries).

When you import data from an ASCII export file that contains no Global Variable List, each
imported POU header will be checked for external variables. If one or more variables with the
class VAR_EXTERNAL or VAR_EXTERNAL_CONSTANT are found, you will be warned that
the variable(s) will be skipped.

This message will not be displayed when you are importing an ASCII export file that was
created by GX IEC Developer version 7.00 or newer.

In FX projects before version 7.00, SFC reset variables were assigned to the POUs based on
declaration comments, i.e. in each POU the first variable having the comment “!RESET!” was
set to be the SFC reset variable of the POU.During ASCII import the SFC reset variable will be
assigned to the POU information. When you call Object Information for the SFC POU of
the FX project, you can check the setting of the SFC reset variable.

ASCII Export

To keep compliance with the IEC standard, when exporting the project or any part of the
project that includes at least one POU, the global variables used in each POU will be automati-
cally declared as external variables of those POUs in the exported ASCII file. If such an
exported file is imported in a new GID version working without external variables, the external
variables will be removed from the headers. If it is imported in a previous version of GID,
external variables will be imported as usual.

For FX projects, to keep compliance with the IEC standard, the SFC reset variable of a POU
will be exported by setting the variable declaration’s comment field to “!RESET!”. This is
because the SFC reset variable is a special GX IEC Developer feature, for which there is no
standard IEC definition.When a global variable is used as a reset variable for a POU, the auto-
matically declared external variable (please see "Declaration of a SFC Reset Variable" in
section 10.1.3) will get the “!RESET!” comment.

When the comment field of a variable that is used as the SFC reset variable is not empty or is
not equal to “!RESET!”, you will be warned that the comment field of that variable will be over-
written in the export file.
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Fig. 10-11:
Warning message

Fig. 10-12:
Warning message



If there is already another variable in the POU header with the comment “!RESET!”, you will be
offered to set the comment of the actual SFC reset variable to “!RESET!” and clear the
comment field of other variables having the comment text “!RESET!”.
This change affects only the ASCII export file, not the project.
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Fig. 10-13:
Warning message



10.1.7 User Libraries

Installing Libraries

When installing user libraries, external variables will be removed from the header of each POU
installed into the project from the user library. The removal affects only the POUs installed into
the project, the user library file will be kept unchanged.

In FX projects, SFC reset variables will be assigned to the POUs based on declaration
comments, i.e. in each POU the first variable having the comment “!RESET!” will be the SFC
reset variable of the POU. Since version 7.00 the SFC reset variable is assigned to the POU
information.

Saving Libraries

To keep compliance with the IEC standard, user libraries will be saved to the corresponding
user library file, so that for each POU the global variables used in the POU will be automatically
declared as external variables in the header of that POU.

This ensures that user libraries saved in GID 7.00 or later are compatible with former GID
versions, starting from version 4.00.

If the user library is installed in a new GID version working without external variables, the
external variables will be removed from the headers.
If a user library saved in the new GID version is installed in a former GID version, it will be able
to use it without any problems because the necessary external variables will be declared.

For FX projects, to keep compliance with the IEC standard, the SFC reset variable of a POU
will be saved so that it will work also when the user library is installed in a former GX IEC Devel-
oper version. Because of this the variable’s comment will be set to “!RESET!”.

When the comment field of a variable that is used as the SFC reset variable is not empty or is
not equal to “!RESET!”, you will be warned that the comment field of that variable will be over-
written in the user library file.
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Fig. 10-14:
Warning message



If there is already another variable in the POU header with the comment “!RESET!”, you will be
offered to set the comment of the actual SFC reset variable to “!RESET!” and clear the
comment field of other variables having the comment text “!RESET!”.
This change affects only the user library file, not the project.
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Fig. 10-15:
Warning message



10.1.8 Browser

In the Browser window the VAR_EXTERNAL and VAR_EXTERNAL_CONSTANT classes are
no longer available in the Scope list.

When a global variable is selected in the left hand side list, the location of its declaration (the
GVL of the project or a user library) will be shown on the right hand side list, together with the
references to it.
Formerly there could be several items in the Declaration part of the right hand side list for a
global variable, because external variable declarations were listed as well.

With the removal of external variables only the GVL declaration is listed for a global variable.
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Fig. 10-16:
Browser dialogue



10.1.9 Entry Data Monitor

The setting List global variables used in a POU in the EDM Setup is used to switch the listing
of global variables used in a POU on and off.
When the setting is off, only local variables (those declared in the POU header) will be listed
under the POU.
When the setting is on, the list will also contain all global variables used in the POU’s body,
actions and transitions.
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Fig. 10-17:
Setup dialogue



10.2 Opening Projects saved by former Versions

10.2.1 Opening older projects

When opening a projects saved by a former version of GX IEC Developer, the project will be
converted according to the new variable scope convention:

� External variables will be removed from each POU’s header (including POUs in user
libraries) (also see section 10.2.2).

� SFC reset variables in FX projects will be assigned to the POUs based on declaration
comments, i.e. the first variable having the comment “!RESET!” will be the SFC reset
variable of the POU (also see section 10.2.3).

� The objects of an SFC POU (steps, actions and transitions) conflicting with global variable
names will be offered to be automatically renamed.

The objects of an SFC POU (steps, actions and transitions) are not allowed to be named the
same as any local or global variable accessible from the POU. Before GX IEC Developer
Version 7.00 a global variable could be used in a body only if it had been declared in the POU
as an external variable, therefore an SFC object could have the same name as a global but
non-external variable.

Since GID 7.00 each global variable is accessible in every POU, therefore the name of an SFC
object may be the same as the name of any global variable. This leads to the problem that a
project that could be compiled in a former version could cause an error in GID 7.00 or later
when building the project, if it had one or more SFC objects sharing names with global but
non-external variables.

If a project last saved with a GX IEC Developer version preceding 7.00 is opened, or a project
is imported from an .ASC file using File � Other � Import, SFC objects conflicting with global
variable names will be offered to be automatically renamed.

Yes: This renames the mentioned SFC object.

Yes All: Renames the mentioned and following problematic SFC objects without showing this
dialogue again.

No: Does not rename the mentioned SFC object.

No All: Does not rename the mentioned nor the following SFC objects.

Automatic renaming sets an index number at the end of the name, or increases it if there is one.
If the name is too long, the last character will be cut before numbering. If the new name would
conflict with a device name, the index number will be separated with an underscore character
(e.g. X_1 instead of X1).

If the conflicting SFC object is not write-accessible, no renaming will be offered. Any unre-
solved conflict will cause an error during build, and can then be fixed manually by the user.
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Auto-renaming SFC POU
objects



10.2.2 Copying and Moving Variables

When inserting variables into the POU header of GX IEC Developer 7.00 or later from a POU
header editor of a former GX IEC Developer version via clipboard operations
(Copy/Cut/Paste) or Drag & Drop, variables with the class VAR_EXTERNAL or
VAR_EXTERNAL_CONSTANT will be skipped. This applies also to the case when variables
are dropped from a declaration list of a former GX IEC Developer version onto a POU header in
the project navigator window.

To easily create a local variable with the same properties as a global one, when a variable with
the class VAR_GLOBAL or VAR_GLOBAL_CONSTANT is copied to a POU header, its class
will be changed to VAR or VAR_CONSTANT, respectively. This is also possible in the opposite
direction: VAR_CONSTANT converts to VAR_GLOBAL_CONSTANT, while all other classes
convert to VAR_GLOBAL.
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10.2.3 Clipboard Operations and Drag & Drop in the Project Navigator

When a selection including one or more POUs and the Global Variable List is copied or moved
from a project opened in a former GID version to a project opened in the new GID version by
clipboard operations (Copy/Cut/Paste) or Drag & Drop, external variables will be removed
from POU headers.

If the copied or moved selection includes one or more POUs but no Global Variable List, the
header of each selected POU will be checked for external variables. If one or more variables
with the class VAR_EXTERNAL or VAR_EXTERNAL_CONSTANT are found, you will be
warned that the variables will be skipped.

This message will be displayed only when copying or moving data from a project opened in a
GX IEC Developer version preceding version 7.00.

In FX projects, SFC reset variables will be assigned to the POUs based on declaration
comments, i.e. in each POU the first variable having the comment “!RESET!” will be the SFC
reset variable of the POU.

To keep compliance with the IEC standard, when a selection including one or more POUs is
copied or moved by clipboard operations (Copy/Cut/Paste) or Drag & Drop from a project
opened in the new GID version to a project opened in a former GID version, the global vari-
ables used in each POU will be automatically declared as external variables in the POU’s
header in the destination project.As a result, former GID versions – working with external vari-
ables – will be able to compile a copied POU without any problems.

For FX projects, to keep compliance with the IEC standard, the SFC reset variable of a POU
will be copied by setting the variable declaration’s comment field to “!RESET!”. When a global
variable is used as the reset variable of a POU, the automatically declared external variable
(see previous paragraph) will get the “!RESET!” comment.

When the comment field of a variable that is used as the SFC reset variable of the POU is not
empty or is not equal to “!RESET!”, you will be warned that the comment field of that variable
will be overwritten when copied. This warning will be displayed only for clipboard operations,
not for drag & drop. For drag & drop “Yes All” is assumed as the user’s answer.
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If there is already another variable in the POU header with the comment “!RESET!”, you will be
offered to set the comment of the actual SFC reset variable to “!RESET!” and clear the
comment field of other variables having the comment text “!RESET!”.
This change affects only the declaration copied to the clipboard, not the declaration in the
project. This warning will be displayed only for clipboard operations, not for drag & drop. For
drag & drop “Yes All” is assumed as the user’s answer.
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10.3 Special characters for identifier

In former versions of GX IEC Developer it was not possible to have identifier names which
include special characters like e.g. ‘ä’, ‘ö’, ‘ü’. This was not possible due to the IEC naming
convention.
GX IEC Developer does now support the usage of special characters.

When the option "Allow special characters for identifier names" in the Options-General
dialogue is checked, you can use special characters for identifier names.

The following list shows all newly supported valid characters:

Valid characters: ‘ä’, ‘Ä’, ‘ö’, ‘Ö’, ‘ü’, ‘Ü’, ‘ß’, ‘_’, ‘å’, ‘Å’

The usage of these characters is valid for the following identifier and all functionalities where
these identifiers are used (e.g. Variable selection dialogue):

� Library names

� Task names

� DUT names and DUT component names

� Global and local variable names

� POU names (PRG, FUN, FB)

� Network label names

� SFC Transition names

� SFC Action names

� SFC Step names

� SFC Jump label names

The character ‘_’ (underscore) was already allowed in older versions of GX IEC Developer.
Due to the restrictions by the IEC naming convention it was not allowed to use a double under-
score character at the beginning of an identifier (e.g. “__TestVar”). Additionally there was a
restriction for the usage of the underscore character as the last character of an identifier (e.g.
“TestVar_”). These restrictions can now be disabled by the user.
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These identifiers can be used in every program editor:

� LD

� FBD

� IL

� MELSEC-IL

� SFC

� ST

NOTES The usage of numbers for the first character for identifier names is not possible.

Identifiers including special characters should only be used in the same way as they were
listed in the local header or GVL (upper/lower case).
Otherwise the compiler will show an error message after compiling.
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10.4 Compatibility

10.4.1 File based compatibility with former versions

� GX IEC Developer 7.03 can open project databases (*.pro file) of MM+ 2.1, 2.30a, 2.31,
2.31a, 2.32, 2.40, 2.40a, 2.50, 3.00, GX IEC Developer 4.00, 5.00, 5.01, 5.02, 6.00, 6.01,
6.10, 6.11, 7.00, 7.01 and 7.02, but these versions can not open GX IEC Developer 7.03
project databases.
Exception:GX IEC Developer 7.03 can not open project databases (*.pro file) of MM+ 2.1,
2.30a, 2.31, 2.31a, 2.32, 2.40, 2.40a, 2.50 and 3.00 with Microsoft Windows� XP and
Microsoft Windows Vista�.

� GX IEC Developer 7.03 can not open project databases (*.pro file) of MM+ 2.41 and vice
versa.

� GX IEC Developer 7.03 can import projects, which have been exported (*.asc file) by
MM+ 2.1, 2.30a, 2.31, 2.31a, 2.32, 2.40, 2.40a, 2.41, 2.50, 3.00, GX IEC Developer 4.00,
5.00, 5.01, 5.02, 6.00, 6.01, 6.10, 6.11, 7.00, 7.01 and 7.02, but these versions cannot
import *.asc exports of GX IEC Developer 7.03.

� GX IEC Developer 7.03 can open library files (*.lib file) of GX IEC Developer 4.00, 5.00,
6.00, 6.10, 6.11, 7.00, 7.01 and 7.02, but these vers ions cannot open
GX IEC Developer 7.03 library files.

10.4.2 PLC project based compatibility with former versions

It is possible, that the generated code of GX IEC Developer 7.03 is different to the generated
code of a former version of GX IEC Developer. This could result in the following facts:

� An online change can fail, if the project was not downloaded with GX IEC Developer 7.03.

� The functionality to verify the generated code with the program on the PLC can show
differences.

The reason for the differences are internal changes in the code generator which result from the
implementation of new features in GX IEC Developer 7.03.

NOTE Please also see section 2.9.1, Code Generation.
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10.4.3 Compatibility with other programming software for MELSEC PLCs:

� GX IEC Developer 7.03 can import MELSEC MEDOC/DOS print files (*.tmp) of the
versions 1.64b/c, 2.20 and 2.30.

� GX IEC Developer 7.03 generally can not upload parameters and programs from Q and
QnA/S CPUs, which are generated by GX Developer or GPPQ.

� GX IEC Developer 7.03 can upload only programs from Q and QnA/S CPUs which are
generated according to the limitations of GX IEC Developer 7.03 compared to the Q and
QnA/S features (only one program file MAIN.QPG).

� GX IEC Developer 7.03 can upload programs from A CPUs which are generated with
GX Developer or GPPA.

� GX IEC Developer 7.03 can not open project databases from GX Developer, GPPQ or
GPPA.

There is currently no direct possibility to exchange projects between GX IEC Developer 7.03
and GX Developer, GPPQ or GPPA.
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11 Support of other Applications

11.1 GX Configurator-DP Support

GX IEC Developer supports the configuration of Profibus Modules. A entry called Module
Configuration is implemented in the Parameters section of the Navigator.

The module configuration invokes a dialogue with a list of all configured modules, which are
currently available. This information is initially copied from the I/O settings in the PLC param-
eter configuration. Furthermore it is possible to change the module name. In this case, the I/O
settings in the PLC parameter are updated.

For all intelligent function modules a configuration editor can be called by Configure module.

Configure module: Opens the corresponding module configuration program (only for
Profibus and intelligent function modules).
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� Profibus modules

Profibus modules are identified by the module name and the module type intelli.. Valid
module names for Profibus modules are PB92D (for QJ71PB92D or A(1S)J71PB92D),
PB93D (for QJ71PB93D) and FX3U-64DP-M (for FX3U-64DP-M). In case of Profibus
Modules, each module can be assigned to a Profibus configuration by either selecting
an existing configuration path or by creating a new configuration. By clicking on
Configure module, the optional application GX Configurator-DP will be called for a
more comfortable configuration of the selected Profibus module.

� Intelligent function modules:

If the module type is intelli. and the module name does not match the Profibus
description, Configure module calls the intelligent function utilities.

For all other modules, the button Configure module is disabled.

NOTE At the first time GX Configurator-DP is called from the dialogue, the user will be prompted to
specify the location of the application.
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11.2 FX Configurator-EN Support

With the introduction of the new Ethernet unit (FX3U-ENET), GX IEC Developer is now able to
communicate with the FX3U via Ethernet. The parameters of the new Ethernet unit are not be
part of the PLC parameter, they are stored in the Ethernet unit.

An external application, FX Configurator-EN was introduced to set the parameters and
diagnose the FX3U-ENET module.

Open the Module Configuration implemented in the Parameters section of the Navigator.

For the FX3U eight module positions are available. For each position the type and name of the
module can be selected. If the selected module in a row is either a Profibus module or a
Ethernet module, for each of which a Configurator is available, the field to specify or browse for
the path of the configuration file will be enabled.

The button Configure module… will be enabled, if ...

� FX3U-ENET is selected in the active row and FX Configurator-EN (optional) is installed.
Clicking on Configure module will start the FX Configurator-EN.

� FX3U-64DP-M is selected in the active row and GX Configurator-DP (optional) is installed.
Clicking on Configure module will start the GX Configurator-DP.
At the first time GX Configurator-DP is called from the GX IEC Developer, the user will be
prompted to specify the location of this application’s executive file to be able to start the
application.
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Fig. 11-4: Module Configuration for a FX3U CPU
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A Glossary

Absolute address
A variable’s absolute address references a fixed memory location in the CPU or a physical
input or output. This absolute address can be assigned using either IEC syntax (IEC
address) or MITSUBISHI syntax (MITSUBISHI address). The user must only assign
absolute addresses for the global variables. The program assigns suitable memory
locations for the local variables automatically.

Absolute Label
Absolute labels are the addresses of specific pointers in the PLC program (e.g. P20). When
PLC programs are uploaded to GX IEC Developer absolute labels are assigned as jump
instruction destinations. Every program section identified by a pointer in the original PLC
program is loaded in a separate MELSEC network. You can also use absolute labels
(Syntax: P_20) when you assign your own names to networks.

Accumulator
The accumulator is a result handling facility used in IEC Instruction List. You may be familiar
with it from other high-level programming languages. The result of every operation
performed is written to the accumulator directly after execution. The accumulator thus
always contains the result of the last instruction programmed. This means that you do not
have to program any input conditions (execution conditions) for the operations, as execution
is always dependent on the contents of the accumulator.

Action
An action is allocated to every step in an SFC sequence. These actions can be Boolean
output variables or PLC programs.

Action Pool
When you write a POU in Sequential Function Chart language the action pool is displayed
in the Project Navigator window as an entry in that POU. The Action Pool contains all the
actions belonging to the program organisation unit.

Actual parameters
Functions and function blocks have two kinds of parameters: Formal parameters and actual
parameters. The formal parameters are the variables used when you create a function or a
function block. The actual parameters are the variables or values passed to the function or
function block instance when they are used in another program organisation unit.

’Adapted’ MELSEC instructions
‘Adapted’ MELSEC instructions are MITSUBISHI ELECTRIC instructions with a special
modified nomenclature (e.g. BMULTI_M, PLUS_M, FLOAT_MD) for use in the IEC editor.
They always have the suffix _M for ‘MELSEC’ or _MD for ‘MELSEC Dedicated instruction’.
All the ‘adapted’ MELSEC instructions are stored in the Manufacturer Library. These
instructions can only be used in the IEC editor (� Appendix E).

Array
Arrays are derived data types, consisting of fields of one kind of variable. You can define
arrays with up to three dimensions.

AutoConnect mode
The Autoconnect mode is a special editing mode used in the graphical editors
(� Chapter 3).

Body
Program organisation units (POUs) always consist of a header and a body. The body
contains the actual PLC program code.
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Class
The class is specified in the declaration table to define the way variables are to be used in
the project. The following classes are supported: VAR, VAR_CONSTANT, VAR_INPUT,
VAR_OUTPUT, VAR_IN_OUT, VAR_GLOBAL and VAR_GLOBAL_CONSTANT.

Comment
You can enter and store explanatory comment texts for all objects used in GX IEC
Developer. National characters can be used.

Compiling
When you compile a project GX IEC Developer translates the program into code that can
be read and executed directly by the PLC.

Computer link module
One of the several ways of connecting the PLC to your personal computer is with a
MITSUBISHI ELECTRIC computer link module. Computer link modules available from
MITSUBISHI ELECTRIC include the following models: AJ71C21, AJ71UC24, AJ71QC24,
A1SJ71QC24, QJ71C24.

Continue condition
� ‘Transition condition’

Controller instruction
PLC programs written in Instruction List language consist of a series of controller
instructions. Each controller instruction contains an operator, i.e. the programming
instruction, and an operand, i.e. the variable.

CPU interface
You can connect the PLC to your personal computer via the CPU interface, which is located
on the PLC unit.

Data type
The data type of a variable defines the number of bits it contains, how they are processed
and the variable’s value range. The following data types are available: BOOL, INT, DINT,
WORD, DWORD, TIME, REAL, ARRAY, STRING.

Data Unit Type
The Data Unit Type (DUT) is a structured data type. It contains a collection of variables.

Declaration table
Declaration tables are lists used for managing and declaring both global and local
variables.

Device Editor
The device editor allows you to display and edit the contents of the PLC CPU’s bit and word
devices (registers). The central element of the device editor is a table that is very similar to
a Microsoft Excel worksheet, both in its appearance and in the way it is used.

Dialogue box
A dialogue box is a special kind of window used for handling dialogues with the user. They
can contain a number of different elements, including fields for entering data, check boxes
or radio buttons for selecting options and messages containing important warnings or
information. Dialogue boxes are displayed at many different points in the program, for
example when you select menu commands followed by three periods (e.g. Open...).

Download
Transfer process from GX IEC Developer to the PLC
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DUT Pool
The DUT Pool is one of the standard entries in the Project Navigator window (DUT_Pool). It
contains all the Data Unit Types used in the project.

Edit mode
When you are editing the body of a POU you can choose between Select mode and Edit
mode. In Edit mode you can perform actions on selected program elements (e.g. move,
overwrite, delete etc).

Editing area
The editing window for working on the body of a POU is divided into two main areas, the
network bar and the editing area. The editing area is where you enter the component
elements of your program.

Editor
The GX IEC Developer editors are program modules used for writing and editing programs
in the supported programming languages. The editors are displayed as separate windows
on the screen. GX IEC Developer includes text, graphical, IEC and MELSEC editors.

EN input
In addition to their input and output variables, some function blocks also have a Boolean
input (EN = ENable) and a Boolean output (ENO = ENable Out). The status of the ENO
output always corresponds to the current status of the EN input.

ENO output
� ‘EN input’

Entry Data Monitor
GX IEC Developer supports a variety of different monitoring modes: Program Monitor, Entry
Data Monitor and Header Monitor. In the Entry Data Monitor mode the program displays the
status of a user-defined list of variables. The variables in this list can be displayed in any
order.

Ethernet card
One of the several ways of connecting the PLC to your personal computer is via an
Ethernet network. To do this, you must then have an Ethernet card in your PC and connect
it to the MITSUBISHI ELECTRIC Ethernet module.

Final step
The final step is the last step in an SFC sequence.

Formal parameters
� ‘Actual parameters’

Function
The function is a program organisation unit (POU) with the class ‘Function’ (FUN). It can be
used in the same way as a normal programming instruction. When they are executed,
functions deliver precisely one output variable. Functions do not store any internal status
data. This means that all a function’s internal variables are always set to 0. When a function
is called with the same input parameters it thus always delivers the same output value.

Function block
The function block is a program organisation unit (POU) with the class ‘Function Block’
(FB). It can be used in the same way as a normal programming instruction. Function blocks
deliver one or more output variables when they are executed. All the values of the output
variables and the internal variables are stored in the function block following execution. This
means that function blocks do not necessarily always deliver the same output values when
they are called again with the same input parameters. Function blocks can only be called in
the form of instances. Be careful not to confuse these function blocks with the graphical
function blocks used in the Function Block and Ladder Diagram language!!
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Function Block Diagram
Function Block Diagram (FBD) is a programming language. Programming instructions are
displayed as graphical blocks which are connected with horizontal and vertical interconnect
lines. Be careful not to confuse these graphical function blocks with the Function Block (FB)
program organisation units!!

Function blocks in the graphical editors
In the graphical editors most programming instructions are displayed as graphical blocks in
the editing screen. These graphical blocks are sometimes referred to as ‘function blocks’.
Be very careful not to confuse these blocks with the Function Block program organisation
units!!

Global variable
Global variables have fixed hardware addresses (absolute addresses). They are declared
‘globally’ for the entire project and can be referenced from all function block (FB) and
program (PRG) program organisation units. They make it possible to exchange data
between the individual program modules that make up the project. The global variables are
also included as a standard entry in the Project Navigator window, Global_Vars.

Graphic macro
You can define any selected section of a PLC program as a graphic macro. Macros are a
useful construct when you need to use the same piece of code several times at different
points in your PLC program. Graphic macros are only supported in the graphical editors.

Graphical editor
The following programming languages use graphical editors, which are used in the same
way as a standard graphics drawing program: Ladder Diagram (LD), Function Block
Diagram (FBD) and Sequential Function Chart (SFC).

Header
Program organisation units (POUs) always consist of a header and a body. The header
contains the declarations of all the variables used in the POU, which are organised in a
declaration table.

Header Monitor
GX IEC Developer supports a variety of different monitoring modes: Program Monitor, Entry
Data Monitor and Header Monitor. Header Monitor mode is fundamentally the same as Entry
Data Monitor mode. However, in addition to the user-defined list of variables the monitor also
always displays the variables of the active program organisation unit.

Identifier
The identifier is the name allocated to a variable that serves as its symbolic address.

IEC address
The IEC address assigns a fixed memory location to a global variable. The syntax of IEC
addressing is defined in the IEC 61131-3 standard. Examples: %IX0 (input X0) ,
%MW0.450 (data register D450).

IEC editor
The IEC editor is used for programming in the IEC 61131-3 programming languages.

IEC function
� ‘Programming instructions’

IEC function block
� ‘Programming instructions’

IEC Instruction List
GX IEC Developer supports both IEC Instruction List language and MELSEC Instruction List.
In IEC Instruction List the program is written according to the IEC 61131-3 standard, using
only the instructions from the IEC standard library. However, if you need to do so you can
insert MELSEC networks in programs written in IEC Instruction List.
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IEC operator
� ‘Programming instructions’

IEC programming instruction
� ‘Programming instructions’

Initial step
The initial step is the first step in an SFC sequence.

Initialisation file
MMP703.INI is the ‘initialisation file’ for GX IEC Developer. It is stored in the Windows
directory and contains all the parameters necessary for initialising the GX IEC Developer
program when it is started.

Input variable
� ‘Output variable’

Installation program
The installation program INSTALL.EXE copies the contents of the GX IEC Developer
program distribution disks to your hard disk and sets the program up for your hardware
configuration.

Instance
An instance is a copy of a function block. Function blocks can only be called in the form of
instances. Instances are created by declaring them in the headers of program organisation
units, and they are called in the body of the POU. Special programming instructions are
provided for calling instances.
It is also possible to create global function block instances. These global instances can be
used in different program organisation units.

Instructions
� ‘Programming instructions’, ‘Controller instructions’

Instruction List
Instruction List is a programming language. GX IEC Developer supports two Instruction List
variants, IEC Instruction List and MELSEC Instruction List. An Instruction List program
consists of a list of controller instructions.

Interconnect mode
Interconnect mode is a special editing mode in the Ladder Diagram editor, with functionality
similar to a line-drawing tool in a graphics program. In Interconnect mode you connect
programming elements by drawing horizontal and vertical lines between them.

Interface card
One of the several ways of connecting the PLC to your personal computer is with the
A7BDE interface card from MITSUBISHI ELECTRIC and a MITSUBISHI network. This is an
expansion card which must be installed in your computer. (Not yet supported)

Jump entry point
The jump entry point is the point in an SFC sequence to which a jump is to be performed
(i.e. the jump label).

Jump exit point
The jump exit point is the point in an SFC sequence from which a jump is to be performed
(i.e. the position of the jump instruction).

Jump instruction
Jump instructions are used to execute a branch from the current POU to another network.
In the graphical editors the jump instruction is implemented as a tool. In IEC Instruction List
jumps are programmed with the JMP operator.
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Label
The word ‘Label’ is automatically displayed as a dummy variable when you are
programming jump instructions in the graphical editors. It must be overwritten with the
designator of the actual jump entry point or destination (� absolute label, network label,
system label)

Ladder Diagram
Ladder Diagram is a programming language. The programming elements are contacts
(inputs), coils (outputs) and programming instructions which are displayed as graphical
blocks. These elements are connected to make circuits using horizontal and vertical
interconnect lines. The circuits always start at the power bar on the left.

Library
There are three types of libraries: Standard Library, Manufacturer Library and User Library.

Local variables
Local variables are only accessible within the program organisation units in which they are
declared. They are declared in the POU header.

Macro step
In an SFC sequence a macro step is a step that in turn contains another complete SFC
sequence.

Manufacturer Library
The Manufacturer Library (Manufacturer_Lib) contains the ‘adapted’ MELSEC programming
instructions, with a special nomenclature for use in the IEC editor (� ‘Programming
Instructions’ in the Appendix E).

MELSEC editor
The MELSEC editor is used for editing MELSEC Instruction Lists and MELSEC networks.

MELSEC Instruction List
GX IEC Developer supports both IEC Instruction List language and MELSEC Instruction
List language. MELSEC Instruction List programs only contain MELSEC networks.

MELSEC network
MELSEC networks are programmed according to the DIN 19239 standard, using only the
‘pure’ MELSEC instructions.

MELSEC programming instructions
� ‘Programming instructions’

MELSEC upload
The MELSEC upload procedure loads a program into GX IEC Developer from the PLC unit.
Only the binary data is read in when this process is carried out.

MITSUBISHI address
The MITSUBISHI address is used to assign a fixed memory location to a global variable.
Examples: X0, M1024.

Monitoring mode
GX IEC Developer supports a variety of different monitoring modes: Program Monitor, Entry
Data Monitor and Header Monitor.

Network
A network is a logically continuous program section within a program organisation unit.

Network bar
The editing window in which you work on the body of a POU is divided into the network bar
and the editing area. The network bar is used for making the network label and title
assignments.
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Network label
The network label is the name assigned to a network. It can be used as the destination
address for jump instructions in PLC programs.

Network list
The network list contains all the networks in a program organisation unit, along with their
network labels and titles.

Network title
The network title is a brief description of the network. It is optional, and it is not displayed in
the network bar.

Null modem cable
� ‘RS-232 cable’

Object
GX IEC Developer uses the following objects: The IEC Standard Library (Standard_Lib),
the Manufacturer Library (Manufacturer_Lib), the PLC Parameter (PLC_Parameter), the
Task Pool (Task_Pool), the Data Unit Type Pool (DUT_Pool), the Global Variables
(Global_Vars) and the POU Pool (POU_Pool). These objects are all displayed as standard
entries in the Project Navigator window.

Object window
Object windows contain the data of selected objects (e.g. the declaration table for the global
variables or a task’s table).

Output variable
Function blocks have input and output variables. The input variables give the function block
the values it uses to perform its programmed operations. The output variables pass the
results of these operations out of the function block.

PLC Parameter
The PLC parameter (PLC_Parameter) is one of the standard entries in the Project
Navigator window. It contains the user-editable parameters of the connected PLC system.

POU Pool
The POU Pool is one of the standard entries displayed in the Project Navigator window
(POU_Pool). It contains all the program organisation units used in the project.

Power bar
In the Ladder Diagram graphical editor all circuits start at the vertical power bar on the left
of the editing area. This bar is sometimes also referred to as the rail.

Program
1) Program = An application program (e.g. GX IEC Developer);
2) Program = A PLC program, consisting of a series of programming instructions;
3) Program = A program organisation unit classed as a ‘Program’ (PRG). Program POUs

can only be executed in tasks.

Program class
The program class of a POU defines its functionality. You can declare POUs as Programs
(PRG), Function Blocks (FB) or Functions (FUN).

Program group
The Windows Program Manager organises programs in groups called ‘program groups’.
Each group can contain a large number of individual programs (i.e. application programs).
The GX IEC Developer installation program automatically creates a program group for GX
IEC Developer containing the GX IEC Developer program icon.
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Program Monitor
GX IEC Developer supports a variety of different monitoring modes: Program Monitor, Entry
Data Monitor and Header Monitor. You can activate the Program Monitor mode in all the
editors. This monitor displays the values and switching statuses of the variables visible in
the current editor window.

Program organisation unit
Program organisation units (POUs) can be regarded as subprograms or program modules.
There are three different POU classes, defined by their functionality: Programs (PRG),
Function Blocks (FB) and Functions (FUN). Every POU consists of a header and a body.

Programming elements
Examples of programming elements in the graphical editors include contacts, function
blocks, interconnect lines and variable connections.

Programming instructions
GX IEC Developer supports the following groups of programming instructions: IEC
programming instructions, MELSEC programming instructions and user programming
instructions (� ‘Programming Instructions’ in the Appendix E).

Programming language
GX IEC Developer supports the following programming languages for writing PLC
programs: Instruction List (IL), Ladder Diagram (LD), Function Block Diagram (FBD),
Sequential Function Chart (SFC).

Project
The project is the element at the top of the GX IEC Developer object hierarchy. It is
equivalent to a PLC system.

Project name
The project name is actually the name of a subdirectory. This subdirectory contains all the
individual files that form the components of a project.

Project Navigator
The Project Navigator is the control centre of GX IEC Developer. It is used to administrate
all the objects that go to make up a project. It is displayed on the screen as a separate
window, the Project Navigator window.

Project Navigator tree
The entries in the Project Navigator window are arranged using a hierarchical tree
structure. Some of the levels can be expanded and collapsed to display or hide further
levels of the tree hierarchy.

Project Navigator window
All the objects contained in a project are listed in the Project Navigator window. This
window is opened on the left hand side of the screen as soon as you create or open a
project. It always contains the following standard entries: Standard_Lib, Manufacturer_Lib,
PLC_Parameter, Task_Pool, DUT_Pool, Global_Vars and POU_Pool.

’Pure’ MELSEC Instructions
The ‘pure’ MELSEC instructions are the original MITSUBISHI MELSEC instructions with the
standard nomenclature (e.g. AND=, +, FLOAT). These instructions are only supported in
the MELSEC editor (� ‘Programming Instructions’ in the Appendix E).

Return instruction
The Return instruction effects a return from a function block to the point in the program
from where the function block was called. In the graphical editors the Return instruction is
implemented as a tool. In the IEC Instruction List editor returns are implemented with the
RET operator.

RS-232 cable
An RS-232 cable wired as a null modem cable is required for connecting the personal
computer to a computer link module.

A – 8 MITSUBISHI ELECTRIC
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Select mode
When you are working in the programming editors you can choose between Select mode
and Edit mode. In Select mode the mouse pointer is displayed as an arrow with which you
can select the various programming elements.

Sequence
Sequences are written with the Sequential Function Chart language (SFC). An SFC
sequence consists of steps, actions, transitions and transition conditions. Both parallel and
selective branching are supported in sequences.

Sequential Function Chart Language
Sequential Function Chart is a programming language in which steps are linked together
with conditions referred to as continue conditions. The elements of the SFC language are
steps, actions, transitions and transition conditions.

SFC sequence
� ‘Sequence’

Signal configuration
You can set the following signal configuration parameters for the input and output variables
of a function block and the input contacts and output coils used in the Ladder Diagram
language: Poll for signal status 0 or 1, set and reset.

Standard Library
The Standard Library (Standard_Lib) contains the standard IEC functions (e.g.
INT_TO_BOOL) and function blocks (e.g. R_TRIG).

Status bar
The status bar displayed at the bottom of the screen shows information on the current
status of the project. You can configure the status bar to suit your personal requirements.

Step
Sequences in the SFC language always consist of several steps connected by transitions.
An action is assigned to each step in the sequence.

Step mode
Step mode execution is a debugging aid. In this mode, the program is executed one step at
a time. Please note that the connected PLC system must be switched to step run mode
when you use this option.

STRING
A STRING data type contains characters.

System Label
The system labels (pointers) are system variables that GX IEC Developer needs for internal
management of the project. The number of available system labels depends on the PLC
used. One system label is needed for each of the following elements: every instance of a
function block, every user-defined function, every event-triggered task, every network label.

Task
A task contains one or more program organisation units of the class ‘Program’ (PRG). The
task controls the execution of its component POUs. Tasks can be event-triggered,
interval-triggered or priority-triggered.

Task Pool
The Task Pool (Task_Pool) is one of the standard entries in the Project Navigator window. It
contains all the tasks defined in the project.

Text editor
The text editor is used for writing and editing Instruction List programs. Its functionality is
similar to that of a standard word processor.
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Toolbar
The toolbar displays icons with which the most-used menu commands can be selected
directly by clicking with the mouse.

Transition
Transitions connect steps in SFC language sequences. Each transition is allocated a
transition condition, i.e. a continue condition that controls how and when control is passed
to the next step in the sequence.

Transition condition
A transition condition is a PLC program. It is executed when the preceding SFC step is
completed, and if the condition is satisfied control is passed to the next step in the
sequence.

Upload
Transfer process from the PLC to GX IEC Developer

User library
A user library gives you the possibility of creating functions and program segments which
can be used on a supra-project basis. The program segments are grouped in a library and
can be used in any project. Following updating, changes made to the library can be applied
to other projects. A user library can contain all the objects that are also available in a
project: Global Variables List, Structured Data Types, Arrays and Program Organisation
Units. You can assign a password to protect the know-how in the library. The name of the
user library file has the file extension SUL.

User programming instructions
Programming instructions written by the user. � ‘Programming instructions’.

Variable
Variables can be compared with operands. They contain the values of inputs, outputs or
internal memory locations in the PLC. GX IEC Developer makes a distinction between
global and local variables. Variables are declared and administered in declaration tables;
they are defined with a class, an identifier, an absolute address (global variables only) and
a data type.

Wizard
The Wizard is a special aid that can be activated and deactivated by editing the initialisation
file MMP703.INI. When the Wizard is activated the program can automatically generate a
program organisation unit and a task for you when you create a new project.

A – 10 MITSUBISHI ELECTRIC

Glossary



B Keyboard Commands

B.1 GX IEC Developer Menu Keys
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Keyboard Commands GX IEC Developer Menu Keys

Key(s) Functions

�
Activate/deactivate the Menu Bar

�
Activate/deactivate the Menu Bar

�
Move through Menu Bar to the right (GX IEC Developer menus and Windows control
menu)

�
Move through Menu Bar to the left (GX IEC Developer menus and Windows control
menu)

� - - When Menu Bar or menu activated: Select corresponding menu or menu
option/command
(e.g. L for Online)

�
Activate highlighted menu or menu option/command

	
Move highlight up through menu options



Move highlight down through menu options

�
Exit menu/selection

��
Quit GX IEC Developer (Project - Quit)

�
Activate Help system

��
Open Task List (list of all application programs currently running) and select program

��
Open Windows Start menu

Tab. B-1: GX IEC Developer menu keys



B.2 Common Keys
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Common Keys Keyboard Commands

Key(s) Function

�
Show next compile/check error (Window - Show Next Error)

��
Quit the application (Project - Quit)

�%
Activate the navigator window (Window - Navigator)

��.
Download the current project to the PLC (Project - Transfer - Download to PLC...)

�&
Start, stop or reset the PLC or view the PLC operating status (Online - Start/Stop PLC)

���
Build the project (Project - Build)

��/
Rebuild the project (Project - Rebuild All)

��0
Setup modem for communication (Online - Modem)

��1
View the system errors (Debug - System Errors)

�2
View the user defined errors (Debug - User Errors)

�3
Create a new project (not LD editor)

�3
Insert a contact (Tools - Network Elements - Contact) (LD editor only)

�4
Open a project (not LD and FBD editor)

�4
Insert an output variable field (Tools - Network Elements - Output Variable) (LD and FBD
editor only)

��5
Open an Entry Data Monitor window (Online - Entry Data Monitor)

��0
Change the program online without stopping the PLC (Project - Online Program Change)

��
Enable or disable the monitoring mode (Online - Monitoring Mode)

��
Show previous compile/check error (Window - Show Previous Error)

Tab. B-2: Common keys



B.3 Project Navigator Keys
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Keyboard Commands Project Navigator Keys

Key(s) Function

	
Move highlight up through Project Navigator Window



Move highlight down through Project Navigator Window

�
Scroll window contents to the right

�
Scroll window contents to the left

6
Page window contents up one screen

7
Page window contents down one screen

�,

,: num. keypad

Display lower tree levels of selected entry (Tools - Expand)

�+

+: num. keypad

Hide lower tree levels of selected entry (Tools - Collapse)

�
Undo the last action (Edit - Undo)

�8
Undo the last action

�'
Cut selected entry and copy to the clipboard (not available for all entries!)  (Edit - Cut)

��
Cut selected entry and copy to the clipboard

��
Copy selected entry to clipboard (not available for all entries!)  (Edit - Copy)

�(
Paste data from the clipboard to highlight position (Edit - Paste)

�9
Paste data from the clipboard to highlight position

�
Delete selected entry (not available for all entries!) (Edit - Delete)

�:
Find the specified text (Edit - Find)

:
Find the next occurrence of the specified text

�:
Find the previous occurrence of the specified text

��:
Replace specific text with different text (Edit - Replace)

�:
Replace the next occurrence of the specified text

��:
Replace all occurrences of the specified text

�9
Insert copied contents

�5
Start monitoring of the active body (Online - Start Monitoring)

�5
Stop monitoring of the active body (Online - Stop Monitoring)

�;
Modify the variable value (Online - Modify variable value)

� Open object window or dialogue box of selected entry (Object - Open)

��
Edit the properties of the current object (Object - Information...)

Tab. B-3: Project Navigator keys
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Project Navigator Keys Keyboard Commands

Key(s) Function

��
Check the selected object (Object - Check)

�<
Create a new task (Object - New - Task)

�=
Create a new Program Organisation Unit (Object - New - POU)

���
Create a new Sequential Function Chart action (Object - New - Action)

�>
Print the active object (Object - Print)

�?
Show the print preview of the active object (Object - Print Preview)

�&
Save the selected object (Object - Save)

�� Close Project Navigator Window (i.e. close project) (Project- Close)

Tab. B-3: Project Navigator keys



B.4 Object Window Keys

GX IEC Developer Reference Manual B – 5

Keyboard Commands Object Window Keys

Key(s) Function

��
Step through all opened windows

��
Switch to next window

���
Switch to previous window

6 Page window contents one screen up

7
Page window contents one screen down

�6 Scroll window contents to the left

�7 Scroll window contents to the right

�+ Open the Windows control menu of the active window

�� Close the active window (Object - Close)

��@ Arrange all opened windows side by side (Window - Tile)

	 1) Move pointer up in window
2) Following selection of Move (Size) in the control menu: Move window
up (resize window)


 1) Move pointer down in window
2) Following selection of Move (Size) in control menu: Move window
down (resize window)

� 1) Move pointer right in window
2) Following selection of Move (Size) in control menu: Move window right
(resize window)

� 1) Move pointer left in window
2) Following selection of Move (Size) in control menu: Move window left
(resize window)

� 1) Storing the new window position or window size
2) In Project Navigator Window: Open the object window or dialogue box
of the selected entry

�A Save object (Object - Save)

�� Check object (Object - Check)

�> Print object (Object - Print)

�� View object information (Object - Information)

Tab. B-4: Object window keys



B.5 Dialogue Box Keys
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Dialogue Box Keys Keyboard Commands

Key(s) Function

��
Move to next dialogue box

���
Move to previous dialogue box

�
Activate/deactivate control menu button

�
Activate/deactivate control menu button

�
Step through options from top to bottom / from left to right

��
Step through options from bottom to top / from right to left

�� - 8 Execute option (e.g. L for Latch Range)

�
1) Control menu button selected: Open control menu
2) Option selected: Execute option (often the same as clicking the OK! button)
3) List box: Activate selected element

��
Close dialogue box (often the same as selecting the Cancel! button)

B
Close dialogue box (often the same as selecting the Cancel! button)

��
Step through options

	

1) Step through options
2) List box: Page list up/down one screen at a time

�
1) List box: Move to first list element
2) Text box: Move to first character

�
1) List box: Move to last list element
2) Text box: Move to last character

�
1) List box: Activate/deactivate list element
2) Activate/deactivate check boxes

Tab. B-5: Dialogue box keys



B.6 Declaration Table Keys
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Keyboard Commands Declaration Table Keys

Key(s) Function

	
Move up one line at a time



Move down one line at a time

�
Move right one cell at a time

�
Move left one cell at a time

6
Page window contents up one screen at a time

7
Page window contents down one screen at a time

�
1) Move to cell in the first column
2) Editing mode: Move to first character in the cell

�
1) Move to cell in the last column
2) Editing mode: Move to last character in the cell

�
Step through all cells from left to right

��
Step through all cells from right to left

��
Move highlight to beginning of table

��
Move highlight to end of table

�	
Extend or reverse continuous selection up one line at a time

�

Extend or reverse continuous selection down one line at a time

��
Select current line

��
Select current line

���
Select all lines from the first line to the current line

���
Select all lines from the current line to the last line

�

Open dialogue box or list box of a selected cell containing an arrow symbol

�
Activate editing mode in the current cell

�
Deactivate editing mode in the current cell

��
Edit the properties of the current object (Object - Information...)

��
Check the selected object (Object - Check)

�>
Print the active object (Object - Print)

�?
Show the print preview of the active object (Object - Print Preview)

�&
Save the selected object (Object - Save)

�
1) Delete selected range
2) Editing mode: Delete character to right of cursor (Edit - Delete)

1) Delete selected range
2) Editing mode: Delete character to left of cursor

�'
Cut selected range and copy to clipboard (Edit - Cut)

��
Cut selected entry and copy to the clipboard

Tab. B-6: Declaration table keys
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Declaration Table Keys Keyboard Commands

Key(s) Function

��
Copy selected range to clipboard (Edit - Copy)

�(
Paste data from clipboard to current position (Edit - Paste)

�9
Paste data from the clipboard to highlight position

�8
Undo the last action

�9
Insert copied contents

��
1) From any cell: Move to first column of the next line
2) From any cell in the last line: Insert a new line

�
Undo the last command (not supported for all operations!)  (Edit - Undo)

�
Undo the last Undo command (not supported for all operations!)  (Edit - Redo)

�:
Find (Edit - Find)

:
Find Next (Edit - Find Next)

�:
Find the previous occurrence of the specified text

��:
Replace specific text with different text (Edit - Replace)

�:
Replace the next occurrence of the specified text

��:
Replace all occurrences of the specified text

�5
Start monitoring of the active body (Online - Start Monitoring)

�5
Stop monitoring of the active body (Online - Stop Monitoring)

��5
Monitor the header of the active body (Online - Monitor Header)

�,

,: num. keypad

First cell in the line is marked by a - sign: Display all lines in the comment column
(Tools - Expand declaration)

�+

+: num. keypad

First cell in the line is marked by a + sign: Display only one line in the comment column
(Tools - Collapse declaration)

Tab. B-6: Declaration table keys



B.7 Entry Data Monitor Keys

B.8 Show Generated Code Keys

B.9 Show Verify Differences Keys
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Keyboard Commands Entry Data Monitor Keys

Key(s) Function

�
Delete rows from the EDM (Edit - Delete Rows)

�
Insert objects into the EDM (Edit - Insert Objects)

:
Insert next object into the EDM (Edit - Next Object)

9
Insert empty row into the EDM (Edit - Insert Row)

��
Show context menu

�5
Start monitoring of the active body (Online - Start Monitoring)

�5
Stop monitoring of the active body (Online - Stop Monitoring)

�,

,: num. keypad

First cell in the line is marked by a - sign: Display all lines in the comment column
(Tools - Expand declaration)

�+

+: num. keypad

First cell in the line is marked by a + sign: Display only one line in the comment column
(Tools - Collapse declaration)

Tab. B-7: Entry Data Monitor keys

Key(s) Function

�9
Copy the whole editor content to the clipboard (Edit - Copy All)

��
Copy the whole editor content to the clipboard

Tab. B-8: Show generated code keys

Key(s) Function

�
Go to the next difference (Tools - Next Difference)

��
Go to the previous difference (Tools - Previous Difference)

�,
Open the according body and go to the related position (Tools - Go to Editor)

�/
Copy the whole content of the window to the clipboard in plain text format (Edit - Copy All)

Tab. B-9: Show verify differences keys



B.10 Device Editor Keys

B – 10 MITSUBISHI ELECTRIC

Device Editor Keys Keyboard Commands

Key(s) Function

	
Move up one cell



Move down one cell

�
Move right one cell

�
Move left one cell

�	
Move to top of current data range

�

Move to bottom of current data range

��
Move to right edge of current data range

��
Move to left edge of current data range

6
Page up

7
Page down

�6
Page left

�7
Page right

�
Select cell in first column of current row

�
Select cell in last column of current row

��
Select cell in first column of first row (top left)

��
Select cell in last column of last row (bottom right)

�
Step through all cells from left to right

��
Step through all cells from right to left

�
Step down through all cells

��
Step up through all cells

�	
Extend or cancel selection upwards one line at a time

�

Extend or cancel selection downwards one line at a time

��
Extend or cancel selection right one cell at a time

��
Extend or cancel selection left one cell at a time

��	
Extend or cancel selection to top of current data range

��

Extend or cancel selection to bottom of current data range

���
Extend or cancel selection to right edge of current data range

���
Extend or cancel selection to left edge of current data range

�6
Extend or cancel selection up one page

�7
Extend or cancel selection down one page

��6
Extend or cancel selection left one page

��7
Extend or cancel selection right one page

��
Extend or cancel selection to beginning of current line

Tab. B-10: Device Editor keys
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Keyboard Commands Device Editor Keys

Key(s) Function

��
Extend or cancel selection to end of current line

���
Extend or cancel selection to first column in first line (top left)

���
Extend or cancel selection to last column in last line (bottom right)

��
Select current line

��
Select current column

���
Select entire table

��
Select entire table

�
Delete selected range

�'
Cut selected range to clipboard

��
Copy selected range to clipboard

�(
Paste contents of clipboard

�9
Copy selected range to clipboard

�9
Paste contents of clipboard

��
Cut selected range to clipboard

�
Activate editing mode for selected cell

Clear contents of selected cell and activate editing mode

��
Terminate editing mode

B
Abort editing mode

�
Toggle value of selected bit device between 0 and 1

Tab. B-10: Device Editor keys



B.11 Text Editor Keys (IL, MIL, ST)
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Text Editor Keys (IL, MIL, ST) Keyboard Commands

Key(s) Function

�@C
Activate editing mode (Tools - Edit Network)

�@D
Activate Select mode (Tools - End Edit)

�=
Display the New Variable dialogue (Tools - New Variable)

�E
Start the variable tracking (Tools - Tracking - Start Tracking)

�E
Next variable occurrence (Tools - Tracking - Next)

�F
Previous variable occurrence (Tools - Tracking - Previous)

�
Display a list of available operands (Tools - List Operands) (ST only)

��
Display a list of available operators (Tools - List Operators) (ST only)

	
��
1) Select mode: Move cursor/pointer in window
2) Editing mode: Scroll through Instruction List

�
1) Select mode - Pointer on network bar: Open dialogue box for entry of network labels

and titles
2) Editing mode: Select/enter new line

�(2x)
Select mode - pointer on network bar: Open dialogue box for assigning network label and
title

�
1) Select mode - pointer on network bar: Activate network
2) Select mode - cursor/pointer in editing window: Activate editing mode

�	

Pointer on bottom border line of network bar: Change size of network area

���
Pointer on column dividing line: Change column width

�
1) Line without text: Select next column
2) Line with text: Move text to next column

�
1) Cursor/pointer in first column: Open programming instructions list
2) Cursor/pointer in second column: Open variables list

6
Page window contents up one screen

7
Page window contents down one screen

�6
Scroll window contents to the right

�7
Scroll window contents to the left

�
Move to first character in the line

�
Move to last character in the line

��
Move to beginning of Instruction List

��
Move to end of Instruction List

��
Extend or reverse selection to the right one character at a time

��
Extend or reverse selection to the left one character at a time

�	
Extend or reverse selection up one line at a time

�

Extend or reverse selection down one line at a time

���
Select all lines from the first line to the current line

Tab. B-11: Text editor keys (IL, MIL, ST)
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Keyboard Commands Text Editor Keys (IL, MIL, ST)

Key(s) Function

���
Select all lines from the current line to the last line

��
Edit the properties of the current object (Object - Information...)

�/
Check the selected object (Object - Check)

�>
Print the active object (Object - Print)

�?
Show the print preview of the active object (Object - Print Preview)

�&
Save the selected object (Object - Save)

�
1) Delete selected range
2) Delete character to right of cursor (Edit - Delete)

1) Delete selected range
2) Delete character left of cursor

�'
Cut selected range and copy to clipboard (Edit - Cut)

��
Cut selected entry and copy to the clipboard

��
Copy selected range to clipboard (Edit - Copy)

�(
Paste data from clipboard to current position (Edit - Paste)

�9
Paste data from the clipboard to highlight position

�9
Insert copied contents

�:
Find (Edit - Find)

:
Find Next (Edit - Find Next)

�:
Find the previous occurrence of the specified text

��:
Replace specific text with different text (Edit - Replace)

�G
(Edit - Toggle Bookmark)

G
(Edit - (Next Bookmark)

�G
(Edit - Previous Bookmark)

�:
Replace the next occurrence of the specified text

��:
Replace all occurrences of the specified text

�
Undo last command (not supported for all operations!) (Edit - Undo)

�8
Undo the last action

�
Undo last Undo command (not supported for all operations!) (Edit - Redo)

��
Insert a new network after the current network (Edit - New Network - After)

��
Insert new network before the current network (Edit - New Network - Before)

�5
Start monitoring of the active body (Online - Start Monitoring)

�5
Start program monitoring (Online - Start Monitoring - Body) (ST only)

�5
Start program monitoring (Online - Start Monitoring - Split Window) (ST only)

�5
Stop monitoring of the active body (Online - Stop Monitoring)

��5
Monitor the header of the active body (Online - Monitor Header)

�;
Modify the variable value (Online - Modify variable value)

Tab. B-11: Text editor keys (IL, MIL, ST)



B.12 Graphical Editor Keys (FBD, LD)
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Graphical Editor Keys (FBD, LD) Keyboard Commands

Key(s) Function

��
Activate Select mode (Tools - Select Mode)

�@
Activate Interconnect mode (draw lines) (Tools - Interconnect Mode)

��
Activate the auto connect mode (Tools - Auto Connect)

�

Select the comment placement mode (Tools - Network Elements - Comment)

�E
Start the variable tracking (Tools - Tracking - Start Tracking)

�E
Next variable occurrence (Tools - Tracking - Next)

�F
Previous variable occurrence (Tools - Tracking - Previous)

	
��
Move pointer

� (2x)
1) Pointer on network bar: Open dialogue box for entering network labels and titles
2) Pointer on a contact: Open dialogue box for signal configuration F"Helvetica"P10

�
Pointer on network bar: Open dialogue box to assign network label and title

�	

Pointer on lower border of network bar: Change size of network area

6
Page window contents up by one screen

7
Page window contents down by one screen

�6
Scroll window contents to the right

�7
Scroll window contents to the left

�
1) Select programming element
2) Select network bar
3) Activate editing mode to overwrite the dummy names Var and Label

�
1) Editing mode for overwriting dummy variable name Var: Open list of variables
2) Open list of programming instructions

�	�
�
1) Move selected programming element
2) Following selection of Tools - Open Row/Column: Increase row/column spacing
3) Following selection of Tools - Comment: Draw a comment box
4) Interconnect mode: Draw interconnect lines

�	�
�
Select a continuous group of program elements

�	�
�
Select several program elements individually

��
Edit the properties of the current object (Object - Information...)

�/
Check the selected object (Object - Check)

�>
Print the active object (Object - Print)

�?
Show the print preview of the active object (Object - Print Preview)

�&
Save the selected object (Object - Save)

�
1) Delete selected range
2) Delete character right of cursor (Edit - Delete)

Delete character left of cursor

�'
Cut selected range and copy to clipboard (Edit - Cut)

��
Cut selected entry and copy to the clipboard

Tab. B-12: Graphical editor keys (FBD, LD)
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Keyboard Commands Graphical Editor Keys (FBD, LD)

Key(s) Function

��
Copy selected range to clipboard  (Edit - Copy)

�(
Paste data from clipboard to current position  (Edit - Paste)

�9
Paste data from the clipboard to highlight position

�9
Insert copied contents

�:
Find (Edit - Find)

:
Find Next (Edit - Find Next)

�:
Find the previous occurrence of the specified text

��:
Replace specific text with different text (Edit - Replace)

�:
Replace the next occurrence of the specified text

��:
Replace all occurrences of the specified text

���
Toggle the signal configuration (Edit - Toggle Signal Configuration)

�
Undo last command (not supported for all operations!) (Edit - Undo)

�8
Undo the last action

�
Undo last Undo command (not supported for all operations!) (Edit - Redo)

�
Insert input contact (Tools - Contact) (LD only)

�
Insert input contact negation (Tools - Contact Negation) (LD only)

�
Insert input L-connect contact (Tools - L-Connect Contact) (LD only)

�
Insert input L-connect contact negation (Tools - L-Connect Contact Negation) (LD only)

"
Insert output coil (Tools - Network Elements - Coil) (LD only)

�H
Insert jump instruction (Tools - Network Elements - Jump)

�I
Insert return instruction (Tools - Network Elements - Return)

$
Insert input variable (Tools - Network Elements - Input Variable)

%
Insert output variable (Tools - Network Elements - Output Variable)

!
Draw horizontal line segment (Tools - Network Elements - Horizontal Line Segment)

 
Draw vertical line segment (Tools - Network Elements - Vertical Line Segment)

#
Insert programming instruction (Function Block) (Tools - Function Block)

�.
Increase horizontal spacing (Tools - Open Row)

�2
Increase vertical spacing (Tools - Open Column)

��J
Insert network label (Tools - Network Elements - Label of the Network)

���
Delete line mode (Tools - Network Elements - Delete Line Mode)

��
Insert graphic macro 1 (Tools - Custom 1)

��
Insert graphic macro 2 (Tools - Custom 2)

��
Insert graphic macro 3 (Tools - Custom 3)

��
Insert graphic macro 4 (Tools - Custom 4)

Tab. B-12: Graphical editor keys (FBD, LD)
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Graphical Editor Keys (FBD, LD) Keyboard Commands

Key(s) Function

� 
Insert graphic macro 5 (Tools - Custom 5)

�=
Display the New Variable dialogue (Tools - New Variable)

��
Insert new network after the current network (Edit - New Network - After)

��
Insert new network before the current network (Edit - New Network - Before)

�5
Start monitoring of the active body (Online - Start Monitoring)

�5
Stop monitoring of the active body (Online - Stop Monitoring)

�;
Toggle the selected variable (Online - Toggle variable)

��5
Monitor the header of the active body (Online - Monitor Header)

�;
Modify the variable value (Online - Modify variable value)

�
Step through all the variable objects in the current network forwards, selecting them one
after another.

��
Step through all the variable objects in the current network backwards, selecting them one
after another.

,

(+: num. keypad)

Function block is activated: Increment number of input variables (pins)
(Edit - Increment Pins)

+

(–: num. keypad)

Function block is activated: Decrement number of input variables (pins)
(Edit - Decrement Pins)

��*
Toggle the view mode for the addresses (View Mode - Toggle)

Tab. B-12: Graphical editor keys (FBD, LD)



B.13 Sequential Function Chart Editor Keys

GX IEC Developer Reference Manual B – 17

Keyboard Commands Sequential Function Chart Editor Keys

Key(s) Function

	
��
Move highlight

��
Highlight on a connection line: Move highlight to the leftmost branch in the row

��
Highlight on a connection line: Move highlight to the rightmost branch in the row

�	
Move highlight to the next branch above or to the Initial Step

�

Move highlight to next branch below or to the Final Step

��
Extend selection to the element to the left of the highlight

��
Extend the selection to the element to the right of the highlight

�	
Extend the selection up one element

�

Extend the selection down one element

���
Highlight on a connection line: Extend the selection to the leftmost element in the row

���
Highlight on a connection line: Extend the selection to the rightmost element in the row

��	
Extend the selection to the next element above or to the Initial Step

��

Extend the selection to the next element below or to the Final Step

�
Move the highlight to the next element

��
Extend the selection to the next element

�
Move the highlight to the first column

�
Move the highlight to the last column

��
Move the highlight to the beginning of the program

��
Move the highlight to the end of the program

��
Select all elements between the current highlight position and the left column

��
Select all elements between the current highlight position and the right column

���
Select all elements between the current highlight position and the beginning of the program

���
Select all elements between the current highlight position and the end of the program

�
1) Highlight on an unnamed Transition or an unnamed Step: Switch to Editing mode
2) Highlight on a named Step: Open window of associated POU
3) Highlight on a Macro Step: Open Macro Program window

K
1) Undo all selections

�
Delete selected elements

6
Page window contents up by one screen

7
Page window contents down by one screen

�
1) Cursor/pointer in first column: Open programming instructions list
2) Cursor/pointer in second column: Open variables list

�&
Save the selected object (Object - Save)

��
Edit the properties of the current object (Object - Information...)

�/
Check the selected object (Object - Check)

�>
Print the active object (Object - Print)

�?
Show the print preview of the active object (Object - Print Preview)

�
Undo last command (not supported for all operations!) (Edit - Undo)

�8
Undo the last action

�
Undo last Undo command (not supported for all operations!) (Edit - Redo)

�'
Cut selected range and copy to clipboard  (Edit - Cut)

Tab. B-13: Sequential Function Chart editor keys
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Sequential Function Chart Editor Keys Keyboard Commands

Key(s) Function

��
Cut selected entry and copy to the clipboard

��
Copy selected range to clipboard  (Edit - Copy)

�(
Paste data from clipboard to current position  (Edit - Paste)

�9
Insert copied contents

�9
Paste data from the clipboard to highlight position

�:
Find (Edit - Find)

:
Find Next (Edit - Find Next)

�:
Find the previous occurrence of the specified text

��:
Replace specific text with different text (Edit - Replace)

�:
Replace the next occurrence of the specified text

��:
Replace all occurrences of the specified text

�2
Insert Step/Transition unit at the current position (Edit - Insert - Step/Trans Unit)

�L
Insert Step at the current position (Edit - Insert - Step)

�@
Insert Transition at the current position (Edit - Insert - Transition)

�J
Insert left divergence from the current position (Edit - Insert - Left Divergence)

�I
Insert right divergence from the current position (Edit - Insert - Right Divergence)

��J
Insert left convergence to the current position (Edit - Insert - Left Convergence)

��I
Insert right convergence to the current position (Edit - Insert - Right Convergence)

��H
Insert Label (jump destination/entry step) (Edit - Insert - Label)

�H
Insert Jump (jump/exit step) (Edit - Insert - Jump)

�=
Display the New Variable dialogue (Tools - New Variable)

�M
Open (zoom) Step, Transition or Macro Program window (Tools - Zoom Into)

�N
Undo zoom operation (Tools - Zoom Back)

�5
Start monitoring of the active body (Online - Start Monitoring)

��5
Monitor the header of the active body (Online - Monitor Header)

�;
Modify the variable value (Online - Modify variable value)

Tab. B-13: Sequential Function Chart editor keys



B.14 Keys for Checking and Downloading Programs
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Keyboard Commands Keys for Checking and Downloading Programs

Key(s) Function

���
Compile project (Project - Rebuild All)

��.
Download project to CPU (Project - Transfer - Medoc -> PLC)

��D
Change program in Online mode operation (Project - Online Program Change)

��
Check object (Object - Check)

�5
Start program monitoring (Online - Start Monitoring)

�5
Stop program monitoring (Online - Stop Monitoring)

��5
Open monitoring window for variable status of current Header (Online - Monitor Header)

��5
Open Entry Data Monitor (Online - Entry Data Monitor)

OK
Activate Monitoring mode (Online - Monitoring Mode)

�A
Switch PLC CPU to Start or Stop mode (Online - Start/Stop PLC)

G
Execute program in stop mode, stopping after each step (Debug - Step)

��C
Display contents of system error registers (Debug - System Errors)

�2
Associate error messages to error flags (Debug - User Errors)

Tab. B-14: Keys for checking and downloading programs



B.15 Online Help System Keys

For more details on using the online Help system select How to use help in the Help menu.
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Online Help System Keys Keyboard Commands

Key(s) Function

�
Activate Help system

M
Contents button

A
Search button

-
Back button

I
History button

P
<< button (previous topic)

Q
>> button (next topic)

�
Activate Menu Bar

�
Select one of the icons/buttons on the screen
Step through the icons/buttons clockwise

��
Select one of the icons/buttons on the screen
Step through the icons/buttons anticlockwise

��
Select all the icons/buttons on the screen

��
Copy the current help topic text to the clipboard

��
Copy the clipboard contents to the Annotate dialogue box

��
Close the Help window

Tab. B-15: Online Help System Keys



C Tools

C.1 General Tool Icons
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Tools General Tool Icons

Tool Function Menu command Key(s)

Open an existing project Project - Open

Save an opened project Project - Save

Print the active object Project - Print

Shows a print preview of the active object Project - Print Preview

Cut the selected object to the clipboard Edit - Cut
�'

Copy the selected object to the clipboard Edit - Copy
�/

Paste object from the clipboard Edit - Paste
��

Undo the last action Edit - Undo
��

Redo the previously undone action Edit - Redo
��

Edit the properties of current selection Object - Information
��

Open the cross reference browser Project - Browse

Start the check routine for the currently selected
object

Object - Check
��

Build the current project (compile changes) Project - Build
���

Rebuild the current project (compile project) Project - Rebuild All
���

Enable or disable the monitoring mode Online - Monitoring Mode
�B

Activate Online Change mode Online - Online-Change
Mode

Download the current project to the PLC Project - Transfer -
Download to PLC ��.

Upload the project from the PLC Project - Transfer -
Upload from PLC

Tab. C-1: General tool icons



C.2 Instruction List Editor Tool Icons
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Instruction List Editor Tool Icons Tools

Tool Function Menu command Key(s)

Insert a new network before the current network Edit - New Network -
Before ��

Insert a new network after the current network Edit - New Network - After
��

Activate Select mode, End Editing mode Tools - End Edit

Activate Editing mode, End Select mode Tools - Edit Network

Tab. C-2: Instruction List Editor Tool Icons



C.3 Ladder Diagram and Function Block Diagram Editor
Tool Icons
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Tools Ladder Diagram and Function Block Diagram Editor Tool Icons

Tool Function Menu command Key(s)

Insert a new network before the current network Edit - New Network -
Before �N

Insert a new network after the current network Edit - New Network - After
�R

Activate Select mode, End Editing mode (toggles
with Interconnect mode)

Tools - Select Mode
�R

Activate Interconnect mode, Line tool (toggles
with Select mode)

Tools - Network Elements -
Interconnect Mode ��

Insert input contact
(Ladder Diagram only)

Tools - Network Elements -
Contact �

Insert input contact negation
(Ladder Diagram only)

Tools - Network Elements -
Contact Negation �

Insert input L-contact
(Ladder Diagram only)

Tools - Network Elements -
L-Connection Contact �

Insert input L-contact negation
(Ladder Diagram only)

Tools - Network Elements -
L-Connection Contact
Negation

�

Insert vertical line
(Ladder Diagram only)

Tools - Network Elements -
Vertical Line Segment  

Insert horizontal line
(Ladder Diagram only)

Tools - Network Elements -
Horizontal Line Segment !

Insert output coil
(Ladder Diagram only)

Tools - Network Elements -
Coil "

Insert programming instruction
(Function Block)

Tools - Network Elements -
Function block #

Insert input variable Tools - Network Elements -
Input Variable $

Insert output variable Tools - Network Elements -
Output Variable %

Activate Auto Connect mode Tool - Auto Connect
�N

Insert Jump instruction Tools - Network Elements -
Jump �H

Insert Return instruction Tools - Network Elements -
Return �I

Increase vertical spacing Tools - Open Row
�2

Increase horizontal spacing Tools - Open Column
�.

Insert comment Tools - Network Elements -
Comment �*

Tab. C-3: Ladder Diagram and Function Block Diagram editor tool icons



C.4 Sequential Function Chart Editor Tool Icons
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Sequential Function Chart Editor Tool Icons Tools

Tool Function Menu command Key(s)

Insert a Step/Transition unit at the current position Edit - Insert - Step/Trans
Unit �2

Insert a Step at the current position Edit - Insert - Step
�L

Insert a Transition at the current position Edit - Insert - Transition
��

Insert a left divergence from the current position Edit - Insert - Left
Divergence �J

Insert a right divergence from the current position Edit - Insert - Right
Divergence �I

Insert a left convergence to the current position Edit - Insert - Left
Convergence ��J

Insert a right convergence to the current position Edit - Insert - Right
Convergence ��I

Insert a Label (entry step/jump destination) Edit - Insert - Label
��S

Insert a Jump (exit step jump instruction) Edit - Insert - Jump
�S

Open (zoom) a Macro Program window Tools - Zoom Macro

Open (zoom) the Action Association window for
the selected Step

Tools - Edit Action
Association

Edit the Step Comment Tools - Edit Step Comment

Edit the Transition Condition Tools - Edit Transition
Condition

Open (zoom) the Body of a Step or Transition Tools - Zoom Body

Open (zoom) a Step, Transition, or Macro
Program window

Tools - Zoom Into
�M

Undo zoom operation (i.e. close window) Tools - Zoom Back
��

List all available variables or operands Tools - List Operands…
�

Tab. C-4: Sequential Function Chart Editor Tool Icons



C.5 Project Navigator Window Tool Icons
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Tools Project Navigator Window Tool Icons

Tool Function Menu command Key(s)

Display lower levels of the Project Navigator tree Tools - Expand
�,

Hide displayed levels of the Project Navigator Tools - Collapse
�+

Create a new Program Organisation Unit Object - New - POU
�3

Create a new Data Unit Type Object - New - DUT

Create a new Task Object - New - Task
�T

Create a new Action (this icon is only enabled
when a POU written in Sequential Function Chart
language is selected)

Object - New - Action
���

Tab. C-5: Project Navigator Window Tool Icons
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Project Navigator Window Tool Icons Tools



D Temporary Files

D.1 Temporary Files Created when Projects are Compiled

A number of temporary files are created during compilation. These files are normally deleted
when the program is finished; if you don’t want them to be deleted you must start GX IEC
Developer with the /debug command line option. To do this, add this option to the GX IEC
Developer command line in the Program Item Properties dialogue box in the Windows
Program Manager:
E.g.: c:\melsec\gx iec developer\sc.exe /debug.

� _tskmain.sic Data of all tasks allocated to the MAIN memory range
(stored in a special format)

_tskmain.out Data of all tasks allocated to the MAIN memory range
(special MELSEC code)

_tskmain.bin Data of all tasks allocated to the MAIN memory range
(the compiled code that is downloaded to the controller)

� _tsksub.sic Data of the Task MELSEC_SUB, allocated to the SUB memory range
(stored in a special format)

_tsksub.out Data of the Task MELSEC_SUB, allocated to the SUB memory range
(special MELSEC code)

_tsksub.bin Data of the Task MELSEC_SUB, allocated to the SUB memory range
(the compiled code that is downloaded to the controller)

� POUname.sic Data of a specific Program Organisation Unit
(stored in a special format)

POU-Name.out Data of a specific Program Organisation Unit
(special MELSEC code)

POU-Name.bin Data of a specific Program Organisation Unit
(the compiled code that is downloaded to the controller)

� _end.sic Data of the END instruction (stored in a special format)
_end.out Data of the END instruction (special MELSEC code)
_end.bin Data of the END instruction (the compiled code that

is downloaded to the controller)

� main.map All the data of the program allocated to the MAIN memory range
(compiled structural tree)

� sub.map All the data of the program allocated to the SUB memory range
(compiled structural tree)

� sfc.map All the data of the program written in Sequential Function Chart
Language (compiled structural tree)

� sfccode.cod Data of the Program Organisation Units that were written in Sequential
Function Chart Language (compiled code)

� mmicro.bin Data of the Program Organisation Units that were written in
Sequential Function Chart Language - MELSEC A-Series
(compiled code)

� build.out, tab.out, rebuild.out, comp.out
Compiling data
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Temporary Files Temporary Files Created when Projects are Compiled



D.2 Temporary files Created During Downloads

� dwl_sym.asc

� upl_sym.pac

� upl_main.bin

� upl_sub.bin

� fnw_main.dis

� fnw_sub.dis

� fnw_imp.asc

� task_imp.asc
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E Programming Instructions

Standard Library

The standard library contains all the IEC functions and function blocks. Every available
function has a FUN (function) POU, the headers of which you can open and view on the
screen.

Manufacturer Library

The Manufacturer Library contains the ‘adapted’ MELSEC instructions, with a nomenclature
adapted for use in IEC. Every function has a FUN (function) POU, the headers and bodies of
which you can open and view on the screen. With the help of a special tool you can also add
your own POUs to the Manufacturer Library.These POUs can be declared as functions (FUN),
function blocks (FB) or programs (PRG).
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Programming Instructions

Fig. E-1: Programming instructions
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MELSEC Instructions

The functionality of the ‘adapted’ and ‘pure’ MELSEC functions is identical. The only difference
between the two versions is the way they are written and how they are used in the various
editors.

The ‘pure’ MELSEC instructions use the familiar MELSEC nomenclature (e.g. AND=, +,
FLOAT). These instructions can only be used in the MELSEC editor.

The ‘adapted’MELSEC instructions use a special nomenclature.Their names always end with
_M for MELSEC or _MD for MELSEC Dedicated Instructions (e.g. PLUS_M,
FLOAT_K_P_MD). You can use these instructions in the IEC editor.

The suffixes _P_MD and _K_MD indicate that the instruction under consideration is executed
on a rising edge or with a constant.
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Programming Instructions

Fig. E-2:
This dialogue box is displayed when you are working in the
MELSEC editor. The list contains the ‘pure’ MELSEC
instructions.

Fig. E-3:
This dialogue box is displayed when you are working
in the IEC editor.
The list of the Manufacturer Library contains the
‘adapted’ MELSEC instructions.



MELSEC Instructions
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Programming Instructions

MELSEC Editor IEC Editor Explanation
LEDA FLOAT
LEDC (S)
LEDC (D)
LEDR

FLOAT_MD Normal execution (16 Bit)

LEDB FLOAT
LEDC (S)
LEDC (D)
LEDR

FLOAT_P_MD Pulse-triggered execution (16 Bit)

LEDA FLOAT
SUB
(S)
LEDC (D)
LEDR

FLOAT_K_MD Normal execution (16 Bit) Constant used in operand (S)

LEDB FLOAT
SUB
(S)
LEDC (D)
LEDR

FLOAT_K_P_MD Pulse-triggered execution (16 Bit) Constant used in
operand (S)

LEDA
DFLOAT

LEDC (S)
LEDC (D)
LEDR

DFLOAT_MD Normal execution (32 Bit)

LEDB
DFLOAT

LEDC (S)
LEDC (D)
LEDR

DFLOAT_P_MD Pulse-triggered execution (32 Bit)

LEDA
DFLOAT

DXNR (S)
LEDC (D)
LEDR

DFLOAT_K_MD Normal execution (32 Bit) Constant used in operand (S)

LEDB
DFLOAT

DXNR (S)
LEDC (D)
LEDR

DFLOAT_K_P_MD Pulse-triggered execution (32 Bit) Constant used in
operand (S)

Tab. E-1: MELSEC Instructions



Meaning of extensions in the IEC editor

The following table lists the extensions of MELSEC instructions in the IEC editor. The nomen-
clature is as follows:

� _instruction_

� _instruction

EN input and ENO output

In the Standard Library, most of the programming instructions are displayed in two similar forms.
The only difference between these programming instructions is the suffix _E. This suffix specifies
functions and function blocks which have an EN input and an ENO output (➜ page 6-80).

The functions in the Manufacturer Library do not have this suffix although they all have an EN
input and an ENO output.
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Programming Instructions

Extension in IEC Editor Meaning

_M MELSEC instruction

_P_M Pulse triggered execution of MELSEC instruction

_MD Dedicated MELSEC Instruction

_P_MD Pulse triggered execution of dedicated MELSEC Instruction

_K_MD Constant used in dedicated MELSEC Instruction

_K_P_MD Constant used in and pulse triggered execution of dedicated MELSEC Instruction

_E Floating point number operands are used

_S, _STRING
S_, STRING_

String operands are used

_J_M,
_JP_M

Network number of HOST station is used in operand

_U_M,
_UP_M

Head I/O address of network in HOST station is used in operand

Tab. E-2: Meaning of extensions in the IEC editor



E.1 IEC Programming Instructions
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Programming Instructions IEC Programming Instructions

Instruction Modi-
fier

Description No. of
input
variables

Data types

Input
variables

Output
variables

) IEC Instruction List operator
Right parenthesis
The right parenthesis (close parenthesis) is used to
evaluate a deferred operation. The beginning of the
deferred operation is marked with a left parenthesis

e.g.
AND(

MUL( NE(. The
left
parenthesis
is added to
the operator
itself as a
modifier.

ABS
ABS_E

Absolute value
Writes the input variable data to the output variable
with a positive sign.

1 INT, DINT INT, DINT

ADD
ADD_E

( Addition n
(2 – 28)

(IN1) –
(INn):
INT, DINT,
Constant

INT, DINT

ADD_TIME
ADD_TIME_E

Addition 2 (IN1), (IN2):
TIME

TIME

AND
AND_E

N, ( Logical AND operation n
(2 – 28)

WORD,
DWORD,
BOOL,
Constant

WORD,
DWORD,
BOOL

BCD_TO_DINT
BCD_TO_DINT_E

Converts BCD format to binary format (DINT) 1 BOOL,
WORD,
DWORD

DINT

BCD_TO_INT
BCD_TO_INT_E

Converts BCD format to binary format(INT) 1 BOOL,
WORD,
DWORD

INT

BOOL_TO_DINT
BOOL_TO_DINT_E

Converts BOOL data type to DINT data type 1 BOOL DINT

BOOL_TO_DWORD
BOOL_TO_DWORD_E

Converts BOOL data type to DWORD data type 1 BOOL DWORD

BOOL_TO_INT
BOOL_TO_INT_E

Converts BOOL data type to INT data type 1 BOOL INT

BOOL_TO_TIME
BOOL_TO_TIME_E

Converts BOOL data type to TIME data type 1 BOOL TIME

BOOL_TO_WORD
BOOL_TO_WORD_E

Converts BOOL data type to WORD data type 1 BOOL WORD

CAL C, N IEC Instruction List operator
Calls a Function Block instance.
In the Instruction List language Function Block
instances are called with the CAL operator.  The
operator must be followed by the instance name, which
in turn must be followed by the argument list in
parentheses, containing the actual parameters to be
passed to the formal parameters.

- - -

DINT_TO_BCD
DINT_TO_BCD_E

Converts binary format (DINT) to BCD format 1 DINT,
Constant

BOOL,
WORD,
DWORD

DINT_TO_BOOL
DINT_TO_BOOL_E

Converts DINT data type to BOOL data type 1 DINT BOOL

DINT_TO_DWORD
DINT_TO_DWORD_E

Converts DINT data type to DWORD data type 1 DINT DWORD

DINT_TO_INT
DINT_TO_INT_E

Converts DINT data type to INT data type 1 DINT INT

DINT_TO_REAL
DINT_TO_REAL_E

Converts DINT data type to REAL data type 1 DINT REAL

Tab. E-3: IEC programming instructions
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IEC Programming Instructions Programming Instructions

Instruction Modi-
fier

Description No. of
input
variables

Data types

Input
variables

Output
variables

DINT_TO_TIME
DINT_TO_TIME_E

Converts DINT data type to TIME data type 1 DINT TIME

DINT_TO_WORD
DINT_TO_WORD_E

Converts DINT data type to WORD data type 1 DINT WORD

DIV
DIV_E

( Division; (IN1) : (IN2) 2 (IN1), (IN2):
INT, DINT,
Constant

INT, DINT

DIV_TIME
DIV_TIME_E

Division; (IN1) : (IN2) 2 (IN1), (IN2):
TIME

TIME

DWORD_TO_BOOL
DWORD_TO_BOOL_E

Converts DWORD data type to BOOL data type 1 DWORD BOOL

DWORD_TO_DINT
DWORD_TO_DINT_E

Converts DWORD data type to DINT data type 1 DWORD DINT

DWORD_TO_INT
DWORD_TO_INT_E

Converts DWORD data type to INT data type 1 DWORD INT

DWORD_TO_TIME
DWORD_TO_TIME_E

Converts DWORD data type to TIME data type 1 DWORD TIME

DWORD_TO_WORD
DWORD_TO_WORD
_E

Converts DWORD data type to WORD data type 1 DWORD WORD

EQ
EQ_E

( Equality (=);
[(IN1 = IN2)] & [(IN2) = (IN3)] & ... & [(INn-1) = (INn)];
If the comparison result is true, then 1 to output.
If the comparison result is false, then 0 to output.

n
(2 – 28)

(IN1) –
(INn): INT,
DINT,
WORD,
DWORD,
BOOL,
Constant

BOOL

F_TRIG
F_TRIG_E

Function Block;
Falling edge detector; the current signal status on the
output variable (Q) changes in response to a falling
edge on the input variable (CLK).

1 (CLK):
BOOL

Q: BOOL

GE
GE_E

( Greater than/equals sequential comparison (>=);
[(IN1) >= (IN2)] & [(IN2) >= (IN3)] & ... & [(INn-1) >=
(INn)];
If the comparison result is true, then 1 to output.
If the comparison result is false, then 0 to output.

n
(2 – 28)

(IN1) –
(INn): INT,
DINT,
WORD,
DWORD,
BOOL,
Constant

BOOL

GT
GT_E

( Greater than sequential comparison (>)
[(IN1) >  (IN2)] & [(IN2) > (IN3)] & ... & [(INn-1) > (INn)]
If the comparison result is true, then 1 to output.
If the comparison result is false, then 0 to output.

n
(2 – 28)

(IN1) –
(INn): INT,
DINT,
WORD,
DWORD,
BOOL,
Constant

BOOL

INT_TO_BCD
INT_TO_BCD_E

Converts binary format (INT) to BCD format 1 INT BOOL,
WORD,
DWORD

INT_TO_BOOL
INT_TO_BOOL_E

Converts INT data type to BOOL data type 1 INT BOOL

INT_TO_DINT
INT_TO_DINT_E

Converts INT data type to DINT data type 1 INT DINT

INT_TO_DWORD
INT_TO_DWORD_E

Converts INT data type to DWORD data type 1 INT DWORD

INT_TO_REAL
INT_TO_REAL_E

Converts INT data type to REAL data type INT REAL

INT_TO_TIME
INT_TO_TIME_E

Converts INT data type to TIME data type INT TIME

Tab. E-3: IEC programming instructions
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Programming Instructions IEC Programming Instructions

Instruction Modi-
fier

Description No. of
input
variables

Data types

Input
variables

Output
variables

INT_TO_WORD
INT_TO_WORD_E

Converts INT data type to WORD data type 1 INT WORD

JMP C, N IEC Instruction List operator
Jump to network label
Performs a jump from one program section to a label in
another network. You must specify the network label
name after the operator.

- - -

LD N IEC Instruction List operator
Load
Loads the value of the specified operand into the
accumulator.

1 BOOL,
WORD,
DWORD,
INT, DINT

-

LE
LE_E

( Less than/equals sequential comparison (<=)
[(IN1) <=  (IN2)] & [(IN2) <= (IN3)] & ... & [(INn-1) <=
(Inn)]
If the comparison result is true, then 1 to output.
If the comparison result is false, then 0 to output.

n
(2 – 28)

(IN1) –
(INn): INT,
DINT,
WORD,
DWORD,
BOOL,
Constant

BOOL

LIMIT
LIMIT_E

Value limitation
If (IN) > (MX), then (MX) to output.
If (IN) < (MN), then (MN) to output.
If (MN) < (IN) > (MX), then (IN) to output

3 (MN), (IN),
(MX): INT,
DINT,
WORD,
DWORD,
BOOL

INT, DINT,
WORD,
DWORD,
BOOL

LT
LT_E

( Less than sequential comparison (<)
[(IN1)<  (IN2)] & [(IN2)< (IN3)] & ... & [(INn-1) <  (INn)]
If the comparison result is true, then 1 to output.
If the comparison result is false, then 0 to output.

n
(2 – 28)

(IN1) –
(INn): INT,
DINT,
WORD,
DWORD,
BOOL

BOOL

MAX
MAX_E

Select maximum value
The largest value in (IN1) – (INn) as written to the
output.

n
(2 - 28)

(IN1) –
(INn): INT,
DINT,
WORD,
DWORD,
BOOL

INT, DINT,
WORD,
DWORD,
BOOL

MIN
MIN_E

Select minimum value
The smallest value in (IN1) – (INn) is written to the
output.

n
(2 - 28)

(IN1) –
(INn): INT,
DINT,
WORD,
DWORD,
BOOL

INT, DINT,
WORD,
DWORD,
BOOL

MOD
MOD_E

Remainder  (IN1) - [(IN1) : (IN2)] x (IN2) 2 (IN1), (IN2):
INT, DINT

INT

MOVE
MOVE_E

Move 1 INT, DINT INT, DINT

MUL
MUL_E

( Multiplication n
(2 – 28)

(IN1) –
(INn): INT,
DINT

INT, DINT

MUL_TIME
MUL_TIME_E

Multiplication 2 (IN1), (IN2):
TIME

TIME

MUX
MUX_E

Multiplexer
Writes the data of the input variable between (INO) and
(Inn) to the output. The input variable is specified in (K).

n
(2 – 28)

(K): INT,
DINT; (IN0)
– (INn):
INT, DINT,
WORD,
DWORD,
BOOL

INT, DINT,
WORD,
DWORD,
BOOL

Tab. E-3: IEC programming instructions
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IEC Programming Instructions Programming Instructions

Instruction Modi-
fier

Description No. of
input
variables

Data types

Input
variables

Output
variables

NE
NE_E

( Not equal (<>)
[(IN1) <> (IN2)]
If the comparison result is true, then 1 to output.
If the comparison result is false, then 0 to output.

2 (IN1), (IN2):
INT, DINT,
WORD,
DWORD,
BOOL

BOOL

NOT
NOT_E

Negation 1 WORD,
DWORD,
BOOL

WORD,
DWORD,
BOOL

OR
OR_E

N, ( Logical OR operation n
(2 – 28)

WORD,
DWORD,
BOOL

WORD,
DWORD,
BOOL

R IEC Instruction List operator
Reset
Resets the BOOL variable to 0. This operation is only
performed if the value in the accumulator is 1.

1 BOOL -

R_TRIG
R_TRIG_E

Function Block
Rising edge detector
The status of the output variable (Q) is changed in
accordance with the presence of a rising edge on the
input variable (CLK).

1 (CLK):
BOOL

(Q): BOOL

REAL_TO_DINT
REAL_TO_DINT_E

Converts REAL data type to DINT data type REAL DINT

REAL_TO_INT
REAL_TO_INT_E

Converts REAL data type to INT data type REAL INT

RET C, N IEC Instruction List operator
Return from a Function Block
Executes a return from a Function Block to the program
in which the Function Block instance was called.

- - -

ROL
ROL_E

Rotate left
Rotates the data of the input variable (IN) to the left by
(N) bits.  No bits are lost in this process.

2 (IN): BOOL,
WORD,
DWORD;
(N):
Constant

WORD,
DWORD,
BOOL

ROR
ROR_E

Rotate right
Rotates the data of the input variable (IN) to the right
by (N) bits.  No bits are lost in this process.

2 (IN): BOOL,
WORD,
DWORD;
(N):
Constant

WORD,
DWORD,
BOOL

S IEC Instruction List operator
Set
Sets the value of the BOOL variable to 1. This
operation is only performed when the value in the
accumulator is 1.

1 BOOL -

SEL
SEL_E

Binary selection
When (G) = 0 then (IN0) to output.
When (G) = 1 then (IN1) to output.

3 (G): BOOL;
(IN0), (IN1):
INT, DINT,
WORD,
DWORD,
BOOL

INT, DINT,
WORD,
DWORD,
BOOL

SHL
SHL_E

Left shift
Shifts the data of the input variable (IN) to the left by
(N) bits. The upper (N) bits of (IN) are lost in this
process.

2 (IN): BOOL,
WORD,
DWORD;
(N):
Constant

WORD,
DWORD,
BOOL

SHR
SHR_E

Right shift
Shifts the data of the input variable (IN) to the right by
(N) bits. The lower (N) bits of (IN) are lost in this
process.

2 (IN): BOOL,
WORD,
DWORD;
(N):
Constant

WORD,
DWORD,
BOOL

Tab. E-3: IEC programming instructions
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Programming Instructions IEC Programming Instructions

Instruction Modi-
fier

Description No. of
input
variables

Data types

Input
variables

Output
variables

ST N IEC Instruction List operator
Store
Stores the value of the specified operand to the
accumulator.

1 BOOL,
WORD,
DWORD,
INT, DINT

-

SUB
SUB_E

( Subtraction; (IN1) - (IN2) 2 (IN1), (IN2):
INT, DINT

INT, DINT

SUB_TIME
SUB_TIME_E

Subtraction; (IN1) - (IN2) 2 (IN1), (IN2):
TIME

TIME

TIME_TO_BOOL
TIME_TO_BOOL_E

Converts TIME data type to BOOL data type 1 TIME BOOL

TIME_TO_DINT
TIME_TO_DINT_E

Converts TIME data type to DINT data type 1 TIME DINT

TIME_TO_DWORD
TIME_TO_DWORD_E

Converts TIME data type to DWORD data type 1 TIME DWORD

TIME_TO_INT
TIME_TO_INT_E

Converts TIME data type to INT data type 1 TIME INT

TIME_TO_WORD
TIME_TO_WORD_E

Converts TIME data type to WORD data type 1 TIME WORD

WORD_TO_BOOL
WORD_TO_BOOL_E

Converts WORD data type to BOOL data type 1 WORD BOOL

WORD_TO_DINT
WORD_TO_DINT_E

Converts WORD data type to DINT data type 1 WORD DINT

WORD_TO_DWORD
WORD_TO_DWORD
_E

Converts WORD data type to DWORD data type 1 WORD DWORD

WORD_TO_INT
WORD_TO_INT_E

Converts WORD data type to INT data type 1 WORD INT

WORD_TO_TIME
WORD_TO_TIME_E

Converts WORD data type to TIME data type 1 WORD TIME

XOR
XOR_E

N, ( Logical exclusive OR operation n
(2 – 28)

WORD,
DWORD,
BOOL

WORD,
DWORD,
BOOL

Tab. E-3: IEC programming instructions



E.2 IEC – MELSEC

The following tables list the most common IEC programming instructions with their corre-
sponding MELSEC programming instructions. For a complete overview of instructions refer to
the programming manuals for the A/Q and FX series.

E.2.1 Addition

� Dedicated instructions with LEDA/B
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IEC – MELSEC Programming Instructions

Programming instruction Description No. of
input
variables

Series Notes

IEC
IEC Editor

The IEC functions with input
variables of the INT (DINT) data
type correspond to the MELSEC
functions with 16 (32) bit data.

The number of input variables is
fixed using the MELSEC functions
and variable using the IEC
functions (min. 2, max. 28).

All the MELSEC functions have an
EN input and an ENO output.

ADD
ADD_E
Modifier: (

Addition of numerical data/with EN
input and ENO output

n
(2 – 28)

Q, QnA, A,
FX, FX0

MELSEC
IEC Editor

MELSEC
MELSEC
Editor

ADD_M
DADD_M

ADD
DADD

Addition of numerical data (16/32
bit)

3 Q, QnA, FX

PLUS_M
DPLUS_M

+
D+

Addition of numerical data (16/32
bit)

2 Q, QnA, A

PLUS_3_M
DPLUS_3_M

Addition of numerical data (16/32
bit)

3 Q, QnA, A

ADD_MD ADD
(with LED* !)�

Addition of floating-point numbers 2 Q, QnA,
AnA

For floating-point numbers only

BPLUS_M
DBPLUS_M

B+
DB+

BCD addition (16/32 bit) 2 Q, QnA, A For BCD data only

BPLUS_3_M
DBPLUS_3_M

BCD addition (16/32 bit) 3 Q, QnA, A

SADD_MD SADD
(with LED* !)�

Concatenation of two ASCII strings 2 Q, QnA,
AnA

WARNING!
No addition!

Tab. E-4: Addition

IEC MELSEC in the IEC Editor

ADD_E with 3 input variables
of data type INT

� ADD_M for the FX series
PLUS_3_M for the A series

ADD_E with 2 input variables of data type
DINT

� DPLUS_M for the A series

Advantage: Enables addition of up to 28
input variables.



E.2.2 Subtraction

� Dedicated instructions with LEDA/B
� These instructions are not supported by the IEC editor.
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Programming Instructions IEC – MELSEC

Programming instruction Description No. of
input
variables

Series Notes

IEC
IEC Editor

The IEC functions with input
variables of the INT (DINT) data
type correspond to the MELSEC
functions with 16 (32) bit data.

All the MELSEC functions have an
EN input and an ENO output.

SUB
SUB_E
Modifier: (

Subtraction of numerical data/with
EN input and ENO output

2 Q, QnA, A,
FX, FX0

MELSEC
IEC Editor

MELSEC
MELSEC
Editor

SUB_3_M
DSUB_3_M

SUB
DSUB

Subtraction of numerical data
(16/32 bit)

3 FX

MINUS_M
DMINUS_M

-
D-

Subtraction of numerical data
(16/32 bit)

2 Q, QnA, A

MINUS_3_M
DMINUS_3_M

Subtraction of numerical data
(16/32 bit)

3 Q, QnA, A

SUB_MD SUB
(with LED* !)�

Subtraction of floating-point
numbers

2 Q, QnA,
AnA

For floating-point numbers only

BMINUS_M
DBMINUS_M

B-
DB-

BCD subtraction
(16/32 bit)

2 Q, QnA, A For BCD data only

BMINUS_3_M
DBMINUS_3_
M

BCD subtraction
(16/32 bit)

3 Q, QnA, A

� SUB Execute a microcomputer program 1 Q, QnA, A WARNING!
No  subtraction!

Tab. E-5: Subtraction

IEC MELSEC in the IEC Editor

SUB_E with input variables
of data type INT

� MINUS_M for the A series

SUB_E with input variables
of data type DINT

� DMINUS_M for the A series



E.2.3 Multiplication

� Dedicated instructions with LEDA/B
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IEC – MELSEC Programming Instructions

Programming instruction Description No. of
input
variables

Series Notes

IEC
IEC Editor

The IEC functions with input
variables of the INT (DINT) data
type correspond to the MELSEC
functions with 16 (32) bit data.

The number of input variables is
fixed using the MELSEC functions
and variable using the IEC
functions (min. 2, max. 28).

All the MELSEC functions have an
EN input and an ENO output.

MUL
MUL_E
Modifier: (

Multiplication of numerical
data/with EN input and ENO output

n
(2 – 28)

Q, QnA, A,
FX, FX0

MELSEC
IEC Editor

MELSEC
MELSEC
Editor

MUL_M
DMUL_M

MUL
DMUL

Multiplication of numerical data
(16/32 bit)

3 FX

MULTI_M
DMULTI_M

*
D*

Multiplication of numerical data
(16/32 bit)

2 A

MULTI_3_M
DMULTI_3_M

Multiplication of numerical data
(16/32 bit)

3 Q, QnA, A

MUL_MD MUL
(with LED* !)�

Multiplication of floating-point
numbers

2 Q, QnA,
AnA

For floating-point numbers only

BMULTI_M
DBMULTI_M

B*
DB*

BCD multiplication (16/32 bit) 2 Q, QnA, A For BCD data only

BMULTI_3_M
DBMULTI_3_M

BCD multiplication (16/32 bit) 3 A

Tab. E-6: Multiplication

IEC MELSEC in the IEC Editor

MUL_E with 3 input variables of
data type INT

� MUL_M for the FX series
MULTI_3_M for the A series

MUL_E with 2 input variables of
data type DINT

� DMULTI_M for the A series

Advantage: Enables multiplication of up to
28 input variables.



E.2.4 Division

� Dedicated instructions with LEDA/B
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Programming Instructions IEC – MELSEC

Programming instruction Description No. of
input
variables

Series Notes

IEC
IEC Editor

The IEC functions with input
variables of the INT (DINT) data
type correspond to the MELSEC
functions with 16 (32) bit data.

All the MELSEC functions have an
EN input and an ENO output.

DIV
DIV_E
Modifier: (

Division of numerical data/with EN
input and ENO output

2 Q, QnA, A,
FX, FX0

MELSEC
IEC Editor

MELSEC
MELSEC
Editor

DIV_M
DDIV_M

DIV
DDIV

Division of numerical data
(16/32 bit)

3 FX

DIVID_M
DDIVID_M

/
D/

Division of numerical data
(16/32 bit)

2 A

DIVID_3_M
DDIVID_3_M

Division of numerical data
(16/32 bit)

3 Q, QnA, A

DIV_MD DIV
(with LED* !)�

Division of floating-point numbers 2 Q, QnA,
AnA

For floating-point numbers only

BDIVID_M
DBDIVID_M

B/
DB/

BCD division (16/32 bit) 2 Q, QnA, A For BCD data only

BDIVID_3_M
DBDIVID_3_M

BCD division (16/32 bit) 3 A

Tab. E-7: Division

IEC MELSEC in the IEC Editor

DIV_E with input variables of
data type INT

� DIVID_M for the A series

DIV_E with input variables of
data type DINT

� DDIVID_M for the A series



E.2.5 Move

� Dedicated instructions with LEDA/B
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IEC – MELSEC Programming Instructions

Programming instruction Description No. of
input
variables

Series Notes

IEC
IEC Editor

The IEC functions with input
variables of the INT (DINT) data
type correspond to the MELSEC
functions with 16 (32) bit data.

All the MELSEC functions have an
EN input and an ENO output.

MOVE
MOVE_E

Moves numerical data/
with EN input and ENO output

1 Q, QnA, A,
FX, FX0

MELSEC
IEC Editor

MELSEC
MELSEC
Editor

MOV_M
DMOV_M

MOV
DMOV

Moves numerical data (16/32 bit) 1 Q, QnA, A,
FX, FX0

BMOV_M BMOV Block data move 2 Q, QnA, A,
FX, FX0

Special move operations

BMOVR_MD BMOVR
(with LED* !)�

Moves the data from one block to
another block with the extension file
registers

2 AnA

FMOV_M FMOV Fill move 2 Q, QnA, A,
FX, FX0

SMOV_M SMOV Shift move 4 FX

SMOV_MD SMOV
(with LED* !)�

Character string move 1 Q, QnA,
AnA

Tab. E-8: Move

IEC MELSEC in the IEC Editor

MOVE_E with 1 input variable of
data type INT

� MOV_M for the A and FX series

MOVE_E with 1 input variable of
data type DINT

� DMOV_M for the A and FX series



E.2.6 BCD – BIN conversion

� Dedicated instructions with LEDA/B
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Programming Instructions IEC – MELSEC

Programming instruction Description No. of
input
variables

Series Notes

IEC
IEC Editor

The IEC functions with input
variables of the INT (DINT) data
type correspond to the MELSEC
functions with 16 (32) bit data.

All the MELSEC functions have
an EN input and an ENO output.

INT_TO_BCD
INT_TO_BCD_E

Conversion of binary format (INT) to
BCD format/with EN input and ENO
output

1 Q, QnA, A,
FX, FX0

DINT_TO_BCD
DINT_TO_BCD_E

Conversion of binary format (DINT) to
BCD format/with EN input and ENO
output

1 Q, QnA, A,
FX, FX0

BCD_TO_INT
BCD_TO_INT_E

Conversion of BCD format to binary
format (INT)/with EN input and ENO
output

1 Q, QnA, A,
FX, FX0

BCD_TO_DINT
BCD_TO_DINT_E

Conversion of BCD format to binary
format (DINT)/with EN input and ENO
output

1 Q, QnA, A,
FX, FX0

MELSEC
IEC Editor

MELSEC
MELSEC
Editor

BCD_M
DBCD_M

BCD
DBCD

Conversion of binary format to BCD
format (16/32 bit)

1 Q, QnA, A,
FX, FX0

BIN_M
DBIN_M

BIN
DBIN

Conversion of BCD format to binary
format (16/32 bit)

1 Q, QnA, A,
FX, FX0

BINDA_MD
DBINDA_MD

BINDA
DBINDA
(with LED* !)�

Conversion of binary data (16/32 bit) to
an ASCII string (decimal)

1 Q, QnA,
AnA

For ASCII strings

BINHA_MD
DBINHA_MD

BINHA
DBINHA
(with LED* !)�

Conversion of binary data (16/32 bit) to
an ASCII string (hexadecimal)

1 Q, QnA,
AnA

DABIN_MD
DDABIN_MD

DABIN
DDABIN
(with LED* !)�

Conversion of an ASCII string (decimal)
to binary data (16/32 bit)

1 Q, QnA,
AnA

HABIN_MD
DHABIN_MD

HABIN
DHABIN
(with LED* !)�

Conversion of an ASCII string
(hexadecimal) to binary data (16/32 bit)

1 Q, QnA,
AnA

BCDDA_MD
DBCDDA_MD

BCDDA
DBCDDA
(with LED* !)�

Conversion of BCD data (16/32 bit) to
an ASCII string (decimal)

1 Q, QnA,
AnA

DABCD_MD
DDABCD_MD

DABCD
DDABCD
(with LED* !)�

Conversion of an ASCII string (decimal)
to BCD coded data (16/32 bit)

1 Q, QnA,
AnA

Tab. E-9: BCD – BIN conversion

IEC MELSEC in the IEC Editor

INT_TO_BCD_E � BCD_M for the A and FX series

BCD_TO_INT_E � BIN_M for the A and FX series



E.2.7 Logic Operations

� These instructions are not supported by the IEC editor.
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IEC – MELSEC Programming Instructions

Programming instruction Description No. of
input
variables

Series Notes

IEC
IEC Editor

The IEC functions with input
variables of the INT (DINT) data type
correspond to the MELSEC functions
with 16 (32) bit data.

The number of input variables is
fixed using the MELSEC functions
and variable using the IEC functions
(min. 2, max. 28).

All the MELSEC functions have an
EN input and an ENO output.

AND
AND_E
Modifier: N, C

Logical AND operation/with EN input
and ENO output

n
(2 – 28)

Q, QnA,
A, FX,
FX0

OR
OR_E
Modifier: N, C

Logical OR operation/with EN input
and ENO output

n
(2 – 28)

Q, QnA,
A, FX,
FX0

XOR
XOR_E
Modifier: N, C

Logical exclusive OR
operation/with EN input and ENO
output

n
(2 – 28)

Q, QnA,
A, FX,
FX0

MELSEC
IEC Editor

MELSEC
MELSEC
Editor

WAND_M
DAND_M

WAND
DAND

Logical AND operation (16/32 bit) 2 Q, QnA, A

WAND_3_M
DAND_3_M

Logical AND operation (16/32 bit) 3 Q, QnA,
A, FX,
FX0

WOR_M
DOR_M

WOR
DOR

Logical OR operation (16/32 bit) 2 Q, QnA, A

WOR_3_M
DOR_3_M

Logical OR operation (16/32 bit) 3 A, FX,
FX0

WXOR_M
DXOR_M

WXOR
DXOR

Logical exclusive OR
operation (16/32 bit)

2 Q, QnA, A

WXOR_3_M
DXOR_3_M

Logical exclusive OR
operation (16/32 bit)

3 Q, QnA,
A, FX,
FX0

WXNR_M
DXNR_M

WXNR Logical exclusive NOR operation
(16/32 bit)

2 Q, QnA, A Exclusive NOR is not available as an
IEC function.

WXNR_3_M
DXNR_3_M

Logical exclusive NOR operation
(16/32 bit)

3 Q, QnA, A

� AND AND operation with poll for signal
status 1

1 Q, QnA,
A, FX,
FX0

Input contacts

� ANI AND operation with poll for signal
status 0

1 A, FX,
FX0

� OR OR operation with poll for signal
status 0

1 Q, QnA,
A, FX,
FX0

� ORI OR operation with poll for signal
status 0

1 A, FX,
FX0

�
AND**
ANDD**

AND comparison operations
(16/32 bit)

2 Q, QnA, A Comparison
(� Comparisons table)

�
OR**
ORD**

OR comparison operations (16/32 bit) 2 Q, QnA, A

Tab. E-10: Logic Operations

IEC MELSEC in the IEC Editor

AND_E with 3 input variables of
data type WORD

� WAND_3_M for the A and FX series

AND_E with 2 input variables of
data type DWORD

� DAND_M for the A and FX series

Advantage: Enables operation performance
of  up to 28 input variables.



E.2.8 Start of an Operation and Output of a Result

� These instructions are not supported by the IEC editor.
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Programming Instructions IEC – MELSEC

Programming instruction Description No. of
input
variables

Series Notes

IEC
IEC Editor

The IEC function LD does not
function as an input condition. This
function loads a value into the
accumulator.

The MELSEC LD and LDI functions
are used as the input condition for
the subsequent operations.

The IEC functions LD and ST are
operators that are only used in the
IEC Instruction List language
(� Chapter 6).

LD
Modifier: N

IEC Instruction List operator
Load specified value/variables into
the accumulator

1 Q, QnA, A,
FX, FX0

ST
Modifier: N

IEC Instruction List operator
Load specified value/variables into
the accumulator

1 Q, QnA, A,
FX, FX0

MELSEC
IEC Editor

MELSEC
MELSEC
Editor

� LD Start of a logic operation with poll for
signal status 1 (input contact)

1 Q, QnA, A,
FX, FX0

� LDI Start of a logic operation with poll for
signal status 0 (input contact)

1 Q, QnA, A,
FX, FX0

�
LD**
LDD**

Start of comparison operations
(16/32 bit)

1 Q, QnA, A

� OUT Output, Assignment of a logic
operation result (output coil)

1 Q, QnA, A,
FX, FX0

Tab. E-11: Start of an Operation and Output of a Result



E.2.9 Comparisons
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IEC – MELSEC Programming Instructions

Programming instruction Description
No. of
input

variables
Series Notes

IEC
IEC-Editor

The number of input variables is
fixed using the MELSEC functions
and variable using the IEC functions
(min. 2, max. 28).GT

GT_E
Decreasing sequence >/with EN
input and ENO output

n
(2 – 28)

Q, QnA, A,
FX, FX0

GE
GT_E

Monotonic sequence >=/with EN
input and ENO output

n
(2 – 28)

Q, QnA, A,
FX, FX0

EQ
EQ_E

Equality =/with EN input and ENO
output

n
(2 – 28)

Q, QnA, A,
FX, FX0

LE
LE_E

Monotonic sequence <=/with EN
input and ENO output

n
(2 – 28)

Q, QnA, A,
FX, FX0

LT
LT_E

Increasing sequence </with EN input
and ENO output

n
(2 – 28)

Q, QnA, A,
FX, FX0

NE
NE_E

Inequality <>/with EN input and ENO
output

2 Q, QnA, A,
FX, FX0

MELSEC
IEC-Editor

MELSEC
MELSEC-
Editor

� LD>
LDD>

Beginning of a comparison,
Sequential comparison > (16/32 bit)

2 Q, QnA, A

� LD>=
LDD>=

Beginning of a comparison,
Sequential comparison >= (16/32 bit)

2 Q, QnA, A

� LD=
LDD=

Beginning of a comparison,
Equality = (16/32 bit)

2 Q, QnA, A

� LD<=
LDD<=

Beginning of a comparison,
Sequential comparison <= (16/32 bit)

2 Q, QnA, A

� LD<
LDD<

Beginning of a comparison,
Sequential comparison < (16/32 bit)

2 Q, QnA, A

� LD<>
LDD<>

Beginning of a comparison,
Inequality <> (16/32 bit)

2 Q, QnA, A

� AND>
ANDD>

AND comparison,
Sequential comparison > (16/32 bit)

2 Q, QnA, A

� AND>=
ANDD>=

AND comparison,
Sequential comparison >= (16/32 bit)

2 Q, QnA, A

� AND=
ANDD=

AND comparison,
Equality = (16/32 bit)

2 Q, QnA, A

� AND<=
ANDD<=

AND comparison,
Sequential comparison <= (16/32 bit)

2 Q, QnA, A

� AND<
ANDD<

AND comparison,
Sequential comparison <  (16/32 bit)

2 Q, QnA, A

� AND<>
ANDD<>

AND comparison,
Inequality <> (16/32 bit)

2 Q, QnA, A

� OR>
ORD>

OR comparison,
Sequential comparison > (16/32 bit)

2 Q, QnA, A

� OR>=
ORD>=

OR comparison,
Sequential comparison >= (16/32 bit)

2 Q, QnA, A

� OR=
ORD=

OR comparison,
Equality = (16/32 bit)

2 Q, QnA, A

� OR<=
ORD<=

OR comparison,
Sequential comparison <= (16/32 bit)

2 Q, QnA, A

� OR<
ORD<

OR comparison,
Sequential comparison <  (16/32 bit)

2 Q, QnA, A

� OR<>
ORD<>

OR comparison,
Inequality <> (16/32 bit)

2 Q, QnA, A

Tab. E-12: Start of an Operation and Output of a Result



� These instructions are not supported by the IEC editor.
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Programming Instructions IEC – MELSEC

IEC MELSEC in the IEC Editor

GT_E with 2 input variables of
data type INT

� LD_GT_M for the A series

GT_E with 2 input variables of
data type DINT

� LDD_GT_M for the A series

Advantage: Enables comparison of up to 28
input variables.



E.2.10 Shift
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IEC – MELSEC Programming Instructions

Programming instruction Description No. of
input
variables

Series Notes

IEC
IEC Editor

The upper bits are lost in the IEC
functions.

With the MELSEC functions the upper
bits are also lost

SHL
SHL_E

Left shift
Shifts the data of the input
variable (IN1) to the left by (N)
bits. The upper (N) bits of (IN1)
are lost in this process/with EN
input and ENO output

2 Q, QnA, A,
FX, FX0

SHR
SHR_E

Right shift
Shifts the data of the input
variable (IN1) to the right by (N)
bits. The upper (N) bits of (IN1)
are lost in this process /with EN
input and ENO output

2 Q, QnA, A,
FX, FX0

MELSEC
IEC Editor

MELSEC
MELSEC
Editor

SFL_M SFL Shift a 16-bit data word to the left
by (n) bits (Carry Flag)

2 Q, QnA, A

SFR_M SFR Shift a 16-bit data word to the
right by (n) bits (Carry Flag)

2 Q, QnA, A

SFTL_M SFTL Shift bit devices (n) bits to the left 4 FX

SFTR_M SFTR Shift bit devices (n) bits to the
right

4 FX

WSFL_M WSFL Shift word devices (n) places to
the left

4 FX

WSFR_M WSFR Shift word devices (n) places to
the right

4 FX

SFT_M SFT Shift bit devices by 1 bit 1 Q, QnA, A

BSFL_M BSFL Shift bit devices one place to the
left (Carry Flag)

2 Q, QnA, A

BSFR_M BSFR Shift bit devices one place to the
right (Carry Flag)

2 Q, QnA, A

DSFL_M DSFL Shift word devices one place to
the left

2 Q, QnA, A

DSFR_M DSFR Shift word devices one place to
the right

2 Q, QnA, A

Tab. E-13: Shift

IEC MELSEC in the IEC Editor

SHL_E with input variables of
data type WORD

� SFL_M for the A series (Difference: Carry
Flag)

SHR_E with input variables of
data type WORD

� SFR_M for the A series (Difference: Carry
Flag)



E.2.11 Rotation
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Programming Instructions IEC – MELSEC

Programming instruction Description No. of
input
variables

Series Notes

IEC
IEC Editor

None of the bits are lost.

ROL
ROL_E

Rotate left
The data in (IN) are rotated left by
(N) bits; no bits are lost/with EN
input and ENO output

2 Q, QnA, A,
FX, FX0

ROR
ROR_E

Rotate right
The data in (IN) are rotated right by
(N) bits; no bits are lost /with EN
input and ENO output

2 Q, QnA, A,
FX, FX0

MELSEC
IEC Editor

MELSEC
MELSEC
Editor

ROL_M
DROL_M

ROL
DROL

Rotate left in A0 and A1 (16/32 bit) 1 Q, QnA, A

ROR_M
DROR_M

ROR
DROR

Rotate right in A0 and A1 (16/32 bit) 1 Q, QnA, A

ROL_2_M
DROL_2_M

ROL
DROL

Rotate left (16/32 bit) 2 FX Special rotation

ROR_2_M
DROR_2_M

ROR
DROR

Rotate right (16/32 bit) 2 FX

RCL_2_M
DRCL_2_M

RCL
DRCL

Rotate left with Carry Flag
(16/32 bit)

2 FX

RCR_2_M
DRCR_2_M

RCR
DRCR

Rotate right with Carry Flag
(16/32 bit)

2 FX

RCL_M
DRCL_M

RCL
DRCL

Rotate left in A0 and A1 with Carry
Flag (16/32 bit)

1 Q, QnA, A

RCR_M
DRCR_M

RCR
DRCR

Rotate right in A0 and A1 with Carry
Flag (16/32 bit)

1 Q, QnA, A

Tab. E-14: Rotation

IEC MELSEC in the IEC Editor

ROL_E with input variables of
data type WORD

� ROL_M for the A series
(Difference: Carry Flag,
Fixed device A0)

ROR_E with input variables of
data type DWORD

� DROR_M for the A series
(Difference: Carry Flag,
Fixed devices A0 and A1)



E.2.12 Set and Reset Operations

� Dedicated instructions with LEDA/B
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IEC – MELSEC Programming Instructions

Programming instruction Description No. of
input
variables

Series Notes

IEC
IEC Editor

In the IEC functions the contents of
the accumulator have an effect on
the execution of the functions
(� Chapter 6)S IEC Instruction List operator

Set
Sets the value of the BOOL variable
to 1. This operation is only executed
when the value in the accumulator is
1.

1 Q, QnA, A,
FX, FX0

R IEC Instruction List operator
Reset
Sets the value of the BOOL variable
to 0. This operation is only executed
when the value in the accumulator is
1.

1 Q, QnA, A,
FX, FX0

MELSEC
IEC Editor

MELSEC
MELSEC
Editor

SET_M SET Device set operation 1 Q, QnA, A,
FX, FX0

RST_M RST Device reset operation 1 Q, QnA, A,
FX, FX0

BSET_M BSET Used to set individual bits in word
devices

2 Q, QnA, A Special set and reset operations

BRST_M BRST Used to reset individual bits in word
devices

2 Q, QnA, A

DSET_MD DSET
(with LED!)�

Direct set 1 Q, QnA,
AnA

DRST_MD DRST
(with LED!)�

Direct reset 1 Q, QnA,
AnA

ZRST_M ZRST Reset device zones 2 FX

Tab. E-15: Set and Reset Operations



E.2.13 Rising/Falling Edge
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Programming Instructions IEC – MELSEC

Programming instruction Description No. of
input
variables

Series Notes

IEC
IEC Editor

R_TRIG/E_R_TRIG and
F_TRIG/E_F_TRIG are Function
Blocks. This means that you must
create instances of them before you
can use them in your program
(� Chapter 6).

R_TRIG
R_TRIG_E

Function block
Rising edge detect
The current signal status of the output
variable (Q) changes on the rising
edge on the input variable (CLK)/with
EN input and ENO output

1 Q, QnA,
A, FX

F_TRIG
F_TRIG_E

Function block
Falling edge detect
The current signal status of the output
variable (Q) changes on the falling
edge on the input variable (CLK)/with
EN input and ENO output

1 Q, QnA,
A, FX

MELSEC
IEC Editor

MELSEC
MELSEC
Editor

PLS_M PLS Generates a single pulse on rising
edge;
the current signal status changes on
a rising edge.

1 Q, QnA,
A, FX,
FX0

PLF_M PLF Generates a single pulse on a falling
edge;
the current signal status changes on
a falling edge.

1 Q, QnA,
A, FX,
FX0

Tab. E-16: Rising/Falling Edge

IEC MELSEC in the IEC Editor

R_TRIG_E � PLS_M

F_TRIG_E � PLF_M



E.2.14 Negation
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IEC – MELSEC Programming Instructions

Programming instruction Description No. of
input
variables

Series Notes

IEC
IEC Editor

NOT
NOT_E

Negation/with EN input and ENO
output

1 Q, QnA,
A, FX,
FX0

MELSEC
IEC Editor

MELSEC
MELSEC
Editor

CML_M
DCML_M

CML
DCML

Data negation (16/32 bit)
Negation of the individual bits

2 Q, QnA,
A, FX,
FX0

NEG_M
DNEG_M

NEG
DNEG

Data negation (16/32 bit)
Formation of the two’s complement

0 Q, QnA,
A, FX,
FX0

Tab. E-17: Negation

IEC MELSEC in the IEC Editor

NOT_E with an input variable
of data type WORD

� CML_M

NOT_E with an input variable
of data type DWORD

� DCML_M



E.2.15 Jumps/Program Branching

Meaning of the modifiers for the jump function JMP:

JMP (Jump):
The jump is always executed unconditionally.

JMPC (Jump Conditional):
The jump is only executed when the value in the accumulator is 1.

JMPCN (Jump Conditional Not):
The jump is only executed when the value in the accumulator is 0.
� These instructions are not supported by the IEC editor.
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Programming Instructions IEC – MELSEC

Programming instruction Description No. of
input
variables

Series Notes

IEC
IEC Editor

The IEC JMP function is normally
executed without any input condition.
You must use the modifier to
program a conditional jump.

Network labels are used as jump
destinations.
(� Chapter 6).

JMP
Modifiers: N, C

IEC Instruction List operator.
Jump to a network label.
You can execute a jump to another
network within a  program section.
Specify the name (label) of the
network after the operator.

0 Q, QnA, A,
FX, FX0

MELSEC
IEC Editor

MELSEC
MELSEC
Editor

� JMP Unconditional jump within a program 1 Q, QnA, A

� CJ Conditional jump within a program 1 Q, QnA, A,
FX

� SCJ Conditional jump within a program,
executed in the next program cycle

1 Q, QnA, A

Tab. E-18: Jumps/Program Branching



E.2.16 Calling Subprograms and Function Blocks

� These instructions are not supported by the IEC editor.
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IEC – MELSEC Programming Instructions

Programming instruction Description No. of
input
variables

Series Notes

IEC
IEC Editor

The IEC functions are used for jumps
to and returns from Function Blocks.

The MELSEC functions are used for
jumps to and returns from the normal
subroutines/subprograms in the PLC
sequence program.

CAL
Modifiers: C, N

IEC Instruction List operator
Call to a Function Block instance.
In Instruction List the instances of
Function Blocks can only be called
via the CAL operator. Specify the
instance name after the operator,
then pass the actual parameters to
the formal parameters.

0 A, FX

RET
Modifiers: C, N

IEC Instruction List operator
Return from a Function Block.
From a Function Block, you can
return to the program from which the
Function Block instance was called.

0 Q, QnA, A,
FX

MELSEC
IEC Editor

MELSEC
MELSEC
Editor

� CALL Call a subprogram 1 Q, QnA, A,
FX

� SRET End/return from a subprogram 0 FX

� RET 0 Q, QnA, A

Terminate Step Ladder 0 FX

Tab. E-19: Calling Subprograms and Function Blocks



E.2.17 Exclusive Q Series Instructions
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Programming Instructions IEC – MELSEC

Programming instruction Description No. of
input
variables

Series Notes

MELSEC
IEC Editor

MELSEC
MELSEC
Editor

UNIRD_M

UNIRDP_M

UNIRD
UNIRDP

Read the module information stored
in the area starting from the
designated I/O No. and store it in the
area starting from the designated
device.

3 Q

TRACE_M TRACE Store trace data set at a peripheral
device to trace file in IC memory card
by the designated number when
SM800, SM801, and SM802 turn
ON.

0 Q

TRACER_M TRACER Reset the data set by the TRACE
instruction.

0 Q

SP.FWRITE_M SP.FWRITE Write data to a designated file. 6 Q

SP.FREAD_M SP.FREAD Read data from a designated file. 6 Q

PLOADP_M PLOADP Transfer the program stored in a
memory card or standard memory
card (other than drive 0) to drive 0
and place the program in stand-by
status.

2 Q

PUNLOADP_M PUNLOADP Delete the stand-by program stored
in standard memory (drive 0).

2 Q

PSWAPP_M PSWAPP Delete stand-by program stored in
designated standard memory (drive
0). Then the program stored in a
memory card or standard memory
(other than drive 0) is transferred to
drive 0 and placed in stand-by status.

3 Q

RBMOV_M
RBMOVP_M

RBMOV
RBMOVP

Block data move 3 Q

Tab. E-20: Exclusive Q Series Instructions
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IEC – MELSEC Programming Instructions



F Menu structure

The following pages show the menu structure of GX IEC Developer. The menu structure and
the available commands are context-sensitive, changing depending on which CPU series you
are using and what you are currently doing in the program.

This is marked by the following footnotes:
� no Remote I/O
� no FX0 / FX0S
� no A- and FX-series
	 no FX-series

 no Q00(J)/Q01
� only FX-series
� only Q00(J)/Q01
" only A- and FX-series
$ only FX3U
% only Q- and QnA-series
& only Q-series
' only Q-series except Q25SS
( only QnPRH
) only with MXFastLinx PAK code
* only available in the IEC Instruction List (Body IL)
+ only available in Ladder Diagram
, only available in Global Variable List
- only available in SFC
. only available in Ladder Diagram and Function Block Diagram
/ only QnU
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Menu structure



Project
all windows

F – 2 MITSUBISHI ELECTRIC

Menu structure

New…

Open...

Close

Save

Save as…

Other � Rename…

Copy…

Import…

Export…

Export to Eprom "

Update Libraries �

Verify

Change PLC Type… �

Build �

Rebuild All �

Transfer � Upload from PLC…

Download to PLC…

Verify

Online verify (

Download Symbolic Information � %

Copy Program Memory to Flash ROM � &

Copy Program Cache to
Program Memory /

Online Program Change � �

Browse… � '

Make Cross Reference �

FastLinx � FastLinx New � )

FastLinx Open � )

MXChange Database Actions � New � )

Open � )

Save as � )

Delete � )

Compact � )

Change Password � )

Close � )

MXChange Project Actions � Load from MXChange � )

Show Changes � )

Global Adjust � )

Delete � )

Printer Setup…

Print Options…

Print Preview…

Print…

Change Security Level…

Change Passwords…

Recent Files

Quit



Object
in Navigator

Object
in Body IL, MELSEC IL, LD, FBD, ST, SFC

Object
in Declaration editors
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Menu structure

New � POU… �

Task… �

Action… �

Data Unit Type… �

Open �

Close �

Save �

Rename… �

Comment…

Information…

Check

Print…

Print Preview…

Import…

Export…

Close

Save

Comment…

Information…

Check

Print…

Print Preview…

Open Header

Close

Save

Comment…

Information…

Check

Print…

Print Preview…

Open Body



Edit
in Navigator

Edit
in Body IL, MELSEC IL

Edit
in Body LD, FBD
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Menu structure

Cut �

Copy

Paste

Delete �

Find… �

Replace… �

Update Library �

User Library � Install/Create… �

Deinstall �

Modify… �

Open… �

Close �

Save �

Delete �

Change Password… �

Undo

Redo

Cut

Copy

Paste

Delete

Find…

Replace…

New Network � Top

Before

After

Bottom

MELSEC Before *

Undo

Redo

Cut

Copy

Paste

Delete

Find…

Replace…

New Network � Top

Before

After

Bottom

Increment Pins

Decrement Pins

Signal Configuration…

Toggle Signal Config…



Edit
in Body ST

Edit
in Body SFC
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Menu structure

Undo

Redo

Cut

Copy

Paste

Delete

Find…

Replace…

Toggle Bookmark

Next Bookmark

Previous Bookmark

Delete all Bookmarks

Undo

Redo

Cut

Copy

Paste

Delete

Find…

Replace…

Mark

Macro

Expand Macro

Modify � Name

Initial Step

Final Step

Macro Step

Entry Step

Exit Step

Insert � Step/Transition Unit

Step

Transition

Left Divergence

Right Divergence

Left Convergence

Right Convergence

Label

Jump



Edit
in Declaration editors

Edit
in Entry Data Monitor (EDM)

Edit
in Show Generated Code
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Menu structure

Undo

Redo

Cut

Copy

Paste

Delete

Find…

Replace…

New Declaration � Top

Before

After

Bottom

Insert Objects… �

Next Object

Insert Forced Inputs 	 


Insert Set Inputs � �

Insert Set Outputs

Clear Device File

Cut

Copy

Paste

Insert Row

Delete

Delete All

Close

Copy All



Tools
in Navigator

Tools
in Body IL, MELSEC IL

Tools
in Body ST
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Menu structure

Edit Network

End Edit

Network List…

Show MELSEC Code Of Networks

Import GX Developer Network

Import MEDOC Network

List Operators/Operands

Create Template *

Tracking � Start Tracking

Next

Previous

First

Last

New Variable…

Zoom � Header

Body

Expand

Collapse

Show MELSEC Code Of Networks

Show MELSEC Code Of Selection

List Operands

List Operators

Create Template

Tracking � Start Tracking

Next

Previous

First

Last

New Variable…

Zoom � Header

Body



Tools
in Body LD
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Menu structure

Network Elements � Contact +

Contact Negation

Coil +

Jump

Return

Function Block

L-Connection Contact

L-Connection Contact Negation

Input Variable

Output Variable

Horizontal Line Segment

Vertical Line Segment

Comment

Lable of the Network

Delete Line

Open Row

Open Column

Define Graphic Macros…

Custom � Custom 1

Custom 2

Custom 3

Custom 4

Custom 5

More Custom…

Select Mode

Interconnect Mode

Auto Connect

Guided Mode � Guided Editing

Overwrite Mode

Insert Mode

Line Mode

Auto Comment

Recalculate Line

Network List…

Show MELSEC Code Of Networks

List Operators/Operands

Tracking � Start Tracking

Next

Previous

First

Last

New Variable…

Zoom � Header

Body



Tools
in FBD

Tools
in Body SFC
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Menu structure

Network Elements � Jump

Return

Function Block

Input Variable

Output Variable

Horizontal Line Segment

Vertical Line Segment

Comment

Open Row

Open Column

Define Graphic Macros…

Custom � Custom 1

Custom 2

Custom 3

Custom 4

Custom 5

More Custom…

Select Mode

Interconnect Mode

Auto Connect

Recalculate Line

Network List…

Show MELSEC Code Of Networks

List Operators/Operands

Tracking � Start Tracking

Next

Previous

First

Last

New Variable…

Zoom � Header

Body

Edit Action Association

Edit Step Comment

Edit Transition Condition

End Edit

List Operands

List Operators

New Variable

Zoom Macro

Zoom Body

Zoom Into

Zoom Back

Find Error



Tools
in Declaration editors

Tools
in the Entry Data Monitor (EDM)

Tools
when no project is opened

Tools
in Show Verify Differences
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Menu structure

Expand Declaration

Collapse Declaration

Read from PLC

Write to PLC

Read from File

Write to File

Setup…

Always on top

Reorganize Database

Next Difference

Previous Difference

Goto Editor

Show Step Number

Expand Declaration

Collapse Declaration

Sort � Class

Identifier

Address ,

Type

Find Overlapping Addresses

Address Batch Replace �

Export to Excel

Import from Excel



Online

* for ST / IL see below

Online
specific items: ST / IL
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Menu structure

Start Monitoring � Body

Split Window

Transfer Setup � Ports

Modem

Project

Start Monitoring  (*, see below)

Stop Monitoring

Monitor Header �

Entry Data Monitor

Modify Variable Value

Online-Change Mode � �

Monitoring Mode

Start In Cycle Monitor � �

Stop In Cycle Monitor � �

Change Instance… �

Start/Stop PLC �

PLC Redundancy Mode (

PLC Status

PLC Keyword � Current �

New �

Delete �

Disable Protection $

Enable Protection $

Set PLC Time (

GX Simulator �

Latch Data Backup Backup /

Delete Backup Data /

PLC Clear � All �

Devices "

Latch � %

Forced Inputs 	 


Format Drive � %

File Info %

Close communications



Debug
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Menu structure

SFC Control - Set selected steps %

Reset Selected steps %

Replace active by selected steps %

PLC Diagnostics

Ethernet Diagnostics 	

CC IE Control Diagnostics ( /

MELSECNET Diagnostics 	

CC-Link(/LT) Diagnostics 	

System Monitor &

Online Module Change (

Device Edit

Buffer memory batch

System Errors

User Errors � 	

HW Diagnostics � 	

Scan �

Show Step

Forced input output
registration/cancellation…



View
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Menu structure

Toolbar

Statusbar

Horizontal Scrollbar

Grid

Zoom � 50%

75%

100%

150%

View mode . � Standard

Mitsubishi Address

IEC Address

Toggle

Font…

Colors � Background…

Selection…

Text…

Selected Text…

Read Only Text…

Locked Text…

Foreground…

Monitoring…

Errors…

Shade Left Top…

Shade Right Bottom…

Grid…

Browser Items…

SFC Raster Elements…

Overwrite Mode Cursor

Insert Mode Cursor

Line Mode Cursor

Cursor Fill

ST Keywords…

ST Operators…

ST Comments…

ST Constant Numbers…

ST Constant Strings…

ST Variables…

Save Workspace

Load Workspace

Extended Information . � Navigator

SFC editor

Environment

Configure Status Bar

System Defaults



Extras

Window

Help

F – 14 MITSUBISHI ELECTRIC

Menu structure

Project Backup…

Project Restore…

Declare MXChange Tags �

Delete MXChange Tags �

Update Variables �

Export Variables �

Find Unused Variables �

Double Coil Check �

Intelligent Function Utility � Start &

Verify System Variables � &

Options…

SV � Export Alarm Info… %

Update Time %

Options…

Tile Horizontally

Tile Vertically

Cascade

Arrange Icons

Close All

Navigator

Show Compile/Check Messages

Show Next Error

Show Previous Error

Show Next Warning

Show Previous Warning

1 Window 1

2 Window 2

3 Window 3

4 Window 4

Index

Overview

Glossary

Error Messages

Search…

How to use Help

About…



G Compliance List

This list provides a description of all the features of the GX IEC Developer programming and
documentation system that comply with the specifications of IEC standard 61131, Part 3.

The format of the list corresponds to the tables in IEC 61131-3. This makes it possible to obtain
additional information quickly by referring to the corresponding tables and the accompanying
texts in the IEC standard publication.

Character set features

Identifier features

Comment feature
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Compliance List

No. Description Note

1 ISO/IEC 646 character set “A-Z,_” Supported

2 Lower case characters “a-z” Supported

3a Number sign “#” Supported

3b Pound sign “£” Not supported

4a Dollar sign “$” Supported

4b Currency sign Not supported

5a Vertical bar “|” Not supported

5b Exclamation mark “!” Not supported

6a Left and right brackets “[]” Supported (Arrays)

6b Left and right parentheses “()” Supported

Tab. G-1: Character set features

No. Description Note

1 Upper case and numbers Supported

2 Upper and lower case, numbers, embedded underlines Supported

3 Upper and lower case, numbers, leading or embedded underlines Supported

Tab. G-2: Identifier features

No. Description Note

1 (*This is a comment*) Supported

Tab. G-3: Comment feature



Numeric literals

Character string literals

Two-character combinations in character strings

Duration literal features
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Compliance List

No. Description Note

1 Integer literals Supported

2 Real literals Supported

3 Real literals with exponents Supported

4 Base 2 literals Supported

5 Base 8 literals Supported

6 Base 16 literals Supported

7 Boolean zero (0) and one (1) Supported

8 Boolean FALSE and TRUE Supported

Tab. G-4: Numeric literals

No. Description Note

1 ‘’, ‘A’, ‘ ‘, ‘$", ‘$R$L", ‘$0D$0A’, ‘$$1.00’ Supported

Tab. G-5: Character string literals

No. Description Note

2 $$ Not supported

3 $’ Not supported

4 $L or $I Not supported

5 $N or $n Not supported

6 $P or $p Not supported

7 $R or $r Not supported

8 $T or $t Not supported

Tab. G-6: Two-character combinations in character strings

No. Description Note

1a Duration literals without underlines:
Short prefix

Supported

1b Long prefix Supported

2a Duration literals with underlines:
Short prefix

Supported

2b Long prefix Supported

Tab. G-7: Duration literal features



Date and time of day literals

Date and time of day literals notation

Elementary data types
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No. Description Note

1 Date literals (long prefix) Not supported

2 Date literals (long prefix) Not supported

3 Time of day literals (long prefix) Not supported

4 Time of day literals (short prefix) Not supported

5 Date and time literals (long prefix) Not supported

6 Date and time literals (short prefix) Not supported

Tab. G-8: Date and time of day literals

No. Description Note

1 Time literals notation Not supported

Tab. G-9: Date and time of day literals notation

No. Description Note

1 BOOL Supported

2 SINT Not supported

3 INT Supported

4 DINT Supported

5 LINT Not supported

6 USINT Not supported

7 UINT Not supported

8 UDINT Not supported

9 ULINT Not supported

10 REAL Supported

11 LREAL Not supported

12 TIME Supported

13 DATE Not supported

14 TIME_OF_DAY or TOD Not supported

15 DATE_AND_TIME or DT Not supported

16 STRING Supported

17 BYTE Not supported

18 WORD Supported

19 DWORD Supported

20 LWORD
Plus: EDGE, CHANGE, SGRAY, GRAY, DGRAY, BCD, WFIX, DFIX

Not supported

Tab. G-10: Elementary data types



Hierarchy of generic data types

Data type declaration feature

Default initial values
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Compliance List

No. Description Note

ANY

ANY_NUM

ANY_REAL

REAL

ANY_INT

DINT

INT

ANY _BIT

DWORD

WORD

BOOL

TIME

Tab. G-11: Hierarchy of generic data types

No. Description Note

1 Direct derivation of elementary data types Not supported

2 Enumerated data types Not supported

3 Subrange data types Not supported

4 Array data types Supported

5 Structured data types Supported

Tab. G-12: Data type declaration feature

No. Description Note

BOOL = FALSE Supported

INT, DINT = 0 Supported

WORD, DWORD = 0 Supported

REAL = 0.0 Supported

TIME = T#0s Supported

Tab. G-13: Default initial values



Data type initial value declaration features

Location and size prefix features for directly represented variables

Variable declaration keywords
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No. Description Note

1 Initialisation of directly derived types Not supported

2 Initialisation of enumerated data types Not supported

3 Initialisation of subrange data types Not supported

4 Initialisation of array data types Not supported

5 Initialisation of structured data type elements Not supported

6 Initialisation of derived structure data types Not supported

Tab. G-14: Data type initial value declaration features

No. Description Note

1 I, Input location Supported

2 Q, Output location Supported

3 M, Memory location Supported

4 X, Single bit size Supported

5 None, Single bit size Not supported

6 B, Byte (8 bits) size Not supported

7 W, Word (16 bits) size Supported

8 D, Double word (32 bits) size Supported

9 L, Long (quad) word (64 bits) size Not supported

* See table on page 6-7

Tab. G-15: Location and size prefix features for directly represented variables

No. Description Note

VAR / VAR_CONSTANT Supported

VAR_INPUT Supported

VAR_OUTPUT Supported

VAR_IN_OUT Supported

VAR_GLOBAL / VAR_GLOBAL_CONSTANT Supported

VAR_ACCESS Not supported

RETAIN Not supported

CONSTANT Not supported

AT Supported

Tab. G-16: Variable declaration keywords



Variable type assignment features

Variable initial value assignment features

Graphical negation of Boolean signals
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No. Description Note

1 Declaration of directly represented, non-retentive variables Supported

2 Declaration of directly represented retentive variables Not supported

3 Declaration of locations of symbolic variables Supported

4 Array location assignment Supported

5 Automatic memory allocation of symbolic variables Supported

6 Array declaration Supported

7 Retentive array declaration Not supported

8 Declaration of structured variables Supported

Tab. G-17: Variable type assignment features

No. Description Note

1 Initialisation of directly represented, non-retentive variables Not supported

2 Initialisation of directly represented retentive variables Not supported

3 Location and initial value assignment to symbolic variables Not supported

4 Array location assignment and initialisation Not supported

5 Initialisation of symbolic variables Not supported

6 Array initialisation Not supported

7 Retentive array declaration and initialisation Not supported

8 Initialisation of structured variables Not supported

9 Initialisation of constants Not supported

Tab. G-18: Variable initial value assignment features

No. Description Note

1 Negated input Supported

2 Negated output Supported

Tab. G-19: Graphical negation of Boolean signals



Use of EN input and ENO output

Typed and overloaded functions

Type conversion function features

Standard functions with one numeric variable
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No. Description Note

1 Use of EN and ENO
Required for Ladder Diagram (LD) language

Supported

2 Use of EN and ENO
Optional for Function Block Diagram (FBD) language

Supported

3 FBD without EN and ENO Supported

Tab. G-20: Use of EN input and ENO output

No. Description Note

1 Overloaded functions (untyped) Supported*

2 Typed functions Not supported

* Implicit typing through passing of the actual parameters

Tab. G-21: Typed and overloaded functions

No. Description Note

1 *_TO_** Supported

2 TRUNC Not supported

3 BCD_TO_** Supported

4 *_TO_BCD Supported

Tab. G-22: Type conversion function features

No. Description Note

1 ABS Supported

2 SQRT Supported*

3 LN Supported*

4 LOG Not supported

5 EXP Supported*

6 SIN Supported*

7 COS Supported*

8 TAN Supported*

9 ASIN Supported*

10 ACOS Supported*

11 ATAN Supported*

* Only for PLC systems that support floating point values: Q, QnA, AnA, AnU

Tab. G-23: Standard functions with one numeric variable



Standard arithmetic functions

Standard bit-shift functions

Standard bitwise Boolean functions

Standard selection functions
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Compliance List

No. Description Note

12 ADD Supported

13 MUL Supported

14 SUB Supported

15 DIV Supported

16 MOD Supported

17 EXPT Supported

18 MOVE Supported*

* Only for PLC systems that support floating point values: Q, QnA, AnA, AnU Supported

Tab. G-24: Standard arithmetic functions

No. Description Note

1 SHL Supported

2 SHR Supported

3 ROR Supported

4 ROL Supported

Tab. G-25: Standard bit-shift functions

No. Description Note

5 AND Supported

6 OR Supported

7 XOR Supported

8 NOT Supported

Tab. G-26: Standard bitwise Boolean functions

No. Description Note

1 SEL Supported

2a MAX Supported

2b MIN Supported

3 LIMIT Supported

4 MUX Supported

Tab. G-27: Standard selection functions



Standard comparison functions

Standard character string functions
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No. Description Note

5 GT Supported

6 GE Supported

7 EQ Supported

8 LE Supported

9 LT Supported

10 NE Supported

Tab. G-28: Standard comparison functions

No. Description Note

1 LEN Supported *

2 LEFT Supported *

3 RIGHT Supported *

4 MID Supported *

5 CONCAT Supported *

6 INSERT Supported *

7 DELETE Supported *

8 REPLACE Supported *

9 FIND Supported *

* Only for PLC systems that support character strings: Q, QnA

Tab. G-29: Standard character string functions



Functions of time data types

Functions of enumerated data types

Function block I/O parameter usage features
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Compliance List

No. Description Note

1 ADD (TIME, TIME, TIME) Not supported

2 ADD (TOD, TIME, TOD) Not supported

3 ADD (DT, TIME, DT) Not supported

4 SUB (TIME, TIME, TIME) Not supported

5 SUB (DATE, DATE, TIME) Not supported

6 SUB (TOD, TIME, TOD) Not supported

7 SUB (TOD, TOD, TIME) Not supported

8 SUB (DT, TIME, DT) Not supported

9 SUB (DT, DT, TIME) Not supported

10 MUL (TIME, ANY_NUM, TIME) Not supported

11 DIV (TIME, ANY_NUM, TIME) Not supported

12 CONCAT (DATE, TOD, DT) Not supported

13 DT_TO_TOD Not supported

14 DT_TO_D Not supported

Tab. G-30: Functions of time data types

No. Description Note

1 SEL Not supported

2 VIUX Not supported

3 EQ Not supported

4 NE Not supported

Tab. G-31: Functions of enumerated data types

No. Description Note

1 Input read Supported

2 Input write Supported

3 Output read Supported

4 Output write Supported

Tab. G-32: Function block I/O parameter usage features



Function block declaration features

Standard bistable function blocks

Standard edge detection function blocks
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No. Description Note

1 RETAIN qualifier on internal variables Not supported

2 RETAIN qualifier on output variables Not supported

3 RETAIN qualifier on internal function blocks Not supported

4a Input/output declaration (textual) Supported

4b Input/output declaration (graphical) Not supported

5a Function block instance name as input (textual) Not supported

5b Function block instance name as input (graphical) Not supported

6a Function block instance name as input/output
(textual)

Not supported

6b Function block instance name as input/output
(graphical)

Not supported

8a Declaration of rising edge inputs (textual) Not supported

8b Declaration of falling edge inputs (textual) Not supported

9a Declaration of rising edge inputs (graphical) Not supported

9b Declaration of falling edge inputs (graphical) Not supported

Tab. G-33: Function block declaration features

No. Description Note

1 Bistable function block (set dominant) Supported

2 Bistable function block (reset dominant) Supported

3 Semaphore with non-interruptible “Test and Set” Not supported

Tab. G-34: Standard bistable function blocks

No. Description Note

1 Rising edge detector Supported

2 Falling edge detector Supported

Tab. G-35: Standard edge detection function blocks



Standard counter function blocks

Standard timer function blocks

Standard timer function blocks — timing diagrams

Program declaration features
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Compliance List

No. Description Note

1 Up-counter Supported

2 Down-counter Supported

3 Up/Down-counter Supported

Tab. G-36: Standard counter function blocks

No. Description Note

1 TP Supported

2a TON Supported

2b T—-0 Not supported

3a TOF Supported

3b 0—-T Not supported

Tab. G-37: Standard timer function blocks

No. Description Note

1 TP Supported

2 TON Supported

3 TOF Supported

Tab. G-38: Standard timer function blocks — timing diagrams

No. Description Note

1-9b Features 1 to 9b of table 23

10 Formal input and output parameters Not supported

11-14 Features 1-4 of table 17

15-18 Features 1-4 of table 18

19 Use of directly represented variables Supported

20 VAR_GLOBAL...END_VAR
declaration within a program

Supported

21 VAR_ACCESS...END_VAR
declaration within a program

Not supported

Tab. G-39: Program declaration features



Step features

Transitions and transition conditions

Declaration of actions
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No. Description Note

1 Step - graphical form with directed links
Initial step - graphical form with directed links

Supported

2 Step - textual form without directed links
Initial step - textual form without directed links

Not supported

3a Step flag - general form:
name.X = a variable of  type BOOL

Not supported

3b Step flag - direct connection of Boolean variable
name.X to right side of step

Not supported

4 Step elapsed time - general form
name.T = a variable of type TIME

Not supported

Tab. G-40: Step features

No. Description Note

1 Transition condition using ST language Supported

2 Transition condition using LD language *

3 Transition condition using FBD language *

4 Use of transition connector Supported

4a Transition condition in LD language with transition connector Supported

4b Transition condition in FBD language with transition connector Supported

5 Transition condition in ST in textual form Not supported

6 Transition condition in IL in textual form Not supported

7 Transition with transition name Supported

7a Transition condition using LD language Supported

7b Transition condition using FBD language Supported

7c Transition condition using IL language Supported

7d Transition condition using ST language Supported

* Supported through connectors

Tab. G-41: Transitions and transition conditions

No. Description Note

1 Any Boolean variable declared in a VAR or VAR_OUTPUT block, or their
graphical equivalents, can be an action.

Supported

2l Graphical declaration of an action in LD language Supported

2s Inclusion of SFC elements in an action Not supported

2f Graphical declaration of an action in FBD language Supported

3s Textual declaration of an action in ST language Supported

3i Textual declaration of an action in IL language Supported

Tab. G-42: Declaration of actions



Step/action association

Action block features

Action qualifiers
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Compliance List

No. Description Note

1 Action block *

2 Concatenated action blocks *

3 Textual step body with action calls Not supported

4 Action block “d” field Not supported

* Implemented through the editors

Tab. G-43: Step/action association

No. Description Note

1 “a”: Qualifier Not supported

2 “b”: Action name Not supported

3 “c”: Boolean “indicator” variables Not supported

4 “d”: Action using IL language Not supported

5 “d”: Action using ST language Not supported

6 “d”: Action using LD language Not supported

7 “d”: Action using FBD language Not supported

8 Use of action blocks in ladder diagrams Not supported

9 Use of action blocks in function block diagrams Not supported

Tab. G-44: Action block features

No. Description Note

1 None: Non-stored (mull qualifier) Supported

2 N: Non-stored Not supported

3 R: overriding Reset Not supported

4 S: Set (stored) Not supported

5 L: time Limited Not supported

6 D: time Delayed Not supported

7 P: Pulse (edge) Not supported

8 SD: Stored and time Delayed Not supported

9 DS: Delayed and Stored Not supported

10 SL: Stored and time Limited Not supported

Tab. G-45: Action qualifiers



Sequence evolution

Compatible SFC features (graphical only)

SFC minimal compliance requirements (graphical only)
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No. Description Note

1 Single sequence Supported

2a Divergence of sequence selection, priority of evaluation from left to right Supported

2b Divergence of sequence selection, user-defined priority of evaluation (numbers) Not supported

2c Divergence of sequence selection with user-defined mutual exclusion of
transition conditions as specified by IEC 848.

Not supported

3 Convergence of sequence selection Supported

4 Simultaneous sequences — divergence Simultaneous sequences —
convergence

Supported

5abc Sequence skip (corresponding to 2a, b, c) Supported (2a only)

6abc Sequence loop (corresponding to 2a, b, c) Not supported

7 Directional arrows in SFC charts Not supported

Tab. G-46: Sequence evolution

No. Description Note

40 1, 3a, 3b, 4 Not supported

41 1, 2, 3, 4, 4a, 4b, 7, 7a, 7b Not supported

42 1, 2l, 2s, 2f Not supported

43 1, 2, 4 Not supported

44 1 to 9 Not supported

45 1 to 10 Not supported

46 1 to 7 Not supported

57 all Not supported

Tab. G-47: Compatible SFC features (graphical only)

No. Description Note

40 1 Supported

41 1 or 2 or 3 or (4 and (4a or 4b)) or (7 and (7a or 7b or 7c or 7d)) Supported

42 1 or 2l or 2f Supported

43 1 or 2 or 4 *

45 1 or 2 Supported

46 1 and (2a or 2b or 2c) and 3 and 4 Supported

47 (1 or 2) and (3 or 4) and (5 or 6) and (7 or 8) and (9 or 10) and (11 or 12) Not supported

* Implemented through the editors

Tab. G-48: SFC minimal compliance requirements (graphical only)



Configuration and resource declaration features

Task features
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Compliance List

No. Description Note

1 CONFIGURATION...END_CONFIGURATION construction Not supported

2 VAR_GLOBAL...END_VAR construction within CONFIGURATION Not supported

3 RESOURCE...ON...END_RESOURCE construction Not supported

4 VAR_GLOBAL...END_VAR construction within RESOURCE Not supported

5a Periodic TASK construction within RESOURCE Not supported

5b Non-periodic TASK construction within RESOURCE Not supported

6a PROGRAM declaration PROGRAM-to-TASK association Not supported

6b PROGRAM declaration with FUNCTION BLOCK-to-TASK association Not supported

6c PROGRAM declaration with no TASK association Not supported

7 Declaration of directly represented variables in VAR_GLOBAL Not supported

8a Connection of directly represented variables to PROGRAM inputs Not supported

8b Connection of GLOBAL variables to PROGRAM inputs Not supported

9a Connection of PROGRAM outputs to directly represented variables Not supported

9b Connection of PROGRAM outputs to GLOBAL variables Not supported

10a VAR_ACCESS...END_VAR construction Not supported

10b Access paths to directly represented variables Not supported

10c Access paths to PROGRAM inputs Not supported

10d Access paths to GLOBAL variables in RESOURCES Not supported

10e Access paths to GLOBAL variables in CONFIGURATIONS Not supported

10f Access paths to PROGRAM outputs Not supported

Tab. G-49: Configuration and resource declaration features

No. Description Note

1a Textual declaration of periodic TASKS according to feature 5a of table 49 Not supported

1b Textual declaration of non-periodic TASKS according to feature 5b of table 49 Not supported

2a Graphical representation of periodic TASKS Supported

2b Graphical representation of non-periodic TASKS Supported

3a Textual association with PROGRAMS according to feature 6a of table 49 Not supported

3b Textual association with FUNCTION BLOCKS according to feature 6b of table 49 Not supported

4a Graphical association with PROGRAMS (within RESOURCES) Supported

4b Graphical association with FUNCTION BLOCKS
(within PROGRAMS in RESOURCES) Supported

5a Non-pre-emptive scheduling Supported

5b Pre-emptive scheduling Not supported

Tab. G-50: Task features



Examples of instruction fields

Instruction List (IL) operators

Function block invocation features for IL language
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No. Description Note

1 Label, Operator, Operand Supported

Tab. G-51: Examples of instruction fields

No. Description Note

1 LD Supported

2 ST Supported

3 S, R Supported

4 AND, N, ( Supported

5 &, N, ( Not supported

6 OR, N, ( Supported

7 XOR, N, ( Supported

8 ADD, ( Supported

9 SUB, ( Supported

10 MUL, ( Supported

11 DIV, ( Supported

12 GT, ( Supported

13 GE, ( Supported

14 EQ, ( Supported

15 NE, ( Supported

16 LE, ( Supported

17 LT, ( Supported

18 JMP, C, N Supported

19 CAL, C, N Supported

20 RET, C, N Supported

21 ) Supported

Tab. G-52: Instruction List (IL) operators

No. Description Note

1 CALL with input parameter list Supported

2 CALL with load/store of input parameters Supported

3 Use of input operators Not supported

Tab. G-53: Function block invocation features for IL language



Standard function block input operators for IL language

Operators of the ST language

ST language statements
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Compliance List

No. Description Note

!!!Only relevant when supported in 53.3!!!

Tab. G-54: Standard function block input operators for IL language

No. Description Note

1 (Expression) parenthesisation Supported

2 Function call (argument list) Supported

3 ** Supported

4 - (Negation) Supported

5 NOT Supported

6 * Supported

7 / Supported

8 MOD Supported

9 + Supported

10 - (Subtraction) Supported

11 <, >, <=, >= Supported

12 = Supported

13 <> Supported

14 & Supported

15 AND Supported

16 XOR Supported

17 OR Supported

Tab. G-55: Operators of the ST language

No. Description Note

1 Assignment := Supported

2 Function block invocation and FB output usage Supported

3 RETURN Supported

4 IF Supported

5 CASE Supported

6 FOR Supported

7 WHILE Supported

8 REPEAT Supported

9 EXIT Supported

10 Empty statement Supported

Tab. G-56: ST language statements



Representation of lines and blocks

Graphic execution control elements, examples

Power bar
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No. Description Note

1 Horizontal lines: ISO 646 “–” character, semigraphic Not supported

2 Horizontal lines, graphic Supported

3 Vertical lines ISO 646 “+” character, semigraphic Not supported

4 Vertical lines, graphic Supported

5 Horizontal/vertical connection ISO 646 “+” character, semigraphic Not supported

6 Horizontal/vertical connection, graphic Supported

7 Line crossing without connection ISO 646 characters, semigraphic Not supported

8 Line crossing without connection, graphic Supported

9 Connected and non-connected corners ISO 646 “+” character, semigraphic Not supported

10 Connected and non-connected corners, graphic Supported

11 Blocks with connecting lines, ISO 646 character, semigraphic Not supported

12 Blocks with connecting lines, graphic Supported

13 Connectors using ISO 646 characters, semigraphic Not supported

14 Connectors, graphic Supported

Tab. G-57: Representation of lines and blocks

No. Description Note

1 Unconditional jump in FBD language Supported

2 Unconditional jump in LD language Supported

3 Conditional jump in FBD language Supported

4 Conditional jump in LD language Supported

5 Conditional return in LD language Supported

6 Conditional return in FBD language Supported

7 Unconditional return from functions and function blocks Supported

8 Alternative representation in LD language Supported

Tab. G-58: Graphic execution control elements, examples

No. Description Note

1 Left power bar with attached horizontal link Supported

2 Right power bar with attached horizontal link Not supported

Tab. G-59: Power bar



Link elements

Contacts

Coils (terminating operations)
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Compliance List

No. Description Note

1 Horizontal link Supported

2 Vertical link (with attached horizontal links) Supported

Tab. G-60: Link elements

No. Description Note

1 Normally open contact (make) —|   |— Supported *

2 Normally open contact (make) —!   !— Not supported *

3 Normally closed contact (break) —| / |— Supported *

4 Normally closed contact (break) —! / !— Not supported *

5 Positive transition-sensing contact —| P |— Not supported *

6 Positive transition-sensing contact —! P !— Not supported *

7 Negative transition-sensing contact —| N |—

Negative transition-sensing contact —! N !—

Not supported *
Not supported *

* Graphical

Tab. G-61: Contacts

No. Description Note

1 Coil —(   )— Supported *

2 Negated coil —( / )— Supported *

3 SET (latch) coil —( S )— Supported *

4 RESET (unlatch) coil —( R )— Supported *

5 Retentive (memory) coil —( M )— Not supported

6 SET retentive (memory) coil —( SM )— Not supported

7 RESET retentive (memory) coil —( RM )— Not supported

8 Positive transition-sensing coil —( P )— Not supported

9 Negative transition-sensing coil —( N )— Not supported

* Graphical

Tab. G-62: Coils (terminating operations)
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